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Preface

Audience
This guide is written for administrators who are responsible for setting up and
maintaining the Action Request System (AR System). The administrator is the
architect of the support request and problem resolution process.

As an administrator, you will also need to be familiar with the AR System User
Tool and Notification Tool. This manual assumes that you understand the
information contained in the Action Request System User’s Guide.

This manual describes the operations that are performed regularly by those
using the Administrator Tool and assumes familiarity with MS-DOS and
Microsoft Windows.

Overview of this Document
Chapter 1, “Installing the Windows Administrator and Import Tools,” provides
instructions for installing the Administrator and Import Tools on a personal
computer (PC) running Windows.

Chapter 2, “Getting Started with the Administrator Tool,” describes how to
start, stop, and use the Administrator Tool.

Chapter 3, “Using the Administrator Tool,” provides an introduction to the
Administrator Tool window and menus. It also describes how to obtain
information about the AR System UNIX and Windows NT servers and licenses
and how to build and use change history for AR System structures.
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Chapter 4, “Setting Up the AR System,”gives an overview of concepts an AR
administrator will need to understand in order to design and build an efficient
application of the AR System.

Chapter 5, “Setting Up Groups and Users,” describes how to set up client users
and establish client environments on users’ machines. This chapter includes a
discussion of access control.

Chapter 6, “Defining Schemas,” describes how to create and maintain the
schemas that define the information fields in your database.

Chapter 7, “Defining Fields,” describes how to create and maintain the
information fields in your schemas.

Chapter 8, “Defining Schema Views,” describes how to create and modify
different schema views.

Chapter 9, “Defining Menus,” describes how to create and maintain pull-right
character menus and how to attach the menus you create to any character field
on any schema.

Chapter 10, “Defining Filters,” describes how to create and maintain the filters
that define your workflow process and other conditional processing.

Chapter 11, “Defining Escalations,” describes how to create and maintain the
escalations that control the timing aspects of your workflow process and other
conditional processing.

Chapter 12, “Defining Active Links,” describes how to create and maintain the
active links that take specific actions on the client machine when a user
performs a particular task or operation.

Chapter 13, “Importing and Exporting Definitions,” describes how to transfer
schema, filter, active link, escalation, and menu definitions.

Chapter 14, “Using the Import Tool,” describes how to start and use the AR
System Import Tool.

Chapter 15, “Electronic Mail Support,” describes how to configure the mail
handler so that ARs can be submitted using email (in addition to the User
Tool), and explains the conventions used for mail templates.

Chapter 16, “The Multi-Process Server Option,” describes how to use and
administer the optional multi-process server feature of the AR System.
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Chapter 17, “Full Text Search,” describes how to use and administer the
optional full text search (FTS) feature of the AR System.

Chapter 18, “AR System Server Utilities,” describes how to use the arcache
and arreload utilities with the Windows NT server.

Appendix A, “Networking Notes,” tells you about the supported network
stacks and requirements for their use.

Appendix B, “AR System File Locations,” describes the various files needed by
and created by the AR System.

Appendix C, “Core and Reserved Schema Fields,” describes the fields all
schemas must contain as well as the fields that are reserved for special uses.

Appendix D, “Operators, Wildcards, and Keywords,” lists the operators,
keywords, and wildcards that you use to build qualifications in filters,
escalations, and active links.

Appendix E, “Design Worksheets,” provides worksheets that you can
reproduce for designing your workflow, schemas, active links, filters, and
escalations.

Appendix F, “Procedures,”provides a list of procedures and their locations.

The “Glossary” lists and describes terms that you will need to be familiar with
as you use the AR System.

AR System Documents
The Action Request System Installation Guide is a guide to installing and
licensing the AR System software for all Windows and Windows NT
environments.

The Action Request System Getting Started Guide and Sample
Schemas provides an online demonstration showing the use of the AR System
in a sample help desk environment and describes how you can use the sample
schemas provided with the AR System.

The Action Request System User’s Guide is a how-to description of the
operations performed by all users of the AR System. There are separate User’s
Guides for environments supporting the Motif, Macintosh, and Windows
graphical user interfaces (GUIs) and for ASCII terminals.
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The Action Request System Administrator’s Guide (this manual) describes
how the AR System Administrator can use the Administrator Tool to set up the
AR System and define its local operations. This manual is also a reference of
advanced AR System concepts. There are separate Administrator’s Guides for
the Motif and Windows environments.

The Action Request System Programmer’s Guide is a reference guide for
programming with the application programming interfaces (APIs) that come
with the AR System.

The Action Request System Troubleshooting and Error Messages Guide
provides information to help you identify and solve problems with the AR
System.

The Action Request System Distributed Server Option Administrator’s Guide
provides information about operating the AR System in a distributed, multi-
server environment.

The ARWeb Administrator’s Guide provides details about installing, using,
and customizing the ARWeb application, so that you can provide access to
your company’s AR System applications through the World-Wide Web.

The Action Request System Help Desk Template Guide describes the Help
Desk application that runs in conjunction with the AR System to help you
manage your internal help desk organization.

Conventions Used in this Manual
bold font

Indicates that a word is a new or important term.
Example: filters.

Initial Caps
Button and menu names and items have the first letter capitalized.
Example: File.

computer font
Indicates computer output, including UNIX prompts, an explicit directory, or a
file name.
Example: prompt%.

Indicates data to be entered by the user.
Example: aruser & .
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<small italic  fon in angle bracketst>
Indicates a variable directory, file name, or string that you replace with an
appropriate directory, file name, or string.
Example: <ar_config_dir>.

italics
Indicates a reference to another manual or to a different section within the
current manual.
Example: see AR System Documents.
Italic type is also used for emphasis.
Example: All users will be affected.
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1

Installing the Windows
Administrator and Import Tools 1

This chapter explains how to extract the AR System Windows Administrator
and Import Tools from the distribution media and install it on a PC-compatible
client computer running Windows.

This chapter covers the following topics:

• Hardware, operating system (OS), and network dependencies.

• Installing the software on PC client machines.

The AR System Windows Administrator Tool and Import Tool software is
distributed on 3.5" disks. These media are used to install the Windows
Administrator and Import Tool software and modify Windows-related system
files.
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1

Hardware, OS, and Network Dependencies
Table 1-1 summarizes the minimum configuration requirements for PC client
machines:

See either the Release Notes that came with this product or Appendix A, for
specific information about network stacks.

Table 1-1 System Requirements for a PC Running Windows

Platform/Hardware OS Network Stacks

IBM PC (and
compatibles) 386 or
higher.

* Monitor with a
minimum screen
resolution of 640 x 480
(VGA) that supports 16
colors.
* 4MB of hard disk
space available
(minimum) for the AR
System software.
* 4MB RAM minimum,
8 MB RAM
recommended.
* Mouse.
* Any of the network
adapter cards needed
by the networking
software.

MS-DOS 3.3 (or
later).
and
Microsoft
Windows 3.1
running in enhanced
mode.
1ci
Microsoft
Windows for
Workgroups 3.11
running in enhanced
mode.

* Chameleon NFS 4.0 (with patch
4) or later by NetManage.
* LAN Workplace 4.12 or later
by Novell.
* Pathway 3.2 or later by
Wollongong.
* PC-NFS 5.1 or later by
SunSelect.
* PC/TCP 3.0 (VxD) or later by
FTP.
* Reflection Network Series 4.0 or
later by Walker Richer & Quinn.
* Super TCP/NFS 4.0 (with
patch) or later by Frontier.
* TCP/IP-32 version 3.11a or later
by Microsoft.

Microsoft
Windows 95
16MB RAM
minimum required.

Default TCP/IP network stack
for
Windows 95.

Microsoft
Windows NT 3.5 (or
later)
16MB RAM
minimum required.

TCP/IP-32 version 3.11a or later
by Microsoft.

IBM OS/2 Warp
16 MB RAM
minimum required.

TCP/IP Version 2.0 for OS/2:
Base Kit
TCP/IP Version 2.0 for OS/2:
DOS/Windows Access Kit



Installing the Windows Administrator and Import Tools 3

1

Installing the Software on a Windows Client
Before you install the Windows Administrator and Import Tools, make sure
you have all of the following information:

• The host names of the AR System servers.

• The directory in which Windows is installed.

• The network stack you are using.

Note – Before installing, it is a good idea to make backup copies of your AR
System Administrator Tool for Windows disks. From the Disk menu in the
Windows File Manager, use Copy Disk. (Refer to the Copy Disk command in
your Microsoft Windows User’s Guide for instructions.)

To install the Windows Administrator and Import Tool software:

Note – When you install the tools, make sure your old ar.ini file is copied
into ar.ini  in the \home\backup  directory.

1. Ensure that the network stack is properly installed. (For information on
which network stacks are supported, see the previous section, “Hardware,
OS, and Network Dependencies.)

2. Use the ping utility provided by the network stack to ping each server
that will be managed with the Windows Administrator Tool and Import
Tool software.

3. Scan the Release Notes for any installation information you need to know
before installing the tools.

4. Start Windows, if it is not already running.

5. Exit any AR System client tools that are running. You cannot install the
Administrator or Import Tools if any of these are running.

6. Insert the media into the drive.

7. In the Program Manager, choose Run from the File menu. The Run dialog
box appears as shown in Figure 1-1.
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Figure 1-1 Run Dialog Box

8. In the Command Line field, type A:SETUP (or B:SETUP) and click the OK
button.
The installation program starts and a window appears indicating that the
Setup program is initializing. The Setup program searches your local drives
for a previous Windows Administrator Tool installation.

The Welcome dialog box appears as shown in Figure 1-2.

Figure 1-2 Welcome Dialog Box

9. After reading the greeting, do one of the following:
• Click the Continue button to proceed with the installation.
• Click the Exit button if you want to stop the installation procedure.
If you clicked the Continue button, the Installation Options dialog box
appears displaying your current installation directories and disk space
information, as shown in Figure 1-3.
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Figure 1-3 Installation Options Dialog Box

10. In the Installation Options dialog box, do one of the following:

Table 1-2 Installation Options

If you want to... Click the...

Continue with the installation procedure and install
both the Administrator and Import Tools.

Continue button.

Install only the Administrator Tool. Clear the ARImport  box,
then click the Continue
button.

Install only the Import Tool. Clear the ARAdmin box,
then click the Continue
button.

Stop the installation procedure. Exit button (F3 key).

Display the Directories dialog box to change the
default directories for the tools installation,
configuration files, or your Windows files.

Directories button.
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11. If you clicked the Directories button, the Directories dialog box appears,
as shown in Figure 1-4.

Figure 1-4 Directories Dialog Box

• To find out how much space is available on one of your drives, choose the
drive from the Drive drop-down list. The Disk Space Information box
reflects the available space on the disk.

• To change the directories in the Install Directory, Home Directory and
Windows Directory fields, either type directly in the fields or click the
Browse button next to the Install Directory and Home Directory fields to
display the Browse Directories dialog box. The Browse Directories dialog
box allows you to browse through and select from all available directories
on the different drives on your system.

Click the OK button to apply your changes and return to the Installation
Options dialog box.

Note – If you specify a Windows directory that does not already
contain the win.ini  file, the value in the Windows Directory
field returns to the default directory.
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12. If you clicked the Continue button, the Time Zone dialog box appears, as
shown in Figure 1-5.

Figure 1-5 Time Zone Dialog Box

In the Time Zone field, choose the appropriate time zone for your region
from the drop-down list:

If you are in a region in which daylight savings time is observed, select the
Daylight Savings Time check box.

Click on the Continue button to continue with the installation, or click on
the Exit button if you want to stop the installation procedure.

13. If you click the Continue button, the Server Locations dialog box appears
as shown in Figure 1-6, allowing you to view the location of current
servers, or add/delete servers. The Server List in the lower portion of the
dialog box is a list of AR System servers to which your tools can connect.

* PST8, Pacific Standard Time * ST-3, Israeli Standard Time

* MST7, Mountain Standard Time * KST-9, Korean Standard Time

* CST6, Central Standard Time * JST-9, Japanese Standard Time

* EST5, Eastern Standard Time * WST-8, Australian/West Standard
Time

* AST4, Atlantic Standard Time * EST-10, Australian/Tasmania
Standard Time

* GMT, Greenwich Mean Time * NZT-12, New Zealand Standard Time

* WET, Western European Standard Time * HST10, Hawaiian Standard Time

* CET-1, Central European Standard Time * YST9, Yukon Standard Time

* EET-2, Eastern European Standard Time
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Figure 1-6 Server Locations Dialog Box

Note – Do not be confused with the abbreviation “NT” that appears in the
Server List. Here NT specifically refers to the Notification Tool, not to the AR
System Windows NT 2.1 servers running in the Windows NT operating
system.

14. In the Server Locations dialog box (Figure 1-6), do one of the following:
• To add a server, enter a server name in the Server Name field, select the

AR System Server or Notification Server check boxes, then click the Add
button.

• To delete a server from the Server List, select the server from the Server
List, and then click the Delete button.

• To disable access to a server, select a server, then enter a pound sign (#)
before its name in the Server Name field.

15. Once your server list is correct, click on the Continue button to continue
with the installation procedure. (Or, if you want to stop the installation
procedure, click on the Exit button.)
A status bar appears displaying the progress of loading the tool files, as
shown in Figure 1-7. (To stop the installation procedure, click on the Exit
icon in the lower right corner of the screen, or press the F3 key.)
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Figure 1-7 Status Bar

16. Remove the first disk and insert the second disk when the installation
program asks you to do so.
After the tool files have been installed, the Configuration Files dialog box
(Figure 1-8) appears allowing you to modify your win.ini  and any existing
tool files either now or after the installation is completed.

Figure 1-8 Configuration Files Dialog Box

17. In the Configuration Files dialog box (Figure 1-8), do one of the following:
• Keep the default choice (Make Changes now and backup current

version ) in the Initialization file handling options  group box and
click the Continue button to back up the current version of your win.ini

and tool files and to make the changes to the original files when the
software is installed.

• Select the Write modified version to another location  radio button,
then press the Continue button to have the installation process save your
modifications in another location, allowing you to update your win.ini

and tool files at a later time.
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• Click the Exit button if you want to stop the installation procedure at this
point.

If you selected the default choice in the Configuration Files dialog box (Make

Changes now and backup current version ), the Modified Files dialog
box appears as shown in Figure 1-9, which provides the location of the
backup files.

Figure 1-9 Modified Files Dialog Box (First File-Handling Option)

If you specified the Write modified version to another location  radio
button, then the Modified Files dialog box appears as shown in Figure 1-10,
which provides the location of the files modified during the installation and
further instructions.

Figure 1-10 Modified Files Dialog Box (Second File-Handling Option)

18. Click the OK button to acknowledge the file locations and dismiss the
dialog box.
The Setup Complete dialog box appears (shown in Figure 1-11) indicating
that you have successfully installed the Windows Administrator and Import
Tools.



Installing the Windows Administrator and Import Tools 11

1

Figure 1-11 Setup Complete Dialog Box

19. Click the OK button to complete the installation process.

20. Eject the media and store it in a safe place.
You now can start the Administrator and Import Tools.

• To start the Administrator Tool, see “Starting the Administrator Tool” on
page 13.

• To start the Import Tool, see “Import Tool Functions” on page 319.
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Getting Started with the
Administrator Tool 2

This chapter explains how to start and stop the AR System Windows
Administrator Tool. It also explains basic information about using the
Administrator Tool.

This chapter covers the following topics:

• Starting the Administrator Tool.

• Logging into the Administrator Tool.

• Exiting the Administrator Tool.

• Displaying help and version information.

• Working in the Administrator Tool main window (includes information on
making menu selections and using the toolbar).

Starting the Administrator Tool
Once the AR System is installed, your desktop automatically displays the
“Remedy AR System” group window containing the Administrator Tool icon.
To start the tool, simply double-click the Administrator Tool icon.

Note – In Windows 3.1, you can run only one instance each of the AR System
clients at any one time on a given machine. However, in Windows NT, you can
run multiple instances of the clients in separate memory spaces. For further
information, refer to the Microsoft Windows NT System Guide.
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User Name and Password

Only users registered as AR administrators or subadministrators will be able to
use the Administrator Tool. See Chapter 5, for information on how to add users
and groups to the AR System.

Note – To operate the Administrator Tool in a production environment, you
must have a fixed write license and administrator or subadministrator
privileges.

To start the Administrator Tool:
1. From the Remedy AR System program group, double-click the AR

Administrator Tool icon. The Login dialog box appears as shown in
Figure 2-1.

Figure 2-1 Login Dialog Box

2. Log in as Demo.

Note – Demo is installed without a password during the initial installation.
The AR System is case sensitive. This means you must use Demo, not demo or
DEMO.
Do not let the Demo user become a security hole in the AR System. Add a
password for this user as soon as possible. See Chapter 5, for information on
adding a password.
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Note – The user Demo may not be present on existing servers.

If the name and password you entered are valid, the Login dialog box
closes. You are in the AR System Administrator Tool Main window and
ready to begin working.

If this is the first time you are logging into the Administrator Tool, your
login information consists of the default configuration directory and server
list on your PC. If you have already created alternate logins for the User
Tool, these names appear as options from the User Name menu. For
information on modifying login names, configuration directories, and server
lists in the User Tool, see the following section, “Login Information”.

If you enter a valid user name but an invalid password, you receive an error
message and are not logged in.

The Administrator Tool Main window and Server window are displayed, as
shown in Figure 2-5 on page 25. After starting the Administrator Tool, refer
to the appropriate chapter for information about specific tasks.

Note – Security Alert:For security reasons, the Windows Administrator Tool
does not automatically save your name and password, so the Login dialog box
will always appear. If security is not an issue for you, you can add the
following to the [Admin ] section of your ar.ini  file:
[Admin ]
User=<your_name>

Password=<your_password>

The Windows Administrator Tool will then read the login information from the
file and the Login dialog box will display your name and password.

Login Information

Your login information consists of a login name, configuration directory (AR
Home Directory), and a server list. The configuration directory is a directory
that the AR System uses to hold your personalized configuration information
for the client tools. If you do not specify alternate configuration directories and
more than one person logs into your client tools, your customizations
(preferences) may be overwritten and notifications stored in the notification log
may be both yours and theirs. If more than one person will be using the tools
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on your PC, you may want to specify an alternate configuration directory for
each user. This allows users to have their own customizations (preferences,
customized defaults, and customized views) and notification log.

We provide default login information for any user who logs into the
Administrator Tool and who does not specify any alternate login information.
When first installing the AR System, the default login’s configuration directory
is named Home. Throughout this manual, we refer to your configuration
directory as either <ar_config_dir> or \Home.

Note – If you change your configuration directory for the Administrator Tool,
you are also changing it for the other client tools.

The server list is the list of servers that you can connect to with your client
tools. The server name must be a name that is known on the network. You
supply the default server list when first installing the Action Request System.

Note – Any user of the Administrator Tool can change any other user’s login
information.

Specifying Alternate Login Information

You can specify alternate login information for any user name from within the
Administrator Tool. When you do this, you add the user name to the User
Name drop down list box on the Login dialog boxes for the client tools. This
makes it easier to log into the tools.

Use the following instructions to specify alternate login information after
logging into the Administrator Tool.

To specify alternate login information:
1. Choose Login from the File menu.

The Login dialog box (shown in Figure 2-1 on page 14) appears.

2. Click the Login Information button.
The Login Information dialog box appears, as shown in Figure 2-2.
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Figure 2-2 Login Information Dialog Box

3. To use the default configuration directory and server list, select
***Default Login***  in the User Names list.
*** Default Login ***  appears in the Login Name field. The default
configuration directory and server list appear in the AR Home Directory
and Servers fields.

4. To copy someone else’s configuration directory and server list, select that
person’s user name in the User Names list. For more information, see
“Copying Login Information” on page 20.
That user’s login name, configuration directory, and server list appear in the
Login Name, AR Home Directory, and Servers fields.

5. To change the configuration directory, in the AR Home Directory field
enter a new directory path.

6. To make changes in the server list, select the Servers button.
The Servers dialog box appears, as shown in Figure 2-3.
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Figure 2-3 Servers Dialog Box

7. To add a server to the server list, enter a server name in the Name field,
select the User or Notifier check boxes as appropriate, and then select the
Add button.

8. To modify a server in the server list, select the server name in the Servers
list, make any changes in the Name field or in the User and Notifier check
boxes, and then select the Modify button.

9. To delete a server from the server list, select the server name in the Server
list and select the Delete button.

10. To comment out a server from the server list without deleting it, select a
server from the Servers list and place a pound sign (#) in front of the
server name, then click the Modify button.

11. Click the OK button to save server information and close the Servers
dialog box and return to the Login Information dialog box. Click the
Cancel button to cancel any changes.

12. To go back to the last saved server list for the given AR Home directory,
click the Refresh button.
All changes that you have made to the server list are lost.

13. Edit the Login Name field, as appropriate.

14. To add this login information, click the Add button.

15. For each additional user, repeat from Step 3.

16. To remove the Login Information dialog box, click the Close button.
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Note – After specifying alternate login information, the changes go into effect
the next time this user name logs into the Administrator, User, Import, or
Notification Tools.

Modifying Login Information

You can modify any user’s login information (including the default login
information) from within the Administrator Tool. Use the following
instructions to modify any user’s configuration directory or server list.

Use the following instructions to modify login information at any time after
you have successfully logged into the Administrator Tool.

To modify login information:
1. Choose Login from the File menu.

The Login dialog box (shown in Figure 2-1 on page 14) appears.

2. Click the Login Information button.
The Login Information dialog box appears, as shown in Figure 2-2 on
page 17.

3. Select the user name from the User Names list.
The AR Home Directory field and Servers list contain your configuration
directory and server list.

4. To change the configuration directory, in the AR Home Directory field,
enter a new directory path.

5. To make changes in the server list, click the Servers button.
The Servers dialog box appears, as shown in Figure 2-3 on page 18.

6. To add a server to the server list, enter a server name in the Name field,
select the User or Notifier check boxes as needed, and then click the Add
button.

7. To modify a server in the server list, select the server name in the Servers
list, make any changes in the Name field or in the User and Notifier check
boxes, and then click the Modify button.

8. To delete a server from the server list, select the server name in the Server
list and click the Delete button.
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9. To comment out a server from the server list without deleting it, place a
pound sign (#) in front of the server name and click the Modify button.

10. Click the OK button to save server information and close the Servers
dialog box and return to the Login Information dialog box.

11. To go back to the last saved server list for the given AR Home directory,
click the Refresh button.
All changes that you have made to the server list are lost.

12. To save the modified login information, click the Modify button.

Note – After modifying login information, the changes go into effect the next
time this user name logs into the client tools.

Copying Login Information

You can copy either the default login information or an existing user’s login
information to another user.

Note – You cannot enter a name in the Login Name field that already exists in
the User Names list. If you want to copy existing login information to a name
already in the User Names list, you must first delete the user name from the
User Names list.

Use the following instructions to copy login information at any time after you
have successfully logged into the Administrator Tool.

To copy login information:
1. Choose Login from the File menu.

The Login dialog box (shown in Figure 2-1 on page 14) appears.

2. Click the Login Information button.
The Login Information dialog box appears, as shown in Figure 2-2 on
page 17.
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3. To copy the default configuration directory and server list, select
***Default Login***  in the User Names list.
*** Default Login ***  appears in the Login Name field. The default
configuration directory and server list appear in the AR Home Directory
and Servers fields.

4. To copy someone else’s configuration directory and server list, select that
person’s user name in the User Names list.
That user’s login name, configuration directory, and server list appear in the
Login Name, AR Home Directory, and Servers fields.

5. Edit the Login Name field as appropriate.

6. Rename the AR Home Directory as appropriate.

7. To add this new user’s login information, click the Add or Modify button.

Note – After modifying login information, the changes go into effect the next
time this user name logs into the client tools.

Deleting Login Information

You can delete login information from within the Administrator Tool. If you do
this, the user name no longer appears in the User Name drop down list box on
the Login dialog boxes for the client tools and that user name will use the
default configuration directory and server list when they log in.

Use the following instructions to delete login information at any time after you
have successfully logged into the Administrator Tool.

To delete login information:
1. Choose Login from the File menu.

The Login dialog box (shown in Figure 2-1) appears.

2. Click the Login Information button.
The Login Information dialog box appears, as shown in Figure 2-2 on
page 17.

3. Select the user name from the User Names list.

4. Click the Delete button.
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Note – When you delete a user name from the User Names list, all directories
and files associated with this user name remain on your system.

5. To dismiss the Login Information dialog box, click the Close button.

Logging In as a Different User

If the Administrator Tool was previously started by another user, you can
change the login information and log in as yourself. You can log in at any
machine on the network that has access to the AR System server.

Note – Preference and other settings are saved in each user’s configuration
directory on each PC and are therefore specific to the PC on which they were
set. This means that if you log onto a machine other than the one you normally
use, and the directory containing your login information is not mounted as a
network drive, or your login information has not been added to this
Administrator Tool, the preference settings and customized default settings
(login information) may be different from those you normally see.

To change the current login:
1. Choose Login from the File menu.

The Login dialog box (shown in Figure 2-1 on page 14) appears.

2. Type your user name in the User Name field or click on the drop down list
box symbol and select your user name from the drop down list box.

3. Type your password in the Password field.

4. Click the OK button to complete the login.

Exiting the Administrator Tool

To exit the Administrator Tool:
You can exit the Administrator Tool by any one of the following ways:

• Choose Exit from the File menu (see Figure 3-1 on page 35).

• Type Alt+F, then X .
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• Type Alt+F4 .

• Choose Close from the Control menu box in the upper left hand corner of
the Main window.

• Double-click the Control menu box.

If you have selected the Confirm to Exit AR System confirm preference, a
dialog box appears asking you if you really want to exit the AR System. Click
the OK button to exit the Administrator Tool. Click the Cancel button to cancel
the exit operation.

Note – If your Administrator Tool is in the middle of a transaction with the
server, you will not be able to exit the Administrator Tool until the transaction
is completed.

Displaying Help
Application help information is available on all Administrator Tool windows
and commands. Help is also available on many of the procedures that you
most commonly perform.

To display Administrator Tool help:
• From the Help menu, choose Contents to see an index of available help

topics.

• Pressing the F1 key or clicking the Help button when any Administrator
Tool window or dialog box is open causes the help for that window to
appear.

Displaying Version and Environment Information

To display version and environment information about the
Administrator Tool:
• From the Help menu, choose About Admin Tool to display information

about the product, as shown in Figure 2-4 on page 24. You should be
prepared to provide this information whenever you call Customer Support.
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Figure 2-4 Administrator Tool Version Information

Using the Main Window
The Administrator Tool Main and Server windows are the basic windows of
the AR System Windows Administrator Tool, as shown in Figure 2-5 on
page 25.

• You use the menus and options available from the Main window to select
and control the operations you need to perform.

• You use the Server window to administer all the schemas, active links,
filters, escalations, and menus that reside on a particular server. (To use the
Server window, see “Selecting a Server to Administer” on page 39.)
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Figure 2-5 Administrator Tool Main and Server Windows

The Main window includes a title bar, a menu bar, a toolbar, and a status bar.
The menu bar provides access to the Administrator Tool menus that allow you
to select the operations you want to perform. The toolbar provides shortcuts to
some of the most common Administrator Tool operations. The status bars
displays messages that let you know the status of the operation in progress.

You can determine whether or not to display the toolbar and the system status
bar by setting your desktop preferences. See “Defining Preferences” on page 61
for information.

Windows User Conventions in the AR System

Remember the rules that follow as you work with the AR System Windows
Administrator Tool:

• Within the Administrator Tool, the window (or dialog box) that is active
(selected) is the one whose title bar is highlighted.

Title bar

Status bars

Servers
listed in
<ar_config_dir>\
ar file

Menu bar
Toolbar

Tooltip
for toolbar
buttons
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• In a dialog box with selection buttons, pressing the Return/Enter key
performs the default action. The default action is the action performed by
the button that has a heavy black border (the focus rectangle) around it.

• In a dialog box, pressing escape (Esc)  closes the dialog box. (Pressing Esc  is
the same as choosing Close from the File menu when a window is active,
and Esc  is the same as clicking the Cancel button when a dialog box is
active. Pressing Esc  also removes a menu.)

• In selection lists, pressing the Shift  key lets you select consecutive items.
Pressing the Control key lets you select nonconsecutive items.

• In dialog boxes, clicking the OK button saves the changes and closes the
dialog box. Clicking the Apply button saves the changes but leaves the
dialog box open.

Using the Mouse with the AR System

Mouse operations in the AR System tools are much like those in other
Windows applications. The following terminology is used in this manual to
describe the operations you perform using the mouse.

Double-click means to click the left mouse button twice in quick succession.

Drag means while pointing on an object, hold down the left mouse button and
move the mouse.

Press means hold down the left mouse button without moving the mouse.

Pull-right means to click and hold the left mouse button on the character menu
symbol (to the right of a field) to display the items. Continue to hold the mouse
button as you move the pointer over the menu items. (An arrow to the right of
a selection means that there are cascading menu items for that selection. To
display and select the items from a cascading menu, move the mouse to the
right with that choice highlighted.) When your choice is highlighted, release
the mouse button and your selection is made. (If you release the mouse button
with the cursor on the character menu symbol and the menu is small, the menu
remains displayed until either you select an item or select outside of the menu.
If you release the button outside of the menu, the menu closes and nothing is
selected.)

Select or choose means to click once on an item with the left mouse button.
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Controlling Window Size and Position

You can manipulate windows in the AR System in the same way that you can
for most Windows applications. For more information, see your Microsoft
Windows User’s Guide.

You can also set options that save the size of the Administrator Tool window
when closed or exited by setting preferences. See “Defining Preferences” on
page 61 for more information.

Making Menu Selections

You can choose options from the menu bar on the Main window in any of three
ways:

• Use the mouse to display the menu and select the desired item.

• Hold down the Alt  key as you press the key that corresponds to the letter
that is underlined in the menu, then press the key that corresponds to the
letter that is underlined in the menu item. For example, to choose Save
Schema from the File menu, type Alt +F, then S.

• Type the shortcut key sequences that are shown beside many of the items in
the menu. These key sequences are also called accelerator keys. For
example, to choose Save Schema from the File menu, type Ctrl+S .

Note – The Cut, Copy, Paste, and Delete accelerator keys work in any text
entry field, including those in the Login dialog box and the query bar.

Using the Toolbar

For many of the most commonly performed menu items, a corresponding
button is available from the toolbar located below the menu bar on the Main
window. To select a function from the toolbar, simply click the mouse on the
button for that function. To see a Windows Tooltip description of the toolbar
buttons, simply point to any toolbar button (see Figure 2-5 on page 25).
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Table 2-1 shows the toolbar buttons and their functions.

Table 2-1 Toolbar Functions

Button Function

New Server Window. New Server window appears, which allows you
to open additional Server windows for administering multiple servers
and their objects.

New Object. New Object dialog box appears, which allows you create a
new schema, active link, filter, escalation, or menu.

Save. Writes all changes made to the object to the database.

Align Left. When modifying schemas, align fields and buttons on the
left edge of the field, including the field label. Button is active only
when multiple objects are selected.

Align Right. When modifying schemas, align fields and buttons on the
right edge of the field, including any associated field menus. Button is
active only when multiple objects are selected.

Align Value Left. When modifying schemas, align fields and buttons on
the left edge of the data entry portion of the field. Button is active only
when multiple objects are selected.

Align Value Right. When modifying schemas, align fields and buttons
on the right edge of the data entry portion of the field. Button is active
only when multiple objects are selected.

Align Top. When modifying schemas, aligns the top edges of objects,
allowing you to place fields and buttons side by side. Button is active
only when multiple objects are selected.

Align Bottom. When modifying schemas, aligns the bottom edges of
objects, allowing you to place fields and buttons side by side. Button is
active only when multiple objects are selected.

Show Grid. Toggle button to make the grid lines visible or invisible in
the Create/Modify Schema window.
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Where to Go from Here
At this point, you have successfully installed the Windows Administrator Tool.
You can now select a server to administer, as described in “Selecting a Server to
Administer” on page 39.
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Using the Administrator Tool 3

The Action Request (AR) System Administrator Tool is the tool you, as the AR
System administrator, will use to set up the AR System for use by support staff
and end-users. You will use the tool to create and modify servers, schemas,
menus, filters, escalations, and active links.

This chapter describes the basic operations of the Administrator Tool. It
includes instructions for running the tool and provides a brief introduction to
the tool’s basic menus. It also describes how to display information about the
AR System servers and licenses and how to build and use change history
information for the objects (or structures) you create and modify using the
Administrator Tool.

Before attempting to use the Administrator Tool, you must have a general
familiarity with the Action Request System’s features and functions. If you are
not yet familiar with the AR System, review the Action Request System User’s
Guide before continuing with this guide.

The following topics are covered in this chapter:

• Overview of Administrator Tool functions.

• Using menus in the Main window.

• Selecting a server to administer.

• Defining server and license information.

• Defining default permissions for schemas, active links, and fields.

• Defining preferences.
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• Building and using a history of changes made to schemas, menus, filters,
escalations, and active links.

• Defining help for end-users and administrators.

Administrator Tool Functions
You use the Administrator Tool primarily to create and maintain the AR
System schemas, menus, filters, escalations, and active links (known as objects
or structures). You also use the tool to import and export definitions and
electronic mail (email) templates and to view and manage information about
the server. You can use the Windows Administrator Tool to administer all
UNIX and Windows NT server processes running in the AR System.

The functions of the AR System Administrator Tool are described below.

Creating and Modifying Schemas

The information fields in your AR System databases are described in schemas.
Each schema represents a table in a database on the AR server. The AR System
comes with several sample schemas and you can build as many additional
schemas as you need.

When you define a schema, you set up the fields on the schema and determine
what kind of information users will enter in each field. You may also create
field fill-in aids (menus) and help text.

All schemas have a set of core fields (discussed in Appendix C) and as many
additional fields as needed. For information on designing schemas, see
Chapter 4. For details on creating and modifying schemas and defining schema
fields, see Chapter 6 and Chapter 7.

Creating and Modifying Menus

You can define menus that you can then attach to any character field on any
schema. You can create menus that are simple lists of items, menus that are
stored files on both the server and client machine, or menus that are built
dynamically based on queries of AR System schemas. For details on creating
menus and using them on a schema, see Chapter 9.
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Creating and Modifying Filters

Filters define the workflow process and other conditional processing steps for
your application of the AR System. Filters test for specified conditions on each
server transaction and, if the conditions are met, they take one or more actions.
These conditions and actions are called filter conditions and filter actions. For
example, you might define a filter so that when an AR changes state (filter
condition) the AR System notifies a specific end user (filter action).

Keep in mind when creating a filter for any purpose that filters execute on the
AR System server.

For information on designing filters, see Chapter 4. For details on creating and
modifying filters, see Chapter 10.

Creating and Modifying Escalations

Escalations test for entries matching specified conditions on a defined interval.
If the conditions are met, one or more actions are taken. These conditions and
actions are called escalation conditions and escalation actions. For example,
you might create an escalation that executes when a ticket more than eight
hours old has not yet been closed by support personnel.

Keep in mind when creating an escalation for any purpose that escalations
execute on the AR System server.

For information on designing escalations, see Chapter 4. For details on creating
and modifying escalations, see Chapter 11.

Creating and Modifying Active Links

Active links define operations that are executed on the client machine when
the user performs a specific action. These conditions and actions are called
active link conditions and active link actions. For example, you might create
an active link that searches the database for information about the customer
when the user presses Return in the Customer Name field.

Keep in mind when creating an active link that active links execute on the
client system when triggered.

For information on designing active links, see Chapter 4. For details on
creating and modifying active links, see Chapter 12.
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Importing and Exporting Definitions

A definition is the structure in which the data in the AR System is organized
and manipulated (for example, for fields or active links). You can use the
Administrator Tool to export definitions on an AR server. The definitions are
exported to files. The tool also supports the import of definitions into the AR
server from files exported from AR servers. In this way, it is possible to share
definitions among organizations and to migrate an AR System setup to a new
server. For a full discussion of importing and exporting definitions, see
Chapter 13.

Creating Export Mail Templates

You can use electronic mail to submit action requests or to notify users. As the
administrator, you are responsible for generating a template for users to fill in
and use to submit their ARs. For details on generating mail templates using the
export operation, see Chapter 13. For information on setting up and using the
electronic mail handler, see Chapter 15.

Using Menus in the Server Window
The Administrator Tool Server window is the window from which you access
the main utility menus within the tool. This section provides a short
description of the File, Edit, Tools, Window, and Help menus.

Note – Additional menu items appear when you select a Server Window. For
information on these menu items, see “Using the Schemas Window” on
page 118.

The File Menu

The File menu is shown in Figure 3-1 on page 35.
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Figure 3-1 Administrator Tool — File Menu

The File menu provides the following options:

Login Allows you to log in to the AR System. You must (1)
belong to the Administrator or Subadministrator group
and (2) have a fixed license.

New Object Opens the New Object dialog box, which you use to
create a new active link, escalation, filter, menu, or
schema. You can also use a corresponding toolbar button
to create new objects.

Close Quits the currently active window.
Server
Information

Displays information about the currently selected server.
If you are an administrator, it also allows you to set
server options. See “Setting Server Information and
Option Settings” on page 41.

License
Information

Displays information about licenses that are available or
in use on the currently selected server. If you are an
administrator, it also allows you to release a floating
license, if necessary. See “Displaying License
Information” on page 53.

Default
Permissions

Allows you to define default permissions on the server
for active links, schemas, and fields. See “Setting Default
Permissions” on page 56.

Preferences Allows you to set options that control the behavior of
the Administrator Tool for your user login. Preference
categories are: Desktop, Confirmations, Schema Fonts,
and Display Menu Method. See “Defining Preferences”
on page 61.

Exit Quits the Administrator Tool.
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The Edit Menu

The Edit menu, shown in Figure 3-2, lets you delete a selected item (you can
delete only one item at a time).

Figure 3-2 Administrator Tool — Edit Menu

The Edit menu provides the following choice:

Note – This is a permanent action and cannot be undone.

The Tools Menu

The Tools menu, shown in Figure 3-3 on page 37, lets you import and export
object definitions.

Delete <object> Deletes the selected object from the server.
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Figure 3-3 Administrator Tool — Tools Menu

The Tools menu provides the following choices:

For more information, see Chapter 13.

The Window Menu

The Window menu, shown in Figure 3-4, provides a choice of actions you can
perform on open windows in the Administrator Tool.

Figure 3-4 Administrator Tool — Window Menu

Import Allows you to import definitions that have been exported from the AR
System.

Export * Definitions — Exports definitions from the selected server.
* Mail Templates — Generates mail templates.
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The Window menu provides the following choices:

The Help Menu

The Help menu, shown in Figure 3-5, displays help options available in the
Administrator Tool.

Figure 3-5 Administrator Tool — Help Menu

The Help menu provides the following choices:

New Server
Window

Allows you to open additional Server windows for
administering multiple servers and their objects. You can
also use a corresponding toolbar button to open a new
Server window.

Cascade Arranges open windows so that they overlap with the title
bar of each window visible.

Tile Arranges all open windows so that each is visible.
Arrange Icons Arranges any window icons at the bottom of the main

window.
Close All
Windows

Closes all open windows, including windows that are
iconified.

Save
Window
Position/Size

Remembers the size and position of each type of window.
The size and position are used the next time you open a
window of this type.

‘Open
Windows List’

Lists all open windows. A check mark next to the menu
selection means this window is the active window.

Contents Opens a window that contains a list of help topics for selection.
Each help topic may have one or more levels of subtopics
available.



Using the Administrator Tool 39

3

Selecting a Server to Administer
You can use the Windows Administrator Tool to administer the servers listed
in your <ar_config_dir>\ar  file.

To select a server:
1. Open a server window (if one is not already open) by clicking the New

Server Window button on the toolbar. The servers available to you as an
Administrator or Subadministrator appear in the Servers list, as shown in
Figure 3-6 on page 40.
• An “available” server is any server you have permission to administer.
• An “unavailable” server is any server that is not currently running or that

is in your <ar_config_dir>\ar  file but you do not have permission to
administer.

You can have multiple server windows open at the same time.

Procedures Displays help on the most commonly performed Administrator
Tool procedures. A list of available procedures appears so that
you can select the procedure in which you are interested.

Toolbar Displays a summary of the operations performed when you select
each of the toolbar icons.

Menu Items Displays a list of options available for each of the menus in the
Main window menu bar.

Search for Help On Display Search dialog box to search for available
Administrator Tool help topics.

How to Use Help Displays help on using the help system.
About Admin Tool Displays information about the AR System Windows

Administrator Tool, including the version number of the AR
System software and available resources.
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Figure 3-6 Administrator Tool — Server Window

2. Select a server to administer by double-clicking on it.
Depending on your level of permissions, the Administrator Tool then
displays categories of objects from the server that you chose (Figure 3-7 on
page 41). For example, if you selected the server metaphysix, you now can
administer its schemas, active links, filters, escalations, and menus.

For each server, you can open multiple windows for creating or modifying
the objects in each server that you have permission to administer.

Note – The only limit to how many windows you can have open at one time is
the amount of resource memory available on your PC.

3. From the Servers list, click the category to administer it. For example, in
Figure 3-7 on page 41, double-clicking the Schemas category displays all
available schemas on the server.

Available servers

Unavailable server
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Figure 3-7 Administrator Tool — Available Objects On Server

Setting Server Information and Option Settings
To display information about the currently selected server or to set server
options, select Server Information from the File menu of the Administrator
Tool Main window. The Server Information dialog box appears, as shown in
Figure 3-8 on page 42.

Note – The Server Information window will not display either the tabs or the
information for administering the full text search and multi-process server
options if the server is not licensed for these options.
These options are not available with the current release of the Windows NT
server.

A number of the fields on the Server Information dialog box contain display-
only information that cannot be modified. Other fields in the dialog box allow
you to set options that control how the server will act. If you do not set an
option for a field, the default value is in effect. You must be an Administrator
to make changes in this dialog box.

Available objects
on server

Available schemas
on server



42 Action Request System Adminitrator’s Guide for Windows—May 1996

3

Note – You may be asked to provide information from the Server Information
dialog box when you place a call to Customer Support.

Platform Information

When the Server Information dialog box (Figure 3-8) first appears, it displays
information about the platform on which the selected server is running.

To display platform information about the currently selected server:
1. Select a server to administer by double-clicking on it.

2. Choose Server Information from the File menu. The Server Information
dialog box appears, displaying the platform information.

Figure 3-8 Server Information — Platform

The following display-only fields are available:

Server Version Information field displaying the version number of the AR System
software on the server.

Server
Directory

Information field displaying the directory where the AR server files
reside on the server system.
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3. Click the OK button to close the window.

Timeouts Information

Click the Timeouts tab (Figure 3-9) to specify timeouts for the currently
selected server.

To set timeouts:
1. Select a server to administer by double-clicking on it.

2. Choose Server Information from the File menu. The Server Information
dialog box appears.

3. In the Server Information window, click the Timeouts tab.

Figure 3-9 Server Information — Timeouts

Hardware Information field displaying the hardware platform on which the
server is running.

Operating
System

Information field displaying the operating system software version
running on the server system.
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4. Enter values for the following timeout settings as required:

5. Click the OK or Apply button to save the option settings.

License Information

Click the Licenses tab (Figure 3-10 on page 45) to display information about the
type and number of AR System licenses available on their server. You also set
the Submitter Mode in this window.

Process
Timeout
(seconds)

A filter or escalation can perform a Set Fields action that runs a
process and waits for a return. To prevent blocking the server if a
process does not return, the server waits a specified interval and
then returns even if the process has not completed.
Enter a value from 1 to 20 to set a timeout in seconds. The
timeout defaults to 5 seconds. (Specifying long intervals can
cause an increase in response time for users.)

Floating License
Timeout (hours)

This field allows you to set a time limit on how long a floating
write license reserved for a user will remain reserved if the user
is not accessing the AR System.
When using floating write licenses, a user will reserve a token
while connected to the server. If the user does not perform any
AR System operation for this period of time, the license is
automatically freed. You specify the number of hours of
inactivity before automatic release of the license.
Enter a value in hours to set a time limit. The timeout defaults to
two (2) hours (a two-hour limit avoids undesired timeouts over
lunch). The minimum value you can set is one (1) hour. The
maximum is 99 hours.

Full Text
Timeout
(hours)

This option allows you to set a time limit on how long a floating
full text search license reserved for a user will remain reserved if
the user is not accessing the AR System.
When using full text search licenses, a user will reserve a token
while connected to the server. If the user does not perform any
AR System operation for this period of time, the license is
automatically freed. You specify the number of hours of
inactivity before automatic release of the license.
Enter a value in hours to set a time limit. The timeout defaults to
two (2) hours (a two-hour limit avoids undesired timeouts over
lunch). The minimum value you can set is one (1) hour. The
maximum is 99 hours.
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To display license information and set the Submitter Mode:
1. Select a server to administer by double-clicking on it.

2. Choose Server Information from the File menu. The Server Information
dialog box appears.

3. In the Server Information window, click the Licenses tab.

Figure 3-10 Server Information — Licenses

4. The following fields and options appear. Enter values as required:

Server License Type Information field displaying the server’s license type.
Fixed Write Licenses Information field displaying the total number of fixed write

licenses that exist on the server.
Floating Write Licenses Information field displaying the total number of floating write

licenses that exist on the server.
Fixed
Full Text Licenses

Information field displaying the total number of fixed full text
search licenses that exist on the server.

Floating
Full Text Licenses

Information field displaying the total number of floating full
text search licenses that exist on the server.

Max
Schemas Allowed On
Server

Information field displaying the number of schemas your
license allows you to create on the server. If the field reads
Unlimited , you can create all the schemas you want.
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5. Click the OK or Apply button to save the option settings.

To display information about the use of these licenses, see “Displaying License
Information” on page 53.

Configuration Information

Click the Configuration tab (Figure 3-11 on page 47) to set various
administrative options.

To set the configuration:
1. Select a server to administer by double-clicking on it.

2. Choose Server Information from the File menu. The Server Information
dialog box appears.

3. In the Server Information window, click the Configuration tab.

Remedy
Server ID

Information field displaying the unique Remedy identifier
code attached to the machine licensed to run the AR System.

Submitter
Mode

These radio buttons let you specify whether or not anyone can
change the name in the Submitter field of an AR ticket.
Submitter mode determines if a submitter must have a license
to write to a ticket.
* If you select Changeable (the default setting), modifications
to ARs is restricted to users with write licenses. Licensing is
strictly enforced so that all users (even submitters) require a
write license to make any updates.
* If you select Locked, the submitter field is “locked” at submit
time. Its value cannot be changed by any user. Licensing is
relaxed so that submitters do not need a write license to
update fields that they have change access to. This allows
users to update information on ARs that have their names in
the Submitter field without requiring a write license.
Note: Changes to the Submitter Mode settings do not take
effect until after the server is stopped and restarted. For more
information on the role of submitters, licenses, and access
control, see “Understanding Access Control” on page 99 and
especially “Special Submitter Access” on page 101.
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Figure 3-11 Server Information — Configuration

4. Select from the following options or enter settings as required:

Allow Guest Users This option lets you specify whether or not the AR System will
allow access by users who are not registered users of the
system. If allowed, guest users have the following capabilities
in the AR System:
* View any structures that are visible to the Public group.
* Submit new entries, if open submissions are allowed.
* View fields on schemas where fields allow Public view
capability.
* View fields on schemas where they are the Submitter or
Assignee, if the Submitter or Assignee have View permission.
Guest users will not have permissions to update existing ARs,
unless the Submitter mode is set to Locked. Then, if guest
users submit an AR and the Submitter or Public group has
change permissions, they can modify fields in the ARs they
submit.
Selecting the Allow Guest Users option (the default) allows
guest users on this server.
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Allow
Unqualified
Queries

This option lets you specify whether or not the server will
accept unqualified queries. Unqualified queries are requests
for the system to return entries with no qualifications set on
the data; all database entries are returned by an unqualified
query. The main reason to consider restricting the use of
unqualified queries is to prevent the performance penalty of
retrieving and returning large blocks of data due to accidental,
unqualified queries to the database.
Selecting the Allow Unqualified Queries option (the default)
allows a query with no qualifications on the data.

Use
Password
File
(UNIX
servers
only)

You can set this option to use the /etc/passwd  file for user
validation. When a user logs on with this option set, the AR
System first attempts to validate the user against users
registered with the AR System. If a match is found, that user
definition and permissions specified in the matching User
record are used. If no match is found, the AR System checks
the /etc/passwd  file or NIS password map for a match. If a
match is found, the user is considered a valid user (not a
guest) of the system. The UNIX group specification from the
file is retrieved and the user is considered to be a member of
the AR System group whose Group ID matches the UNIX
group.
Note: The /etc/passwd  file used is the file on the machine
running the AR System server.
Selecting the Use Password File option (the default) causes the
server to reference the
/etc/passwd  file if the user is not registered with the AR
System.
This setting is not displayed for Windows NT servers.

Cross Ref
Blank
Password
(UNIX
servers
only)

You can set this option to tie the password for a user to the
password for the UNIX user of the same name. When a user
logs on with this option set, the AR System checks the AR
System database for the user specified. If a password is found
for the user, that password is used. If the password is blank,
the AR System validates the password against the password in
the /etc/passwd  file.
Note: The /etc/passwd  file used is the file on the machine
running the AR System server.
The default setting (Cross Ref Blank Password option is not
selected) specifies that all passwords for the AR System are
stored within the AR System; a blank password means that the
user has no password.
This setting is not displayed for Windows NT servers.
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5. Click the OK or Apply button to save the option settings.

Log Files Information

Click the Log Files tab (see Figure 3-12 on page 50) to set one or more of the
debugging modes for the system. In debug trace mode, the AR System creates
log files containing information about system activity.

You can activate logging at any time; logging will start immediately. Each log
file is flushed and restarted when you restart the AR server process or when
you reactivate logging after it has been deactivated. When this occurs, the
previous log file is written to <logname>.bak.

You should be aware that log files consume increasing amounts of disk space
as messages accumulate. You may want to monitor your disk resources
carefully while logging is active.

You can enter a location and name other than the default location and name for
each of the log files created in debug mode. You can specify the same files for
multiple type of logging to have data from multiple logs entered in a single
file.

Max Entries Returned By
GetList

This field lets you limit how many database entries are
returned after a query. For example, setting the maximum
entries to 50 would return a maximum of 50 entries, even if
there were more entries that satisfied the qualification. The AR
System warns users that the query matched more entries than
the administrator allows to be retrieved.
The default setting is not limited.

User Email
Notifies From
(UNIX
servers
only)

This field lets you specify the From user for email
notifications.
By default, when the AR System sends email notifications they
are delivered from the user ARSystem . You can specify an
alternate user for the source of these notifications.
If the UNIX user running the arserverd  process is not a
trusted email user, the source of the email messages will be the
UNIX users themselves. The mail system will only allow
trusted users to change the source of the email message. See
your UNIX System documentation for more information on
email and trusted users if you have questions.
Enter a name to set the From address of email notifications.
The default is ARSystem .
This setting is not displayed for Windows NT servers.
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Note – If you are running a multi-process server, each server writes to its own
log file. These log files also include the RPC number of the server, as in the
following: arsql.log.390620 .

See the Action Request System Troubleshooting and Error Messages Guide for more
information on the debug modes.

To set log files:
1. Select a server to administer by double-clicking on it.

2. Choose Server Information from the File menu. The Server Information
dialog box appears.

3. In the Server Information window, click the Log Files tab.

Figure 3-12 Server Information — Log Files
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4. Select from the following options to enable the desired debug modes (you
can select all log files, some log files, or no log files). Note that the file
name field is disabled until you select the related logging check box. After
you select a logging mode, you can specify a different file name, if you
desire, or leave the field unchanged to accept the default file name.

5. Click the OK or Apply button to save the option settings.

Database Information

Click the Database tab (Figure 3-13 on page 52) to display information about
the database you are using. You can also use the Database tab to define the
database password.

To display and update information about the database:
1. Select a server to administer by double-clicking on it.

SQL Logging Logs SQL commands sent to the database. Information is
logged for each SQL command issued, including a timestamp
and the user name of the user performing the operation. By
default, the log file is called arsql.log .

Filter Logging Logs information about filter activity for each operation.
Information includes the filters that executed and whether or
not filter execution was successful. By default, the log file is
called
arfilter.log .

User Logging Logs information about connection activity for each user.
Information includes the time that each user logs on, whether
or not they are able to obtain a license, and when each floating
license is released. This allows you to keep an audit trail of user
activity to help you determine if you need more floating
licenses. By default, the log file is called aruser.log .

Escalation
Logging

Logs information about escalation activity. Information
includes that escalations were checked and whether or not the
escalation qualification found any matches and escalation
actions were taken. By default, the log file is called
arescl.log .

API Logging Logs information about all API calls made by all clients.
Information is logged on entering and exit of ever API call. By
default, the log file is called arapi.log .
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2. Choose Server Information from the File menu. The Server Information
dialog box appears.

3. In the Server Information window, click the Database tab.

Figure 3-13 Server Information — Database

4. The following fields and settings appear. Enter a value as required:

Database Type Information field displaying the type of database that the server is
using.

Database Home For UNIX only, information field displaying the directory path of the
database that the server is using.

Database Name Information field displaying the name of the database created for the
AR System within the SQL database.

Database
Version

Information field displaying the version of the SQL database that the
server is using.
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5. Click the OK or Apply button to save the option settings.

Multiple Process Server Option

If you are licensed for the multiple-process server option, see “Configuring
Multiple Process Servers” on page 373 for information on configuring multiple
processes from the Server Information window. This chapter also describes
how to administer multi-process servers in the AR System.

If you have not licensed the multi-process server option, the Multiple Processes
tab does not appear in the Server Information window.

Full Text Search Option

If you are licensed for the full text search (FTS) option, see “Configuring FTS in
the AR System” on page 394 for information on configuring FTS from the
Server Information window. This chapter also describes how to administer FTS
in the AR System.

If you have not licensed the full text search option, the Full Text Search tab
does not appear in the Server Information window.

Displaying License Information

To display information about licenses:
• Choose License Information from the File menu of the Administrator Tool

Main window. This causes the License Information dialog box to appear, as
shown in Figure 3-14 on page 54.

Database
Password

For SYBASE, ORACLE, or SQL Server databases, this field allows you
to define the password used by the AR System for access to the
database. Note that the existing password is not displayed.
Enter a value in this field to change the password.
See the Action Request System Troubleshooting and Error Messages Guide
for information on how to recover if you do not remember this
password or have changed it outside the AR System and need to reflect
the change within the AR System.
The default user/table password created by the AR System for the
database is AR#Admin#.
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Figure 3-14 Current License Information Dialog Box

The License Information dialog box shows you information about the users on
the currently selected server. You can get a list of registered users on the server
or a list of the users who are currently connected to the system. You can select
whether to see the registered or current users and for each, whether to see all
the users or just the users in one of the six license categories: Fixed, Floating,
Read, FTS Fixed, FTS Floating, or FTS None. Use the Category menu to choose
the list and category of license within that list to be displayed. The type of
information currently selected is shown at the bottom of the screen. For
example, Figure 3-14 shows the total number of users with fixed write licenses
currently connected the server.

Registered Licenses

When you display information about registered users (Figure 3-15 on page 55),
you see information about all users of the selected category that are known to
the system. You will see the name of the user, the type of license the user is
assigned, if the user has an FTS license, the default notify mechanism for the
user, and the email address for the user. By viewing this list, you can discover
who is using floating licenses and who has write license access versus read-
only access.
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Figure 3-15 Registered License Information Dialog Box

See Chapter 5, for more information on defining users.

Current Licenses

When you display information about current licenses in use, you see
information about the name of the user, the type of license the user is assigned,
if the user has an FTS license, the connect time for the user during the current
session, and the time the user last accessed the server during this session. The
list shows only those users who are currently connected to the AR System.

Releasing a Floating License

If you are an Administrator, you can also use the License Information window
to force the release of a floating license that has not yet timed out.

When using floating licenses, a timeout interval determines the point at which
a user’s floating license will automatically be released if the user has
performed no action against the server within that interval. However, it is
sometimes necessary to free a user license that has not yet timed out. (For
example, if a Windows client fails and the user cannot get back onto the
system, it may be necessary to release the license held by the PC user before
the failure.)
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To force the release of a floating license:
1. Select the user name with the license that you want released from the

Current Licenses List in the License Information window.

2. Click the Release User button at the bottom of the License Information
window.

If a user has a Fixed or Read license, this only removes the user from the list of
current users; there is no effect on the user’s connection to the server. They are
not occupying a token on the server that prevents access by others; the next
time they access the server, the license information for that server will
reappear. If a user has a Floating license, however, the license token held by
that user is freed. This means that another user could grab the token and start
working. If the original user returns, they may not be able to get back into the
system if there are no tokens available.

Setting Default Permissions
Choose Default Permissions under the File menu of the Administrator Tool
Main window to display the Default Permissions dialog box, as shown in
Figure 3-16 on page 57. You use this dialog box to set the default permissions
for schemas, active links, and fields for any server that you can administer.

Setting default permissions for schemas, active links, and fields lets you easily
define access control, especially when you are adding new objects to the AR
System. New items use the default permissions you specify here.

Setting Default Schema Permissions

Click the Schema Permissions tab in the Default Permissions dialog box
(Figure 3-16) to specify the values to be used as the default settings for new
schemas. Schema permissions determine which groups have access to a
schema.

Setting up default permissions allows you to establish initial permissions for
new schemas. This is especially useful if you have a large number of groups.

Remember that in the Default Permissions window, you only create the default
schema permissions. You actually set schema permissions in the Schema
Properties dialog box. See “Defining Permissions for the User Tool” on
page 132 for information on setting schema permissions.
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To create default schema permissions:
1. Select a server by double-clicking on it.

2. Choose Default Permissions from the File menu. The Default Permissions
dialog box appears.

3. In the Default Permissions dialog box, click the Schema Permissions tab.

Figure 3-16 Default Schema Permissions

4. From the No Permission list, double-click the group you want to have
default schema access (or select one or more groups, then click the Add
button).

5. Click the OK or Apply button to save the option settings.

Setting Default Active Link Permissions

Click the Active Link Permissions tab in the Default Permissions dialog box
(Figure 3-17 on page 58) to specify the values to be used as the default settings
for new active links. Active link permissions determine which groups have
access to an active link. Groups without access to an active link cannot fire it.

Setting up default permissions allows you to establish initial permissions for
new active links. This is especially useful if you have a large number of groups.
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Remember that, in the Default Permissions window, you only create the default
active link permissions. You actually set active link permissions within the
Active Links dialog box. See “Defining Permissions for Active Links” on
page 306 for information on setting active link permissions.

To create default active link permissions:
1. Select a server by double-clicking on it.

2. Choose Default Permissions from the File menu. The Default Permissions
dialog box appears.

3. In the Default Permissions dialog box, click the Active Link Permissions
tab.

Figure 3-17 Default Active Link Permissions

4. From the No Permission list, double-click the group you want to have
default active link access (or select one or more groups, then click the Add
button).

5. Click the OK or Apply button to save the option settings.
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Setting Default Field Permissions

Click the Field Permissions tab in the Default Permissions dialog box
(Figure 3-18 on page 60) to specify the values to be used as default settings for
fields. Field permissions determine which groups have view and change access
to fields.

Setting up default permissions allows you to establish initial permissions for
new fields. This is especially useful if you have a large number of groups you
generally grant access to.

Remember that, in the Default Permissions window, you only create the default
permissions. You actually set permissions within the Field Properties dialog
box. See “Defining Permissions for Fields” on page 164 for information on
setting field permissions.

When giving a group access to a field, you can specify either view or change
access for the group. You add the group to the list of groups having access to
the field and then define what type of access is allowed by selecting the View
or Change option from the menu button in the Permissions list.

To create default field permissions:
1. Select a server by double-clicking on it.

2. Choose Default Permissions from the File menu. The Default Permissions
dialog box appears.

3. In the Default Permissions dialog box, click the Field Permissions tab.

Selecting the View menu button gives a group view permissions only.

Selecting the Change menu button gives a group both view and change
permissions.



60 Action Request System Adminitrator’s Guide for Windows—May 1996

3

Figure 3-18 Default Field Permissions

4. From the No Permission list, double-click the group you want to have
default field access (or select one or more groups, then click the Add
button).
The group you selected appears in the Permission field with default view
permissions.

5. To assign Change access to the group, click the Change menu button.
Remember that groups without change access can only view the field.
In Figure 3-18, the HD Staff and Lab Manager groups have only view
permissions for the field, but the Flashboards Administrator and
HD Manager groups have view and change permissions.

6. Select the Allow Any User To Submit option to select the create mode for
the field. You use this mode to determine access control (security settings)
for the field at the time an AR is submitted.
• Selecting the Allow Any User To Submit check box allows anyone to assign

a value to the field at submission time, regardless of whether or not the
submitter belongs to a group that has change permission for the field.

• Clearing the check box restricts data entry to users who belong to one or
more groups with explicit change permission for the field.

7. Click the OK or Apply button to save the option settings.

Groups with view
and change
permissions

Groups with view
permissions only

Clicking menu
button lets you
choose either
View or Change
permissions
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Defining Preferences
Click Preferences under the File menu of the Administrator Tool Main window
to display the Preferences dialog box, as shown in Figure 3-19. You use this
dialog box to select desktop settings, confirmation warnings, schema font
settings, and how menus are displayed in the Administrator Tool.

To set desktop preferences:
1. Choose Preferences from the File menu. The Preferences dialog box

appears.

2. In the Preferences dialog box, click the Desktop tab.

Figure 3-19 Preferences — Desktop

3. To select or clear an option, click on the option. You can set any of the
following desktop options:

Maximize
on Startup

Select to have the Administrator Tool Main window fill the
entire screen (maximize) when the tool first starts.

Show
Status Bar

Select to cause the status bar to appear at the bottom of the
window. Clear to hide the status bar.
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4. Click the OK or Apply button to save the desktop option settings.

To set confirmation preferences:
1. Choose Preferences from the File menu. The Preferences dialog box

appears.

2. In the Preferences dialog box, click the Confirmations tab.

Show Toolbar Select to cause the toolbar to appear below the menu bar. Clear
to hide the toolbar.

Save
Windows’
Position and Size
on Close

Select to cause the AR System to remember the size and position
of all types of windows (all menu windows, all active link
windows, and so on) at the time you close the window. The size
and position are used the next time you open a window of the
same type.

Show Field Properties
on Field Creation

Select to cause the Field Properties dialog box to appear when
you create a new field. If you clear the check box, you must
double-click the field to open the dialog box.

Keyboard Step Size Defines the number of pixels a field is moved by when you
select a field and press the arrow keys in a schema.

Date Format Defines whether date is displayed in short or long date format
(for example, in the change history).

AR Path Specifies the directories where the Administrator Tool can access
macros. Enter the entire directory name for each directory you
want to access, separating each directory name with a
semicolon. The default value is <ar_config_dir>\arcmds . You
also can enter multiple pathnames by separating them with a
semi-colon (;).
You also can click the Browse button to specify a different
directory.
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Figure 3-20 Preferences — Confirmations

3. To select or clear an option, click on the option. You can select any of the
following confirmation options:

Confirm to Exit Select to cause a confirmation box to appear each time
you exit the Administrator Tool.

* Confirm to Close:
* Schemas
* Active Links
* Filters
* Escalations
* Menus
* Group Permissions

Select to cause a confirmation box to appear when you
close an object window if you made changes and did not
save them. You can choose a confirmation setting for each
object type independently.

Confirm to Delete:
* Schemas
* Active Links
* Filters
* Escalations
* Menus
* Actions (from Active Link,
Filter, or Escalation)

Select to cause a confirmation box to appear each time
you delete an object or an action. You can choose a delete
confirmation setting for each object type as well as for
active link, filter, and escalation actions independently.
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4. Click the OK or Apply button to accept the confirmation options settings.

To set schema fonts preferences:
Setting fonts allows administrators to design schemas using the same fonts in
the Administrator Tool that AR users use in the User Tool. However, these
schema font settings are local to the Administrator Tool. Users of the User Tool
can still define their own font settings based on their own preferences.

Note – Changing the size of the fonts you use can affect schema layout. For
example, if you choose a large font size for buttons, they may become too large
to fit the space available for them on the schema. This will cause screen
elements to overlap.

1. Choose Preferences from the File menu. The Preferences dialog box
appears.

2. In the Preferences dialog box, click the Schema Fonts tab.

Warnings: Admin Only
Permissions

Select to cause a warning message to appear if an
administrator or subadministrator creates a field and
does not give groups permissions to view or change the
field. Clearing the check box suppresses the warning.

Warnings: Duplicate Field
Names

Select to cause a warning message to appear if an
administrator or subadministrator creates fields that have
the same name. Clearing the check box suppresses the
warning.
Note: If you create fields with duplicate names, those
fields will appear elsewhere in the Administrator Tool
with their field IDs, for example, in the Fields drop-down
list in the Set Fields action of a filter.
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Figure 3-21 Preferences — Schema Fonts

3. Select a screen element from the Select Font For list by clicking on the
drop down list box symbol and highlighting one of the choices. The
current font type, style, and size is shown at the bottom of the Preferences
dialog box and a sample is displayed in the Sample box. You can set the
font for the following screen elements:

Edit Field Specifies the font to use for data in fields.
Optional Field Specifies the font to use for labels of optional fields.

Default: normal font
Push Button Specifies the font to use for buttons that you select to perform

an action.
System Field Specifies the font to use for labels of fields set by the AR

System.
Default: italic font

Radio Button Specifies the font to use for radio buttons.
Required Field Specifies the font to use for labels of fields required by the AR

System.
Default: bold font
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Note – If you change the font used for required or system fields, it is a good
idea to continue to use a font that differentiates these fields from normal
(optional) fields and from each other.

4. With the chosen screen element highlighted, click the Change Font
button. The Font dialog box appears, as shown in Figure 3-22.

Figure 3-22 Font Dialog Box

5. In the Font dialog box, select a font, font style, and size, and then click the
OK button.

6. To change the font of additional screen elements, select the new element
by repeating steps 3, 4 and 5.

7. When you have finished specifying font settings, click the OK or Apply
button in the Preferences dialog box to accept the schema font settings.

To set the display menu method:
1. Choose Preferences from the File menu. The Preferences dialog box

appears.

2. In the Preferences dialog box, click the Display Menu Method tab.
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Figure 3-23 Preferences — Display Menu Method

3. To select or de-select an option, click on the check box or radio button, or
enter a value in the field to the right of the option. You can set the
following display menu method preferences (popup menu is the default):

Popup Menu Select to display standard popup menus in windows. Hierarchical
menus will display with arrows indicating that you must pull to
the right to view lower level menu selections. Be aware that large
menus may cause display problems.

List Box Select to display menus in a list box. You should choose this
option if you need to display large menus.
When you select this option you must also specify the settings
below.
Always: Select to display all menus as list boxes regardless of size.
Only If: Select to specify item and level thresholds beyond which
menus will display in list boxes. (Enter the threshold values in the
fields.) Menus containing fewer items and fewer levels than
specified will continue to display as popup menus. Menus
containing more items or more levels than specified will display
in list boxes.
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4. When you have finished specifying display menu method preferences,
click the OK or Apply button in the Preferences dialog box to accept the
menu display method settings.

Building and Using Change History
For each object that you build using the Administrator Tool (schemas, fields,
menus, filters, escalations, and active links), the AR System automatically
records information about the owner, the user who last modified the structure,
and the date of the modification. You can view and modify this history
information at any time by clicking the Change History tab in each object
window.

The Change History window for an active link is shown in Figure 3-24 on
page 69.

Expand Items at
Startup

For menus displayed in list boxes, select this option to cause all
levels of hierarchical menus to display at the time the menu is first
opened.
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Figure 3-24 Change History Window

You can use the Change History window as a diary of changes made to each
structure. The window works in a manner similar to diary fields in the User
Tool. Each time you modify an object, you can update the change history to
maintain a record of the changes made over time.

To update the change history:
1. On the Create or Modify window of an object, click the Change History

tab to open the Change History window (see Figure 3-24 on page 69).

2. If you want to change the ownership of the object, enter the name of the
user who is to own (have responsibility for) that object from this point on
in the Owner Field.
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Note – Any user with Administrator or Subadministrator permissions can
modify an item regardless of who the specified owner is for the item.

3. Enter information about the item or about the change you have just made
in the New Description field. (You will not be able to type in the upper
portion of the window to modify an entry once it has been made.)
You can use the standard Windows keyboard shortcuts to edit text (for
example, Ctrl+C  to copy text, and so on).

4. Click the Save button on the toolbar. When you click the Save button,
your entry will appear in the upper portion of the screen along with the
time you made the entry and your user name.

5. Double-click the Control menu to close the Change History window.

Setting Help
The help text you supply for schemas, fields, and active links is included in the
context-sensitive help in the User Tool. The help text you supply for menus,
filters, and escalations is available to the administrators and subadministrators
who have access to these objects.

Context-Sensitive Help for End-Users

The context-sensitive help that you create for schemas, fields, and active links
will be read by end-users and should be written accordingly. The Help Text
window as displayed in the User Tool for schemas, fields, and active links
contains a simple description of the feature, to which you then can add
additional comments.

• For schemas, the AR System generates a listing of all the fields that are
indexed for FTS and active links that activate on submit, modify, and
display (the active link names, execute conditions, and any administrator-
defined help text are included as well).

• For fields, the AR System generates a listing of field attributes and active
links that activate on return or menu-choice.

• For active links that activate on a button, the AR System generates a listing
of the active link name and execute conditions.
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Any user running version 1.2 (or later) of the AR System User Tool can display
this help text by choosing Field/Schema Help from the Help menu. If the user
chooses Field/Schema Help from the menu, the pointer changes to a question
mark; the user can then position the question mark over the field for which
they want to view help text and click the mouse button.

Note – If you are creating context-sensitive help that will be viewed on a
Windows client, limit the text to 28,000 characters; on a Macintosh client, limit
the text to 32,000 characters.

To view help for schemas, fields, and active links, do the following:

• For active links that activate on a button, use context-sensitive help on the
button.

• For help on fields or for active links that activate on a menu choice or a
return, use context-sensitive help on the field.

• For help on schemas or for active links that activate on submit, modify, and
set to defaults, use context-sensitive help on the schema window.

Help for Administrators

The help that you create for menus, filters, and escalations will be read by AR
administrators and subadministrators who use the Administrator Tool. This
help is available for viewing and editing only by AR administrators and
subadministrators who have permission to access the objects.
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The AR System is most appropriate where there are frequent events, the events
move through states, and the action requests (ARs) are entered and worked on
by a group of people. However, you can design schemas for almost any
database application. You can create as many schemas as you require. How
you use the AR System depends on many factors that are specific to your
business needs.

This chapter provides some guidelines for setting up your application of the
AR System. It covers the following topics:

• General factors to consider and questions to ask as you design your
application.

• Schema and field design considerations.

• Menu design considerations.

• Filter design considerations.

• Escalation design considerations.

• Active link design considerations.

• Using macros as automation aids.
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Note – The discussion and examples in this chapter are specific to the use of
the AR System as a trouble tracking and reporting application. While this is a
good example of one of the uses of the AR System, it is by no means the only
possible application. You will be able to apply the basic information presented
here about AR System design considerations regardless of how you are using
the AR System.

To help set up the AR System, Appendix E provides worksheets you can
reproduce to track your workflow and design schemas, active links, filters, and
so on.

General Design Questions
The process of designing your application of the AR System involves several
steps:

1. Design a schema or schemas to contain and display needed information.

2. Define a process flow that determines actions that will occur based on
specific AR System events.

3. Define users and groups of users who have access to some or all of the
information in your schemas.

When designing a new support application for the AR System, it is best to
begin by evaluating how support requests and problems are currently
resolved. The answers to a series of simple questions will help you evaluate
your current problem-solving process and determine the best way to take
advantage of the AR System’s capabilities.
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• The answers to the following questions will help you design schemas for
your database.
What stages does each problem pass through from discovery through
resolution?

What information needs to be collected and communicated during each of
these stages?

What is the source of each piece of information? Is there some information
that is available from more than one source?

Is there information that needs to be made available in more than one place?

What information is most likely to be valuable in summary form or
included in a report?

• The answers to the following questions will help you design the filters,
escalations, and active links that will define the workflow process.
What is your current workflow process? Create a simple process flowchart
or other representation that describes how your current problem-solving
process works. An example of a process flowchart is shown in Figure 4-1.

What events occur that result in the need for specific actions? What,
specifically, keys these actions?

• The answers to the following questions will help you define groups of users
and determine the appropriate level of access for each group.
What distinct functional groups are involved in your problem-solving
process (for example, support staff, help desk, and end users)?

Who in your organization needs to belong to each of these groups? Consider
who needs to know what and at what stage in the problem-solving process.
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Figure 4-1 Workflow Process Flowchart Example

End User Dispatcher Staff Management

Discover
problem and
report it to
dispatcher.

Check for new problems
and determine priority.
Check staff to see who
is available and assign
problem. Send list of
new problems to
management daily.

Check for new
assignments. Begin
problem
resolution.

List of new
problems.

Track open problems. If
problem is still open after 1
day and priority is high,
begin escalation. If still
open after 2 days and
priority is medium, begin
escalation. Report to
management on
escalated problems.

Work with staff and
escalation team to
assure all problems are
resolved. Notify users
as individual problems
are resolved.
Provide status and
summary information to
management.

Check history reports to
see if
similar problems have
been reported and
resolved. Follow
procedures for problem
identification and
resolution.

Close resolved
problems and
report to
dispatcher.

Escalated
problems.

Summary
Information.

Monitor open
problems and
respond to
escalations.
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Designing Schemas
Once you understand the information requirements of your organization, you
can start designing your schema.

A schema defines how information is stored in your database. When you open
an AR System schema, you see a screen that contains a set of fields. The fields
are where various pieces of information are entered and displayed.

When you design your schema, you should first decide whether you want to
start from scratch to design a new schema or start with an existing schema that
is similar to the schema you want to create. Starting with an existing schema, if
an appropriate one exists, can often save you time since you may not have to
create every field.

Note – The User and Group schemas contain several reserved fields that make
these schemas special. You should never copy these schemas as you may
introduce unintended access control problems into your environment.

The sections that follow describe the processes involved when you create a
new schema from scratch or modify an existing schema to fit a new purpose.

Working with New Schemas

Create a new schema if there is no existing schema that you can easily modify
and adapt to your needs. You will find detailed instructions for creating a
schema in Chapter 6.

Core Fields

When you create a schema from scratch, the schema automatically contains a
set of core fields. These are fields that all AR System databases are likely to
need. Core fields help provide consistency when merging and sharing
databases and when exchanging macros. You cannot delete core fields, though
you can modify their appearance by altering labels, adding or changing menus,
altering the display type, altering their location, or hiding them from view. You
can also customize some aspects of specific core fields. For detailed
information on each of the core fields, see Appendix C.
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It is likely that some of the information you identified as needed when you
analyzed your current process will be accounted for by the core fields.

A newly created schema is shown in Figure 4-2. Notice that the field labels
appear in different styles. The styles have special meaning, as described below:

Figure 4-2 New Schema with Core Fields

Schema Layout

Once you have opened the new schema and decided what fields you need in
addition to the core fields, you can begin to define the additional fields and
design the schema so that it fits your needs. It is a good idea to sketch out the
layout you want for the screen before you actually begin adding fields. That
way you will have an idea of where you want to insert fields and in what
order. When deciding where to place fields that will have character menus, text

Italic text Field is system maintained; information is automatically updated
by the AR System.

Bold text Field is required; submitter must enter information in this field.
Plain text Field is optional; submitter can submit a request without entering

information in this field.

Required
Fields

Optional Field

System
Maintained
Fields
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editors, or diary editors associated with them, you will need to allow space for
the icons that will appear next to the fields. (In some cases, a field may have
both a menu icon and a text editor icon next to it.)

As you design your layout, take into account that users in different roles will
need to manipulate different fields and that different users will have different
access privileges to the fields.

You might want to lay out your schema so that it is convenient for use by the
various types of users you have identified. For example, you can group fields
that will be most significant to end users at the top of the schema and group
fields that will be used only by dispatchers at the bottom. You can also arrange
your layout so that fields that are of interest to only a few people will not show
on the opening view of the schema.

You should also consider the platform on which your users will be running the
User Tool. You can provide users with multiple views of the same schema,
based upon the platform they are operating from, whether Motif, Windows, or
Macintosh. If the schema you are designing will be used exclusively on
personal computers, you can take advantage of that fact and lay out the
schema in the way that looks best on that platform. If, on the other hand, your
users are on a variety of platforms, you may want to create several different
views, one for each environment.

Users with Administrator or Subadministrator access to a schema can
customize the view on the User Tool, then export the view back to the server as
an alternate admin view. For information on exporting customized views, see
Chapter 4, Customizing The Environment in the Action Request System User’s
Guide.

Note – Users at ASCII terminals will not be able to customize their own views.

Working from Existing Schemas

If there is an existing schema that you can easily modify and adapt to your
needs, you can use it as a basis for your new schema.

Note – The User and Group schemas contain several reserved fields that make
these schemas special. You should never copy these schemas as you may
introduce unintended access control functionality into your environment.
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Modifying Fields

To adapt an existing schema to new needs, simply verify that the fields that
currently exist are defined appropriately. If not, you can modify the field
definitions according to the instructions in “Creating and Modifying Fields” on
page 141. Add any additional fields that are required on the new schema,
rearrange the fields on the schema, or change a field’s display properties to
meet your new needs. Follow the guidelines for schema layout presented
above.

Sample Schema and Database

You may want to look at the sample schemas that came with your AR System
software to see if one of them can serve as a starting point for your schema
design process. Use them to help you become familiar with the AR System or
as starter schemas in your organization. See the Action Request System Workflow
Demonstration and Guide to Sample Schemas for descriptions of the available
sample schemas.

Default Schema Views

When you define a schema layout, from either a new or existing schema, you
are defining a default (administrator) view. This is the view of the schema that
users will see unless they customize their view or set a different default view.

Multiple Schema Views

You can create multiple views of a schema. It is easy to use the Modify Schema
window to open a schema, copy it, then create a different “view” of the schema
by rearranging or even hiding fields, based on which platform you are
operating from or what role the user plays. You will find detailed instructions
for modifying an existing schema and creating multiple schema views in
“Schema Views” on page 173.

Schema Attribute Settings

For each schema, you can define attribute settings that control the behavior of
that schema. You can set database indexing on selected fields, specify which of
the schema’s fields will appear in the list in the Query List window, and set
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overall access permissions that determine which users will be able to view or
modify the fields on a schema. For information on how to set attributes for a
schema, see Chapter 6.

Defining Fields

Once you have decided on the information that your schema will contain and
designed the layout of the schema, you can begin defining the individual
fields. It is the fields that determine the internal structure of the AR System
application database.

Before adding a new field to a schema, you should consider carefully the
purpose of the field and whether adding the field is the best way to handle
your information requirements. The addition of new fields should be
motivated by the planned use of the field for querying and reporting during
the process that this schema is designed to manage. You may find it impractical
to eliminate a field once users have come to rely on it.

Occasionally, you may want to include information that is also kept in another
database. If the information is stable and unlikely to change frequently, then
keeping it in two places may be manageable. However, if the information is
changing at a rate that would require frequent updating just to keep it
consistent with another database, the information is not a good candidate for
adding to this schema. See the discussion of active links later in this chapter for
ways you can cross-reference data in other places.

Field Definition and Display Properties

As you define each field on a schema, you describe field attributes that include
its definition properties (such as the field’s data type and attributes of the
information it will contain), access control (such as group permissions and
create mode), and global settings (such as whether or not it is a required field).
You also can set a field’s display properties that might apply only to a
particular schema view (such as a field visible in one schema view but hidden
in another view). Chapter 7 includes step-by-step instructions for defining
fields and describes each of the field properties in detail.



82 Action Request System Adminitrator’s Guide for Windows—December 1995

4

Core Field Design Considerations
The following core fields have special characteristics that need to be considered
when defining a new schema.

Short-Description Field

Fields that categorize problem and request types are essential to the efficient
use of the AR System. A new schema includes a Short-Description field for this
purpose. Unless you modify Query List fields when you define a schema’s
attributes, the contents of the Short-Description field are displayed by the
Query List operation.

It is a good idea to define a character menu for the Short-Description field that
will help users define the possible problem and request types. This makes AR
submission easier and it creates a problem type “vocabulary” that the entire
organization can use. A uniform vocabulary makes queries and reporting
much more efficient.

If other short descriptive fields are necessary, you can add other fields with
similar fill-in aids.

As you decide how many descriptive choices to set up in your menu, you
should balance the need for query efficiency against the need for completeness
of description.

Status Field

In your process, each event represented by an AR moves from the status (or
state) of newly submitted to some resolved state. Along the way, an AR moves
through different states as it is being worked on. The meaning of each
individual state helps define the workflow process. The core schema includes a
Status field that permits you to define any number of states. The AR System
keeps additional information with the Status field as ARs move through their
states. This information is called status history and includes the user name of
the person who puts the AR into a particular state and the time the change
occurred.

You should take some care in defining states. The Status field represents the
problem resolution process more than any other field in the schema. The states
must capture the important steps in the process. Often the best case process is
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represented by four or five states, while the worst case process is defined by
many more. The right number of states may be somewhere in between, with
several states being defined, but not used during the resolution of a typical AR.

Note – As with all selection fields, it is difficult to modify the Status field
choices once users have begun to use the schema. For example, if the current
choices are New, Assigned , and Closed , and you add a choice labeled Fixed

before the Closed  selection, existing database entries with a status of Closed

will now have a status of Fixed  instead. This is because the data for a selection
field is stored in the database as an integer that relates to the order of the
choices, as in the following examples:

New = 0

Assigned = 1

Closed = 2

Fixed = 3

To avoid confusion, do not add selection choices to an active schema other than
as the last choice of the selection field.

Designing Menus
You can design menus that you can then attach to any character field on any
schema. You can attach each menu to as many character fields in as many
different schemas as you would like. Each menu has a name that you specify
and a set of options that you define using the Administrator Tool. There are
three different styles of menus you can define:

Menus are defined and stored independently of schemas. This allows you to
define a single menu and use it anywhere on any schema. For example, you
might create a menu that includes the names of all members of your support
group. You could then attach that menu to as many schemas as you desire. If

Character You define the menu by entering a series of labels and
values into the fields of the Menu window.

File You specify a file that contains a formatted character
menu.

Query You specify a query that lets you pull values from a
schema.
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any change should occur in the members of the group, you would only need to
update a single menu in order to change the menu selections on all schemas
that list group members.

See Chapter 9 for information on creating each style of menu and attaching
menus to the fields of a schema.

Designing Filters
Your workflow process is defined partly by your schema (especially the Status
field), but mostly by the filters, escalations, and active links you create. This
section describes how filters work and presents issues to consider in designing
them.

Filters define what actions the server will take when an AR transaction meets
certain conditions. For example, you can define a filter that automatically
notifies the end user that his problem has been solved (action) when the Status
field of the AR is changed to “Fixed” (condition).

Filter Conditions

You can design filters that act on the query, modify, submit, delete, or merge
operation or any combination of those operations. You can also include a
qualification in the condition to further refine the filter conditions.

Filter Actions

There are five kinds of actions you can define for a filter, as shown in
Table 4-1. A single filter can invoke up to 25 multiple actions.

Table 4-1 Filter Actions  (1 of 2)

Action Description

Log to File Records an entry in an audit trail log file.

Message Sends an interactive error, warning, or note to the user
who initiated the transaction.
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Filter processes run on the server, as opposed to active links, which run on the
client machine (see Designing Active Links on page -92). Filters are defined and
modified from within the Administrator Tool without programming, by using
convenient forms and other aids. You can use filters to guide ARs through each
stage of the resolution process.

Filters run on the server with the same permissions as the administrator. You
can use filters to restrict how users can submit or modify an AR. You can also
use them to check for conditions in ARs that are submitted by a network
management system for a device that it is monitoring; the filter can then
automatically call a program to control that device. Filters can act upon
virtually any condition that arises in manipulating an AR.

Note – You should always remain aware while designing filters that filters run
on the server with Administrator privileges. This can have an impact on
system security as well as on server performance.

Be conservative in designing your first filters. A user base may be initially
excited about the prospect of being notified of each step in your process, only
to become irritated by receiving too many notifications. The following are
examples of useful filters.

Filter example #1, notify the assignee of an AR:
For every AR where the Status field is modified to the “Assigned” state, use
the Notification Tool to notify the user whose name is in the Assigned-to
field. Include some fixed text and the variable information text from the
Entry ID and the Short Description fields.

Notify Sends text to a specified user or group.

Run Process Runs a specified program.

Set Fields Sets field values in the current AR to static or keyword
values or to values retrieved from another data source.
The data source may be a field in the same schema or
another schema on the same server or another server, the
results of an independent system process or the results of
a mathematical calculation or a function.

Table 4-1 Filter Actions  (2 of 2)

Action Description
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Filter example #2, assign a particular problem to a specific support person:
For every newly submitted AR operation that has the word “print”
anywhere in the description field, set the Assigned-to field to Sally, update
the diary field to indicate that the AR has been assigned to Sally, and set the
Status to “Assigned.”

When you create filters, you assign them an execution order so that multiple
filters can act on a single server transaction. For the two example filters above,
the filter assigning a problem (example #2) should be executed before the filter
that notifies the assignee (example #1).

You can export filters from one site and import them to another site so
organizations can share the definition of the workflow process.

Sending Notifications From Filters

You can greatly improve the efficiency of your workflow process by assuring
that the support staff is proactively notified of new things to do and that end
users are immediately told that their problem is fixed. Immediate notification
can greatly reduce the length of time required by the process life cycle. The
Notification Tool of the AR System gives immediate notification to the user —
it acts as a “desktop beeper.” It is a low-overhead tool that is dormant unless
the user is notified through some filter or escalation action. The tool can notify
the user by beeping, displaying a pop-up dialog box, flashing its icon, or any
combination of the above.

The Notification Tool also holds a memory of past notifications and allows the
user to immediately open any AR for which a notification has occurred.

Alternatives to the Notification Tool are also available. A more passive
notification option of electronic mail (email) is available. Notifications are sent
to a specific name or a name contained in another field. You can also route the
notification to a spooling file to be read by a program for integration with
paging beepers and other notification alternatives.

Designing Escalations
Escalations function much like filters except that they occur at a specific time
on a time interval instead of on a transaction to the database. Like filters,
escalations define what actions the server will take when an AR transaction
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meets certain conditions. For example, you can define an escalation that
automatically sets the Assigned-Priority field to High (action) if a problem has
not been solved within 24 hours (condition).

Escalation Strategy

There are some basic steps to help you decide when escalations should take
place, as described in the following example of users submitting problems to a
support staff responsible for resolving problems.

1. Decide on the rules.
Think about the basic conditions under which you want to escalate an entry.
Consider all the different possibilities and decide exactly what conditions
determine when escalation is appropriate.

You may determine that an entry that is not closed after 5 days should be
escalated. You might also determine that a specific type of problem should
be escalated after only three days.

Typical categories of escalation include the following:

• New problems not handled quickly enough. For example, you might
decide that new problems with a critical priority should be assigned within
8 hours and those with a serious priority assigned within 24.

• Assigned problems not closed soon enough. For example, you might
decide that assigned problems, if critical, must be handled within 5 days of
being submitted; if serious, within 14; and if medium, within 60.

2. Decide on escalation actions.
Once you have defined the escalation criteria, you can determine the action
you want to take when each of these criteria is encountered. For example,
you may want to notify another person that you are escalating an entry.

For new problems that are not handled quickly enough, you might want to
assign ARs to Doug Dispatcher with a notification to him. For assigned
problems not closed soon enough, you might want to notify the escalation
manager, Marie Manager. You also might want to send a warning to the user
name in the Assigned-to field when an escalation is about to occur.
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3. Add escalation field(s)/state(s).
You may need to add one or more new fields or states to your schema to
note the escalation cases. You may want to introduce new escalation states
to the Status field in a schema or add a field to hold which escalation case
was last applied. (Usually this is a selection field, though it could be any
type.)

To have a record of an escalation, you might create two new fields that are
option selection-type fields: Assign-Escalate-State and Fix-Escalate-State.
The selection values are None and Escalated for the Assign-Escalate-State
field and None, Pre-Escalated, and Escalated for the Fix-Escalate-State field.
The Pre-Escalate state is needed to issue the warning before escalation.

4. Decide how often to check escalations.
You can define an escalation so that the AR System checks the conditions for
activating the escalations at a specific time or at specified time intervals. You
can also include a qualification in the condition to further refine the
escalation conditions.

When you set a specific time for execution (for example, first of month or
every Monday), the server checks the escalation at the time defined. If the
qualification is true, the escalation triggers the action. Otherwise, the server
waits for the next scheduled time.

In contrast, when you set an execution interval (for example, every hour),
the server checks the escalation at the interval. Figure 4-3 illustrates how
escalation intervals work:
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Figure 4-3 Escalation Intervals

Escalation intervals are immediately checked when the escalation is
created or enabled or modified. Then the server waits for the defined
interval and checks if the qualification is true.

• If the qualification is true, the escalation triggers the actions in order. The
server then waits for the next interval.

• If the qualification is false, the escalation triggers no actions and the server
waits for the next interval.

Escalations execute on the server machine. Each escalation is attached to a
single schema on the server. How often you want the server to check an
escalation is a question only you the AR administrator can answer. If you
make frequent AR server checks (for example, 50 escalations that query the
database every 2 minutes), you can seriously impact the performance of the
AR system. Balance the load on the AR System against how often you
actually need to check the escalation.

5. Use the Escalations window to create the escalation, specifying the
following:
• Conditions, including setting the time of escalations and transaction

qualifications.
• Actions, including notifying users, setting fields, and so on.
Figure 4-4 illustrates how escalations are executed in the AR System.

(Note:  Escalation is checked immediately when created, enabled, or modified.)
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Figure 4-4 Escalations in the AR System

Escalation Conditions

You can define an escalation so that the AR System checks conditions for
activating the escalations at a specific time or at specified time intervals. You
can also include a qualification in the condition to further refine the escalation
conditions.

Escalation Actions

There are four kinds of actions you can define for an escalation, as shown in
Table 4-2. A single escalation can invoke up to 25 multiple actions.

Table 4-2 Escalation Actions

Action Description

Log to File Records an entry in an audit trail log file.

arserverd

DatabaseSet Fields

Escalations

Check Escalation
Conditions Database

Queries

Run Process

Notifications

Define Escalations

Intervals/Times

Checks
That Server

Escalations

Log to File
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Escalation processes run on the server. Escalations are defined and modified
from within the Administrator Tool without programming, by using convenient
forms and other aids. You can use escalations to guide ARs through each stage
of the resolution process.

Note – Be aware while designing escalations that escalations run on the server
with Administrator privileges. This can have an impact on system security as
well as on server performance.

Be conservative in designing your first escalations. It may seem like a good
idea at the time to notify your user base of all the exceptions to normal process
flow, but creating too many escalations might cause them to be less effective or
even annoying.

The following are examples of useful escalations.

Escalation example #1, track open problems:
For every AR where the Priority field is set to “High” and the problem is
still open after 24 hours, send a notification to the user whose name is in the
Assigned-to field. Include some fixed text and the variable information text
from the Entry ID and the Short Description fields.

Escalation example #2, assign escalated problems to management:
For every AR where the Priority field is set to “High” and the problem is
still open after 48 hours, set the Assigned-to field to Management, update
the diary field to indicate that the AR has been reported to Management,
and set the Status to “Escalated.”

Notify Sends text to a specified user or group.

Run Process Runs a specified program.

Set Fields Sets field values in matching ARs to static or keyword
values or to values retrieved from another data source.
The data source may be a field in the same schema or
another schema on the same server, the results of an
independent system process or the results of a
mathematical calculation or a function.

Table 4-2 Escalation Actions

Action Description
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Unlike filters, there is no execution order field you can use when creating
escalations. Instead, use the Time calendar in the Escalation window to set an
execution order. First create an escalation and set a specific time for the server
to check the escalation (for example, 2:00 AM). Then create another escalation
and set a later time for the server to check the escalation (for example, 2:05
AM).

You can export escalations from one site and import them to another site so
organizations can share the definition of the workflow process.

Sending Notifications From Escalations

Sending notifications from escalations works like sending notifications from
filters. For more information, refer to “Sending Notifications From Filters” on
page 86.

Designing Active Links
In addition to filters and escalations, which are executed on the server, you can
define active links, which are executed on the client machine based on actions
taken by the user. You can assign an execution order to active links so that
more than one active link can execute based on a single user action. You can
also specify basic conditions that must be met before an active link will
execute.

Active link actions are performed on the data in the current user window. For
example, you can define an active link that causes information to be retrieved
from another AR, from the same schema, or from a different schema, and
inserted in the AR the user is working on when the user presses Return in a
particular field.

Active links are associated with a single schema and execute under explicit
user control. Access control is supported for active links so that you can control
which users will be able to execute a specific active link.

Note – When designing active links that launch other processes or tasks, you
should take care if users in your environment are running on different
platforms (UNIX, Windows, Macintosh, and so on). Not all OS commands are
available on all platforms.
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Active Link Conditions

As with filters and escalations, it is possible to define qualifications that must
be met before an active link operation will occur. For example, you could
define an active link that checks which hardware platform the tool is running
on and uses that information to determine whether or not to execute.

By combining conditional execution with the ability to tie more than one active
link to a single user action, you can design an active link that will execute a
different operation based on conditions at the time the active link operation
occurs. For example, you can design an active link that checks the name in the
Submitter field and attaches a different menu to the Short Description field
depending on the results. This would let you provide one set of descriptive
options to Sally Smith and a different set to John Jones.

Execution Options

When you define an active link, you specify the user activity that will cause the
active link to execute. You can choose from seven execution options, as shown
in Table 4-3 below.

Table 4-3 Active Link Execution Options

Option Description

Submit Executes the active link when a user submits a new AR.

Modify Executes the active link whenever a user modifies an existing AR
for the schema. (Note that the active link does not execute if the
operation is a Modify All operation.)

Display Executes the active link when a user retrieves an AR for display.

Set Default Executes the active link when the user selects the Set to Default
option or when the AR System loads defaults prior to a new
query or submit.

Return Executes the active link when the user presses Return in a
specified field or selects a radio button (if the field is a selection-
type field).

Menu Choice Executes the active link when the user selects a choice from a
character menu.

Button Places a button on the schema that the user can select. You can
attach more than one active link to a button.
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The Button, Return, and Menu Choice options are especially useful when you
are designing an active link that displays additional information or retrieves
information from other sources and inserts it in the current AR. For example,
suppose you are designing a schema for a help desk and you want the help
desk person to be able to verify a user’s configuration before continuing with a
call. You can design a button-activated active link that takes the value entered
in the User Name field of the current AR and uses it as a parameter in a macro
that displays configuration information for the given user. By simply pressing
a button, a help desk person can get information from another schema without
leaving the current AR.

The Submit, Modify, Display, and Set Default options are useful when you are
designing an active link whose purpose is to insure complete and consistent
data definition. For example, whenever a new AR is submitted, you may want
an active link to retrieve the host name of the client and copy it into a field on
the schema. This would guarantee that every submitted AR includes the
hostname.

Actions

There are six kinds of actions you can define for an active link, as shown in
Table 4-4 below. A single active link can invoke multiple actions (up to 25).

Table 4-4 Active Link Actions

Action Description

Change Field Changes the characteristics of a field. You can attach a new
menu to the field, move the focus to the field, or change access
permissions of the field based on conditions and qualifications
specified in the active link.

DDE Executes a DDE operation. (PC clients only)

Message Sends an interactive error, warning, or note to the user who
initiated the transaction.

Run Macro Executes an AR System macro.

Run Process Executes an independent system process on the client system.

Set Fields Sets field values in the current AR to static or keyword values
or to values retrieved from another data source. The data
source may be a field in the same or another schema, the
results of an independent system process, a DDE operation, or
the results of a mathematical calculation or a function.
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Using Filters Versus Active Links
Both filters and active links help you define your workflow process by
allowing you to define actions that will occur based on specific events.
Whether a filter or an active link would be better to accomplish a specific
purpose is a decision you will have to make on a case-by-case basis. There may
be times when either mechanism would suit your purpose. More often,
however, the specifics of the work you are trying to accomplish will determine
whether you use a filter or an active link.

When you determine how to manage your workflow process, it is important to
be aware of both the differences and the similarities between filters and active
links.

Table 4-5 summarizes the features of filters and active links.

Table 4-5 Filters versus Active Links  (1 of 2)

Filter Active Link

Where Action
Executed

On the server. On the client.

Access control Runs with Administrator
permissions.

Runs with permissions of
current user. Access can be
restricted to certain users.

Acts on data In the current transaction. In the current window.

Conditions Query, Modify, Submit,
Delete, Merge.

Button, Return, Submit,
Modify, Display, Menu
Choice, Set Default.

Qualifications Checks values in the current
transaction, the database, or
both the current transaction
and the database.

Checks values in the current
screen only.

Possible actions:

Change Field Not applicable. Adjusts the characteristics of
a field. Use to dynamically
change character menus,
move focus to a field, or
change access to a field.

DDE Not applicable. Executes a DDE operation on
a Windows client.
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Using Macros
The User Tool of the AR System is very simple to use for query, modification,

Log to File Creates audit trail of
transactions that meet
conditions.

Not applicable.

Message Displays error message, note,
or warning to user.

Displays error message, note,
or warning to user.

Notify Provides active event
notification.

Not applicable.

Run Macro On UNIX, can launch a User
Tool to run a macro.
On Windows NT, can launch
runmacro.exe  to run a
macro.
Runs with Administrator
permissions.

Runs a macro.

Run Process Launches an independent
system process. Runs under
arserver  process
permissions on the server.
Same for users on all clients.

Launches an independent
system process. Runs under
the user’s permissions on the
client. Client architecture
dependent.

Set Fields Loads data into fields on
current AR. May be static
values, keywords, data from
field on same or other schema
on the same server, or results
of a function, an independent
process, DDE operation, or a
mathematical calculation.
When you are assigning a
value from another field and
multiple matches to a
qualification are found, a
filter takes only the first AR
that matches a qualification.

Loads data into fields on
current screen. May be static
values, keywords, data from
other fields on same or other
schema, or results of a
function, an independent
process, or a mathematical
calculation.
When you are assigning a
value from another field and
multiple matches to a
qualification are found, an
active link produces a
selection list so that the user
can select which AR to use.

Table 4-5 Filters versus Active Links  (2 of 2)

Filter Active Link
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and reporting. Your users will become skilled at these operations in a few
hours of use. To automate commonly used operations and further simplify
your process, the AR System offers another capability: macros.

Macros allow users to capture commonly run queries and operations on ARs
by a simple record and playback sequence. Any user can create a set of macros;
moreover, you, as the AR administrator, can organize a library of useful
macros. You can keep these organized by different roles, such as support staff
or end user. Users can invoke macros from within the User Tool, from the
command line, or from other tools. Macros can also use variables, so that parts
of the query are specified at the time the macro executes. Macros can be shared
with other AR System users, even those on different hardware platforms and
operating environments. To share macros locally, specify a directory in the AR
Path preference to define a search path where users can find these macros.

The following are examples of a few useful macros:

• Show the ARs assigned to a user, with the user name being a variable.

• Create a periodic report of unresolved, critical ARs, with the begin and end
dates being variables.

• Create a statistics report of the average time to fix problems.

• Open a partially filled in Submit window for a schema.

For information on sharing macros as well as on specifying your AR Path
preference, see Sharing Macros and Custom Reports on page 2-34 in the Action
Request System User’s Guide for Windows.
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Once you have identified the users of your AR System application and
determined the type of information each user will need to access, you can set
up your users and establish their access to the system. You can also define
groups to which various users will belong. It is group membership that
ultimately determines which operations individual users can perform and
which schemas, fields, and active links they can access.

This chapter includes the following:

• A discussion of access control and how it works.

• Instructions on how to create access control groups.

• Instructions on how to add users to the AR System.

• Instructions on how to set up and use Subadministrator access.

Understanding Access Control
The AR System access control mechanism lets you define groups of users and
determine which of the groups have access to each schema and to each field
within a schema. You define these groups of users, called access control
groups, by submitting an entry to the Group schema through the User Tool.
Then, when you define schemas, fields, or active links using the Administrator
Tool, you specify the access each group will have to information in your
database.
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An access control group may reflect a functional area, such as “Tech Support,”
or a general category, such as “Browsers.” Each user may be a member of
several of these groups. In order for the user to be allowed to view or modify a
field, at least one of the groups the user belongs to must have the appropriate
View or Change access to the field. View access means the user is able to see
the contents of the field. Change access means the user is able to modify the
contents of the field. Even if users have view permissions to access a schema,
they cannot see the field if they do not have view or change access to the field
as well.

Groups are assigned their own View and Change permissions as well. The
group access setting determines the maximum rights for the group, but not the
specific rights the group will have for a field. It is the field definition that
ultimately determines a particular group’s access to a specific field. For
example, the “Tech Support” group may have Change access rights in general,
but for the “Problem Description” field this group may be defined as having
only View access.

The submitter and assignee of an AR are given special consideration in the
access control mechanism. The submitter is the person who submits the AR
(whose name is entered in the Submitter field). The assignee is the person who
is assigned responsibility for resolving the AR (whose name is entered in the
Assigned-to field). In the field definition, you can specify that the submitter or
assignee of an AR have access to the field regardless of the access rights of the
individual users who submit or are assigned the ARs.

Note – Except as described in “Special Submitter Access” on page 101, the
submitter and assignee must have valid AR System write licenses to be able to
take advantage of the Change access privileges given to these special groups.

The diagram shown in Figure 5-1 on page 101 illustrates how access control (or
permission) to fields in a schema is defined. In this example, the field
definition for a specific field gives the “CS Staff” group Change access to the
field, and the “Browser” and “HD Staff” groups View access. This means that
John can change the field, but Alice and Rick can only view its contents. Notice
that John is a member of both the Browser and CS Staff groups. Notice also
that even though Alice belongs to a group that has Change access rights, the
field definition limits her to View access for this field.
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Figure 5-1 Specifying Field Access Control (or Permissions)

Special Submitter Access

If you select Locked for the Submitter Mode in the Server Information window,
the Submitter field is “locked” (that is, it cannot be changed) once a ticket is
submitted. Submitters without write licenses are allowed to write to or update
AR tickets for which they are the submitter if the special Submitter group or a
group they are a member of has been allowed Change access. This is one of the
two instances where a user without a write license can update existing entries
(see “Allowing Users to Modify Their Own Passwords” on page 113 for the
other instance).
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If you select Changeable for the Submitter Mode in the Server Information
window, the Submitter field is not “locked” once a ticket is submitted. After a
ticket is submitted, anyone with a valid write license and write permission to
the field can change the name in the Submitter field. In Changeable mode, a
user must have a fixed or floating license to change any record, including
entries for which they are the submitter.

To set the submitter mode, see “License Information” on page 44.

Access Control Groups
Groups are used primarily to define user access to the various features of the
AR System, including schemas, fields within a schema, and active links. They
are also used to define groups of users to receive notifications (for example,
you can designate an entire group to be notified in a filter action). A group can
have Change, View, or no access. A user can be a member of more than one
group.

Six special groups are provided by the AR System — Public, Administrator,
Customize, Submitter, Assignee, and Subadministrator. (The Group ID
numbers 0 through 5 are reserved for these groups.) You may want to set up
additional groups to reflect various functional groups, such as a “Help Desk”
or “Tech Support” group.

Of the special groups, the Administrator, Subadministrator, and Customize
groups are explicit groups to which you can assign users. The Public group is
a group to which every user belongs automatically. The Submitter and
Assignee groups are implicit groups. Users belong to these implicit groups
based on specific conditions; you do not assign users to these groups.

Details about each of the groups are as follows:

Administrator The Administrator group defines users who have full and
unlimited access to the AR System. Users who belong to this
group can create schemas, menus, filters, escalations, and active
links, or delete entries. They also can add or delete users and
other groups.
Users assigned to this group automatically have change access
permission to all fields (the ability to change field contents).
Users will belong to this group only if you explicitly assign
them to it.
Each member of the Administrator group must have a fixed
license or the group assignment is ignored.
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Sub-
Administrator

The Subadministrator group provides a layer of limited
administrative access to the AR System, allowing different
functional administrative groups in a single AR System server.
A user has subadministration access to a schema if (1) the user
belongs to the Subadministrator group and (2) the user belongs
to a group that is enabled for subadministrator access to the
schema.
Each member of the Subadministrator group must have a fixed
license or the group assignment is ignored.
For more information on subadministration in the AR System,
see “Subadministrator Permissions” on page 114.

Customize The Customize group grants users the right to customize their
schema layout and create user commands in the User Tool.
Users will belong to this group only if you explicitly assign
them to it.

Public Every user is a member of the Public group. You can use this
group to define general View or Change access to fields or
schemas. For any field or schema where the Public group is
allowed View access, any user can view the contents of the field
for any entry regardless of what groups they are a member of
and what permissions are granted to those groups.
Note that this includes users who are connected to the system as
“guest” users (users who are not registered users of the AR
System), if guest users are allowed on your server.
For any field where the Public group is allowed Change access,
any user with a fixed or floating license can update the entry
regardless of the groups they belong to and the permissions
granted to those groups. See “Configuration Information” on
page 46 for information on allowing guest users.

Submitter
and
Assignee

The Submitter and Assignee groups are implicit groups. Users
automatically belong to the Submitter group for ARs where
their name is in the Submitter field, and to the Assignee group
for ARs that have been assigned to them. If a field has change
access defined for the Submitter or Assignee group, licensed
users can change the contents of that field when they are the
submitter or assignee of an AR even if they do not belong to any
of the other groups that have change access for that field.
For information on how Submitter Mode affects the Submitter
group, see “Special Submitter Access” on page 101.
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Row Level Access Control

The row level access feature of the AR System extends the access control
capabilities of the system to allow per-entry control on the basis of group
membership. Access to individual ARs, or “rows,” and to the individual fields
within those ARs can be controlled by the group membership of the current
user.

Prior to row level access control, administrators were only able to define group
access for entire schemas, for individual fields on all ARs in a schema and for
individual entries of a specific person. With the addition of row level access
control, administrators may now control access to individual fields on
individual ARs on a group basis.

Implementation

To support row level access control, the AR System has been modified as
follows:

• The Assignee Group group (ID 7) has been defined.

• Field number 112 has been defined as a reserved field.

To initiate row level access control in a schema, add field 112 as a character
field with a length of 30. Enter field 112 into a group name. If an AR contains a
group in field 112, and the current user belongs to that group, the user is
granted the additional access defined for group name Assignee Group .

Once a schema contains field 112, you can set permissions for group name
Assignee Group in the group permissions settings for each field on the
schema. Users that gain access to the schema as members of group name
Assignee Group are able to access each field to which that group has been
granted access.

If group name Assignee Group has not been granted access to any fields in
the schema, users will not be able to access the schema’s contents based on
their membership in the group in field 112. However, users may still access the
schema through any other method available to them.
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To establish row level access to a schema and fields:
1. Add a field to the schema with field ID 112.

You may choose to hide this field. You may also choose to grant no access to
any control group to see or change this field.

2. Add workflow that inserts a group name into field 112 according to the
business rules at your site.
For example, if you determine that group name Assignee Group  should be
set when the AR is created, you can create a filter that fires on submit and
sets field 112 to a group name based on the contents of the current AR.

3. Change the access control of the fields in the schema to either grant or
deny access to users accordingly.

Adding Groups

You add groups by running the User Tool and submitting new entries using
the Group schema, shown in Figure 5-2. You can add as many new groups as
you want.

When you create a new group, the group name is added to the list of groups
that appears when you use the Administrator Tool to define group access to
schemas, individual fields, and active links.
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Figure 5-2 Submit Window — Group Schema

The key fields in the Group schema are:

Group name The Group name is the alias name by which the access control
group is known. This is the name you use in the User schema in its
Group list field. It is also the name that appears in the Group
Permissions list in the Field Properties window when you are
defining schema fields, on the Schema Permissions window when
you are defining schema attributes, and in the permissions lists for
active links.

Group ID Each access control group has an integer ID that is the real identity
of the group. For groups that you create, the ID should be greater
than 10. If you use the same ID with multiple group names, you
must keep the Group type the same for each (you are really
creating aliases for the same group in this case).
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Note – When field access permissions are granted during field creation or
modification, the permissions granted for the group can be no greater than the
type specified for the group in the Group schema. For example, if the group
has a View type, you cannot assign Change permissions on a field for the
group. However, if the group has Change permission, it can be limited to View
permission only on the field.

If a group does not have access permission to a schema’s Entry ID field (core
field 1) or if a group does not have schema permissions, members of that group
will not be able to access any information from that schema, regardless of the
permission settings for other fields on the schema.

To create a group:
1. Start the User Tool by double-clicking the User Tool icon from the

Remedy AR System group window. If this is the first time you have used
the User Tool, the Login dialog box appears. Enter your user name and
password, then select the OK button.
If there are no other Administrator users yet, you must log in as Demo.

For more information on logging in as Demo, see the note on page 14.

2. Open the Group schema in a Submit window (as shown in Figure 5-2).

3. Enter information in the appropriate fields.
Create a new group by specifying a group name, ID and type. There are
additional fields in the Group schema for describing the meaning and
attributes of the group more thoroughly. (If there are additional attributes

Group type The Group type field holds the maximum permission type
intended for the group. The alternatives are None (no access),
View (view field contents), and Change (modify field contents).
You can use the type None to disable all access allowed for the
group without deleting the group itself. The group remains as a
placeholder (and can be restored in the future), but all permissions
for the group are lost. You might create a group with the type
None if you want to define a group that will be used only for
notifications.

Long Group
Name

The Long Group Name lets you enter additional information about the
group. It should be descriptive of the group since this is the name that
will appear by default in the Query List window in the User Tool.
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not represented on the Group schema that are important to your
organization and you would like to specify these attributes in the group
definition, you can use the Administrator Tool to add fields to the Group
schema.)

Note – Privileges for a user are determined by the permissions assigned to the
user’s Group ID. If you later change the Group ID for a group, the users
belonging to the original Group ID will still be attached to the old ID. If there
is no group with the old ID, these users are no longer attached to any group.

4. When you have finished entering information, select the Apply button.
When you receive a confirmation that your entry was successful, the new
group has been added to the system.

After you have created a new group, you can assign users to the group by
using the User schema (also from within the User Tool). Adding users to a
group gives them the access rights of that group. (For more information, see
“Adding Users” on page 109.)

Modifying Groups

Follow these steps to modify a group from the AR System.

To modify a group:
1. Open the Group schema in the User Tool.

2. Select Query List from the Query menu to retrieve a list of currently
defined groups.

3. Select one or more groups that you want to modify from the list.

4. Click the Modify button (or choose Modify Individual from the Query
menu).

5. Modify information in the appropriate fields.

6. When you have finished entering information, select the Apply button to
modify the record.
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Deleting Groups

Follow these steps to delete a group from the AR System.

To delete a group:
1. Open the Group schema in the User Tool.

2. Select Query List from the Query menu to retrieve a list of currently
defined groups.

3. Select the group that you want to delete from the list.

4. From the Query menu in the User Tool, choose Delete.

5. A confirmation box appears to verify that you want to delete the group
entry. Click the OK button to confirm.

AR System Users
When adding users to the system, keep in mind the limitations of your user
licenses. The basic AR System product includes one server license, which
allows unlimited users with submit and query access, and three fixed write
user licenses — that is, three users with the ability to change ARs after they are
submitted. A user with change access may belong to the Administrator or
Subadministrator group or one or more groups with Change permission.

Note – If you want more than three users with change access, you must
purchase the appropriate license from Remedy Corporation or an authorized
reseller. Check with your sales representative for information on the types of
licenses that are available.

Adding Users

You add users to groups by running the User Tool and submitting entries in a
database provided by another special AR System schema, called the User
schema (Figure 5-3).
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Figure 5-3 Submit Window — User Schema

The key fields in the User schema are:

License Type The type of write license the user has: Read (includes submit and
query permission), Fixed, or Floating. The default is Read.

Login name The identifying name that the user will enter into the User Name
field when starting the AR System. The login name for the AR
System is distinct from any other login name the user may have
elsewhere; however, it is convenient to use the same name to
avoid confusion and extra maintenance.

Password The identifying password that the user will enter when starting
the AR System. It is a good idea to select a password that is
different from ones used for other purposes.
You can set options on a UNIX server to tie the password to the
user’s UNIX password or to use the /etc/passwd  file for user
validation. See “Configuration Information” on page 46 for more
information.

Email Address The email address that will be used to notify the user when email
is the notification method.
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Whether or not users have permission to access an AR System database or
specific fields or active links in a database is determined in part by the
permissions given in the Group list field of the User database entry. (Even
when users do not belong to an explicit group with appropriate access, they
may be able to access fields by being the submitter or assignee for a particular
entry.)

It is possible to add more than one user with the same login name as long as
you specify a different password for each entry. It is the combination of user
name and password that makes a user entry unique to the AR System.

The default view of the User schema contains fields in addition to the key
fields listed above that allow you to collect information about the user you are
adding to your system. As with all other schemas, you can change the field
labels and add new fields to suit your needs.

To add users to the system:
1. Run the User Tool on any machine on which you installed the software by

double-clicking the User Tool icon from the Remedy AR System group
window.
If this is the first time you have used the User Tool, the Login dialog box
appears. Enter your user name and password, then select the Apply button.

If there are no other users yet, you must log in as Demo.

For more information on logging in as Demo, see the note on page 14.

2. Open the User schema in a Submit window (as shown in Figure 5-3 on
page 110).

Group list Specifies the access control groups to which the user belongs. If
this field is left empty, the user will have only basic submitter,
assignee, or public permissions. When entering groups in the
Group list, you can specify the groups either by name or ID.

Full Name Holds the full name of a user. By default, this name appears along
with the entry ID in the Query List window when users perform
a Query List operation.

Default Notify
Mechanism

The way in which the user will be notified of actions affecting
them if no notify mechanism is specified or the default
mechanism is specified at the time the action is taken.

Full Text
License

The type of full text search license the user has: None, Fixed, or
Floating. The default is None.
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3. Enter information in the appropriate fields.
Always set passwords, especially for AR administrators. It is recommended
that you make Password a required field. For security reasons, the password
you enter is masked in the Password field.

In the Group list field, enter a list of the groups to which the user is to
belong, separated by spaces. The list can include one or more of the special
groups (Administrator, Subadministrator, or Customize) as well as any
access control group defined in the Group schema. In the example in
Figure 5-3 on page 110, Susan Subadministrator will be a member of the
Sales Staff and Subadmin groups.

• If the Administrator group is in the Group list, the user will be able to
modify all fields, delete entries, and run the Administrator Tool to manage
the objects in the system.

• If the Customize group is in the Group list, the user will be able to use all
features of the customize facility of the User Tool.

• If the Subadministrator group is in the Group list, the user will be able to
perform a subset of the Administrator functions as described in
“Subadministrator Permissions” on page 114. For example, users will be
able to modify all fields and delete entries and to manage objects in the
system to which the Administrator has allowed Subadministrator access
to other groups which the user is a member of.

When first getting started, do not worry about specifying all the additional
access control groups you may need. You can add groups to the Group list
for a user’s entry at any time and give those groups access to fields by
modifying field definitions within schemas.

4. When you have finished entering information, select the Apply button.
When you receive a confirmation that your entry was successful, the user
has been added to the system. If adding a new user will cause you to
exceeded your license agreement, an error message appears.

Note – You may need to delete the AR System demonstration users before you
can add a user.
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Allowing Users to Modify Their Own Passwords

If you desire, you can define your user entries so that users will have the
ability to modify their own password. You can take advantage of the Assignee
(or Submitter) group to accomplish this without allowing users to access any
passwords other than their own.

To allow users to change their passwords:
1. On the User schema entry for the user, make the user the Assignee by

entering the same name in the Login name field and in the Assigned-to
field. (Alternatively, you could make the user the submitter by entering
the same name in the Submitter field as in the Login name field.)

2. Make sure that the Assignee (or Submitter) group has change permission
to the Password field.

Note – In addition to the Password field, you can grant change permission to
the Default Notify Mechanism and Email Address fields.

Deleting Users

Follow these steps to delete a user from the AR System.

To delete a user:
1. Open the User schema.

2. Select Query List from the Query menu to retrieve a list of currently
defined users.

3. Select the user that you want to delete from the list.

4. From the Query menu in the User Tool, choose Delete.

5. A confirmation box will appear to verify that you want to delete the user
entry. Click the OK button to confirm.
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Subadministrator Permissions
Granting subadministrator permissions to a user is a powerful feature of the
AR System. Users can be granted subadmin permissions to a subset of
available schemas, as shown in Figure 5-4. Inside a schema, subadministrators
have the same privileges and permissions that an administrator has, including
creating objects, viewing server settings, setting local preferences, and so on.
Use subadministrator access wisely.

Figure 5-4 Users Subadministering Schemas

Only users who (1) belong to the Subadministrator group and (2) belong to a
group with subadmin access to a schema can be a subadministrator and
perform the following functions:

• Administer any schema that their group has subadministrator access to.

• Create and administer filters, active links, and escalations connected to
schemas that their group has administrative access to.

A

Subadministrator
 for Marketing

Subadministrator
 for Engineering

Contact
Info
Schema

Sales
Lead
Schema

Enhance-
ments
Schema

Bug
Tracking
 Schema
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• Create and administer menus.

• Create new schemas.

• View server info settings.

• Set Administrator Tool preferences.

However, members of the Subadministrator group cannot:

• Change server info settings.

• Release users currently accessing the AR System.

• View users of the AR System.

• Administer schemas they are not subadministrators for.

Allowing multiple subadministrators poses interesting administrative
challenges. For example, if you allow two different groups (say, Engineering
and Marketing) subadmin permissions to a schema, Engineering with their
permissions theoretically could use the Administrator Tool to revoke the
permissions of the Marketing group! However, the AR Administrator could
ultimately restore schema permissions back to the Marketing group. Just be
aware of potential problems.

To create a user with subadministrator capabilities:
1. In the User Tool, open the User schema in a Submit window (as shown in

Figure 5-3 on page 110).

2. Enter information in the appropriate fields.

a. Always set passwords, especially for an AR subadministrator. It is recommended
that you make Password a required field. For security reasons, the password you
enter is not echoed in the Password field.

b. In the License Type field, assign the subadministrator a Fixed write license.

c. In the Group list field, use the menu to enter the groups to which the user is to
belong. The list must include the Subadministrator group. Remember that giving
users membership in the
Subadministrator reserved group only gives them the potential to be a
subadministrator. For users to be subadministrators, they must belong both to the
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Subadministrator group and also to a group with subadmin permissions to a schema.
In the example in Figure 5-3 on page 110, Sarah Subadministrator will be a
member of the Sales Staff and Subadministrator groups.

3. When you have finished entering information, select the Apply button.
When you receive a confirmation that your entry was successful, the user
has been added to the system as a subadministrator.

4. Select the Subadmin Permissions tab (see Figure 6-12 on page 134) in the
Schema Properties dialog box to give subadministrator permissions to a
schema to a specific group or groups. For example, Sarah
Subadministrator will not have subadmin permissions to a schema unless
you explicitly give them to a group she is a member of. To define sub
admin permissions, see “Defining Subadministrator Access for Schemas”
on page 134.
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This chapter describes how to create and modify schemas. A schema consists
of the data fields in a database. Each schema represents a database on an AR
System server.

You should be familiar with the information in “Designing Schemas” on
page 77  before you perform the operations described in this chapter.

The following topics are covered in this chapter:

• Using the Schema window.

• Opening schemas.

• Naming schemas.

• Deleting schemas.

• Creating or modifying active links from a Schema window.

• Defining permissions for multiple schemas.

• Setting schema properties, including:
• Defining indexes.
• Defining query list fields.
• Defining schema permissions.
• Defining group access to schema fields.

• Setting help for schemas.

• Building and using schema change history.
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For information for defining and modifying fields on a schema, see Chapter 7.

Using the Schemas Window
When you open a schema, it is displayed in the Schema Window. Figure 6-1
shows a new schema containing only core fields.

Figure 6-1 Schema Window

You use the Schema Window to perform the following tasks:

• Specify a schema name.

• Create and modify fields. For information on field properties, see Chapter 7.

• Move, align, and modify button-activated active links.

• Define, modify, and delete multiple schema views.

• Create help text for the schema.

• Define schema attributes such as indexing, fields returned in a query list,
permissions for the schema, and subadministrator definitions for the
schema.

This chapter describes the steps to follow to perform the tasks of defining
schemas. Chapter 4 provides information about planning for all these tasks.
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When the Schema window is the active window, new menus and additional
menu items appear in the menu bar in the Admin Tool Main window. The
following section provides a short description of the items in the File, Edit,
Schema, and Layout menus. Toolbar buttons are also described.

The File Menu

The File menu from the Schema Window is shown in Figure 6-2.

Figure 6-2 Schema Window — File Menu

The File menu provides the following additional options:

The Edit Menu

The Edit menu from the Schema Window is shown in Figure 6-3 on page 120.

Close Quits Schema window.
Save Schema
(Ctrl+S)

Saves all changes made in the Schema window. You can also
use the corresponding toolbar button to save changes.

Save Schema As Allows you to copy a schema and save it under a different
name but keep the original.

Rename Allows you to give a different name to a schema.

Additional
items
appearing on
File Menu
when Schema
Window is
active
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Figure 6-3 Schema Window — Edit Menu

The Edit menu provides the following options:

The Schema Menu

The Schema menu from the Schema Window is shown in Figure 6-4.

Figure 6-4 Schema Window — Schema Menu

The Schema menu provides the following options:

Cut
(Ctrl+X)

Deletes highlighted field(s) and moves it to the internal clipboard.

Copy
(Ctrl+C)

Copies highlighted field(s) and moves it to the internal clipboard.

Paste
(Ctrl+V)

Pastes internal clipboard’s current contents at the location of the
cursor.

Delete
(Del)

Deletes highlighted field(s) but does not move it to the internal
clipboard.

Restore Restores the previous field property settings from the database for the
selected field(s).

Schema
Properties

Opens the Schema Properties dialog box, which you use to define
query lists, indexes, permissions, subadministrator permissions, help
text, and change history for schemas.
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The Layout Menu

The Layout menu from the Schema Window is shown in Figure 6-5. Some
Layout menu options also have corresponding buttons available on the toolbar.

Figure 6-5 Schema Window — Layout Menu

For the functions of the Layout menu, see “Using the Layout Menu to Arrange
Fields” on page 178.

View Allows you to select and modify a schema view, including the
following options:
* Select. Selects schema view to display.
* Copy. Copies schema view.
* Delete. Deletes schema view.
* Set Default View. Sets default view that appears in Modify Schema
window.
For information, see “Schema Views” on page 173.

Create
New Field

Allows you to create a new field. Use the cascading menu to select the
data type for the field you want to create:
* Character.
* Date Time.
* Diary.
* Integer.
* Real.
* Selection.
For information, see “Attributes Field Properties” on page 155.

Field
Properties

After you select a field, displays the Field Properties window, which
lets you create or modify properties for the selected field.

Toolbar buttons
available for
aligning objects
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Creating Schemas
Follow these steps to create a new schema.

To create a schema:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Click the New Object button on the toolbar or select New Object from the
File menu. The New Object dialog box appears (Figure 6-6).

Figure 6-6 New Object Dialog Box

4. Double-click Schema in the New Object list (or select Schema, then click
the OK button).
A new schema appears in a Schema Window (see Figure 6-1 on page 118)
and is assigned the name Create Schema [Server_Name ]. You now can
modify the new schema as needed.

Opening Schemas
Follow these steps to open and modify an existing schema.

To open a schema:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click the Schemas object to display all existing schemas on this
server.
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4. Double-click a schema from the Schemas list. You also can select a schema
from the Schemas list, then press Return.
The schema appears in the Schema Window (see Figure 6-1 on page 118).
You now can modify the schema as needed.

Note – You can open as many schemas as you want but you cannot open the
same schema twice.

Saving and Naming Schemas
For a newly created schema, Create Schema [Server_Name] appears as the title
of the schema in the Schema window. When you save the schema, you replace
this title with the name that you want to use for this schema. Schema names
must be unique on each AR server. There is no enforced convention for
specifying schema names, but it is helpful to make the name descriptive and
indicative of the schema’s function. Names may be up to 30 characters,
including blanks.

Note – Users must log onto the server again or restart the User Tool to see a
new or modified schema name.

To save and name a schema:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Click the New Object button on the toolbar or select New Object from the
File menu. The New Object dialog box appears (Figure 6-6 on page 122).

4. Double-click Schema from the New Object list (or select Schema, then
click the OK button).
A new schema appears in a Schema Window (see Figure 6-1 on page 118)
and is assigned the name Create Schema [Server_Name ].

5. Modify the new schema.

6. Click the Save button on the toolbar (or select Save Schema from the File
menu, or type Ctrl+S ) to save the schema. The Save Schema As dialog box
appears (Figure 6-7 on page 124).
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Figure 6-7 Save Schema As Dialog Box

7. In the Schema field, enter the name of the new schema.

8. From the View Name drop-down list, choose the default schema view for
the new schema. You can use the default name or create a new name. For
more information, see “Schema Views” on page 173.

9. Click the OK button to close the dialog box. The name of the new schema
appears in the title bar.

Saving a Schema Under a Different Name

When saving a schema under a different name, the new schema contains all
the fields and properties of the original schema, including its views. The only
difference is the schema name.

Note – Using the Save Schema As command copies only the schema
definitions. Any objects associated with the schema (for example, active links,
filters, and escalations) will not be copied.

To save a schema under a different name:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click the Schemas object from the server you just connected to.
The currently available schemas are listed in the Schemas list.

4. Double-click a schema to open it.

5. From the File menu, choose Save Schema As. The Save Schema As dialog
box appears (see Figure 6-7 on page 124).
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6. In the Schema field, enter the name of the copy of the schema.

7. From the View Name menu, choose the default schema view for the new
schema. For more information, see “Schema Views” on page 173.

8. Click the OK button to make a copy of the schema.

Renaming Schemas

Renaming a schema allows you to save a schema under a different name and
overwrites the original. In this case, the original schema with its original name
no longer exists.

To rename a schema:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click the Schemas object from the server you just connected to.
The currently available schemas are listed.

4. Double-click a schema to open it.

5. From the File menu, choose Rename. The Rename Schema dialog box
appears.

Figure 6-8 Rename Schema Dialog Box

6. In the Schema field, enter the new name of the schema.

7. Click the OK button to rename the schema.
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Deleting Schemas
Deleting permanently removes a schema and all associated ARs. Any data,
filters, escalations, or active links tied to this schema will also be deleted.
Menus are not deleted. Follow these steps to delete an AR System schema:

To delete a schema:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click the Schemas object from the server you just connected to.
The currently available schemas are listed.

4. Select a schema from the Schemas list.

5. From the Edit menu, select Delete - Schema.
A confirmation message appears (if your preferences are set for this). Click
the OK button to delete the schema. For more information, see “Defining
Preferences” on page 61.

Note – Warning:The delete operation is permanent and cannot be undone.
Make sure you no longer need a schema before deleting it. You cannot delete
any schema that is currently open.

Setting Schema Properties
For each schema, you can define properties that determine characteristics of
how that schema will look and act during operations performed in the User
Tool. You can define the following schema properties in the Schema Properties
dialog box:

Query List Fields Allows you to specify which of the schema’s fields will appear in a
query list for the schema.

Indexes Allows you to define up to 16 indexes on the fields of the schemas
you create. By setting an index on a field that users search on
frequently, you can greatly increase the speed of access to items in
the search.
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Instructions for defining each of the schema properties are provided in the
following sections.

Defining Query List Fields

The Query List Fields schema property setting allows you to customize which
fields appear when a user performs a query list operation in the User Tool.
Normally, the user sees the contents of the Entry ID field and the Short
Description field. By specifying this property, you can modify the query list to
contain the contents of any fields on the schema. (The contents of the Entry ID
field will always be returned.)

When you define the list of fields, you specify each field, the width to use for
that field, and the string to use as a separator between that field and the next
field in the list. The total string that you define can be no longer than 128
characters.

Note – Modifying the contents of the query list will also affect the contents of
the Selection List window (pick list in the User Tool). The Selection List
window appears when an active link that performs a set field operation based
on a query returns more than one result. See the Action Request System User’s
Guide for more information on the Selection List window.

Permissions Allows you to specify which of the access control groups defined on
the server are able to see the schema. By denying permission to a
group, you can assure that no member of that group will be able to
access the schema, unless they belong to another group with
permissions.

Subadmin
Permissions

Allows you to specify which groups have
Subadministrator privileges on the schema.

Change
History

Allows you to record information about the owner of a schema, the
user who last modified it, and the date of the modification. You can
add additional change history information as well.

Help Text Allows you to define help text for the schema. In most cases, this
help text is simply a description of the schema, what it does, and
how it is used. User Tool users will be able to view this help text in
the same way that they can view help text that is available for
fields.
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To define fields returned in a query list:
1. Open the schema for which you want to define query list format.

2. Double-click an empty part of the schema. (Or choose Schema Properties
from the Schema menu.) The Schema Properties dialog box appears.

3. Click the Query List Fields tab in the Schema Properties dialog box, as
shown in Figure 6-9.

Figure 6-9 Schema Properties — Query List Fields

4. From the Fields in schema drop-down list, select the name of the first field
that you want to appear in the Field Name list.
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5. In the Separator field, type a character or string to be used as the separator
between that field and the next one in the list. The string may contain
spaces as well as any of the following special characters:

In the Width field, type a number to determine the width of the data that
appears in the query list. If you set a width of 20, only the first 20
characters of the field value will appear in the list, regardless of the length
of the actual entry. Remember that the total string, including separators,
can be no longer than 128 characters.

6. Click the Add button. The field appears in the Field Name list, along with
its separator and width settings.

7. Enter the names of additional fields that you want to appear in the query
list, along with their separator characters and widths. You can display up
to 128 characters in the query list; the number of fields that you can
display will vary depending on the width that you specify for each field.
• To remove a field from the list, select the entry in the Field Name list, then

click the Remove button.
• To modify a field’s separator and width settings, select it from the Field

Name list, make your changes, then click the Modify button.
• To re-arrange the order of the fields in the list, select the entry in the Field

Name list, then click the up or down arrow buttons.

8. Click the OK button to save your query list definition and dismiss the
Schema Properties window.

9. Click the Save button on the toolbar to save all changes to the schema.

Defining Indexes

The Indexes schema property setting lets you define up to 16 indexes. Indexing
can greatly decrease the time required for a database search.

Special Character: You Enter:
Backspace \b

Return \n

Tab \t

Backslash \\

ASCII Character \< nnn> (this number is decimal)
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Note – You can only index a relational database. Flat file databases do not
support indexing.

You can specify up to 16 indexes and up to 16 fields for each index that you
define. The sum of all field lengths in an index must be less than 255 bytes.

Good candidates for fields to index include fields that you search on
frequently. The Entry ID field is already indexed, so there is no need to build a
separate index for that field.

If you define an index for a character field, make sure the QBE Match type set
for the field is Leading or Equal. An index on a field with an Anywhere match
type will not save any search time. (For more information, see “QBE Match” on
page 154.)

Note – You should be aware that for schemas with indexes defined, more time
is required when you make modifications to the schema (such as adding new
fields). The greater the number of indexes defined for the schema the more
time and disk space is required. Additionally, submit and modify operations in
the User Tool take longer on schemas with many indexes.

To define indexes for a schema:
1. Open the schema for which you want to define an index.

2. From the Schema menu, choose Schema Properties. The Schema
Properties dialog box appears.

3. Click the Indexes tab in the Schema Properties dialog box, as shown in
Figure 6-10 on page 131.
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Figure 6-10 Schema Properties — Indexes

4. To define the first index for the schema, select a field from the Fields in
schema list, then click the Add button to enter the names of the schema’s
fields into the Index on list. You can enter up to 16 fields. These are the
fields that will be included in the index. Enter the fields in the order that
you want them indexed.
You can also select a field from the Index on list, then click the Remove
button to delete a field from the index.

5. Select the Unique check box to specify whether the index is a unique
index. Unique means that the system will enforce a rule requiring each
value (existing and new) in the index to be unique. For example, you
would not define a unique index on a field that contains first names, since
more than one person might have the same name. You might, however,
define a unique index on a phone number field, since each phone number
may be unique.

6. To create additional indexes for the schema, click the New Index button.
Select the names of the fields from the Fields in schema list to use for this
second index. Click the Unique check box, if appropriate. Repeat this step
as many times as needed to create the indexes you want.
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7. Click the Previous and Next buttons to move from one defined index to
another, as you desire. If needed, click the Delete Index button to remove
an index from the database.

8. Once you have created all the indexes that you need for the schema, click
the OK button to save your index definition and dismiss the Schema
Properties window.

9. Click the Save button on the toolbar to save all changes to the schema.

Note – If you are creating or administering indexes on a schema for which a lot
of data exists, this step may take a significant amount of time and disk space.
Therefore, you may want to limit defining indexes during your normal
production hours.

Defining Permissions for the User Tool

The Permissions schema property setting lets you determine whether users
belonging to each access control group can see a schema in the User Tool or
not. If the user cannot see the schema in the User Tool, they cannot see any
field or any data from that schema, regardless of other permission settings on
the schema. For example, if Public access is denied for a schema, users who do
not belong to any group that does have access to the schema will not be able to
see it even if the schema contains fields with Public read access. If a user is not
in a group that has permission to see the schema, the schema will not appear in
that user’s Schema list.

If no permissions are set for a schema, only the administrator and any
associated subadministrator will be able to see the schema.

To define permissions for a schema:
1. Open the schema for which you want to define group access.

2. From the Schema menu, choose Schema Properties. The Schema
Properties dialog box appears.

3. Click the Permissions tab in the Schema Properties dialog box, as shown
in Figure 6-11 on page 133. A list of the access control groups defined on
the server is displayed.
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Figure 6-11 Schema Properties — Permissions

4. In the No Permission list, double-click the group for which you want to
allow access to the schema (or select a group, then press the Add button).
Groups with access to the schema appear in the Permission list.
• To remove a group from the Permission list, select a group or groups, then

click the Remove button.
• To add all groups to the Permission list, click the Add All button.
• To remove all groups from the Permission list, click the Remove All button.
• Click the Set to Defaults button to reset the schema to its default

permissions (for more information, see “Setting Default Schema
Permissions” on page 56).

5. Click the OK button to save your schema permissions and dismiss the
Schema Properties window.

6. Click the Save button on the toolbar to save all changes to the schema.

To allow all users to see a schema:
• Add the Public group to the Permission list.
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Defining Subadministrator Access for Schemas

The Subadmin Permissions setting allows you to determine which groups have
subadministrator privileges over the schema. Remember that inside a schema,
subadministrators have the same privileges and permissions that an
administrator has. For further information on subadministration, see “Access
Control Groups” on page 102 and “Subadministrator Permissions” on
page 114.

To define subadministrator permissions:
1. Open the schema for which you want to define sub admin access.

2. From the Schema menu, choose Schema Properties. The Schema
Properties dialog box appears.

3. Click the Subadmin Permissions tab in the Schema Properties dialog box,
as shown in Figure 6-12. A list of the access control groups defined on the
server is displayed.

Figure 6-12 Schema Properties — Subadmin Permissions
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4. To add a group to the set allowed potential subadministrator access, select
a group from the No Permission list, then click the Add button. Groups
with subadministrator permissions over the schema appear in the
Permission list.
• To remove a group from the Permission list, select the group, then click the

Remove button.
• To add all groups to the Permission list, click the Add All button.
• To remove all groups from the Permission list, click the Remove All button.

5. Click the OK button to save your subadministrator definitions and
dismiss the Schema Properties window.

6. Click the Save button on the toolbar to save all changes to the schema.

Building and Using Schema Change History

The AR System lets you record information about the owner of a schema, the
user who last modified the schema, the date of the modification, and change
description.

To define change history for a schema:
1. Open the schema for which you want to define change history.

2. From the Schema menu, choose Schema Properties. The Schema
Properties dialog box appears.

3. Click the Change History tab in the Schema Properties dialog box, as
shown in Figure 6-13 on page 136.
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Figure 6-13 Schema Properties — Schema Change History

4. If needed, assign a new owner of the schema in the Owner field.

5. In the New Description field, enter any information about modifications
to the schema that you think will be helpful to other administrators or
subadministrators of the AR System.

Note – All previous change history is found in the read-only window above
the New Description field. After you enter and save change history, it cannot
be edited.

6. Click the OK button to save your change history and dismiss the Schema
Properties window.

7. Click the Save button on the toolbar to save all changes to the schema.

Enter
change history
here

Read-only
description of
previous
change history
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Creating End-User Help Text for Schemas

You can supply schema help text for end-users of the User Tool in the Schema
Properties window. In most cases, this help text is simply a description of the
schema and what it is used for. The text that you enter appears as context-
sensitive help for end-users when they select Field/Schema Help from the
Help menu or press the Help button on the toolbar.

To define help text for a schema:
1. Open the schema for which you want to define help text.

2. From the Schema menu, choose Schema Properties. The Schema
Properties dialog box appears.

3. Click the Help Text tab in the Schema Properties dialog box, as shown in
Figure 6-14.

Figure 6-14 Schema Properties — Schema Help Text

4. In the Help Text field, enter any information that you think will be
helpful to end-users of your schema.

5. Click the OK button to save your help text entry and dismiss the Schema
Properties window.

Enter
help text
here
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6. Click the Save button on the toolbar to save all changes to the schema.

Defining Group Permissions for Multiple Schemas
The Administrator Tool lets you do bulk assignments of group permissions for
all schemas within a server. Rather than going through each schema
individually to assign permissions for a group, the Group Permissions dialog
box lets you assign them all at once.

The Group Permissions dialog box is particularly useful when you have added
a new access control group since the schemas were created. You use this dialog
box to assign the new group access for every schema instead of having to open
each schema and modify the conditions for each schema.

Note – The Administrator Tool offers several different ways to set permissions.
For example, when creating a schema, you might give access to the Public
group. However, if you decide that you want to deny the Public group access
to schemas, you then can use the Group Permissions dialog box to set the
group permissions for all schemas at the same time.

To define permissions for multiple schemas on a server:
1. In the Server Window, select a server, then double-click Groups to see a

list of groups defined on the server.

2. Double-click a group from the Groups list. The Group Permissions dialog
box appears (Figure 6-15). You use this dialog box to set group
permissions for schemas, fields, and active links.

3. Click the Schema Permissions tab. All the schemas defined for the server
appear. You use this window to set schema permissions globally for each
group defined for a server.
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Figure 6-15 Schema Group Permissions Dialog Box

4. To assign schema permissions to a group, double-click the schema for
which you want to define permissions (or select a schema, then press the
Add button). You can also do the following:
• Click the Add All button to give permissions for all the schemas to the

group.
• Click the Remove button to delete a schema from the Permissions list.
• Click the Remove All button to delete all the schemas from the

Permissions list.

5. Click the OK button to save the group permissions settings.
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Defining Fields 7

This chapter describes how to create and modify fields in schemas. You should
be familiar with the information in “Designing Schemas” on page 77 before
you perform the operations described in this chapter.

The following topics are covered in this chapter:

• Creating and modifying fields.

• Setting field properties, including:
• Setting Display properties.
• Setting Database properties.
• Setting field Attributes.

• Creating selection field values.

• Defining permissions for fields.

• Defining permissions for multiple fields.

• Setting help for fields.

• Building and using field change history.

Creating and Modifying Fields
You can create new fields or modify existing fields in a schema at any time.
Users can continue using the schema while you are creating and modifying
fields. All changes take effect as soon as they are applied to the database.
(Current users will need to reopen the schema in order to see the changes.)
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There are a number of performance considerations that you should keep in
mind when you are adding a field to an existing database, increasing the size
of an existing field, activating or disabling a full text index, or deleting a field.
These operations require a varying amount of time, depending on a number of
factors including the size of the database, the amount of data currently stored
in the database, and the number of indexes that are defined for the fields on
the schema. Additionally, such modifications may require a great deal of disk
space in both the log and data segments.

During these operations, users may not be able to access the AR System server.
Clients may receive timeout messages; however, the operation the client is
performing at the time of the message will continue.

Note – We recommend that you do not modify production schemas while they
are in use.

To create a new field:
1. Open the schema (see “Opening Schemas” on page 122).

2. From the Schema menu, select a data type from the New Field cascading
menu. (See “Attributes Field Properties” on page 155 for more
information on data types.)

Note – You can only choose the data type for a new field; once you have made
your choice here, you cannot modify its data type. However, for selection and
integer fields, you can change their display types.

The new field appears at the upper-left corner of the Schema Window.

3. Double-click the new field to open the Field Properties dialog box. You
can also select the field, then choose Field Properties from the Schema
menu (Figure 7-1 on page 143).
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Figure 7-1 Field Properties Dialog Box (New Field)

4. Specify the field’s properties by filling in or modifying the values in the
Field Properties dialog box. (See “Field Properties” on page 146 for
information on the values you enter in the Field Properties dialog box.)

5. When you have finished setting up the new field, position it where you
want it on the schema using the mouse to drag it into position. (You can
specify more exact coordinates for the field using the display property
settings.) See “Arranging Field Layout” on page 178 for more information.

6. Click the Save button on the toolbar (or select Save Schema from the File
menu, or type Ctrl+S ) to save all changes to the schema.

7. When you have entered the appropriate values in the Field Properties
dialog box, you can double-click the Control menu to dismiss the dialog
box.

To modify a field:
1. Open the schema.

2. Double-click the field to open the Field Properties dialog box. You can
also select the field, then choose Field Properties from the Schema menu
(see Figure 7-1).

Keeps Field Properties
dialog box open if you



144 Action Request System Adminitrator’s Guide for Windows—December 1995

7

Note – You do not have to close the Field Properties dialog box to modify other
fields in the schema. The Field Properties dialog box displays the properties of
any field you select from the Schema Window. However, if you clear the Keep
Window Open check box, the Field Properties dialog box closes when you
select another field (see Figure 7-1 on page 143).

3. Make the appropriate modifications to the field’s properties by filling in
or modifying the values in the Field Properties dialog box. (Note that you
will not be able to modify the field data type.) For information on the
values that you can enter in the Field Properties dialog box, see “Field
Properties” on page 146.

4. Click the Save button on the toolbar to save the changes to the schema.

5. When you have modified the appropriate values in the Field Properties
dialog box, double-click the Control menu to dismiss the dialog box.

To restore field properties:
If you change your mind after performing modifications to a field’s properties
and have not saved the changes to the database, you can restore its properties
by selecting one or more fields and choosing Restore from the Edit menu.

• Before saving changes in the database to the field properties, choose Restore from
the Edit menu. The field’s original values are restored.

Note – You cannot use Restore to recover a field that you delete.

To delete a field:
1. Select one or more fields to delete. You cannot delete the core fields.

2. Choose Delete from the Edit menu. You also can select a field, then press
the Delete key. A delete field warning appears.

3. Click the Yes button if you are sure you want to delete the field. If you are
deleting multiple fields, click Yes To All. The field is removed from the
screen.
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4. Click the Save button on the toolbar (or select Save Schema from the File
menu, or type Ctrl+S ) to save your changes. A final warning message
appears, alerting you that the fields will be deleted from the database.

5. Click the OK button. The field is deleted and your changes are saved.

Note – Deleting a field deletes all the data associated with that field and frees
this space in the database. The operation is expensive in the sense that it may
take several minutes to complete. Your database may be unavailable for this
time so your users will be impacted while the delete is occurring (they will not
be able to access the server and may get time out messages). Accordingly, you
may want to perform deletes off-hours so that users will not be impacted.

To make a field non-operational:
If you don’t want to use a field but also don’t want to delete it, you can make
it non-operational by completing the following steps.

1. Open the schema.

2. Double-click the field to open the Field Properties dialog box. You can
also select the field, then choose Field Properties from the Schema menu.

3. Change the following properties:
• Click the Display tab and select the Hide Field check box.
• Click the Database tab and select Optional for the Entry Mode.
• Click the Attributes tab and delete any existing default information in the

Default Value field.
• Click the Permissions tab and click the Remove All button to clear all

selection choices (so that no group has access to the field).

4. Click the Save button on the toolbar to apply the changes to the database.
The field will no longer appear on any user’s view of the schema. The field
will not be hidden to current users of the schema until they re-open the
schema or log in again.

5. Double-click the Control menu to dismiss the Field Properties dialog box.
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To copy a field:
1. Open the schema and select the field you want to copy. (The field must

have the same data type as the field you want to create since you cannot
change the data type of an existing field.)

2. Choose Copy from the Edit menu (or type Ctrl+C ).

3. If necessary, open the schema that you want to copy the field to.

4. Choose Paste from the Edit menu (or type Ctrl+V ). The new field appears
on the schema. All settings for this field are the same as the original field
except for the field ID.

5. Double-click the new field to open the Field Properties dialog box. You
can also select the field, then choose Field Properties from the Schema
menu. Make the appropriate modifications to the field’s properties by
filling in or modifying the values in the Field Properties dialog box. (Note
that you will not be able to modify the field data type.) For information
on the values that you can enter in the Field Properties dialog box, see
“Field Properties” on page 146.

6. Position the field where you want it on the schema using the mouse to
drag it into position. (You can specify more exact coordinates for the field
using the display property settings.) See “Arranging Field Layout” on
page 178 for more information.

7. Click the Save button on the toolbar to add the new field to the schema.

8. After you have made all your changes to the field definition, double-click
its Control menu to dismiss the Field Properties dialog box.

Field Properties
You use the Field Properties dialog box (Figure 7-2 on page 147) to modify a
field’s properties. You display this dialog box for an existing field by double-
clicking the field or by selecting a field, then choosing Field Properties from the
Schema menu.
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Figure 7-2 Field Properties Dialog Box

Use the tabs in the Field Properties dialog box to change the following field
properties:

To create and modify fields in a schema view, see “Schema Views” on page 173.

Display Allows you to specify the display properties or how the field will
appear. Properties apply only to a particular schema view. For
example, in one schema view a field might be visible while in
another schema view, the field might be hidden or located
somewhere else on the schema.

Database Displays field ID and type and allows you to define field options in
the database. Settings apply to all schema views.

Attributes Allows you to define the attributes or parameters of the field
definition. Settings apply to all schema views.

Permissions Defines who can view and change individual fields of a schema.
Settings apply to all schema views.

Help Text Allows you to supply help text for the field. In most cases, this help
text is simply a description of the field and how it is used. Entries
apply to all schema views.

Change
History

Allows you to record information about the owner of a field, the
user who last modified it, and the date of the modification. You can
add additional change history information as well. Entries apply to
all schema views.
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The following information summarizes each of the settings in the Field
Properties dialog box and provides guidelines for filling in the values in each
field.

Note – The AR System lets you have multiple views of the same schema,
including whether a field hidden in one schema view is displayed in a different
schema view. Some field properties affect schema views while other field
properties do not. For more information, see “Schema Views” on page 173.

Display Field Properties
The following settings appear in the Field Properties dialog box when you
click the Display tab (see Figure 7-2 on page 147). Edit these display properties
as needed.

Table 7-1 Display Properties  (1 of 3)

Label In the Label field, enter a name for the field that will appear in
the currently selected view of the schema. Labels may be up to
30 characters long, including blanks. (However, do not include
trailing blanks as part of the label.) Users can personalize labels
later using the User Tool.
If you leave this field blank, the field will appear on the screen
with no label.
You may use single quotes in field labels; however, when
performing queries, users will need to enter two single quotes
when specifying the label. This is because field labels that
contain special characters must be enclosed in single quotes in
queries and a single quote in the label would otherwise be
interpreted as the end of the field label.
Note: You can use the same label for more than one field on a
schema. However, if duplicate field labels exist on a schema, the
AR System will issue a warning message any time you apply
changes to that schema. (You also can disable the warnings. See
“Warnings: Duplicate Field Names” on page 64.) If you create
fields with no labels or duplicate labels, those fields will appear
elsewhere in the Administrator Tool with their field IDs, for
example, in the Fields drop-down list in the Set Fields action of a
filter.
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Location The Location drop-down list lets you specify whether a field
label will appear above the field data segment or to the left of it
on the schema.
* Select Top to cause the label to appear above the data segment.
* Select Left to cause the label to appear to the left of the data
segment.

X/Y The X/Y fields in the Position/Size box let you determine where
the field is positioned on the schema. After dragging the field to
a general location using the mouse, you can use the X/Y fields to
specify a more exact location on the screen using X and Y
coordinates. If you have a series of fields on the same line, these
fields must have the same Y coordinate in order for tabbing
between fields to work as you would expect. (Tabbing works
from top-to-bottom, left-to-right.)

Width/Height The Width and Height read-only fields in the Position/Size box
shows you the pixel size of the field on the schema.

Length (Char) For text or numeric fields, you enter a display length in the
Position/Size box to determine how much room a field will
occupy on the screen. Display length often differs from the
setting of the maximum length allowed for data entered in the
field. If a user enters more characters than can be displayed, the
text will scroll off the end of the field, provided that the internal
field length is greater than the display length.
For more information about internal field and input lengths, see
“Database Field Properties” on page 150.

Rows For radio buttons, the number of rows in the Position/Size box
determines the number of horizontal rows used for the buttons.
A setting of 1 produces a single horizontal row. A setting of 2 or
more will divide the choices evenly into 2 or more horizontal
rows.
For text or numeric fields, the number of rows determines the
number of rows of text that are displayed.

Table 7-1 Display Properties  (2 of 3)
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Database Field Properties
The following settings appear in the Field Properties dialog box when you
click the Database tab (Figure 7-2 on page 147).

Data Type This read-only field in the Type box displays the kind of
information contained by the field, including the following:
* Character
* Date Time
* Diary
* Integer
* Real
* Selection
For information on these data types, see “Attributes Field
Properties” on page 155.

Display Type For Integer and Selection data types, the Display Type drop-
down list in the Type box lets you toggle between the following
choices:
* For Selection fields, you can choose either Drop-Down List or
Radio button display.
* For Integer fields, you can choose either Edit or Numeric
Spinner display.

Hide Field This check box allows you to specify whether the field will be
hidden or visible. Making a field hidden means the field will not
appear in the user’s view. (Users with Customize permissions
can make a hidden field visible.) A hidden field remains in the
database and may be used by filters, active links, or programs
that might access the field. You can also set administrator
defaults for hidden fields.

Table 7-1 Display Properties  (3 of 3)
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Figure 7-3 Database Properties



152 Action Request System Adminitrator’s Guide for Windows—December 1995

7

Edit the database properties listed in Table 7-2 as needed.

Table 7-2 Database Properties  (1 of 3)

Field Id Every field in a schema has an integer field ID that is unique on
that schema. If you leave the field ID blank or set it to zero when
you are defining a field, the AR System will assign a number
from the unrestricted number set. Restrictions on field ID
numbers are as follows:
* Numbers 1 – 99 are reserved for core fields. You cannot assign
an ID in this range unless you are creating a field that is
compatible with one of the core fields obsoleted as of the 1.2
release of the AR System. See Appendix C, for information on
these fields.
* Numbers 100 – 536870911 are reserved for fields registered to
Remedy Corporation. If you use an ID in this range, the field
definition should match the definition registered with Remedy
Corporation. You will receive a warning that the ID is in this
range and must acknowledge it before you can use the ID.
* Numbers 536870912 – 2147483647 are user defined. There are
no restrictions on assigning numbers in this range.
The field ID is used internally to identify the field throughout
the AR System. The field ID remains constant even if the field
label changes. You cannot modify the field ID after it is applied
to the database.
If you are creating multiple schemas and you are defining fields
that serve the same purpose on more than one schema, it is a
good idea to assign identical IDs to the identical fields in the
different schemas. This allows you to have a consistent meaning
for the ID across the schemas.

Data Type This read-only field displays the type of data contained in this
field:
* Character
* Date Time
* Diary
* Integer
* Real
* Selection
For information on these data types, see “Attributes Field
Properties” on page 155.
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Input Length For character fields, you can enter the maximum length of the
information the field can contain. You will get the most efficient
use of database storage if you set the maximum length of a
character field to be less than or equal to 255 characters. When
the field length is less than or equal to 255 characters, the
allocated storage is equal to the length of field contents. If you
set the maximum length to larger than 255 characters, storage is
allocated in blocks that average 1-2K characters (depending on
the database). A full block is allocated for the first character.
When that block is filled with the field contents, another full
block is allocated. Leaving the Length field blank or setting it to
0 (zero) specifies an unlimited length field. If the field length is
70 characters or more, the user will be able to open a Text Editor
window by selecting the text edit icon to the right of the field.
Remember that, for some databases, you cannot do searches on
fields over 255 characters. If you have questions about the
capabilities of your particular database, refer to your database
reference guides.
Note: When deciding on the length to specify for a field, you
should keep in mind that the maximum amount of data that will
be displayed is 100,000 characters on a UNIX platform and
32,000 characters on a PC or a Macintosh.

Entry Mode The Entry Mode drop-down list allows you to specify whether
the field will be required or optional. Making a field required
forces the user to fill in that field when they submit a new AR. If
a field is optional, each user is free to enter information in the
field or not, as suits their needs.
By default, a required field appears with a bold label to signify
its importance to the user. The core schema has three required
fields: Submitter, Short Description, and Status. You should only
make a field required if it must be filled in for every AR.
Note: You can also use filters and active links to require users to
enter information in a field under specified circumstances. See
the sample schemas for examples. For more information about
filters, see “Designing Filters” on page 84 and Chapter 10. For
more information about active links, see “Designing Active
Links” on page 92 and Chapter 12.

Table 7-2 Database Properties  (2 of 3)
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Index for FTS Lets you define whether to index the field for full text search (if
you are using the FTS option). For more information, see
“Defining a Field for FTS in the Field Properties Window” on
page 404.
If you are not licensed for FTS, this field does not appear.

QBE Match For character fields, you can specify how a match will be
determined when a user performs a query-by-example (QBE).
You can select any of the following values:
AnywhereA query will find a match if the value occurs
anywhere in the field. For example, if the user enters Bob in the
Submitter field, the query will return all ARs submitted by
Bobby Jones, Bob Smith, and Jill Bobbington.
LeadingA query will find a match only if the value occurs at the
beginning of the field entry. For example, if the user enters Bob
in the Submitter field, the query will return all ARs submitted by
Bob Smith and Bobby Jones, but not those submitted by Jill
Bobbington.
EqualA query will find a match only if the value entered in the
query matches the value in the field exactly. For example, to find
ARs submitted by Bob Smith, the user must enter Bob Smith ,
with exact spelling and capitalization, in the Submitter field.
Searches on fields where the QBE match type is Leading or
Equal will be faster than searches on fields where the match type
is Anywhere, especially if the field is indexed.
Note: Relational operators and wild cards will work during a
query-by-example regardless of the QBE Match setting. This
means that users will be able to specify an exact match in a field
with a QBE Match setting of “Anywhere” by using the equal
sign (=) relational operator.
Users will also be able to use the percent sign (%) wild card at
the beginning of the search string (%abcd) to override a QBE
Match setting of “Leading” or “Equal.” However, using the %
wild card at the end of a string (abcd%) does not override the
“Leading” or “Equal” setting.
Overriding the Leading or Equal QBE Match settings will also
override the performance benefits of using those settings.

Table 7-2 Database Properties  (3 of 3)
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Attributes Field Properties
The settings that appear in the Field Properties dialog box when you click the
Attributes tab (Figure 7-4) differ based on the data type of the field. The
Attributes tab lets you specify the kind of information that will be contained by
the field you created. Edit these properties as needed.

Figure 7-4 Character Data Type Attributes

Character Fields

Character fields accept strings of ASCII text (Figure 7-4). Character data types
are useful when there is significant variation in the field contents or length of
the content, for example, descriptive text, names of people, addresses, and
keywords. Long character fields (70 characters or longer) can display a a pop-
up text editing window for viewing and editing the field’s contents. This
allows you to conserve space on the users’ view of the schema because the
display length can be smaller than the input length attribute. A special icon
will appear to the right of any field for which it is possible to open a text
editing dialog box.

On UNIX platforms, a character field can hold up to 100,000 characters. On
PCs and Macintosh computers, a character field can hold up to 32,000
characters.
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Table 7-3 lists the meanings and use of attributes you can set for the character
data type.

Table 7-3 Attributes for Character Data Type Fields  (1 of 2)

Default Value By entering an appropriate value in this field, you can assign an
administrator default to any field on the schema. This value will
be assigned to the field any time the user submits a ticket where no
value has been assigned to the field.
You also can enter the field value that you want to appear when
users load default preferences into the Query or Submit windows
in their User Tool.
Note: Users can override any defaults you may have defined when
you set up the schema.

Pattern You can specify a pattern for the field contents. Specifying a
pattern restricts what the user can enter as the contents of a
character field.
There are two types of character patterns that you can specify. The
first type is a pattern similar to that used in the LIKE operator. This
type of pattern allows you to enter any character pattern you wish
to match. The pattern can include any of the wild card characters
that are allowed in the LIKE comparison operation (see “Table of
Operators” on page 444).
The second type of pattern is a keyword that specifies a style for a
character field. You can specify only one keyword for a pattern and
the pattern keyword cannot be combined with a pattern of
characters and wild cards:
$ALPHA$Value must be alphabetic characters (and blank space).
$ALNUM$Value must be alphabetic characters and digits (and blank
space).
$DIGIT$ Value must be digits.
$LOWER$Value may be any alphabetic character or digit (and blank
space) except uppercase letters.
$MENU$Value must match an item defined on the character menu
for the field.
$PRINT$Value must be printable characters.
$UPPER$Value may be any alphabetic character or digit (and blank
space) except lowercase letters.
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Date Time Fields

Date and time fields (Figure 7-5) are useful for information that is limited to
calendar dates and time. The format is in local (language) time formats, such as
12/21/95 13:14:21 and December 21, 1995 1:14:21 PM. Date and time fields can
play a significant role in providing metrics for your AR System
implementation. You can perform queries and statistical evaluations on Date
Time fields and use the results in a number of ways. For example, you can
design a macro that generates a statistics report of the average time required to
fix problems.

In the Default Value field, enter the field value, including keywords, that you
want to appear when users load default preferences into the Query or Submit
windows in their User Tool.

Name Lets you select a character menu to attach to the diary field.
A special menu icon appears to the right of any field with a
character menu. The character menu provides users with a fill-in
aid that can help standardize the text contents. Character menus
give all users a common vocabulary for description and can
therefore help improve the accuracy of queries made by the
support staff. Note that, unless you specify a pattern match in the
Pattern field (see “Pattern” on page 156), users are free to enter
their own text even when character menus are defined for the field.
See Chapter 9, for information on designing and creating a
character menu.

Append Items Lets you specify how text will be added to the field when a user
selects an item from a character menu.
* If you select Append Items, the menu text will be added to any
text already in the field.
* If you clear Append Items, the menu text will replace any text
already in the field.

Table 7-3 Attributes for Character Data Type Fields  (2 of 2)
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Figure 7-5 Date Time Data Type Attributes

Diary Fields

Diary fields (Figure 7-6 on page 159) are a special data type designed to
capture a history of the resolution of an AR. Diary fields are designed so that
each time an action is taken on an AR an entry to the diary field will be
appended to previous entries. A text editor allows flexible entry of each new
diary addition. A special icon will appear to the right of each diary field to
allow users to open the diary text editor dialog box.

Every diary entry is stamped by time and user name. Once entered, entries
cannot be modified.

You can add one or more diary fields as needed. You might, for example,
designate one diary as the public diary and design another diary that will be
seen only by support staff.

Different platforms can handle different sizes of character fields:

• On UNIX platforms, a diary field can hold up to 100,000 characters.

• On PCs, a diary field can hold up to 64,000 characters.

• On Macintosh computers, a diary field can hold up to 32,000 characters.
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In the Default Value field, enter the field value, including keywords, that you
want to appear when users load default preferences into the Query or Submit
windows in their User Tool.

Figure 7-6 Diary Data Type Attributes

Integer Fields

Integer fields (Figure 7-7 on page 160) accept integer values between -
2147483648 and 2147483647. You can limit the range for a particular field by
entering values in the Minimum and Maximum fields.

Note – You display the integer data type either as an edit field or as a numeric
spinner from the Display tab in the Field Properties dialog box.

You can use integer and real type fields to process statistical information. For
example, you might use them in conjunction with a time field to calculate the
cost of resolving certain types of problems.

For integer fields, you define a low and high limit specifying a range of values
by entering numbers in the Minimum and Maximum fields. During data
submission and modification, the user will be limited to entering values that
fall within the range you specify.
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In the Default Value field, enter the field value that you want to appear when
users load default preferences into the Query or Submit windows in their User
Tool.

Figure 7-7 Integer Data Type Attributes

Real Fields

Real fields (Figure 7-8 on page 161) accept and contain floating point numbers.
This type of field permits you to store more quantitative information in an AR.
You can limit the range for a particular field by entering values in the
Minimum and Maximum fields. You can also set a limit on the number of
decimal places that are displayed in the user’s view by specifying a value in
the Precision field. Values displayed with a precision setting are rounded off.
Note that the precision setting affects only the number that is displayed in the
user’s view; the actual value stored in the database is not changed.

For real fields, you define the following:

• Low and high limit specifying a range of values by entering numbers in the
Minimum and Maximum fields. During data submission and modification,
the user will be limited to entering values that fall within the range you
specify.

• Limit on the number of decimal places that are displayed in the user’s view
by entering a value in the Precision field. The number that is displayed is
rounded off. (The data stored in the database is unchanged.)
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In the Default Value field, enter the field value that you want to appear when
users load default preferences into the Query or Submit windows in their User
Tool.

Figure 7-8 Real Data Type Attributes

Selection Fields

Selection fields (see Figure 7-9 on page 163) offer a flexible method for
providing a small number of choices. The user cannot enter choices that are not
included in the definition of the selection list. (This is one distinction between
selection lists and character fields with menus.) You should use selection lists
only in cases where you do not expect the options available to users to change
over time.

Note – You specify the selection data type either as drop-down list or as a
radio button from the Display tab in the Field Properties dialog box.

Creating Selection Field Values

Follow these steps to create (or modify) the values available in a selection data
type field (a drop down list or radio button).
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Note – You should take great care when modifying selection value choices for
an existing database. If you change the order of existing selection field items,
the meaning of data previously entered in the database will be changed. For
example, in a Status field, if the current choices are New, Assigned , and Closed ,
and you add a choice labeled Fixed  before the Closed  selection, existing
database entries with a status of Closed  will now have a status of Fixed

instead. This is because the data for a selection field is stored in the database as
an integer that relates to the order of the choices.

To avoid confusion, do not add selection choices to an active schema other than
as the last choice of the selection field.

Altering the choices in a selection list often alters views and may require
modifications to the existing database. If it is necessary to add new choices to a
selection list, add them to the end of the list to avoid having to modify the
database

To create selection values:
1. From the Schema menu, create a selection field.

2. Double-click the field to open the Field Properties dialog box. The
Display properties appear under the Display tab.

3. Select either Drop-Down List or Radio Button from the Display Type
drop-down list.

4. Click the Attributes tab. The Field Properties dialog box appears as
shown in Figure 7-9 on page 163.
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Figure 7-9 Drop-Down List Selection Field Attributes

5. To modify a value, select the value in the Selection Values list, edit the
information in the Value field, then click the Modify button. To add a new
value, type the information in the Value field, then click the Add Before
or Add After buttons to add the value to the Selection Values list.
The Selection Values list box in the Field Properties dialog box shows
existing selection values. The order of values in the list box is the order in
which they will appear in the selection field. You use the Value field to
specify a new value or edit an existing one. The Add Before or Add After
buttons let you specify where a new value is inserted in the list box. Add
Before will add an item before the currently selected choice, while Add After
will add the item after the currently selected choice.

6. To delete a value, select the value in the Selection Values list, then click
the Delete button. (See the note in “Creating Selection Field Values” on
page 161 before adding or deleting choices in the middle of a selection
field on an existing schema.)
If you delete the default value, the first selection value in the list becomes
the new default.

7. In the Default Value field, enter the field value that you want to appear
when users load default preferences into the Query or Submit windows
in their User Tool.
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8. Click the Save button on the toolbar (or choose Save Schema from the File
menu, or type Ctrl+S ) to save your changes.

Defining Permissions for Fields
You click the Permissions tab in the Field Properties dialog box (Figure 7-10 on
page 166) to control who can view and change the contents of individual fields
of a schema. You can prevent some groups from accessing the field while
allowing full update permissions to other groups.

On the Field Properties dialog box, the groups listed under the Permissions tab
are the groups defined for the server. When you add a group to the Permission
list, you then select the appropriate view and change permissions. Pressing the
menu button pops up a menu that lets you pick the permissions for that group.

Note – Users who do not belong to a group that has permission to view a
schema’s Entry ID field (core field 1) will not be able to access any information
from that schema, regardless of how permissions are set on other fields.

If you do not add a group to the Permission list, members of the group will not
be able to view or change the field. (Keep in mind that users must be assigned
a valid fixed or floating license in order to be able to change a field’s content.)

You can also set permissions for the entire schema using the Permissions
schema property setting. See “Defining Permissions for the User Tool” on
page 132 for more information.

For more information on groups, permissions, and access control, see
Chapter 5.

* Clicking the View menu button gives a group view permissions only for
schema fields.

* Clicking the Change menu button gives a group both view and change
permissions for schema fields.
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Note – The Administrator Tool offers two different ways to set permissions for
fields. The first lets you set permissions as you create each field. For example,
when creating the field, you might give change access to a particular group in
the Field Properties dialog box. The second lets you assign permissions to one
or more fields for a given group. For example, if you decide that you want to
grant a particular group view access to the field, you can use the Group
Permissions window to set permissions for all fields at the same time. For more
information, see “Defining Group Permissions for Multiple Fields” on
page 169.

To define field permissions for schema fields:
1. From the Server Window, select Schemas from the Servers list. The

Schemas list appears in the Server Window.

2. From the Schemas list in the Server Window, open a schema by double-
clicking it. The Schema Window appears.

3. Select the field for which you want to define group permission by double-
clicking it. (Or choose Field Properties from the Schema menu.) The Field
Properties dialog box appears.

4. Click the Permissions tab to display the field permissions settings, as
shown in Figure 7-10. You use these settings to define field permissions
globally for each group defined for a server.
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Figure 7-10 Permissions in Field Properties Dialog Box

5. In the No Permission list, double-click the group for which you want to
define field permissions (or select a group, then click the Add button).
The group you selected appears in the Permission field. You can also do
the following:
• Click the Remove button to delete a group from the Permission list.
• Click the Add All button to add all the groups to the list.
• Click the Remove All button to delete all the groups from the list.
• Click the Set to Defaults button to reset the field to its default permissions

(for more information, see “Setting Default Field Permissions” on page 59).
Depending on the group you choose, you have different options in this
dialog box. Groups with a group type of View only allow you to select View
permissions for schema fields (for example, the Public group). However,
groups with a group type of Change allow you to select View and Change
permissions. (For more information, see “Group type” on page 107.)

6. Set the permissions for each field. If you do not click the Change menu
button, you allow users only to view the field data in the schema. Clicking
the Change button allows users to view and change the field data in the
schema.
In Figure 7-10 on page 166, the HD Staff and Sales Staff have only view
permissions for the field, but the CS Mgr and CS Staff groups have view and
change permissions.

Groups with
change
permissions

Groups with view
permissions only

Pressing menu
button lets you
choose either
View or Change
permissions
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7. Select the Allow Any User To Submit check box to allow any user to enter
a value into the field at submission time, regardless of permissions or
group membership. Clearing the check box restricts data entry to users
who belong to a group with explicit change permission for the field.
You use this check box in conjunction with the Group Permissions settings
to determine access control (security settings) for the field at the time an AR
is submitted. For more information, see “Defining Group Permissions for
Multiple Fields” on page 169.

8. Click the Save button on the toolbar (or choose Save Schema from the File
menu, or type Ctrl+S ) to save your changes.

Creating End-User Help Text for a Field
You can supply field help text for end-users of the User Tool in the Field
Properties dialog box. In most cases, this is simply a description of the field
and its uses. The text that you enter appears as context-sensitive help for end-
users when they choose Field/Schema Help from the Help menu or click the
Help button on the toolbar.

To define help text for a field:
1. From the Server Window, select Schemas from the Servers list. The

Schemas list appears in the Server Window.

2. From the Schemas list in the Server Window, open a schema by double-
clicking on it. The Schema Window appears.

3. Select the field for which you want to supply help text by double-clicking
it. The Field Properties dialog box appears.

4. Click the Help Text tab, as shown in Figure 7-11.
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Figure 7-11 Field Help Text

5. In the Help Text field, enter any information that you think will be
helpful to end-users of your field. You can use the shortcut key
sequencesstandard Windows keyboard shortcuts to edit text (for example,
Ctrl+C  to copy text, and so on).
However, you cannot use the Edit menu commands to edit text. Using the
Edit menu with the Field Properties dialog box open affects the field itself,
not the help text.

6. Click the Save button on the toolbar (or choose Save Schema from the File
menu, or type Ctrl+S ) to save all changes to your schema.

Building and Using Field Change History
The AR System lets you record information about the owner of a field, the user
who last modified the field, and the date of the modification. You can display
this information at any time by clicking the Change History tab.

To define change history for a field:
1. From the Server Window, select Schemas from the Servers list. The

Schemas list appears in the Server Window.

2. From the Schemas list in the Server Window, open a schema by double-
clicking on it. The Schema Window appears.
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3. Select the field for which you want to define change history by double-
clicking it. The Field Properties dialog box appears.

4. Click the Change History tab, as shown in Figure 7-12 on page 169.

Figure 7-12 Field Change History

5. In the New Description field, enter any information about modifications
to the field that you think will be helpful to other administrators or
subadministrators of the AR System.

Note – All previous change history is found in the read-only field above the
New Description field. After you enter and save change history, it cannot be
edited.

6. Click the Save button on the toolbar (or choose Save Schema from the File
menu, or type Ctrl+S ) to save all changes to your schema.

Defining Group Permissions for Multiple Fields
The Administrator Tool lets you do bulk assignments of field permissions for
all schemas within a server. For example, rather than going through each field
individually to assign permissions for a schema, the Group Permissions dialog
box lets you assign them all at once.

Enter
change history
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Read-only
description of
previous
change history
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Defining permissions for fields from the Group Permissions dialog box is
particularly useful when you have added a new access control group since the
fields were created. You use this dialog box to assign the new group access for
every field instead of having to open each field and modify the properties for
each field.

On the Group Permissions dialog box, the schemas and fields listed under the
Field Permissions tab are those defined for the server. When you add a field to
the Permission list, you then select the appropriate view and change levels.
Pressing the menu button pops up a menu that lets you pick the permissions
for that field.

Note – The Administrator Tool offers several different ways to set permissions.
For example, when creating a field, you might give access to the Public group.
However, if you decide that you want to deny the Public group access to fields,
you then can use the Group Permissions dialog box to set the group
permissions for all fields at the same time.

To define permissions for multiple fields in a schema:
1. In the Server Window, select a server, then double-click Groups to see a

list of groups defined on the server.

2. Double-click a group from the Groups list. The Group Permissions dialog
box appears (Figure 7-13). You use this dialog box to set group
permissions for schemas, fields, and active links.

3. Click the Field Permissions tab. You use this dialog box to set field
permissions globally for each group defined for a server.

Clicking the View menu button gives a group view permissions only for
schema fields.

Clicking the Change menu button gives a group both view and change
permissions for schema fields.
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Figure 7-13 Field Group Permissions Dialog Box

4. To assign a group permissions to a field, select a schema from the Schema
drop-down list. All the fields for that schema appear in the No
Permissions list.

5. Double-click the field for which you want to define permissions (or select
a field, then click the Add button). You can also do the following:
• Click the Add All button to give permissions for all the fields to the group.
• Click the Remove button to delete a field from the Permission list.
• Click the Remove All button to delete all the fields from the Permissions

list.
The field you selected appears in the Permission list.

6. Set the permissions for each field. If you do not click the Change menu
button, you allow users only to view the field data in the schema. Clicking
the Change menu button allows users to view and change the field data in
the schema.
In Figure 7-13 on page 171, the Bug ID and Dup of Bug # fields have view
and change permissions, but the Problem Area and Product fields have only
view permissions.
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7. Click the OK or Apply buttons to save your permissions.
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This chapter describes how to define and modify schema views. A schema
view is what the user sees when they bring up a schema. You can create
multiple schema views for your user community as needed.

You should be familiar with the information in Chapter 6 and Chapter 7 before
you perform the operations described in this chapter.

The following topics are covered in this chapter:

• Creating and modifying schema views.

• Arranging field layout, including:
• Moving fields.
• Using the grid.
• Aligning field segments to the grid.
• Aligning multiple fields and objects.
• Expanding the spacing between fields.

Schema Views
As an administrator, you can provide users with multiple views of the same
schema. For example, you might use the Administrator Tool to create a schema
with one view for Motif users and another for Windows users.
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Note – Administrators or subadministrators also can customize a view on the
User Tool, then export the view back to the server. The next time you open the
schema in the Administrator Tool, the customized view you created in the User
Tool now appears as one of the views you can select and modify in the
Administrator Tool.

Figure 8-1 Schema Window — Multiple Views

The Administrator Tool lets you create as many schema views as you need for
different users by doing the following:

• Rename the new view as appropriate. For example, for users of the
Windows User Tool, you could create a view and call it Windows View . You
cannot create multiple views with the same name. For more information, see
“To copy a schema view:” on page 176.

• Drag fields and buttons to different positions, if needed. You also may want
to hide certain fields. For more information, see “Using the Layout Menu to
Arrange Fields” on page 178.

Multiple
Schema Views
Available

Selected
“view”
displayed in
Schema
Window
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• Change the display properties for a field in each schema view as needed,
including:
• Label and label position.
• Display length.
• X and Y coordinates.
• Number of rows.
• Whether a field is visible or hidden.
For more information on the display properties of a field, see “Display Field
Properties” on page 148.

Note – For a particular schema view, you can only change the field’s display
properties. If you make changes to any other field properties, as in a field’s
attributes or database properties, these changes apply to all schema views. For
example, changing a field’s QBE match setting applies to all schema views.

To select and modify a schema view:
1. Open the schema whose view you want to select or modify.

2. From the Schema menu, display the View cascading menu (as shown in
Figure 8-1) and choose Select. The Select View dialog box appears
(Figure 8-2 on page 175).

Figure 8-2 Select View

3. Double-click the view that you want to display. Or choose one of the
views, then click the OK button. The view appears in the Schema
Window.

4. Modify the view as needed.
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5. When you are ready to save your changes, click the Save button on the
toolbar.

To copy a schema view:
1. Open the schema to display it (if it is not already displayed).

2. Choose View, then Copy from the Schema menu. The Copy View dialog
box appears (Figure 8-3).

Figure 8-3 Copy View

3. Select a view from the View Name list.

4. Enter a new name in the New View Name field, then click the OK button.
The new view (and its name) appear in the Schema Window.

5. When you are ready to save your changes, click the Save button on the
toolbar.

To select a default administrator view:
1. Open the schema to display it (if it is not already displayed).

2. From the View cascading menu, as shown in Figure 8-1 on page 174,
choose Set Default View. The Select Admin Default View dialog box
appears (Figure 8-4 on page 177).
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Figure 8-4 Select Admin Default View

3. Select the view that you want to appear when you open the schema in the
Administrator Tool, then click the OK button.

4. When you are ready to save your changes, click the Save button on the
toolbar.

To delete a schema view:
1. Open the schema to display it (if it is not already displayed).

2. From the View cascading menu, as shown in Figure 8-1 on page 174,
choose Delete. The Delete View dialog box appears (Figure 8-5).

Figure 8-5 Delete View

3. Select one or more views that you want to delete, then click the OK
button.
If preferences are enabled, a warning message appears, listing the name of
the views you want to delete. For more information, see “Defining
Preferences” on page 61.
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4. Click the Yes button if you are sure you want to delete the view. If you are
deleting multiple views, click Yes To All.
The view is removed from the Schema Window.

Note – You cannot delete all views for a schema. Each schema must have at
least one view.

5. When you have made all of the modifications you want to the different
schema views, click the Save button on the toolbar.

Arranging Field Layout
Depending on the needs of your user community, you can create multiple
views by doing the following in the Windows Administrator Tool:

• Move single or multiple fields or active link buttons.

• Enable and display the grid for precise field alignment, including:
• Defining the grid.
• Aligning field label and data entry segments (the part of the field where

you enter information) to the grid.

• Align multiple fields (either with the grid on or off).

Using the Layout Menu to Arrange Fields

You use the Layout menu from the Schema Window (Figure 8-6) to align fields.

Figure 8-6 Schema Window — Layout Menu

Toolbar buttons
available for
aligning objects
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The Layout menu provides the following options:

Align
Objects

Aligns one object according to the position of a control field (see “Aligning
Field Segments to the Grid” on page 184). Pull to the right (or use the
toolbar) to select from the following options:

* Left. Aligns the left edges of the field labels.

* Right. Aligns the right edges of the fields, including any
associated field menus, text edit, or diary icons.

* Value Left. Aligns the left edges of the data entry segment (the
part of the field where you enter information) of the fields.

* Value Right. Aligns the right edges of the data entry segment
(the part of the field where you enter information) of the fields.
* Center. Centers the fields over each other.
* Top. Aligns the top edges of fields, allowing you to place fields
side by side.

* Bottom. Aligns the bottom edges of fields, allowing you to
place fields side by side.

Align to GridDefines what segment of a field is aligned to grid when you select and
drag a field across the schema (see “Aligning Field Segments to the Grid”
on page 184). Pull to the right to select from the following options:
* None. Grid is turned off.
* Left. Aligns the left edges of the field labels to the grid.
* Value Left. Aligns the left edges of the data entry segment of the fields to
the grid.
* Right. Aligns the right edges of the fields, including any associated field
icons, to the grid.
* Value Right. Aligns the right edges of the data entry segment of the
fields to the grid.
A check mark next to the menu selection shows which option is activated.

Expand Proportionally increase or decrease the distance between all fields and
buttons on the schema. The Expand Control Spacing dialog box appears so
you can specify a percentage of the current spacing, horizontally,
vertically, or both. Enter percentages greater than 100 to move the fields
farther apart. Enter percentages less than 100 to pull the fields closer
together.

Show Grid Show the grid. A check mark next to the menu selection means
the grid is displayed.
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Moving Fields

You can change the physical layout of a schema by dragging fields to
reposition them, as shown in Figure 8-7 on page 181. Dragging a field past the
bottom (or top) of the visible window moves the field onto the next (or
previous) schema page.

For greater precision in locating fields on a schema, you also can align single or
multiple fields to a grid. For more information on using the grid, see “Using
the Grid” on page 182.

To move a field:
1. Open the schema to display it (if it is not already displayed).

2. Select the field by clicking on it.

3. Drag the field to its new position, as shown in Figure 8-7 on page 181.

Grid Size Specifies the distance between lines in the grid. The Set Grid Size dialog
box appears to enter a width and height in pixels.

Select All Selects all fields in the Schema Window, letting you reposition all the fields
on the schema at one time.
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Figure 8-7 Rearranging a Field on a Schema

When you move a field, it redisplays to show its field length and its data
entry segments (as shown in Figure 8-12 on page 185).

4. You can continue modifying the schema by moving other fields, adding
new fields, or aligning fields to the grid.

5. When you are ready to save your changes, click the Save button on the
toolbar.

To move multiple fields:
1. Open the schema to display it (if it is not already displayed).

2. Use your mouse to select multiple fields or active link buttons that you
want to move, as shown in Figure 8-8 on page 182.
• “Rubberband” (or region select) a number of fields to select and move

them as a single object.
• Hold down the Shift key and click with the left mouse button to select or

clear other fields.
Click anywhere else in the Schema window to clear the selections.

Select the
field and drag
it to a new
location.
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Figure 8-8 Rearranging Multiple Fields on a Schema

3. Drag the fields to their new position, as shown in Figure 8-12 on page 185.
When you move fields, they redisplay to show their field length and their
data entry segments.

4. You can continue modifying the view by moving other fields or aligning
fields to the grid.

5. When you are ready to save your changes, click the Save button on the
toolbar.

Using the Grid

The grid is particularly useful in creating schema views. You can use a grid for
precise alignment of schema fields along a network of lines, either visible or
invisible.

Note – You can override the grid by specifying X and Y coordinates in the
Field Property window. If your Align to Grid is set, setting X and Y field
coordinates overrides it. For more information, see “Field Properties” on
page 146.

Use your mouse to draw a
rubberband around fields that
you want to move, then drag
fields to their new location.
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To enable and display the grid:
1. Open the schema to display it (if it is not already displayed).

2. From the Layout menu, display the Align to Grid cascading menu and
choose one of the grid options (see Figure 8-6 on page 178).
The grid becomes activated. The check mark next to the menu selection
indicates which grid option is turned on. Any fields or objects that you
move will “snap” to the grid. For more information, see Using the Layout
Menu to Arrange Fields on page -178.

3. Click the Show Grid button on the toolbar. Or choose Show Grid from the
Layout menu. The grid appears on the schema (Figure 8-9).

Figure 8-9 Displaying the Grid on a Schema

To define grid size:
1. Open the schema to display it (if it is not already displayed).

2. Click the Show Grid button on the toolbar.

3. From the Layout menu, choose Grid Size. The Set Grid Size dialog box
appears (Figure 8-10 on page 184).

Grid displayed
in schema
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Figure 8-10 Set Grid Size

4. In the Width and Height fields, enter the pixel size of the grid. The
smaller the number of pixels, the smaller the grid and the more precisely
you can align your fields.

5. Click the OK button. The grid reappears according to your new settings.

Aligning Field Segments to the Grid

From the Layout menu, you also can specify what segment of the field will be
aligned to the grid when you move the field (Figure 8-11). You can align the
entire field to the grid, including its label and icon segments, or just the data
entry segment of the field.

Figure 8-11 Field Segments That You Can Align to the Grid

For further information on using various grid options, see “Using the Layout
Menu to Arrange Fields” on page 178.

To align fields to the grid:
1. Open the schema to display it (if it is not already displayed).

2. Enable, display, or expand the grid as needed.

3. Choose Align to Grid options from the Layout menu or from the toolbar.
The check mark next to the menu selection indicates which align-to-grid
option is turned on.

Field Label Segment Data Entry Segment Menu or Icon
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• If you select Left, the fields would align to their left edges on the grid.
• If you select Value Left, the fields would align to the left edges of their

data entry segment on the grid.
• If you select Right, the fields would align to their right edges on the grid,

including any associated field icons.
• If you select Value Right, the fields would align to the right edges of their

data entry segment on the grid.

4. Select and drag the fields to where you want them aligned.
When you move a field, it redisplays to show its field length and its data
entry segments (Figure 8-12).

Figure 8-12 Using Align To Grid for Field Label and Data Segments

For example, if you selected Value Right from the Align to Grid menu and
then moved the Short Description field, the right edge of the data entry
segment of the field would align itself to the grid (as shown in Figure 8-12).

5. When you are ready to save your changes, click the Save button on the
toolbar.

Aligning value right aligns the right edge of
data entry segment of the field to grid.

With grid
on, fields
that you
move
redisplay to
show their
field label
and their
data entry
segments.
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Aligning Multiple Fields and Objects

You can use the Align Object options to align multiple fields according to the
position of another object on the schema, either with or without the grid. You
also can expand the spacing between fields in the schema.

For information, see “Using the Layout Menu to Arrange Fields” on page 178.

To align multiple objects:
1. Open the schema to display it (if it is not already displayed).

2. Enable, display, or expand the grid as needed.

3. Use your mouse to rubberband the fields that you want to align. (For more
information on selecting multiple fields, see “Using the Layout Menu to
Arrange Fields” on page 178.)
When you select multiple fields or active link buttons, the Align Objects
buttons on the toolbar and menu items are activated. Also, one of the objects
becomes the control object. The control object has dark control handles in
the corners and sides.
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Figure 8-13 Aligning Multiple Fields/Objects (with Grid Displayed)

For example, in Figure 8-13, an active link labeled Test Button  is the
control object. The position of the control object defines how the other
objects are aligned. The other fields with white control handles will be
aligned according to the position of the control object.

4. Select a control field or active link button by clicking it.

5. Use the Align to Grid options from Layout menu to define what segment
of the fields that you want aligned on the grid.

6. Select and drag the fields to where you want them aligned.
You can use the Align Object choices from the toolbar or the Layout menu to
align the fields for you. Remember that multiple fields are aligned according
to the position of the control field. For example, if you select Left from the
Align Objects menu, the Status  and Short-Description  fields would align
to the left edge of the Test Button object on the grid, as shown in
Figure 8-14 on page 188.

Fields with white
control handles

Control object with
dark control handles
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Figure 8-14 Aligning Multiple Fields to the Grid

7. When you are ready to save your changes, click the Save button on the
toolbar.

To expand the spacing between fields:
1. Open the schema to display it (if it is not already displayed).

2. From the Layout menu, choose Expand.

3. The Expand Control Spacing dialog box appears (Figure 8-15 on page 189).

Aligning Left aligns fields on their left edges to
the grid, according to position of the control
object.
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Figure 8-15 Expand Control Spacing

4. In the Horizontal and Vertical Expansion fields, enter the percentages for
spacing the fields. Numbers less than 100% decrease the distance between
fields and numbers greater than 100% increase the distance between
fields.

5. Click the OK button. The fields reappear according to your new settings.

Note – When you open the Expand Control Spacing dialog box, the horizontal
and vertical percentages always appear as 100%, even after you increase or
decrease the spacing between fields.
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Defining Menus 9

This chapter describes how to create and modify menus. Once you create a
menu, you can attach the menu to any character field on any schema on the
server. You can use the same menu for as many different fields as you desire.

You should be familiar with the information in Chapter 6 and Chapter 7 before
you attempt to design and create a character menu.

The following topics are covered in this chapter:

• Using the Menu window.

• Creating and modifying menus.

• Defining character menus.

• Defining menus that use a file.

• Defining menus that query a schema.

• Building and using menu change history.

• Setting help for menus.

Using Menus in Schemas
You can create a menu and attach it to any character-type data field. A
cascading menu with two levels is shown in Figure 9-1 on page 192.



192 Action Request System Adminitrator’s Guide for Windows—December 1995

9

Figure 9-1 Cascading Menu

It is possible to define up to 14 menu levels, though you will probably want to
limit most menus to three levels or less. You define character menus using a
Create (or Modify) Menu window that appears when you click the New Object
button on the toolbar and then double-click Menu on the New Object list.

Using the Menu Window
You create and modify menus from within the Menu window, as shown in
Figure 9-2 on page 193.
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Figure 9-2 Menu Window

You can open multiple windows for creating or modifying menus.

You use the tabs in the Create Menu window to define the following:

Menu Styles

There are three styles of menus that you can define:

Menu
Definition

Defines the basic properties of the menu, including refresh mode and
menu type.

Change
History

Allows you to record information about the owner of a menu, the
user who last modified it, and the date of the modification. You can
add additional change history information as well.

Help Text Shows the Help Text editing window. You can supply help text for the
menu here. In most cases, this help text is simply a description of the
menu, what it does, and how it is used.

Character You use the fields in the menu editing window to define the menu as
a series of label and value entries.
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Creating and Modifying Menus
Follow these steps to create a new menu or to open, copy, or delete an existing
menu.

Note – The maximum number of items that can be displayed in a menu is 1600
for Motif clients, 1729 for Windows and Macintosh
clients.

To create a menu:
1. In the Server Window, choose a server to administer.

2. Click the New Object button on the toolbar. Or select New Object from
the File menu. The New Object dialog box appears (Figure 9-3).

Figure 9-3 New Object Dialog Box

File You specify a file, located on either the client or the server, that
contains a formatted character menu. You can update this file at any
time; the changes will take effect the next time the menu is refreshed.

Query You specify a query, with any conditions, on an AR System schema.
You specify which field of matching entries to use as the label and
which to use as the value. When a user accesses the menu, the AR
System performs the query and places all items retrieved on the
menu. This method allows you to create a dynamic menu that updates
based on current conditions. In addition, because permissions are
checked at the time of the query, users will only be able to see items to
which they have permission.
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3. Select Menu from the New Object list, then click the OK button. The
Menu window that you use for creating menus appears (Figure 9-4).

Figure 9-4 Create Menu Window

4. Enter a name in the Menu Name field. Menu names must be unique on
each AR server. There is no enforced convention for specifying menu
names, but it is helpful to make the name descriptive and indicative of
the menu’s function. Names may be up to 30 characters, including blanks.

5. Select a refresh mode for the menu by choosing one of the following
options:

On
Connect

Menu is retrieved when the user first opens it after selecting the
schema. It will not be updated until the user selects the schema again.

On
Open

Menu is retrieved each time the user opens the menu. (Note that
frequent menu retrieval can have an impact on performance. You
should select this option only if it is critical that the menu be
absolutely up-to-date.)

On
15 Minute
Interval

Menu is retrieved when the user opens the menu and after it has not
been retrieved in the last 15 minutes. This choice provides a balance
between the need to be current and the expense of constant menu
retrieval.
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Note – Refresh modes affect only a menu’s contents, not its definition and work
somewhat differently based upon the style of menu. The definitions of all
menus are updated every time you
re-connect to a schema. But the refresh modes which affect a menu’s contents
work somewhat differently for character menus than for file and query menus.

Note – For example, you cannot dynamically update the contents of a character
menu, no matter which refresh mode you select. Connect, Open, and 15 Minute
Interval all act the same way for character menus. The only way a character
menu is updated is when you re-connect to a schema.

Note – If you select Open or 15 Minute Interval, the contents of file and query
menus are dynamically updated. However, if you select Connect, their contents
are updated only when you re-connect to a schema, just like character menus.

6. Select a menu type for the menu by choosing the Character, File, or Query
option. The remaining fields in the dialog box will change according to
the menu type you select.
For more information, see “Menu Styles” on page 193.

7. Fill in the rest of the fields in the dialog box as appropriate for the menu
type you have selected by following the applicable set of instructions
found later in this chapter:
• To define a character menu, see “Defining Character Menus” on page 200.
• To define a file menu, see “Defining File Menus” on page 202.
• To define a query menu that queries a schema, see “Defining Query

Menus” on page 204.

8. Click the Help Text tab to create help text for the menu. (See “Setting
Help for Menus” on page 208 for more information.)

9. Click the Change History tab if you want to enter a note describing the
menu you are creating. The Change History lets you keep a log of
modifications made to a menu over time. (See “Building and Using Menu
Change History” on page 207 for more information.)
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10. When you are ready to save your menu, click the Save button on the
toolbar (or choose Save Menu from the File menu, or type Ctrl+S ). The
new menu appears in the menu list on the Server Window.

Opening Menus

Follow these steps to open and modify an existing menu.

Note – You can open as many menus as you want but you cannot open the
same menu twice.

To open a menu:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click Menus to see a list of menus currently defined on the server.

4. Select a menu from the Menus list, then double-click the menu to open it.
The menu appears in the Modify Menu window (Figure 9-5 on page 198).
You now can modify the menu as needed.
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Figure 9-5 Modify Menu Window

Saving Menus Under a Different Name

When saving a menu under a different name, the new menu contains all the
properties of the original menu. The only difference is the name.

To save a menu under a different name:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click Menus to see a list of menus currently defined on the server.

4. From the Menus list, open the menu that you want to copy.

5. From the File menu, choose Save Menu As. The Save Menu As dialog box
appears (Figure 9-6 on page 199).
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Figure 9-6 Save Menu As Dialog Box

6. In the Menu Name field, enter the new name of the menu.

7. Click the OK button to make a copy of the menu. The new menu will
appear in the Menus list.
Double-click the menu to open it. You now can modify the menu as needed.

Deleting Menus

The delete operation is permanent and cannot be undone. Make sure you no
longer need a menu before deleting it. You cannot delete any menu that is
currently open in the Administrator Tool.

To delete a menu:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click Menus to see a list of menus currently defined on the server.

4. From the Menus list, select the menu that you want to delete.

5. From the Edit menu, choose Delete - Menu.
A confirmation message appears (if your preferences are set for this). Click
the OK button to delete the menu. For more information, see “Defining
Preferences” on page 61.
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Defining Character Menus
When creating a character menu, it is a good idea to plan out ahead of time
what parent and child menus you want in your menu structure, as in the
following example:

To define a character menu:
1. Create a menu, edit the menu name, and select a Refresh mode (see

“Using Menus in Schemas” on page 191).

2. Select the Character option from the Menu Type box. The Modify Menu
window changes to let you define a character menu (Figure 9-7 on
page 201).

3. Select the New Item button to create a menu item for whichever level you
choose. For example, in a new menu, selecting the New Item button
creates a first-level menu. But if you create and select a child menu,
selecting the New Item button creates a menu entry for that same level.

4. Enter a label into the Label field (the text that will show up in the menu).
Enter a maximum of 30 characters.

AR System

Escalations
Filters
Schemas
Menus

Character
File
Query

First-Level Menu
(parent)

2nd Level Sub-menus
(child)

3rd Level Sub-Menus
(child)
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Figure 9-7 Character Menu Window (with Parent and Child Menus)

5. If the value that you want to appear when the user selects this menu item
differs from the label text, enter the text you want to appear in the Value
field. Enter a maximum of 255 characters. You can only supply a value for
menu items that are selectable. For example, if a parent menu has a child
menu item, you can only provide a value for the child item since you
cannot select the parent menu.
If you do not enter different text, the label text (of the lowest menu level
only) is selected when the user selects the item.

6. To create second-level (or child) menus, select the first-level menu for
which you want sub-menus, then select the New Child button. For
example, for all the Computer child menus, you would select Computer ,
then you would add Sun, HP, and so on.

7. To create third-level (or child) menus, select the second-level menu for
which you want sub-menus, then select the New Child button. For
example, for all the PC child menus, you would select PC, then you could
add 486 , Pentium , and so on.

Plus signs indicate
that child menus are
hidden. Open the
child menus by
double-clicking the
plus sign. Note that a
child menu can have
its own child menus.

Minus signs indicate
that child menus are
displayed. Hide the
child menus by
double-clicking
the minus sign.
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8. Repeat steps 3 through 7 for as many items as are needed at that menu
level.

9. Click the up or down arrows to move menu entries along the menu
structure, as in the following examples.
• Re-arrange parent menus. For example, you could move Computer down

and Hub up. (If you just want to re-arrange parent menus, hide the child
menus first by double-clicking on them.)

• Re-arrange child menus. For example, under the Computer first-level
menu, you could move PC up or move Sun down.

• Move a child menu to become a parent menu. For example, if you selected
Sun and clicked the up arrow, Sun would become a first-level menu (its
sub-menus now become second-level menus).

• Move a parent menu and its child menus move with it. In
Figure 9-7 on page 201, if you selected Hub and clicked the up arrow, Hub

(and its children) become the child menus of Computer .
• Use the Edit menu to cut, copy, paste, or delete menu entries as well.

Note – Moving parent and child menu items around the menu structure is
good practice to learn the subtleties of menu design in the Administrator Tool.

10. To save the menu definition, click the Save button on the toolbar.

Defining File Menus

To define a menu that uses a file:
1. Create a menu, edit the menu name, and select a Refresh mode (see

“Using Menus in Schemas” on page 191).

2. Select the File option from the Menu Type box. The Modify Menu
window changes to let you define a file menu (Figure 9-8 on page 203).
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Figure 9-8 File Menu Window

3. Select a File Location option to indicate where the file is located:
• Select Server if the file is on the server system.
• Select Client if the file is on the system where the client is running.

4. In the Filename field, enter the name of the file that contains the menu
definition. See the next section, “Menu File Format, for information on
how this file is structured.

5. To save the menu definition, click the Save button on the toolbar.

Menu File Format

A menu file is a file that contains a formatted menu structure. Each line in the
file contains a definition of a menu entry in the format:

label\value

To create cascading sub-menu items under a specific item, use tabs to indicate
a child menu. (You can omit the value specification for any label that has sub-
items.)
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Note – You must use the tab key, not spaces, to indicate child menus.

The following example shows a formatted menu file with three main items,
two of which have sub-items:

You can use a # sign in the first column to comment out lines in the menu file.

Defining Query Menus

To define a menu that uses a query:
1. Create a menu, edit the menu name, and select a refresh mode according

to the previous instructions.

2. Select the Query option from the Menu Type box. The Modify Menu
window changes to let you define a query menu (Figure 9-9 on page 205).

OpenWindows\
2.0\OpenWindows 2.0
3.0\Openwindows 3.0

Motif\Motif 1.1
MS Windows\

3.0\Windows 3.0
3.1\Windows 3.1
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Figure 9-9 Query Menu Window

3. From the Server drop-down list, select the server where the schema that
you are querying resides.

4. From the Schema drop-down list, select the schema that you want to
query.

5. From the Label Field drop-down list, select a field on the schema you are
querying. The contents of this field will be used as a label for the menu
items you are creating.

6. From the Value Field drop-down list, select a field on the schema you are
querying. The contents of this field will be used as the value for the menu
items you are creating.

7. Select the Sort On Label option if you want the menu values sorted by
their label.

8. From the Qualification drop-down list, build a qualification that will
determine which items from the schema you are querying will be
included in the menu list. The Qualification drop-down list contains a list
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of keywords and functions for you to use. Select as many as needed to
build your qualification. It is a good idea to make the qualification as
specific as possible to avoid building a list with an unmanageable number
of items.
You can refer to current screen values by using $<field_id>$, for example, as
in the following qualification:

'Problem Summary' = $8$

Note – If you refer to a field on the current screen in the qualification, do not
use the pattern $MENU$ for any field that the menu is attached to. The server
cannot resolve the field references so the value will always be rejected.

9. To save the menu definition, click the Save button on the toolbar.

For example, you could build a menu that brings up the names of everyone
with an open request to the help desk. To do so, you would select the server
and schema that contain the information, in this case perhaps AR-Help Desk
Tickets. You would then select the Submitter field as both the Label and Value.
Finally, you would build a qualification that would search for tickets with a
Status of Open, as shown in Figure 9-10 on page 207.
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Figure 9-10 Query Menu with Qualification for Open Tickets

Once you have created the menu, you can attach it to any field on any schema.
You might use the menu created in this example as an aid to performing
queries on a particular caller’s open tickets on the AR-Help Desk Calls schema.

Building and Using Menu Change History
The AR System lets you record information about the owner of a a menu, the
user who last modified the menu, and the date of the modification. You can
display this information at any time by selecting the Change History tab.

To define change history for a menu:
1. From the Server Window, select Menu from the Servers list. The Menus

list appears in the Server Window.

2. From the Menus list in the Server Window, open a menu by double-
clicking on it. The Modify Menu window appears.

3. Click the Change History tab, as shown in Figure 9-11 on page 208.
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Figure 9-11 Menu Change History

4. In the New Description field, enter any information about modifications
to the menu that you think will be helpful to other administrators or
subadministrators of the AR System.

Note – All previous change history is found in the read-only field above the
New Description field. After you enter and save change history, it cannot be
edited.

5. Click the Save button on the toolbar (or choose Save Menu from the File
menu, or type Ctrl+S ) to save your changes.

Setting Help for Menus
Clicking the Help Text tab in the Menu window brings up a Menu Help Text
editing window. You can supply help text for the selected menu here. In most
cases, this help text is simply a description of the menu and what it is used for.
It is available for viewing and editing by AR administrators who have the
menu open.

Enter
change history
here

Read-only
description of
previous
change history
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To define help text for a menu:
1. From the Server Window, select Menu from the Servers list. The Menus

list appears in the Server Window.

2. From the Menus list in the Server Window, open a menu by double-
clicking on it. The Modify Menu window appears.

3. Click the Help Text tab, as shown in Figure 9-12.

Figure 9-12 Menu Help Text

4. In the Help Text field, enter any information that you think will be
helpful to AR System administrators or subadministrators. You can use
the shortcut key sequences
standard Windows keyboard shortcuts to edit text (for example, Ctrl+C  to
copy text, and so on).

5. Click the Save button on the toolbar (or choose Save Menu from the File
menu, or type Ctrl+S ) to save your changes.
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Defining Filters 10

This chapter describes how to use the Admin Tool to create and modify filters.
A filter is a facility that tests every server transaction to see if certain
conditions are met and responds to the conditions by taking a specific action or
actions.

For example, you might define a filter that notifies support staff members
when they are assigned responsibility for a new AR.

For a detailed discussion about filter design, refer to “Designing Filters” on
page 84.

The following topics are covered in this chapter:

• Using the Filter window.

• Creating and modifying filters.

• Specifying filter conditions.

• Building filter qualifications.

• Specifying filter actions.

• Building and using filter change history.

• Setting help for a filter.
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Using the Filter Window
You create and modify filters from within the Filter window, as shown in
Figure 10-1.

Figure 10-1 Filter Window

You can open multiple windows for creating or modifying the filters that you
have permission to administer.

Filters execute on the server machine. Each filter is attached to a single schema
on the server.

You use the tabs in the Filter window to define the following:

Basic Defines the basic properties of the filter and the conditions that will
cause the filter to execute. For example, the condition may be that the
user submits an AR.
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Creating and Modifying Filters
Follow these steps to create a new filter or to open, copy, or delete an existing
filter.

To create a filter:
1. In the Server Window, choose a server to administer.

2. Click the New Object button on the toolbar. Or choose New Object from
the File menu. The New Object dialog box appears (Figure 10-2).

Figure 10-2 New Object Dialog Box

3. Select Filter from the New Object list, then click the OK button.
The Filter window that you use for creating filters appears (see Figure 10-1
on page 212). For a new filter, the fields are empty.

4. Specify or change filter specifications and conditions according to the
steps described in “Specifying Filter Basics” on page 215.

5. Specify or change filter actions according to the steps described in
“Building Qualifications” on page 218.

Actions Defines the actions the filter will take when specified conditions are
met. For example, a filter condition may be to look for “hardware” in
the Problem Type field. The filter action may be to automatically
delegate the AR to the hardware support person.

Change
History

Allows you to record information about the owner of a filter, the user
who last modified it, and the date of the modification. You can add
additional change history information as well.

Help Text Shows the Help Text editing window. You can supply help text for the
filter here. In most cases, this help text is simply a description of the
filter, what it does, and how it is used.
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Opening Filters

Follow these steps to open and modify a filter.

Note – You can open as many filters as you want but you cannot open the
same filter twice.

To open a filter:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click Filters to see a list of filters currently defined on the server.

4. Select a filter from the Filters list, then double-click the filter to open it.
The filter appears in the Modify Filter window (see Figure 10-1 on
page 212). You now can modify the filter as needed.

Saving Filters Under a Different Name

When saving a filter under a different name, the new filter contains all the
properties of the original filter. The only difference is the name.

To save a filter under a different name:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click Filters to see a list of filters currently defined on the server.

4. From the Filters list, open the filter that you want to copy.

5. From the File menu, choose Save Filter As. The Save Filter As dialog box
appears (Figure 10-3 on page 215).
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Figure 10-3 Save Filter As Dialog Box

6. In the Filter Name field, enter the new name of the filter.

7. Click the OK button to make a copy of the filter. The new filter will
appear in the Filters list.
Double-click the filter to open it.

Deleting Filters

The delete operation is permanent and cannot be undone. Make sure you no
longer need a filter before deleting it. You cannot delete any filter that is
currently open.

To delete a filter:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click Filters to see a list of filters currently defined on the server.

4. From the Filters list, select the filter that you want to delete.

5. From the Edit menu, choose Delete - Filter.
A confirmation message appears (if your preferences are set for this). Click
the OK button to delete the filter. For more information, see “Defining
Preferences” on page 61.

Specifying Filter Basics
This section describes how you use the Filter window to specify filter
specifications and conditions, as shown in Figure 10-4. The filter basics define
the criteria that a transaction must meet before the corresponding filter actions
take place. You specify basics including:
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• Name of the filter.

• Whether the filter is enabled or not.

• The order in which the filter will execute in relation to other filters.

• The schema that the filter is to be applied to.

• The operations that will invoke the filter.

• The specific qualifications that limit the transactions on which the filter will
execute.

Figure 10-4 Specifying Filter Basics

To specify or change filter conditions:
1. Open the filter you want to work with (see the previous section).
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2. If the correct name is not already assigned to the filter, specify the filter
name in the Name field.
Filter names may be up to 30 characters, including blanks, and must be
unique. There is no enforced convention for filter names, but it is helpful if
the name is descriptive and indicative of the filter’s function.

3. Select or clear the Enable check box to set whether you want to activate
the filter. For example, you may want to disable the filter during
development or if you are diagnosing a problem.

4. Specify the filter execution order.
More than one filter may be designed to execute based on the same set of
conditions with the output from one filter affecting another. The Execution
Order field lets you specify the processing order for each filter. Valid values
for Execution Order are numbers between 0 and 1000 inclusive. Filters with
lower numbers are processed first. After a filter is completely processed, the
filter with the next lowest number is then executed. This assures that the
condition check for subsequent filters will be affected by actions of previous
filters. You can assign the same number to multiple filters; however, there is
no guarantee about the processing order for filters that have the same
execution order.

5. In the Schema Name drop-down list, select the name of the schema the
filter will apply to.

6. In the Execute On box, specify which operations will activate the filter by
selecting one or more of the options, as follows:

You can select any combination of operations. If you select multiple options,
the filter will act when any one of the operations takes place.

7. You can further refine your filter selection criteria by entering a
qualification statement in the Run If field. You can specify whether the
qualification is to check conditions for the current transaction only, in the
database only, or both in the current transaction and the database. You can

Submit Filter will act when an AR is submitted.
Modify Filter will act when an AR is modified.
Delete Filter will act when an AR is deleted.
Query Filter will act when an AR is retrieved. You cannot use the Query

option to perform the Set Fields action.
Merge Filter will act when an AR is merged into the database from a different

database. (You can merge ARs using the AR Import Tool, as described
in Chapter 14. You cannot merge ARs through the User Tool.)
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enter the text directly, by typing it in, or build the qualification using the
query bar palette and Run If field menu button, as described in
Appendix D, “Operators, Wildcards, and Keywords.”

8. When you have finished specifying filter basic conditions and
qualifications, go on to specify the filter actions.

Building Qualifications
Qualifications help to narrow down the entries that will cause a filter (or an
active link or an escalation) to execute. As shown in Figure 10-5, you can define
qualification criteria using any of the following techniques:

• Type information directly into the Run If field.

• Add a field or keyword from the cascading menu button.

• Add an operator to a qualification from the palette.

Figure 10-5 Building a Qualification in a Filter Window

Add
operators
by
selecting
from the
palette.

Use the cascading menu button to add
a field name or keyword to a
qualification.
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You must follow a set of formatting conventions when you construct the
qualification criteria in the Run If field. The formatting conventions are
described below.

You will also use a set of operators and wild card symbols that have specific
meaning to the AR System. You can concatenate a qualification string using
keywords, operators, and wild cards, as in the following query:

'Login Name' LIKE ("%" + $Submitter$ + "%")

The operators, wild card symbols, and keywords are described in Appendix D.

Formatting Conventions

Use the following formatting conventions to construct qualification criteria in
the Run If field:

Note – If the label includes a single quote, specify two single quotes when
entering the label. For example, if the field name is Doug's Tickets , enter it as
'Doug' 's Tickets' . (This is done automatically when you select the field
from the Fields menu button.)

Fields Enclose field labels in single quotations. Single quotations are
automatically added when you select fields from the menu button list.
Example: 'Short Description'
If two fields have the same label, the menu button displays their field ID.
You can also reference fields by using their internal field ID. If you use the
ID, you must enclose it in single quotations.
For filters, you can specify whether the qualification is to check field
values in the transaction only, in the database only, or in both the
transaction and the database by using a prefix when you enter the field
name. To check the value for the transaction only, enter the field name as
'TR. field'. To check the value in the database only, enter the field name as
'DB. field' . To check the value for the transaction first and then check the
database if a new value is not found in the transaction, enter the field
name with no prefix. For more information, see “Checking Transaction vs.
Database Values” on page 220.
Examples (to check transaction only): 'TR.Submitter'
Examples (to check database only): 'DB.Submitter'
The TR and DB prefixes are not used for active link or escalation
qualifications.
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Note – It is only possible to use a Status History reference in a filter
qualification if you are checking values in the database; Status History is not
meaningful if you are checking the value of the current transaction. See
“Checking Transaction vs. Database Values” on page 220 for more information
on checking field values in the database or in the transaction.

You cannot use Status History references in active link Run If qualifications.

Checking Transaction vs. Database Values

In filter qualifications only, the qualification can access values in the database
for the current record as well as in the current transaction. This makes it
possible for you to perform state-transition checking using a filter qualification.
For example, you could define a filter that would watch for transactions where

Values Non-numeric values (including time, field, and keyword values) must be
enclosed in double quotations.
Example: ''07/01/92''
When entering time values, note that any integer (unquoted) will be
interpreted as a number of seconds. To specify a number of minutes or
hours, use a relative time value within quotes.
Example (to specify 10 hours): ''10:00''
Keyword values do not require surrounding quotes. (See “Table of
Keywords” on page 447 for available keywords.)
Example: 'Submitter' = $USER$
To query for ARs that have no value in a field, you can use the keyword
$NULL$.
Example (to query for ARs that have no value in the Assigned-to field):
'Assigned-to' = $NULL$

Status
History

Status History references must have the following information and
format:
The name or ID of the Status History field (followed by a period).
The name or index of the status value you want to match (followed by a
period).
The keyword USER (for the user last changing to that status) or TIME (for
the time last changed to that status).
Example: 'Status-History.Fixed.TIME' < ''07/01/92''
This syntax is used automatically when you select the Status History
reference from the Fields menu button list.
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the status of an AR is changed to “Closed.” You can then check the database to
verify that the current status of the AR is “Fixed,” and reject the operation if
the status is anything other than “Fixed.”

There are three ways to specify a field reference in the filter qualification:

Filter Qualification Examples

The examples below show the steps you would follow to create three different
filter qualifications in the Run If field. The first example builds a qualification
that will cause the filter to act on current transactions with a status of either
“Fixed” or “Closed.” The second example builds a qualification that will cause
the filter to act on entries that required more than 10 hours to resolve. The third
example builds a qualification that causes the filter to test that a value has
changed in a field.

Example 1:

The procedure below will build a qualification that causes the filter to act both
on transactions with a “Fixed” status and transactions with a “Closed” status.
(Note that while this example uses the menu button attached to the Run If field
to build the qualification, you can also type the qualification directly into the
Run If field in the Filter window.)

Transaction Only Check the value of the field in the current transaction only. If the
value is not changed in the transaction, it is considered to be $NULL$.
If the operation is a query or a delete, it is considered to be $NULL$.
To specify a check of the transaction only, use the format
'TR.< field>'  when you enter the field name in the Run If or Set Field
If fields.

Database Only Check the value of the field in the database only. No check is made of
the value in the current transaction. If the operation is a create
operation (submit), it is considered to be $NULL$. To specify a check
of the database only, use the format 'DB. <field>'  when you enter the
field name in the Run If or Set Field If fields.

Transaction or
Database

Check the value of the field in the current transaction and use that
value if changed. If not changed in the current transaction, check the
value of the field in the database. To specify a check of both the
transaction and the database, use the format ' field'  when you enter
the field name in the Run If field.
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1. In the Run If menu button, choose the Status  field from the Fields

option. The name of the field appears in single quotes in the Run If field:
'Status'

2. To cause the filter to act on the current transaction only, move the cursor to
the beginning of the field name (after the single quote) and enter the
characters TR. before the field name.
'TR.Status'

3. With the cursor positioned at the end of the qualification, click the =
(equal sign) operator from the palette. The operator is added to the Run If
field, as follows:
'TR.Status' =

4. Type the field value Fixed into the Run If field, enclosed in double quotes.
The Run If field now contains:
'TR.Status' = ''Fixed''

5. Click the OR operator from the palette. The OR operator is added to the
Run If field:
'TR.Status' = ''Fixed'' OR

6. Choose the Status  field from the Fields  option again, then add the TR.
prefix as before. Move the cursor to the end of the field and click the equal
sign (=) operator. The Run If field contains:
'TR.Status' = ''Fixed'' OR 'TR.Status' =

7. Complete your qualification by typing the field value Closed. Enclose it in
double quotes. The Run If field now contains:
'TR.Status' = ''Fixed'' OR 'TR.Status' = ''Closed''

Example 2:

The procedure below will build a qualification that causes the filter to act on an
entry in the database where the difference between the current time and the
time the action request was entered in the AR System greater than 10 hours.
This example uses a status history reference as one of its values.

1. Choose TIMESTAMP from the Keywords option. The TIMESTAMP keyword
will appear in the Run If field, enclosed in dollar signs:
$TIMESTAMP$
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2. Click the - (minus sign) operator from the palette. The operator is added
to the Run If field:
$TIMESTAMP$ -

3. From the Fields cascading option in the menu button, create the status
history reference by choosing Status-History (for the field), then Time (the
keyword for the time the AR was entered), then New (for the status value
you want to match).
Your Run If field will contain the following:

$TIMESTAMP$ - 'Status-History.New.TIME'

This will cause the filter to calculate the difference between the time the AR
was entered with a “New” status and the current time.

Note – When you use a status history reference in the qualification, the AR
System assumes you are checking the value in the database, since status
history has no meaning in the current transaction. You do not need to preface
the field reference with “DB”.

Note – You could also have directly entered the status history value by typing
it into the Run If field.

4. Continue building your filter qualification by clicking the > (greater than)
operator from the palette:
$TIMESTAMP$ - 'Status-History.New.TIME' >

5. Finally, enter a value of ten hours, enclosed in double quotes (see
“Formatting Conventions” on page 219  for information on entering time
values). Your qualification in the Run If field should now look like the
following:
$TIMESTAMP$ - 'Status-History.New.TIME' > ''10:00''

This will cause the filter to determine if the result of the calculation of the
difference between the current time and the time of the entry’s creation is
greater than ten hours.
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Example 3:

The procedure below will build a qualification that causes the filter to test that
a value has changed in a field. (Note that while this example uses the menu
button attached to the Run If field to build the qualification, you can also type
the qualification directly into the Run If field in the Filter window.)

1. In the Run If menu button, choose the field from the Fields  option. The
name of the field appears in single quotes in the Run If field:
'<field>'

2. To cause the filter to check the value of the field on the current transaction
only, move the cursor to the beginning of the field name (after the single
quote) and enter the characters TR. before the field name.
'TR.<field>'

3. With the cursor positioned at the end of the qualification, click the != (not
equal sign) operator from the palette. The operator is added to the Run If
field, as follows:
'TR.<field>' !=

4. In the Run If menu button, choose the field again from the Fields  option.
'TR.<field>' != '<field>'

5. To check the value of the field in the database only, move the cursor to the
beginning of the field name (after the single quote) and enter the
characters DB. before the field name. The Run If field now contains:
'TR.<field>' != 'DB.<field>'

6. Click the AND operator from the palette. The AND operator is added to the
Run If field:
'TR.<field>' != 'DB.<field>' AND

7. Choose the field from the Fields  option again, then add the TR. prefix as
before. Move the cursor to the end of the field and click the equal sign (=)
operator. The Run If field contains:
'TR.<field>' != ''DB.<field>' AND 'TR.<field>' =

8. Complete your qualification by choosing NULL from the Keywords  option.
The Run If field now contains:
'TR.<field>' != ''DB.<field>' AND 'TR.<field>' = $NULL$
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Specifying Filter Actions
You can specify up to 25 filter actions to be performed when an AR transaction
meets the conditions specified by the filter Run If conditions. For example,
actions might include notifying a support staff person, setting the contents of
certain fields, or running a predefined process. If you specify multiple actions,
you can use the Move up or down arrows in the Current Actions list to set the
order in which the actions will occur.

The following sections provide a detailed description of the attributes you
must specify for each type of filter action as well as the steps involved in
creating, modifying or deleting a filter action.

Note – Use this section to obtain information on how to set actions for
escalations as well, since the Escalation Actions window looks and functions
like the Filter Actions window. See “Types of Escalation Actions” on page 262.

To create a filter action:
1. Open the filter you want to work with if it is not already open.

2. Make sure that the filter basic conditions are specified correctly, according
to the instructions provided earlier in this chapter.

3. Click the Action tab in the Filter window. The window changes to allow
you to specify a new action.

4. From the New Action drop-down list, select the action you want: Log to
File, Message, Notify, Run Process, or Set Fields.
The window displays the attribute choices for the action you have selected.

5. Set the attributes as appropriate, then click the Add Action button. Refer
to the following sections for information about setting attributes for a
specific action.

6. To create additional actions for the same filter, select an action from the
New Action drop-down list.

7. Set attributes as appropriate for the additional action, then click the Add
Action button to add the action to the Current Actions list.
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8. When you have defined all the actions you want for the filter, click the
Save button on the toolbar (or choose Save Filter from the File menu) to
save the modified filter, then double-click its Control menu to close the
window.

To modify a filter action:
1. Open the filter you want to work with if it is not already open.

2. Click the Action tab in the Filter window.

3. Select the action that you want to modify from the Current Actions list.

4. Change the various attributes as appropriate. Refer to the following
sections for detailed information about setting attributes for a specific
action.

5. When you have finished making changes, click the Modify Action button.

6. When you have made all of the modifications you want to the filter’s
actions, click the Save button on the toolbar to save the modified filter.

To delete a filter action:
1. Open the filter you want to work with if it is not already open.

2. Click the Action tab in the Filter window.

3. Select the current action that you want to delete from the Current Actions
list.

4. Click the Delete Action button to remove the action.

5. When you have made all of the modifications you want to the filter’s
actions, click the Save button on the toolbar to save the modified filter.

Ordering Filter Actions

The order in which the actions defined for a filter will execute is indicated
when you click the Action tab in the Filter window.

You can change the order in which the actions execute by using the Move up
and down arrow buttons located next to the Current Actions list. The Move
buttons let you adjust the order of the filter actions.
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To change the order of filter actions:
1. Open the filter you want to work with if it is not already open.

2. Click the Action tab in the Filter window.

3. Select the action that you want to move forward or backward from the
Current Actions list.

4. To move the action earlier or later in the action list, click the Move up or
down arrow button.

5. Continue to move between actions and adjust their order using the arrow
buttons until the actions are in the desired order.

6. Click the Save button on the toolbar to save the filter with the new action
order.

Types of Filter Actions
There are five types of filter actions you can specify:

• Log to File writes an audit trail message to a specified file.

• Message returns a message and displays it for the user who activated the
filter. (Escalations do not support message actions.)

• Notify issues a notification message to the designated user.

• Run Process executes an operating system command or a program on the
server.

• Set Fields assigns values to specific fields in the current AR.

Each of the types is explained in the following sections.

The Log to File Filter Action

When you choose the Log to File action, all operations meeting the filter
conditions will be appended to an ASCII file on the AR server. Each log entry
includes a date and time stamp, the name of the user whose action triggered
the filter, the name of the schema, the entry’s ID number, and the fields
included in the transaction. This creates an audit trail of transactions meeting
the filter condition.
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Note – If for any reason or at any time there is a failure writing to the log file,
a warning message is written to the arerror.log  file and the AR System will
log the filter or escalation activity to the <ar_install_dir>/db/ar.log  file
instead. This warning message appears only once, not at every instance of
logging failure.

The ar.log  file is used only when there is a failure to write to the log file you
specify. The AR System continues to try to log filter or escalation activity to the
log file you specify in this action, but if it is unsuccessful, will write to the
ar.log  file.

The next time the system successfully writes to your log file, a message is also
written to the arerror.log  file.

To define the Log to File filter action:
1. Choose Log to File from the New Action drop-down list. The Filter

Actions window will change to allow you to define the log to file action,
as shown in Figure 10-6 on page 229.

2. Specify the full directory pathname of the file to log to in the File Name
field.

3. When you have finished specifying the log to file filter action, click the
Add Action button. All actions for this filter appear in the Current Actions
list.

4. If you want to create an additional action for this filter, choose the action
from the New Action drop-down list.
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Figure 10-6 Log to File Filter Action

5. If you have finished defining basic conditions and actions for this filter,
click the Save button on the toolbar then double-click the Control menu
to close the window.

The Message Filter Action

When you choose the Message action, an interactive error, warning, or note
will be displayed by any application that initiates a transaction that meets the
filter conditions.

Note –  Escalations do not support message actions.
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To define the Message filter action:
1. Choose Message from the New Action drop-down list. The Filter Actions

window will change to present the fields required to define the message
filter action, as shown in Figure 10-7.

Figure 10-7 Message Filter Action

2. In the Message Text field, enter a string, up to 255 characters in length,
which will be the text of the message. The text may include field
substitution parameters or system keywords.
You can use the menu button next to the Message Text field to select the
fields in the current schema as well as a list of keywords. You can simply
select one of these fields or keywords to have it added to the text. In
addition, you can click the text edit icon to open a text edit dialog box for
easier data entry, if desired.
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3. Select a message type for the message. The message type will be
displayed with the message. The available message types are:

4. Specify a message number in the Number field. The message number will
be displayed with the message. The number you specify must be greater
than or equal to 10000. (Numbers under 10000 are reserved for AR System
messages.)

5. If you have finished defining the message filter action, click the Add
Action button. All actions for this filter appear in the Current Actions list.

6. If you want to create an additional action for this filter, choose the action
from the New Action drop-down list.

7. If you have finished defining basic conditions and actions for this filter,
click the Save button on the toolbar then double-click the Control menu
to close the window.

The Notify Filter Action

When you choose the Notify action, all requests meeting the filter conditions
will use a mechanism you specify (such as email, the Notification Tool, or the
user’s default notify mechanism) to send a message to one or more users that
you specify. For example, you could create a filter that would notify support
staff that they have been assigned a new AR.

To define the Notify filter action:
1. Choose Notify from the New Action drop-down list. The Filter Actions

section will change to present the fields required to define the notify filter
action, as shown in Figure 10-8 on page 232.

Note Returns a note and continues the operation. The message type is
displayed as ARNOTE.

Warning Returns a warning and continues the operation. The message type is
displayed as ARWARN.

Error Returns an error and terminates the operation. The message type is
displayed as ARERR. No actions after an error message action will be
performed.
For example, you can use an error type message to disallow entries with
no value in a specific field, even if the field is not normally a required
field.
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Figure 10-8 Notify Filter Action

2. In the Text field, enter a string, up to 255 characters in length, which will
be the text of the notification message.
You can use the menu button next to the Text field to specify the fields in the
current schema as well as a list of keywords (see “Table of Keywords” on
page 447). You can simply choose one of these fields or keywords to have it
added to the text. In addition, you can click the text edit button to open a
text edit dialog box for easier data entry, if desired. The keyword or field
will be expanded when the notification is sent.

The email notify text can contain carriage returns. To place carriage returns
in your notifier text you must open a text edit dialog box for the Notify Text
field.

3. In the User Name field, enter the name of the user to notify.
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Note – You can enter the name of a group instead of the name of a single user.
This allows you to send notifications to all members of a group simultaneously.
Do not put the group name in dollar signs ($) or in quotes.

You can enter a field name or ID within dollar signs ($) to indicate that the
name of the user (or group) to notify is in a field on the AR. For example, to
send a message to the user who submitted the problem, you would enter
$Submitter$ .

You can also use the menu button to enter fields or keywords. The field or
keyword you select will append any value currently in the field (or replace
the text if highlighted).

If the notification will be sent by email, you can enter the email address of
the person to be notified.

4. The Priority field is reserved for future use by Remedy Corporation.

5. Select a mechanism for delivery of the notification message. The available
mechanisms are:

Notifier Users will be notified with the specified text using the Notification Tool.
User can be any user logged into the Notification Tool.
For more information on the Notification Tool, refer to Chapter 8, Using
the Notification Tool in the Action Request System User’s Guide.

E-Mail The supplied text will be sent to the address specified in the User Name
field using electronic mail. The AR System will first try to resolve the
contents of the User Name field by checking for a User entry. If the user
is found, the email address is retrieved from the user record. If the user
cannot be found, the AR System checks for a Group definition. If the
name corresponds to a group name, the message is sent to all members
of the group specified. Finally, if no User or Group definition is found,
the contents of the User Name field are used as a literal address and the
message is sent to the address specified via SMTP mail on UNIX servers
or Microsoft Mail on NT servers. This address could be an email address
representing users that are not AR System users, an alias for a group, or
an email address representing a program.

User Default The filter will check the User record of the user to be notified and use
the default notification method specified in the User record. If no default
notify mechanism is specified on the User record, the filter will attempt
to notify the user through the Notification Tool. If this attempt is not
successful, no notification will be delivered.
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6. The Reference Field is activated if you select Cross Reference. Use the
Reference Field drop-down list to choose which field you want to use for
the cross reference. The drop-down list lists the selection and integer
type fields available on the current schema. Notification is based on the
numeric value in the field of the current ticket, as defined by the “Other
Code” (see above). For example, if you cross reference an integer field and
the field has a value of 1, users will be notified by the notifier; if 2, by
email; if 3, by user default, and so on. (Using 0 (zero) in an integer or
selection field means do not notify users.)

Note – If you cross reference the value of a selection field, remember that the
first value stored in the database in a selection type field is 0 (zero), not one. As
a result, selecting the first value in a selection field will not alert users by the
notifier (because 0 means do not notify). In a selection field, 1 (for the notifier)
is actually the second value, 2 (for email) is the third value, and so on.

7. The Subject Line is activated if you select E-mail, User Default, Cross
Reference, or Other. In the Subject Line field, you can enter text of up to
255 characters which will appear on the subject line of your email
notification. You also can add any of the keywords defined by the system

Cross
Reference

To use this notification mechanism, you identify another field on the
schema that will contain the notification mechanism to use. The field
selected must be a selection or integer type. When you choose Cross
Reference as the notification mechanism, the Reference Field drop-down
list is activated. (See the description of “Other Code” below for an
explanation of how the value of the field is interpreted.)

Other Allows you to specify the index for the mechanism to use. Used in
conjunction with the Other Code field.

Other
Code

When you choose Other as the notification mechanism, the Other Code
field appears. Entering a value of 1 means notifier, a value of 2 means
email, and a value of 3 means user default. Any value from 4 to 98 will
send the notification to a file named
<ar_install_dir>\arserver\db\notify <nn>.arn , where <nn>
is the number you selected. You can read the notifications from this file
or write a UNIX daemon (like a mail daemon) or an NT service to watch
the file and take appropriate action. For example, you could create a
paging beeper daemon in this way.
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(see “Table of Keywords” on page 447) or the value of any field of the AR
by entering the field name enclosed in dollar signs ($). The keyword or
field will be expanded when the notification is sent.
In addition, the text edit icon allows you to open a text edit dialog box for
easier data entry, if desired.

8. The Include Fields drop-down list is activated if you select E-mail, Cross
Reference, User Default, or Other. You then can choose from the Fields
list to specify which fields to deliver with the Notification (in addition to
the Notify text).
When you use any notification method other than the Notifier, you can send
the contents of selected fields, as long as the user being notified has the
appropriate permissions for those fields.

You can choose the following delivery options for notification from the
Include Fields drop-down list:

No fields can be delivered using the Notification Tool so this list is grayed
when the Notifier choice is selected.

If the Notify mechanism is User Default and the User record specifies that
the Notification Tool is the default notify mechanism or the mechanism is
Other and the Other Code is 1, field data will be ignored when the
notification is delivered.

Note – The permissions of the target user are enforced when sending fields.
Only fields that the user has permission to view are delivered from the list of
fields specified. If no user match is found when sending email and the message
is directed to an email address specified in the User Name field, only publicly
viewable fields are delivered.

9. If you have finished defining the notify filter action, click the Add Action
button. All actions for this filter appear in the Current Actions list.

10. If you want to create an additional action for this filter, choose the action
from the New Action drop-down list.

None No fields are included with the notification.
All All fields of the entry are included with the notification.
Selected Selected fields from the list box are included with the notification.
Changed Only fields which have changed in the current transaction are included

with the notification.
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11. If you have finished defining basic conditions and actions for this filter,
click the Save button on the toolbar then double-click the Control menu
to close the window.

The Run Process Filter Action

Choosing the Run Process action allows you to execute a command to run a
process on the server system. When an AR transaction meets the filter
conditions, the system will execute the command specified in the Command
Line field. For example, you could specify a program in the Command Line
field that will automatically fix a problem described in the AR fields. The
command line also accepts parameters.

Note – Security Alert:The process executed with the Run Process command
will be executed with the same permissions as the AR server. You should
consider this carefully when defining filter actions as it may have security
implications for your system.

To define the Run Process filter action:
1. Choose Run Process from the New Action drop-down list. The Filter

Actions section will change to present the fields required to define the run
process filter action, as shown in Figure 10-9 on page 236.

Figure 10-9 Run Process Filter Action

Field contents can be passed as
parameters. Enclose field name
with $ symbols.
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2. In the Command Line field, enter the command that will execute when
filter conditions are met.
You can specify any of the keywords defined by the system (see “Table of
Keywords” on page 447) or you can substitute the value of any field of the
AR generating the notification by enclosing the field name or ID in dollar
signs ($) in the text. The keyword or field will be expanded when the
process is run. If the expanded value contains spaces, remember to enclose
the value within quotes so that the operating system will interpret it as a
single value. If in doubt, use quotes. They will not interfere and they may
prevent a problem.

You can enter up to 255 bytes for your command definition. The command
can be up to 4096 bytes once the substitution parameters are expanded.

You can use the menu button next to the Command Line field to select the
available keywords and fields in the current schema. You then simply select
one of these fields to have it appended to the command. In addition, you
can select the text edit icon to open a text edit dialog box for easier data
entry, if desired.

Note – Remember to adjust your command syntax appropriately for
whatever platform your server is running and include the explicit path to
commands, for example, /home/jim/bin/ <command>. In the Windows NT
environment, you also need to specify the drive, for example,
d:\home\jim\bin\<command.bat>  (for the d: drive).

On the Windows NT server, you can only run a process that runs in a console
(like a .bat script or runmacro.exe ) or that creates its own window. If the
process does create a window, the window appears on the server system
where the AR System is running.

In the UNIX environment, the process will run under a Bourne shell.

For UNIX, use quotes around substituted fields when the values may contain
blanks or other special characters, for example, /bin/cmd  "$<field>$"

Substituted field values containing carriage return or other special characters
may have unexpected results.
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3. If you have finished defining the run process filter action, click the Add
Action button. All actions for this filter appear in the Current Actions list.

4. If you want to create an additional action for this filter, choose the action
from the New Action drop-down list.

5. If you have finished defining basic conditions and actions for this filter,
click the Save button on the toolbar then double-click the Control menu
to close the window.

Using the runmacro.exe Utility from the Command Line

For the Windows NT server, you can execute a Run Process filter action using
runmacro from the Command Line field. The runmacro.exe  utility, located in
your <ar_install_dir>\bin  directory, takes arguments from the command
line to run macros, as in the following example:

c:\remedy\bin\runmacro   -h \\obelix\home    -e "TestMacro"
-p "Submitter"=$USER$ -x $SERVER$

Note – When creating macros, you can record a login with the proper
permissions if you are performing actions that require those permissions, for
example, an administrator deleting ARs. If your macro does not record a login,
you must use the -h option to specify the directory that contains the ar.ini

file.
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Command Line Options

You can enter the following runmacro options in any order on the command
line:

The Set Fields Filter Action

When you choose the Set Fields action, the resulting filter will load specific
values into selected fields for each transaction that meets the filter conditions.
This allows you to automate field updates in entries. For example, you can
define a filter that will automatically set the State field to “Assigned” every
time the Assigned-to entry gets set to a support staff name.

Note – A Set Fields action will be ignored for filters that are based on a Query
operation. This is because the system does not allow updates during a read
operation.

-h Use the -h option to specify a path to the <ar_config_dir>
directory<ar_config_dir>\arcmds  if you are using an ar.ini file that contains
the user and password information for the user running the macro. If you do
not specify the -d option, runmacro  also looks in this directory for the
<ar_config_dir> \arcmds directory that contains the macro to be run.
You can create separate home directories for each user that you want to run a
macro. To run a user’s macros, copy the user’s home directory from the
machine where they run the User Tool to the Windows NT server and specify it
with the -h option, or use the -h option to point to the user’s home
directory on the machine where they run the User Tool.
Warning: The ar.ini  file contains the user and password information of the
last person logged into the machine. If two people are sharing a PC, make sure
that you access the correct ar.ini  file.

-d If your macro is not in the <ar_config_dir >\arcmds  directory or if you do
not have a <ar_config_dir > directory, use the -d option to specify the
directory that does contain the macros.

-e Specify the macro to be run.
-p Specify a value for a parameter. There may be more than one -p  option in a

command line. If the macro specified (using the -e  option) has a parameter, a
value can be supplied by naming that parameter and assigning a value. If
either the parameter name or value includes a space or other special character
that is interpreted by the command line, the parameter must be enclosed in
quotes to stop the interpretation of the special characters.

-x Specify the name of a server to connect to. The -x option may be included
more than once to connect to multiple servers.
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The value you assign to a field can be a simple static value, a keyword, a field
from another schema, the result of a function, or the results of an executing
process or arithmetic operation. These options are described in detail in the
following sections.

Note – You can also assign values to hidden fields.

If you assign a value to a diary field, the value is appended to any user text
already in the field.

To define the Set Fields filter action:
1. Choose Set Fields from the New Action drop-down list. The fields

required to define the set fields filter action are displayed, as shown in
Figure 10-10 on page 240.

Figure 10-10 Set Filter Fields Window
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2. From the Server Name field, use the default CURRENT TRANSACTION if the
value is to come from a field on the same AR or is to be only static values
or keywords. From the drop-down list, you also can select the server from
which the AR System is to retrieve the value for the field.

3. From the Read Value for Field from Schema drop-down list, select the
name of the schema from which the AR System is to retrieve the value for
the field. The default drop-down list choice is CURRENT TRANSACTIONif
the value is to come from another field on the same AR.
Selecting a schema from the Read Value for Field from Schema drop-
down list works in connection with constructing qualification statements to
locate ARs that contain specific data.

Note – If you enter a server name and schema different than the
CURRENT TRANSACTION but you use a static value or a keyword or you do not
actually set a field from the remote schema, the server name and schema revert
to the CURRENT TRANSACTION.

4. If the data or value you want is on a different AR, create a qualification in
the Set Field If:  field to locate the specific ARs.

5. In the Name field, enter the field that you want to be automatically set
when the filter executes. You can use the drop-down list to select the
available fields in the schema.

6. In the Value field, enter the values in the schema fields that you want to
be automatically set when the filter executes. You can use the menu button
next to the Value field to select the available fields, keywords, functions,
or process in the schema.

Note – Since filters and escalations execute with administrator permissions,
field values set through a filter are updated regardless of whether or not the
user has update permissions for the field.

You can set field values to any of the following:

• A static value. Enclose text values that include special characters, such as
parentheses, single quotes, or arithmetic operators, in double quotes.

• A keyword value (see “Assigning Keyword Values” on page 242).
• A value from another field in the same schema or another schema on the

server (see “Assigning Values from Other Fields” on page 242)
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• The value resulting from a specified process (see “Assigning Values from
Process Results” on page 244).

• The value resulting from an arithmetic operation (see “Assigning Values
Using Arithmetic Operators” on page 246).

• The value resulting from a function (see “Assigning Values Using
Function Results” on page 246).

• A combination of the above. You might want to combine a static text entry
with a keyword, for example, 'Entry entered by' + $USER$ .

After you select both a name and a value, the field is automatically added to
the Field Name list for the set fields action. Repeat steps 5 and 6 for as many
fields as needed.

To delete fields from the list, select the fields and click the Delete Fields
button. (You also can delete the Fields Value to remove the field from the
list.)

7. If you have finished defining the set fields filter action, click the Add
Action button. All actions for this filter appear in the Current Actions list.

8. If you want to create an additional action for this filter, choose the action
from the New Action drop-down list.

9. If you have finished defining basic conditions and actions for this filter,
click the Save button on the toolbar then double-click the Control menu
to close the window.

Assigning Keyword Values

You can use any of the keywords listed in “Table of Keywords” on page 447 to
set a field value. The data type of the keyword value must match the field data
type. If there is no match, the system will attempt to convert the data type.
Most conversions are automatic. Use the Keywords option in the menu button
to choose from a list of available keywords.

Assigning Values from Other Fields

You can set a field to a value drawn from another field on the current
transaction or an AR from the same or another schema on the same server.
Each action can draw data only from a single AR. However, you can use data
from multiple ARs by creating additional actions.
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When you assign a value from an existing AR, you must specify the schema
that you want and define the Set Field If condition that will locate the specific
AR within that schema. If only one AR matches the qualification when the
filter executes, the requested values are pulled from the AR and loaded as
values on the current window. If no ARs match the qualification, the field is set
to a null value. If multiple entries match, the values are drawn from the first
AR that meets the qualifications. (This differs from active links, which provide
a selection list in the case of multiple matches.)

Note – There will be no notification to the user that multiple matches were
found in a set fields filter action.

To assign a value from another field in the current transaction:
1. In the Set Fields Filter Action window, make sure the Server Name field is

set to CURRENT TRANSACTION.

2. From the Fields Name drop-down list, select the field where you want the
value loaded.

3. From the Fields Value menu button, select the field from which the value
will be drawn when the filter executes. After you select both a name and a
value, the field is automatically added to the Field Name list for the set
fields action.

To assign a value from a different AR:
The following steps apply to both filters and escalations.

1. From the Server Name drop-down list in the Set Fields Filter window,
select a server.

2. From the Read Value for Field from Schema drop-down list, select the
schema from which you want to retrieve the data.

3. From the Fields Name drop-down list, select the field where you want the
value loaded.

4. From the Fields Value menu button, select the field from which the value
will be drawn when the filter executes. After you select a value, the field
is automatically added to the Field Name list for the set fields action.
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5. Use the Set Field If field to define the qualification criteria that will locate
the specific AR from which the data will be drawn.
• Use the Fields cascading list to reference fields in the schema you are

drawing data from. These fields will be delimited with single quotes.
• Use the Keywords cascading list to reference the value of a field in the

current transaction. These fields will be delimited with dollar signs ($).
For example, if you want to find the AR where the Entry Id field of the From
Schema contains the same ID as the Related-to field in the current
transaction, the qualification would look like this:

'Entry Id' = $Related-to$

For a more detailed description of constructing qualification statements, see
“Building Qualifications” on page 218.

6. When you have finished specifying the qualification, click the Add Action
button.

7. Click the Save button on the toolbar.

Assigning Values from Process Results

You can set a field to the value resulting from running a specified process. For
example, you may want to load information about the current system or
information retrieved from another data source (such as an existing database
holding contact information). To do so, you can define and run a process
whose output will be used as the value for a field.

The syntax for loading the return of a process is as follows:
$PROCESS$ <process-to-run>

Note – Security Alert:The process will run with the same privileges as the AR
server. If the server is running with root privileges, the process will run with
root privileges.

Note – Remember to adjust your command syntax appropriately for
whatever platform your server is running and include the
explicit path to commands, for example,
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/home/jim/bin/ <command>. In the Windows NT
environment, you also need to specify the drive, for example,
d:\home\jim\bin\<command.bat>  (for the d: drive).

Note – On the Windows NT server, you can only run a process that
runs in a console (like a .bat script or runmacro.exe ) or that
creates its own window. If the process does create a window,
the window appears on the server system where the
AR System is running.

Note – In the UNIX environment, the process will run under
a Bourne shell.

Note – Use quotes around substituted fields when the values
may contain blanks or other special characters, for
example, $PROCESS$ /bin/cmd  "$<field>$"

Note – ■Substituted field values containing carriage return or
other special characters may have unexpected results.

The keyword $PROCESS$ indicates that all following text is a command line.
The command line can include substitution parameters from the current screen
to allow values from the current screen to be placed into the command line
before it is executed. You can enter up to 255 bytes for your command
definition. The command can be up to 4096 bytes once the substitution
parameters are expanded. You can select substitution parameters (as well as
the $PROCESS$ string) from the Fields Value menu button.

When the filter is performed, the specified command line will be executed on
the server. All output will be read by the User Tool and processed according to
the return of the process. If the process returns 0, the returned data is used as
the value for the field. The data is expected in ASCII format and is converted
as needed to match the data type of the target value. If the process returns a
value other than 0, it is assumed there was an error and the process failed. In
this case, the data returned is treated as the text of an error message and is
returned to the user. All other server activity is blocked until the process
completes or exceeds the process interval.
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If the process does not complete within a defined interval, the server continues
processing and ignores the process response. The process interval is configured
using the Server Information window. See “Timeouts Information” on page 43
for information on setting time-outs.

Assigning Values Using Arithmetic Operators

You can use arithmetic operators to compute a value that you can then use in a
Set Fields operation. You can combine an arithmetic operator with a static
value, a keyword, a value from the current screen or an existing AR, a function,
or a value from a process. The same arithmetic operators allowed for
specifying qualifications are allowed to build a computed value (see “Table of
Operators” on page 444). The operation must meet all the rules for arithmetic
operators and produce a result whose type is compatible with the target field.

Note – If you include a process result in a mathematical operation, the process
definition must not be contained within parentheses and it must be the last
item in the operation since all data after the keyword $PROCESS$ is considered
to be part of the command line.

Here are some examples of valid arithmetic operators:
$TIMESTAMP$ - $CREATE-DATE$

$FIRST NAME$ + '' '' + $LAST NAME$

''hostname ='' + $PROCESS$ hostname

Assigning Values Using Function Results

The AR System supports a set of functions that you can use in the set fields
action. The functions allow you to manipulate data so that you can control
various aspects of values you are loading into fields. For example, you can use
the UPPER function to convert the ASCII string loaded in a field to all
uppercase.

To assign a value using a function in the set field operation:
1. From the Fields Name drop-down list, select the field where you want the

value loaded.



Defining Filters 247

10

2. From the Fields Value menu button, choose the Function cascading option
to see a list of the available functions.

3. Select the function you want to use. It will appear in the field with a set of
parentheses to its right.

4. Within the parentheses, enter any arguments that are appropriate for the
function you have selected. (With the exception of $PROCESS$, you can
include keywords, field values, other functions, and arithmetic
operations).

Note – If the value of any of the arguments of a function is NULL, the result of
the function is NULL (the field is blank). To avoid this result, use a
qualification that tests that the transaction includes a value for all arguments.

Information about each of the functions supported by the AR System is
provided in Table 10-1.

Table 10-1 Functions in Set Fields Actions  (1 of 5)

Function Return Argument(s) Description

DATE char (timestamp) Returns the date portion of the
timestamp.

DAY long (timestamp) Returns the day of the timestamp (1 to
31).

HOUR long (timestamp) Returns the hour of the timestamp (0
to 23).

LEFT char (char,long) Returns the left most bytes of the first
parameter (char) up to the number of
bytes indicated by the second
parameter (long).
For example, to set the value of a field
to the first ten characters of the
Submitter name, you would enter:
LEFT($Submitter$,10)

LENGTH long (char) Returns the number of characters in
the string (char).

LOWER char (char) Returns all characters in the string
(char) as lowercase characters
(downshifts all characters).
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LPAD char (char,long,char) Returns the value that results from
padding the first parameter (char) to
the left with the value of the third
parameter (char) so that the resulting
value is the length of the second
parameter (long).
For example, if you want the results of
a set field operation to be a 15
character value prefixed with the
word LEAD, followed by zeros, and
ending in the contents of the integer
field “Call #” you would enter:
LPAD($Call\
#$,15,"LEAD00000000000")
If the Call # field contains the number
947, the result of the set field
operation will be LEAD00000000947 .
If the Call # field contains the number
122334556, the result of the set field
operation will be LEAD00122334556 .

LTRIM char (char) Returns the value of (char) after
deleting any blank spaces to the left.

MAX any
(matches
 input)

(any,any[,any]...) Returns the maximum value of the set
specified. The datatype of all values
must match in order for the result to
be meaningful.
For example, to check the current time
and the escalation time and return
only the greater (latest) value of the
two, you would enter:
MAX ($Escalate Date$,\
$TIMESTAMP$)

Table 10-1 Functions in Set Fields Actions  (2 of 5)

Function Return Argument(s) Description
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MIN any
(matches
 input)

(any,any[,any]...) Returns the minimum value of the set
specified. The datatype of all values
must match in order for the result to
be meaningful.
For example, to check the current time
and the escalation time and return
only the lower (earliest) value of the
two, you would enter:
MIN ($Escalate Date$,\
$TIMESTAMP$)

MINUTE long (timestamp) Returns the minute of the timestamp
(0 to 59).

MONTH long (timestamp) Returns the month of the timestamp (1
to 12).

REPLACE char (char,char,char) Returns the value that results from
replacing any occurrences of the
second parameter (char) found in the
first parameter (char) with the
contents of the third parameter.
For example, to replace the name Bob
with the name Robert if Bob is found
in the Submitter field, you would
enter:
REPLACE($Submitter$,"Bob",\
"Robert")

RIGHT char (char,long) Returns the right most bytes of the
first parameter (char) up to the
number of bytes indicated by the
second parameter (long).
For example, to set the value of a field
to the last four characters of an
account code, you would enter:
RIGHT($Account#$,4)

ROUND long (real) Returns the rounded value of a real
number. For example, 5.1 to 5.4 are
rounded to 5, 5.5 to 5.9 are rounded to
6.

Table 10-1 Functions in Set Fields Actions  (3 of 5)

Function Return Argument(s) Description
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RPAD char (char,long,char) Returns the value that results from
padding the first parameter (char) on
the right with the value of the third
parameter (char) so that the resulting
value is the length of the second
parameter (long).

RTRIM char (char) Returns the value of (char) after
deleting any blank spaces to the right.

SECOND long (timestamp) Returns the second of the timestamp
(0 to 59).

STRSTR int (char,char) Returns an integer indicating the
position of string 2 if it is found in
string 1. If string 2 is not found,
returns a -1.

SUBSTR char (char,long,[,long]) Returns the substring of characters in
the first parameter (char) starting at
the position indicated by the second
parameter (long) and continuing to
the position indicated by the third
parameter (long). The string is 0
indexed (numbering of characters
begins at 0). If the third parameter is
not included, returns characters to the
end of the string.
For example, to set the value of a field
to six characters of the Location field,
skipping a three character prefix, you
would enter:
SUBSTR($Location$, 3, 9)

TIME char (timestamp) Returns the time portion of the
timestamp.

TRUNC long (real) Returns the truncated value of a real
number. For example, 5.1 through 5.9
are truncated to 5.

Table 10-1 Functions in Set Fields Actions  (4 of 5)

Function Return Argument(s) Description
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Building and Using Filter Change History
The AR System lets you record information about the owner of a filter, the user
who last modified the filter, and the date of the modification. You can display
this information at any time by clicking the Change History tab in the Filter
window.

To define change history for a filter:
1. From the Server Window, select Filter from the Servers list. The Filters list

appears in the Server Window.

2. From the Filters list in the Server Window, open a filter by double-
clicking on it. The Modify Filter window appears.

3. Click the Change History tab, as shown in Figure 10-11.

Figure 10-11 Filter Change History

UPPER char (char) Returns all characters in the string
(char) as uppercase characters
(upshifts all characters).

WEEKDAY long (timestamp) Returns the weekday of the timestamp
(1 to 7, 1=Sunday, 7=Saturday).

YEAR long (timestamp) Returns the year portion of the
timestamp.

Table 10-1 Functions in Set Fields Actions  (5 of 5)

Function Return Argument(s) Description

Enter
change history
here

Read-only
description of
previous
change history
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4. In the New Description field, enter any information about modifications
to the filter that you think will be helpful to other administrators or
subadministrators of the AR System.

Note – All previous change history is found in the read-only window above
the New Description field. After you enter and save change history, it cannot
be edited.

5. Click the Save button on the toolbar (or choose Save Filter from the File
menu, or type Ctrl+S ) to save your changes.

Setting Help for Filters
Clicking the Help Text tab in the Filter window brings up a Help Text editing
window. You can supply help text for the filter here. In most cases, this help
text is simply a description of the filter, and is available for viewing and
editing only by AR System administrators and subadministrators who have the
filter open.

To define help text for a filter:
1. From the Server Window, select Filter from the Servers list. The Filters list

appears in the Server Window.

2. From the Filters list in the Server Window, open a filter by double-
clicking on it. The Modify Filter window appears.

3. Click the Help Text tab, as shown in Figure 10-12.
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Figure 10-12 Filter Help Text

4. In the Help Text field, enter any information that you think will be
helpful to AR System administrators or subadministrators.

5. Click the Save button on the toolbar (or choose Save Filter from the File
menu, or type Ctrl+S ) to save your changes.

Tracing Filter Activity
You can create a log file of filter activity on each server. This server option logs
information about filter activity for each operation, including the filters that
executed and whether or not filter execution was successful. By default, the log
file is called arfilter.log . See “Log Files Information” on page 49 for more
information on creating a filter log file.
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Defining Escalations 11

This chapter describes how to use the Administrator Tool to create and modify
time-based escalations. An escalation is a general purpose capability that
allows a condition to be checked on a regular basis and, if met, performs one or
more actions.

For example, you might define an escalation that sets the Assigned-Priority to
Urgent if the trouble ticket is not closed within 24 hours. Or you may choose to
escalate tickets to a Critical priority when they have not been addressed in one
hour.

For a detailed discussion about escalation design, see “Designing Escalations”
on page 86.

This chapter covers the following topics:

• Using the Escalation window.

• Opening escalations.

• Specifying escalation basics.

• Specifying escalation actions.

• Specifying escalation time criteria.

• Building and using escalation change history.

• Setting help for an escalation.
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Using the Escalations Window
You create and modify escalations within the Escalation window, as shown in
Figure 11-1.

Figure 11-1 Escalation Window

You can open multiple windows for creating or modifying the escalations that
you have permission to administer.

Escalations execute on the server machine. Each escalation is attached to a
single schema on the server.

You use the tabs in the Create Escalation window to define the following:

Basic Defines the basic properties of the escalation and the conditions that
will cause the escalation to execute. For example, the condition might
be to create an escalation that executes when a ticket more than eight
hours old has not yet been closed by support personnel.
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Creating and Modifying Escalations
Follow these steps to create a new escalation or open, copy, or delete an
existing escalation.

To create an escalation:
1. In the Server Window, choose a server to administer.

2. Click the New Object button on the toolbar. Or choose New Object from
the File menu. The New Object dialog box appears (Figure 11-2).

Figure 11-2 New Object Dialog Box

3. Select Escalation from the New Object list, then click the OK button.
The Escalation window that you use for creating escalations appears (see
Figure 11-1 on page 256). For a new escalation, the fields are empty.

Actions Defines the actions the escalation will take when the specified
qualifications are met at the defined intervals. For example, an
escalation qualification might look for “New” in the Status field for
any entry over 2 hours old. For all matches found, assign the entry to
the manager.

Time
Criteria

Defines how often the AR server will check the escalation
conditions.

Change
History

Allows you to record information about the owner of an escalation,
the user who last modified it, and the date of the modification. You
can add additional change history information as well.

Help Shows the Help Text editing window. You can supply help text for
the escalation here. In most cases, this help text is simply a
description of the escalation, what it does, and how it is used.
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4. Specify or change escalation basic specifications and conditions according
to the steps described in “Specifying Escalation Basics” on page 260.

5. Specify or change escalation actions according to the steps described in
“Specifying Escalation Actions” on page 261.

6. Specify or change escalation time criteria according to the steps described
in “Specifying Escalation Time Criteria” on page 262.

Opening Escalations

Follow these steps to open and modify an escalation.

Note – You can open as many escalations as you want but you cannot open the
same escalation twice.

To open an escalation:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click Escalations to see a list of escalations currently defined on
the server.

4. Select an escalation from the Escalations list, then double-click the
escalation to open it.
The escalation appears in the Modify Escalation window (see Figure 11-1 on
page 256). You now can modify the escalation as needed.

Saving Escalations Under a Different Name

When saving an escalation under a different name, the new escalation contains
all the properties of the original escalation. The only difference is the name.

To save an escalation under a different name:
1. Open a Server Window.

2. Select a server from the Servers list.
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3. Double-click Escalations to see a list of escalations currently defined on
the server.

4. From the Escalations list, open the escalation that you want to copy.

5. From the File menu, choose Save Escalation As. The Save Escalation As
dialog box appears (Figure 11-3).

Figure 11-3 Save Escalation As Dialog Box

6. In the Escalation Name field, enter the new name of the escalation.

7. Click the OK button to make a copy of the escalation. The new escalation
will appear in the Escalations list.
Double-click the escalation to open it.

Deleting Escalations

The delete operation is permanent and cannot be undone. Make sure you no
longer need an escalation before deleting it. You cannot delete any escalation
that is currently open.

To delete an escalation:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click Escalations to see a list of escalations currently defined on
the server.

4. From the Escalations list, select the escalation that you want to delete.
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5. From the Edit menu, choose Delete - Escalation.
A confirmation message appears (if your preferences are set for this). Click
the OK button to delete the escalation. For more information, see “Defining
Preferences” on page 61.

Specifying Escalation Basics
This section describes how you use the Escalation window to specify escalation
specifications and conditions, as shown in Figure 11-4. The escalation basics
define the criteria that a transaction must meet before the corresponding
escalation actions take place. You specify basics including:

• The name of the escalation.

• Whether the escalation is enabled or not.

• The schema that the escalation is to be applied to.

• The specific qualifications that limit the ARs against which the escalation
will execute, as described in “Building Qualifications” on page 218.

Figure 11-4 Specifying Escalation Basics

To specify or change escalation conditions:
1. Open the escalation you want to work with (see the previous section).
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2. If the correct name is not already assigned to the escalation, specify the
escalation name in the Escalation Name field.
Escalation names may be up to 30 characters, including blanks, and must be
unique. There is no enforced convention for escalation names, but it is
helpful if the name is descriptive and indicative of the escalation’s function.

3. Select or clear the Enable check box to set whether you want to activate
the escalation. For example, you may want to disable the escalation during
development or if you are diagnosing a problem.

4. From the Schema Name drop-down list, select the schema the escalation
will apply to in the Schema Name field.

5. You define escalation conditions by entering a qualification statement in
the Run If field. You can enter the text directly, by typing it in, or build
the qualification using the query bar palette and Fields menu, as
described in “Building Qualifications” on page 218.

6. When you have finished specifying escalation conditions and
qualifications, go on to specify the escalation actions.

Specifying Escalation Actions
You can specify up to 25 actions to be performed when an entry meets the
conditions specified by the escalation conditions. For example, actions might
include loading a value into a field on the AR and notifying the escalation
manager about the escalation.

The basic steps involved in creating, modifying, or deleting an escalation
action are just like the steps to define filter actions as described in “Specifying
Filter Actions” on page 225.

Ordering Escalation Actions

The order in which the actions defined for an escalation will execute is
indicated in the Escalation Action window.

You can change the order in which the actions execute by using the Move up
and down arrow buttons located next to the Current Actions list. The Move
buttons let you adjust the order of the escalation actions.
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The basic steps involved in ordering an escalation action are just like the steps
to order filter actions as described in “Ordering Filter Actions” on page 226.

Types of Escalation Actions

There are four types of escalation actions you can specify. With one exception
(escalations, unlike filters, do not support message actions), the Escalation
Actions window looks and functions just like the Filter Actions window as
described in “Types of Filter Actions” on page 227.

• Log to File writes an audit trail message to a specified file. To use the Log to
File Escalation Action, see “The Log to File Filter Action” on page 227.

• Notify issues a notification message to the designated user. To use the Notify
Escalation Action, see “The Log to File Filter Action” on page 227.

• Run Process executes an operating system command or a program on the
server. To use the Run Process Escalation Action, see “The Run Process Filter
Action” on page 236.

• Set Fields assigns values to specific fields in the current AR. To use
the Set Fields Escalation Action, see “The Set Fields Filter Action” on
page 239.

Specifying Escalation Time Criteria
This section describes how you use Time Criteria in the Escalation window to
specify escalation time conditions, as shown in Figure 11-5 on page 263. The
escalation time criteria define the interval or specific times when escalation
conditions are checked.

Note – Creating escalations that check the server too frequently can cause
performance problems.
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Figure 11-5 Time Criteria in Escalation Window

To specify or change escalation time criteria:
1. Open the escalation you want to work with (see Opening Escalations on

page -258).

2. Click the Time Criteria tab in the Escalations window. The window
changes to allow you to specify time conditions.

3. In the Execution box, specify either Interval or Time.
• Select the Interval option button to cause an escalation to be checked at a

regular interval (for example, every 30 minutes, every 6 hours, every 7
days, or any combination of days, hours, and minutes). The interval
begins when you create, modify, or enable the escalation.

For more on setting execution intervals, see the following section, “Setting Execution
Intervals.”
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• Select the Time option button to cause an escalation to be checked at a
specified time (for example, every day at 4:00 PM or 1600 hours). Unlike
the Interval setting, the execution time is not checked immediately; the
server waits until the time that you set. Selecting Time allows you to check
escalations at regular or irregular intervals, for example, the 15th and 31st
of every month or weekdays at 4:00 PM.

For more on setting execution times, see “Setting Execution Times” on page 265.

4. When you have defined all the time criteria you want for the escalation,
click the Save button on the toolbar, then double-click the Control menu
to close the window.

Setting Execution Intervals

You can set the AR server to check the escalation at regular intervals. The
server checks the interval immediately and then at its set interval (for example,
every 4 hours).

To set an execution interval:
1. After you have specified the basic conditions for the escalation, click the

Time Criteria tab. The window changes to allow you to specify times or
intervals.

2. Select Interval from the Execution box. The Interval box is activated.

3. In the Days/Hours/Minutes fields, enter the check interval. The server
checks the escalation at each interval you set (beginning when you set the
interval). For example, if you set the interval to 1 hour, the server checks
the escalation immediately, then every hour. Make the execution interval
as large or as small as you need.

4. When you have defined the time criteria you want for the escalation, click
the Save button on the toolbar, then double-click the Control menu to
close the window.
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Setting Execution Times

Depending on your escalation, you can cause the AR server to check the
escalation at different times and even at irregular intervals. For example, you
can set Day, Hour, and Minute to execute escalations Monday through Friday
at 8:15 (AM) and 16:15 hours (4:15 PM) or that execute on the 15th and 31st of
every month at 8:00 AM.

To set an execution time:
1. After you have specified the basic conditions for the escalation, click the

Time Criteria tab. The window changes to allow you to specify times or
intervals (see Figure 11-6).

2. Select Time from the Execution box. The Time box is activated. You can
choose days of the month, weekdays, hours of the day, and minutes of the
day, or any combination.

Figure 11-6 Escalation Time Criteria Window
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3. From the Time box, select any combination of days of month and
weekdays to check the escalation on specific days of the month.
For example, if you select 15 and 31 from the Day of Month calendar and
Mondays and Fridays from the Weekdays list, the server checks the
escalations on the 15th and 31st as well as all Mondays and Fridays during
the month. If a Friday occurs on a 15th or 31st, the server checks the
escalation only once.

• Clicking the All button selects the entire month.
• Clicking the None button clears the entire month.

Note – In the AR System, selecting the 31st day of month creates an escalation
on the last day of the month for all months, including those with less than 31
days.

4. Select the hours of the day that you need.
You must set an hour to create an escalation but it must also be combined
with a day of month or weekday setting. You cannot set an hour by itself.

If you do not set an hour or if you set only the Hour field, the AR System
returns an error message.

5. In the Minute field, use the drop-down list to enter the minutes past the
hour. (The minutes default for all hours is :00.) The Minute Field is
particularly useful for staggering escalations so that they balance the load
on the server. For example, you can order escalations so that the server
checks some escalations on the hour, others at 15 minutes past the hour,
still others at 30 minutes past the hour, and so on.
You can also type a specific time into the Minute field, for example, 34.

6. When you have defined all the basic conditions, time criteria, and actions
for the escalation, click the Save button on the toolbar to create the
escalation, then double-click the Control menu to close the Escalation
window.

Building and Using Escalation Change History
The AR System automatically records information about the owner of an
escalation, the user who last modified it, and the date of the modification. You
can display this information at any time by clicking the Change History tab in
the Escalation window.
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The basic steps involved in building escalation change history are just like the
steps to define filter change history as described in “Building and Using Filter
Change History” on page 251.

Setting Help for Escalations
Clicking the Help Text tab in the Escalations window brings up a Help Text
editing window. You can supply help text for the selected escalation here. In
most cases, this help text is simply a description of the escalation, and is
available for viewing and editing only by AR System administrators and
subadministrators who have the escalation open.

The basic steps involved in creating escalation help text are just like the steps
to define filter end-user help as described in “Setting Help for Filters” on
page 252.

Tracing Escalation Activity
You can create a log file of escalation activity on each server. This server option
logs information about escalation activity for each operation, including the
escalations that executed and whether or not escalation execution was
successful. By default, the log file is called arescl.log . See “Log Files
Information” on page 49 for more information on creating an escalation log
file.
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This chapter describes how to use the Administrator Tool to create and modify
active links. An active link is a specific operation that is defined by the AR
administrator to be performed when an action is taken by the user.

For example, you might define an active link that runs a macro to display all
problems reported for the current machine whenever a user presses return on
the “Machine Name” field.

For a detailed discussion about active link design, see “Designing Active
Links” on page 92.

This chapter covers the following topics:

• Using the Active Link window.

• Opening an active link.

• Specifying active link basics.

• Specifying active link actions.

• Defining group access for multiple active links.

• Building and using active link change history.

• Setting help for an active link.
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Using the Active Link Window
You create and modify active links using the Active Link window, as shown in
Figure 12-1. For active links that execute on a button, you can also open the
Active Link window from the Modify Schema window.

Figure 12-1 Active Link Window

You can open multiple windows for creating or modifying the active links that
you have permission to administer.

Active links execute on the client machine. Each active link is attached to a
single schema on the server.

You use the tabs in the Create Active Link window to define the following:

Basic Defines the basic properties of the active link and what the user will
do to cause the active link to execute. For example, the condition
may be that the user presses Return in a specified field or clicks a
button on the user’s view of the schema.
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Creating and Modifying Active Links
Follow these steps to create a new active link or to open, copy, or delete an
existing active link.

To create an active link:
1. In the Server Window, choose a server to administer.

2. Click the New Object button on the toolbar. Or choose New Object from
the File menu. The New Object dialog box appears (Figure 12-2).

Figure 12-2 New Object Dialog Box

3. Select Active Link from the New Object list, then click the OK button.
The Active Link window that you use for creating active links appears (see
Figure 12-1 on page 270). For a new active link, the fields are empty.

Actions Defines the actions the active link will take when specified
conditions are met. For example, an action may be to run a specified
macro.

Permissions Defines which groups will be able to use the active link.
Change
History

Allows you to record information about the owner of an active link,
the user who last modified it, and the date of the modification. You
can add additional change history information as well.

Help
Text

Shows the Help Text editing window. You can supply help text for
the active link here. In most cases, this help text is simply a
description of the active link, what it does, and how it is used. User
Tool users will be able to view this help text in the same way that
they can view help text that is available for fields.
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4. Specify or change active link basic specifications and conditions
according to the steps described in “Specifying Active Link Basics” on
page 274.

5. Specify or change active link actions according to the steps described in
“Specifying Active Link Actions” on page 280.

6. Specify or change active link permissions according to the steps described
in “Defining Permissions for Active Links” on page 306.

Opening Active Links

Follow these steps to open and modify an active link.

Note – You can open as many active links as you want but you cannot open the
same active link twice.

To open an active link:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click Active Links to see a list of active links currently defined on
the server.

4. Select an active link from the Active Links list, then double-click the
active link to open it.
The active link appears in the Active Link window (see Figure 12-1 on
page 270). You now can modify the active link as needed.

To open an active link from the Modify Schema window:
• To create a new active link that executes on a button, do the following:

1. Click the New Object button on the toolbar, then select Active Link from the New
Object list.

2. When the Create Active Link window appears, create the active link and attach it
to your schema.

3. Select the Execute On Button checkbox. When you save the new active link, it will
appear as a button at the upper left-hand corner of the Modify Schema window.
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• To open an existing active link, double-click the active link button in the
Modify Schema window.

For information on creating an active link that activates by clicking a button,
see “Using Active Link Buttons” on page 278.

Saving Active Links Under a Different Name

When saving an active link under a different name, the new active link
contains all the properties of the original active link. The only difference is the
name.

To save an active link under a different name:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click Active Links to see a list of active links currently defined on
the server.

4. From the Active Links list, open the active link that you want to copy.

5. From the File menu, choose Save Active Link As. The Save Active Link As
dialog box appears (Figure 12-3).

Figure 12-3 Save Active Link As Dialog Box

6. In the Active Link Name field, enter the new name of the active link.

7. Click the OK button to make a copy of the active link. The new active
link will appear in the Active Links list.
Double-click the active link to open it.
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Deleting Active Links

The delete operation is permanent and cannot be undone. Make sure you no
longer need an active link before deleting it. You cannot delete any active link
that is currently open.

To delete an active link:
1. Open a Server Window.

2. Select a server from the Servers list.

3. Double-click Active Links to see a list of active links currently defined on
the server.

4. From the Active Links list, select the active link that you want to delete.

5. From the Edit menu, choose Delete - Active Link.
A confirmation message appears (if your preferences are set for this). Click
the OK button to delete the active link. For more information, see “Defining
Preferences” on page 61.

Specifying Active Link Basics
This section describes how you use the Active Link window to specify active
link specifications and conditions, as shown in Figure 12-4 on page 275.
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Figure 12-4 Specifying Active Link Basics

The active link basics define the criteria that a transaction must meet before the
corresponding active link actions take place. You specify basics including:

• The name of the active link.

• Whether the active link is enabled or not.

• The order in which the active link will execute in relation to other active
links.

• The schema that will contain the active link.

• How users will activate the active link (for example, by clicking a button or
by pressing Return).

• Specific qualifications that limit the ARs on which the active link will
execute, as described in “Building Qualifications” on page 218.
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To specify or change active link conditions:
1. Open the active link you want to work with (see “Opening Active Links”

on page 272).

2. If the correct name is not already assigned to the active link, specify the
active link name in the Active Link Name field.
Active Link names must be unique. There is no enforced convention for
specifying active link names, but it is helpful to make the name descriptive
and indicative of the active link’s function. Names may be up to 30
characters, including blanks.

3. Select or clear the Enable checkbox to set whether you want to activate the
active link. For example, you may want to disable the active link during
development or if you are diagnosing a problem.

4. Specify the active link execution order.
There may be more than one active link designed to execute based on the
same set of conditions. The output from one active link might affect another
active link. The Execution Order field allows you to specify the processing
order for the particular active link. Valid values for Execution Order are
numbers between 0 and 1000 inclusive. Active links with lower numbers are
processed first. You can assign the same number to multiple active links;
however, there is no guarantee about the processing order for active links
that have the same number.

5. From the Schema Name drop-down list, select the schema the active link
will apply to in the Schema Name field.

Note – Changing the Schema Name field setting after you have already
defined actions that reference the schema fields may invalidate the actions.
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6. In the Execute On box, select when the active link will be performed by
clicking one or more of the options, as described in Table 12-1:

You can select any combination of the options. If you select multiple
options, the active link will act when any one of the selected operations
takes place.

7. You can further refine your active link selection criteria by entering a
qualification statement in the Run If field. You can enter the text directly,
by typing it in, or build the qualification using the menu and text editor,
as described in “Building Qualifications” on page 218.

Table 12-1 Active Link Conditions

Submit Executes when a user submits an AR. The active link will be
performed before the AR is submitted.

Modify Executes when a user modifies an AR. (The active link will not
execute during a Modify All operation.) The active link will be
performed before the AR is modified.

Display Executes when a user retrieves and displays an AR.

Set
Default

Executes when the user selects the Set to Default command or
the User Tool loads defaults prior to a new query or submit.

Return Executes when a user presses Return in a specific field (or
selects a radio button if the field is a selection data type field).
If you choose this option, Field is activated to allow you to
specify the field that will cause the active link to execute.
Note: In multi-line text fields on the Motif User Tool, where
Return inserts a line feed in the text, the user must press Shift-
Return (or press the Enter key on the keypad) to activate the
active link. On the Windows User Tool, you must press the F5
key.

Menu Choice Executes when a user selects a choice from a menu. If you
choose this option, the Field list is activated to allow you to
specify the field for which a menu choice will cause the active
link to execute.
You can combine this condition setting with a qualification on
the contents of the field to build an active link that executes
only if the user chooses a specific menu selection.

Button Executes the active link when a user clicks the active link
button.
For more information, see “Using Active Link Buttons” on
page 278.
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8. When you have finished specifying active link conditions and
qualifications, go on to specify the active link actions.

Using Active Link Buttons

You can associate multiple active links with the same button simply by using
the same button label for all. The AR System will place the buttons on top of
one another so that to the user there appears to be a single button. A good use
of this capability is to define active links that execute conditionally based on
current conditions, such as the platform on which the tool is running.

For example, you could define an active link to execute only if the tool is
running on a PC. You could then associate another active link with the same
button, this time defining the active link so that it executes only if the tool is
running on a UNIX machine. Users on either platform can then perform the
same action to execute the appropriate active link for their platform.

Placing Active Link Buttons on Your Schema

When you create an active link button, it automatically appears in the top-left
side of the schema that the active link applies to (Figure 12-5 on page 279). You
then can define the button’s physical characteristics as needed.
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Figure 12-5 Defining Display Properties for an Active Link Button

To define display properties for active link buttons:
1. Double-click the active link button on the schema. The Active Link

Button Properties dialog box appears, displaying both the name of the
active link button and the active link name (as shown in Figure 12-5). You
use this dialog box to set display properties for active link buttons.

Note – If you click on a field, the dialog box re-appears as the Field Properties
dialog box and its field properties are displayed.

2. Use the Label field to rename the active link to some more appropriate
button label. For example, if the active link activates a DDE action, you
might label it Run DDE.

3. Locate the buttons on the schema as needed, by doing the following:

New
Active
Link
Button
that you
can locate
anywhere
 on the
schema

Field
Properties
dialog box
appears when
you click the
Active Link
button on the
schema

Active link button
name and name of active link
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• Set the same X and Y coordinates precisely for each active link button by
entering the coordinates into the Position/Size X and Y fields. If you are
creating multiple active link buttons, you do not have to close the Field
Properties dialog box to set other active link display properties in the
schema. The Field Properties dialog box displays the properties of any
active link button you select from the Schema Window.

• Drag the buttons on top of each other at the location that you want them
to appear.

These actions ensure the location of the button as it appears to the user in
the User Tool.

4. Place the button with the lowest execution order where you want the
button to appear to the user. The button with the lowest execution order is
the button that will be visible in the User Tool.

5. To make modifications to the active link’s other properties (for example,
actions or permissions), click the Modify Active Link button on the Active
Link Button Properties dialog box. Make any modifications when the
Modify Active Link window appears.

Note – If you clear the Keep Window Open check box, the Active Link Button
Properties dialog box closes when you click the Modify Action Link button,
allowing you to modify more easily the active link properties.

6. When you have made all of the modifications you want to the active link,
click the Save button on the toolbar to save the modified active link.

Specifying Active Link Actions
You can specify up to 25 actions to be performed when an AR transaction
meets the conditions specified by the active link conditions. For example,
actions might include loading the hostname of the client, checking other
problems reported for a machine, or running a pre-defined process. If you
specify multiple actions, you can use the Move up or down arrows in the
Action tab of the Active Link window to set the order in which the actions will
occur.

The following sections provide a detailed description of the attributes you
must specify for each type of active link action as well as the steps involved in
creating, modifying or deleting an active link action.
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To create an active link action:
1. Open the active link you want to work with if it is not already open.

2. Make sure that the active link basics and qualifications are specified
correctly, according to the instructions provided earlier in this chapter.

3. Click the Action tab in the Active Link window. The window changes to
allow you to specify a new action.

4. From the New Action drop-down list, select the action you want: Change
Field, DDE, Message, Run Macro, Run Process, or Set Fields.
The window displays the attribute choices for the action you have selected.

5. Set the attributes as appropriate, then click the Add Action button. Refer
to the sections that follow for information about setting attributes for a
specific action.

6. To create additional actions for the same active link, select an action from
the New Action drop-down list.

7. Set attributes as appropriate for the additional action, then click the Add
Action button to add the action to the Current Actions list.

8. When you have finished specifying active link actions, go on to specify
group access for the active link (see “Defining Permissions for Active
Links” on page 306).

To modify an active link action:
1. Open the active link you want to work with if it is not already open.

2. Select the action that you want to modify.

3. Change the various attributes as appropriate. Refer to the following
sections for detailed information about setting attributes for a specific
action.

4. When you have finished making changes, click the Modify Action button.

5. When you have made all of the modifications you want to the active link’s
actions, click the Save button on the toolbar to save the modified active
link.
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To delete an active link action:
1. Open the active link you want to work with if it is not already open.

2. Select the action that you want to delete.

3. Click the Delete Action button to remove the action.

4. When you have made all of the modifications you want to the active link’s
actions, click the Save button on the toolbar to save the modified active
link.

Ordering Active Link Actions

The order in which the actions defined for an active link will execute is
indicated in the Active Link Action window.

You can change the order in which the actions execute by using the Move up
and down arrow buttons located next to the Current Actions list. The Move
buttons let you adjust the order of the active link actions.

To change the order of active link actions:
1. Open the active link you want to work with if it is not already open.

2. Click the Action tab in the Active Link window.

3. Select the action that you want to move forward or backward in the action
list.

4. To move the action earlier or later in the action list, click the up or down
arrow buttons.

5. Continue to move between actions and adjust their order using the arrow
buttons until the actions are in the desired order.

6. Click the Save button on the toolbar to save the active link with the new
action order.

Types of Active Link Actions
There are six types of active link actions you can specify:

• Change Field dynamically adjusts certain characteristics of a specified field.
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• DDE activates a DDE operation for Windows clients.

• Message returns a message and displays it for the user who activated the
active link.

• Run Macro causes a macro to run in the background.

• Run Process executes a command line on the client.

• Set Fields assigns values to specific fields in the current AR.

Each of these types is explained in the following sections.

The Change Field Active Link Action

The Change Field action allows you to dynamically adjust selected
characteristics of fields in the current window. Based on conditions when the
active link executes, you can specify and attach a different character menu to a
field that already has a character menu, move the focus point to the field, or
change the accessibility of the field.

To define the Change Field active link action:
1. Choose Change Field from the New Action drop-down list. The fields

required to define the change field action are displayed, as shown in
Figure 12-6 on page 284.
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Figure 12-6 Change Field Active Link Action

2. Choose from the Field Name drop-down list the name of the field in the
current schema whose characteristics you want to set.

3. Specify the changes that you want to make:
• To select a character menu and attach it to the field, select the Attach

Menu to Field option, then choose a menu from the menu button. (The
field must already have a character menu assigned in order for you to be
able to change to a different character menu.)

• To change the current access settings for the field, choose one of the
following options from the Field Access drop-down list:

Unchanged Leave the access setting as it is.
Read Only Set the field access to read only. The user will be able to read the

contents of the field but will not be able to enter data.
Read/Write Set the field access to read/write. The user will be able to read

the contents of the field and enter data as required.
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• To move the focus to the field, select the Set Focus to Field option.

4. If you have finished defining the change field active link action, click the
Add Action button. All actions for this active link appear in the Current
Actions list.

5. If you want to create an additional action for this active link, choose the
action from the New Action drop-down list.

6. When you have finished specifying active link actions, go on to specify
the active link permissions (see “Defining Permissions for Active Links”
on page 306).

The DDE Active Link Action

Choosing the DDE action allows you to perform a dynamic data exchange
(DDE) operation on a Windows client. DDE is a part of MS Windows and is a
form of interprocess communication that uses shared memory to exchange
data between applications.

DDE always takes place between a client application and a server application
on the same PC. The client initiates the exchange by establishing a
conversation with the server so that it can request data or services from the
server. The server responds by providing the data or services to the client. A
server can have many clients at the same time and a client can request data
from multiple servers. Additionally, an application can be both a client and a
server.

DDE uses a three-level hierarchy to uniquely identify a unit of data to be
exchanged during a DDE conversation: service (application) name, topic name,
and item name.

A service name is a string that a server application responds to when a client
attempts to establish a conversation with the server.

A topic name is a string that identifies a logical data context.

An item name is a string that identifies a unit of data that a server can pass to
a client during the transaction.

Disabled Set the field access to disabled. The user will be able to read the
field value but not able to write to the field and the field label
will be grayed.
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For two examples of using an active link action with DDE, see “Active Link
DDE/Execute Action” on page 288 and “Active Link DDE/Poke Action” on
page 289.

Refer to the Microsoft Windows documentation for more information on DDE.
To integrate the AR System with other Windows applications, refer to
Appendix C, DDE Functionality in the AR System in the Action Request
System User’s Guide for Windows. To integrate with another application, refer to
that application’s documentation as well.

Note – If you are designing an active link for a schema that is used by clients
on platforms other than a PC, it is a good idea to verify that the current
platform is a PC as a condition of activating the DDE action. To do this, include
a qualification that uses the $HARDWARE$ keyword to check the current
platform. See “Building Qualifications” on page 218 for more information.

To define the DDE active link action:
1. Choose DDE from the New Action drop-down list. The fields required to

define the DDE active link action are displayed, as shown in Figure 12-7.

Figure 12-7 DDE Active Link Action
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2. Select an Action for the DDE operation. The available actions are:

3. In the Service Name field, enter the unique ID of the DDE application.
You can use the menu button next to the Service Name field to select the
available fields in the current schema. You then simply select one of these
fields to have it appended to the service name.

4. In the Topic field, enter the DDE topic. You can use the menu button next
to the Topic field to select the fields in the current schema.

5. In the Item field, enter the DDE item, if applicable. (Item is disabled if
the DDE Action type is Execute.) You can use the menu button next to the
Item field to select the fields in the current schema.

6. In the Path field, enter the path indicating the location of the service on
the PC. You can use the menu button next to the Path field to select the
fields in the current schema.

7. In the Command field, enter the command you want to execute. (You must
enter a value in this field.) You can use the menu button next to the
Command field to select the fields in the current schema as well as a list
of keywords.
• If the action is Execute, the command is sent to the remote application.
• If the action is Poke, the command is the data being set in the remote

application.

8. If you have finished defining the DDE active link action, click the Add
Action button. All actions for this active link appear in the Current
Actions list.

9. If you want to create an additional action for this active link, choose the
action from the New Action drop-down list.

10. When you have finished specifying active link actions, go on to specify
the active link permissions (see “Defining Permissions for Active Links”
on page 306).

Note – All data sent to the server is assumed to be in cf_text  format.

Execute Client request for server to execute the command specified in the
Command field.

Poke Client alters data in the server application data on the contents of the
Command field.
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See “Assigning Values from a DDE Request” on page 304 for information on
how to load the result of a DDE request operation into a field using an active
link that performs a Set Field operation.

Time-out Settings for DDE Transactions

All AR System DDE transactions are synchronous. If you need to set longer
times for DDE transactions, you can create a [DDE] section in your ar.ini  file
and enter your own time-out settings:

[DDE]
AppResponseTimeout=<30>

TransactionTimeout=<20>

AppResponseTimeout  is the active link time-out setting to load the application
into memory after starting it. The default setting is 30 seconds.

TransactionTimeout  is the active link time-out setting if the DDE server does
not respond back with the requested DDE action. The default setting is 20
seconds.

Active Link DDE/Execute Action

You use the DDE/Execute action to execute specific commands or functions on
another Windows application. The DDE Execute action requires the following
components in the DDE Active Link Action window:

For example, you could create an active link button that launches a Windows
application. Instead of the administrator hardcoding a specific DDE application
in a specific directory into the Path field in the DDE Active Link Action
window, Figure 12-7 on page 286 illustrates an active link that uses $Path$  to
reference the Path  field in the Run DDE schema.

Service Name Application DDE name.
Topic Additional DDE definition, for example, a file name or a

category of command (like the system  command in Excel).
Path Location of application executables. Make sure that you point

the path to the DDE application in the Service Name field.
Command Command or function being sent to the Windows application.
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As a result, users of the schema are free to enter their own application and path
name, in this case, a spreadsheet application that starts with a blank page
whenever they enter a path name and then click the Run DDE button, as
shown in Figure 12-8.

Figure 12-8 Creating and Using an Active Link Button for DDE Actions

Active Link DDE/Poke Action

You use the DDE/Poke action to send data to another Windows application.
The DDE Poke action requires all five components in the DDE Active Link
Action window:

Figure 12-9 on page 290 illustrates creating an active link that sends the value
of the $Submitter$  field into cell R1C1 (row one and column one) of Sheet1 in
a Windows application (like a spreadsheet). Users enter their own application
and path name in the $Path$  field in the User Tool, as in Figure 12-8.

Service Name Application DDE name.
Topic Additional DDE definition, for example, a file name or a

category of command (like the system  command in Excel).
Item Multiple items which identify the details in a topic, for

example, the cell location in a spreadsheet.
Path Location of application executables. Make sure that you point

the path to the DDE application in the Service Name field.
Command Data being sent, which can either be a literal value or a data

field value.

User can enter
their own path,
then trigger the
application via
an active link
button
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Figure 12-9 DDE/Poke Action

The Message Active Link Action

When you choose the Message action, an interactive error, warning, or note
will be displayed by any application that initiates a transaction that meets the
active link conditions. This is especially useful when combined with
qualifications so that you can check some conditions on the action request and
issue errors or warnings to the user if there is an unexpected condition.

To define the Message active link action:
1. Choose Message from the New Action drop-down list. The fields required

to define the message active link action are displayed, as shown in
Figure 12-10.

Figure 12-10 Message Active Link Action
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2. In the Message Text field, enter a string, up to 255 characters in length,
which will be the text of the notification message. The text may include
field substitution parameters or system keywords.
You can use the menu button next to the Message Text field to specify the
fields in the current schema as well as a list of keywords. You can simply
choose one of these fields or keywords to have it added to the text. In
addition, you can click the text edit button to open a text edit dialog box for
easier data entry, if desired.

3. Select a message type for the message. The message type will be
displayed with the message. The available message types are:

4. Specify a message number in the Number field. The message number will
be displayed with the message. The number you specify must be greater
than or equal to 10000. (Numbers under 10000 are reserved for AR System
messages.)

5. If you have finished defining the message active link action, click the Add
Action button. All actions for this active link appear in the Current
Actions list.

6. If you want to create an additional action for this active link, choose the
action from the New Action drop-down list.

7. When you have finished specifying active link actions, go on to specify
the active link permissions (see “Defining Permissions for Active Links”
on page 306).

The Run Macro Active Link Action

The Run Macro action lets you specify a macro to run whenever the active link
is executed. The macro may perform any operation or series of operations
(including performing an operation on another schema). If the macro contains
parameters, you can specify values for those parameters — including a value
from a field in the current AR.

Note Returns a note and continues the operation.The message type is
displayed as ARNOTE.

Warning Returns a warning and continues the operation. The message type is
displayed as ARWARN.

Error Returns an error and terminates the operation. The message type is
displayed as ARERR. No actions after an error message action will be
performed.



292 Action Request System Adminitrator’s Guide for Windows—December 1995

12

For example, you might designate the value entered in the “Customer Name”
field of the current AR for use as the parameter value in a macro that queries
the database for information about the specified “Customer.”

Note – To use a macro in an active link, you must first create the macro using
the User Tool. For information about creating a macro, see Chapter 6, Using
Macros, in the Action Request System User’s Guide.

The macro you specify is copied into the active link and recorded with the
active link. Changes you make to this macro after the active link is created will
not affect the operation of the active link. If you want the changes made to the
macro to apply to the active link, you must modify the active link and specify
the macro again.

To define the Run Macro active link action:
1. Choose Run Macro from the New Action drop-down list. The fields

required to define the Run Macro action are displayed, as shown in
Figure 12-11.

Figure 12-11 Run Macro Active Link Action

2. Select the macro from the Macro Name menu button that you want to be
performed when the active link is activated.

Menu button, used to
select fields or
keywords. This
button appears when
you click in any of the
macro name fields.
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3. If the macro contains parameters, a list of parameters appears. You can
enter any of the following as parameter values:
• A static value.
• A keyword.
• A reference to any field in the current schema.
A field reference must be enclosed within dollar symbols. (You cannot use
dollar symbols within the prompt.) For example, if you want the contents of
the Customer Name field to be used for a particular parameter in the macro,
enter $Customer Name$.

You can enter a field reference by clicking a macro name field with the
mouse. A drop-down list appears (see Figure 12-11 on page 292), which
allows you to open a list containing all the fields for the schema. (You also
can select from a list of keywords.) When you select a field from this list, the
field is automatically entered with the correct syntax.

Note – If you specify a field as a parameter, the macro uses the value that it
finds in the field on the window from which the active link was executed.

4. If you have finished defining the run macro active link action, click the
Add Action button. All actions for this active link appear in the Current
Actions list.

5. If you want to create an additional action for this active link, choose the
action from the New Action drop-down list.

6. When you have finished specifying active link actions, go on to specify
the active link permissions (see “Defining Permissions for Active Links”
on page 306).

Hints for Creating Macros for Active Links

When you are creating a macro to be used in an active link, there are several
important things to remember:

• Create the macro before you create the active link.
The macro must exist before you open the Active Link window. If you
forgot to create the macro in advance, you must close and reopen the Active
Link window in order for it to recognize the new macro.
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• If you modify the macro and want the modification to apply to the macro
when it is executed by the active link, you must modify the active link and
specify the macro again. This is because the macro is actually copied into
and recorded as part of the active link definition.

• While recording the macro, size and position any windows as you want
them to appear when the macro executes.
Take advantage of the fact that the macro remembers the size and position
of any window that it displays. For example, you may want to resize a
window to appear in the upper right corner of the user’s screen so that it
will not interfere with other windows the user has open. (Remember that
size and position of windows will vary according to the platform on which
the client is running.)

The Run Process Active Link Action

Choosing the Run Process action allows you to execute a command to run a
process. When the active link is executed, the system will execute the
command specified in the Command Line field. For example, you could
specify a program in the Command Line field that will launch a related
process, such as a program to display a graphical representation of a machine.

The command line also accepts references to values on the current screen if you
specify the field name enclosed in dollar signs ($). You can specify the field
name by selecting the list icon to open a list containing all the fields for the
schema. When you select a field from this list, the field is automatically entered
with the correct syntax.

Note – The Run Process action simply executes an independent
process — it does not return a value to the User Tool. This is not the same as
inserting the results of a process into a field using the Set Fields action (see
“Assigning Values from Process Results” on page 302).

When you design an active link that runs a process, it is important to be aware
of the hardware platforms and operating systems your clients may be using.
The process you are specifying may not be available on all platforms and
operating systems. If your users run the client tools on more than one type of
platform or operating system, you can build a qualification for the active link



Defining Active Links 295

12

using the $HARDWARE$ and $OS$ keywords to verify that the client is running on
an appropriate platform and operating system at the time the active link
executes. See “Building Qualifications” on page 218 for more information.

To define the Run Process active link action:
1. Choose Run Process from the New Action drop-down list. The fields

required to define the run process active link action are displayed, as
shown in Figure 12-12.

Figure 12-12 Run Process Active Link Action

2. In the Command Line field, enter the command that will execute when
active link conditions are met.
You can specify any of the keywords defined by the system (see “Table of
Keywords” on page 447). You also can substitute the value of any field of
the AR that the active link is firing on by enclosing the field name or ID in
dollar signs ($) in the text, for example, $Submitter$ . The keyword or field
will be expanded when the process is run. If the expanded value contains

Field contents can be passed
as parameters.
Enclose field name with
$ symbols.
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spaces, remember to enclose the value within quotes so that the AR System
will interpret it as a single value. If in doubt, use quotes. They will not
interfere and they may prevent a problem.

You can enter up to 255 bytes for your command definition. The command
can be up to 4096 bytes once the substitution parameters are expanded.

You can use the menu button next to the Command Line field to select the
available keywords and fields in the current schema. You then simply select
one of these fields to have it appended to the command. In addition, you
can select the text edit icon to open a text edit dialog box for easier data
entry, if desired.

Note – Remember to adjust your command syntax appropriately for whatever
platform your server is running and include the explicit path to commands, for
example, /home/jim/bin/ <command>. In the Windows environment, you also
need to specify the drive, for example, d:\home\jim\bin\<command.bat>  (for
the d: drive).

In the UNIX environment, the process will run under a Bourne shell.

Use quotes around substituted fields when the values may contain blanks or
other special characters, for example, /bin/cmd  "$<field>$"

If clients are running on different platforms that do not all support the same
process commands, use $HARDWARE$or $OS$ keywords in the qualification to
target the AR to run only on the appropriate platform.

Substituted field values containing carriage return or other special characters
may have unexpected results.

3. If you have finished defining the run process active link action, click the
Add Action button. All actions for this active link appear in the Current
Actions list.

4. If you want to create an additional action for this active link, choose the
action from the New Action drop-down list.

5. When you have finished specifying active link actions, go on to specify
the active link permissions (see “Defining Permissions for Active Links”
on page 306).
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The Set Fields Active Link Action

When you choose the Set Fields action, the resulting active link will load
specific values into selected fields for each transaction that meets the active
link conditions. This allows you to automate field updates for an entry. As in
filters, the value you assign to a field can be a simple static value, a keyword, a
field from another schema, the result of a function, or the results of an
executing process or arithmetic operation. For active links, you can also assign
a value from a DDE request operation performed on a Windows client. The set
field options are described in detail in the following sections.

Note – You can also assign values to hidden fields. A value assigned to a
hidden field will not appear on the screen; however, the value will be used in
any operation (including Submit and Modify operations) that includes hidden
values.

If you assign a value to a diary field, the value is appended to any user text
already in the field.

To define the Set Fields active link action:
1. Choose Set Fields from the New Action drop-down list. The fields

required to define the set fields active link action are displayed, as shown
in Figure 12-13 on page 298.
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Figure 12-13 Set Fields Active Link Action

2. From the Server Name drop-down list, select the name of the server from
which the AR System is to retrieve the value for the field. The default
drop-down list choice displays CURRENT SCREENfor the server you are
currently accessing.

3. From the Read Value for Field from Schema drop-down list, select the
name of the schema from which the AR System is to retrieve the value for
the field. The default drop-down list choice is CURRENT SCREEN if the
value is to come from another field on the same AR.
Selecting a schema from the Read Value for Field from Schema drop-
down list works in connection with constructing qualification statements to
locate ARs that contain specific data.
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Note – If you enter a server name and schema different than the
CURRENT SCREENbut you use a static value or a keyword or you do not
actually set a field from the remote schema, the server name and schema revert
to the CURRENT SCREEN.

4. If the data or value you want is on a different AR, create a qualification in
the Set Field If:  field to locate the specific ARs.

5. In the Name field, enter the field that you want to be automatically set
when the active link executes.

6. In the Value field, enter the values in the schema fields that you want to
be automatically set when the active link executes. You can use the menu
button next to the Value field to select the available fields, keywords, and
functions from the schema name in the Read Value for Field from

Schema field.

Note – Since active links execute with the permissions of the user, field values
set through an active link are updated only if the user has update permissions
for the field.

You can set the field values to any of the following:

• A static value. Enclose text values that include special characters (such as
parentheses, single quotes, or arithmetic operators) in double quotes.

• A keyword value (see “Assigning Keyword Values” on page 300).
• A value from another field in the same schema or another schema (see

“Assigning Values from Other Fields” on page 300).
• The value resulting from a specified process (see “Assigning Values from

Process Results” on page 302).
• The value resulting from a DDE request operation on a Windows client

(see “Assigning Values from a DDE Request” on page 304).
• The value resulting from an arithmetic operation (see “Assigning Values

Using Arithmetic Operators” on page 305).
• The value resulting from a function (see “Assigning Values Using

Function Results” on page 305).
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• A combination of the above. You might want to combine a static text entry
with a keyword, for example, 'Entry entered by' + $USER$ .

After you select both a name and a value, the field is automatically added to
the Field Name list for the set fields action. Repeat steps 5 and 6 for as many
fields as needed.

To delete fields from the list, select the fields and click the Delete Field(s)
button. (You also can delete the Fields Value to remove fields from the list.)

7. If you have finished defining the set fields active link action, click the
Add Action button. All actions for this active link appear in the Current
Actions list.

8. If you want to create an additional action for this active link, choose the
action from the New Action drop-down list.

9. When you have finished specifying active link actions, go on to specify
the active link permissions (see “Defining Permissions for Active Links”
on page 306).

Assigning Keyword Values

You can use any of the keywords listed in “Table of Keywords” on page 447 to
set a field value. The data type of the keyword value must match the field data
type. If there is no match, the system will attempt to convert the data type.
Most conversions are automatic. You can use the menu button next to the
Value field to select from a list of the available keywords.

Assigning Values from Other Fields

You can set a field to a value drawn from another field on the current screen or
an AR from the same or another schema (on the same or a different server).
Each action can draw data only from a single AR. However, you can use data
from multiple ARs by creating additional actions.

When you assign a value from an existing AR, you must specify the schema
that you want and define the Set Field If condition that will locate the specific
AR within that schema. If only one AR matches the qualification when the
active link executes, the requested values are pulled from the AR and loaded as
values on the current window. If no ARs match the qualification, an error
message is displayed and no action is taken. If multiple entries match, a
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selection list will appear so that the user can select the entry to use. (This
differs from filters and escalations which take the first AR that meets
qualifications if multiple matches are found.)

To assign a value from another field on the current screen:
1. In the Set Fields Active Link Action window, make sure the Server Name

and Read Value for Field from Schema field is set to CURRENT SCREEN.

2. From the Fields Name drop-down list, select the field where you want the
value loaded.

3. From the Fields Value menu button, select the field from which the value
will be drawn when the active link executes. The field is automatically
added to the set fields action.

To assign a value from a different AR:
1. From the Server Name drop-down list, select a server.

2. Use the Read Value for Field from Schema field drop-down list to select
the schema from which you want to retrieve the data.

3. From the Fields Name drop-down list, select the field where you want the
value loaded.

4. From the Fields Value menu button, select the field from which the value
will be drawn when the active link executes. The field is automatically
added to the set fields action.

5. Use the Set Field If field to define the qualification criteria that will locate
the specific AR from which the data will be drawn.
• Use the Fields cascading list to reference fields in the schema you are

drawing data from. These fields will be delimited with single quotes.
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• Use the Keywords cascading list to reference the value of a field in the
current transaction. These fields will be delimited with dollar signs ($).

For example, if you want to find the AR where the Entry Id field of the From
Schema contains the same ID as the Related-to field on the current screen,
the qualification would look like this:

'Entry Id' = $Related-to$

You can also search for a field using wild cards. The following example
would locate an AR where the contents of the Name field are LIKE the
contents of the User Name field on the current screen:

'User Name' LIKE "%" + $Name$ + "%"

Use the same general techniques to construct an active link qualification
statement as you use to construct a filter qualification. For a detailed
description, see “Building Qualifications” on page 218.

6. When you have finished defining the Set Fields active link action, click
the Add Action button.

7. Click the Save button on the toolbar.

Assigning Values from Process Results

You can set a field to the value resulting from running a specified process on a
UNIX client (not supported in the Windows and Macintosh clients). For
example, you may want to load information about the current system or
information retrieved from another data source (such as an existing database
holding contact information). To do so, you can define and run a process
output will be used as the value for a field.

The syntax for loading the return of a process is as follows:
$PROCESS$ <process-to-run>
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Note – Remember to adjust your command syntax appropriately for whatever
platform your server is running and include the explicit path to commands, for
example, /home/jim/bin/ <command>. In the Windows NT environment, you
also need to specify the drive, for example, d:\home\jim\bin\<command.bat>

(for the d: drive).

In the UNIX environment, the process will run under a Bourne shell.

Use quotes around substituted fields when the values may contain blanks or
other special characters, for example, $PROCESS$ /bin/cmd  "$<field>$"

Substituted field values containing carriage return or other special characters
may have unexpected results.

The keyword $PROCESS$ indicates that all following text is a command line.
The command line can include substitution parameters from the current screen
to allow values from the current screen to be placed into the command line
before it is executed. You can enter up to 255 bytes for your command
definition. The command can be up to 4096 bytes once the substitution
parameters are expanded. You can select substitution parameters (as well as
the $PROCESS$ string) from the Fields Value menu button.

When the active link is performed, the specified command line will be
executed and the User Tool will wait for the process to complete. All data
returned will be read by the User Tool and processed according to the return of
the process. If the process returns 0, the returned data is used as the value for
the field. The data is expected in ASCII format and is converted as needed to
match the data type of the target value. If the process returns a value other
than 0, it is assumed there was an error and the process failed. In this case, the
data returned is treated as the text of an error message and is displayed to the
user in an error box.

When you design an active link that loads field values from process results, it
is important to be aware of the hardware platforms and operating systems
your clients may be using. The process you are specifying may not be available
on all platforms and operating systems. If your users run the client tools on
more than one type of platform or operating system, you can build a
qualification for the active link using the $HARDWARE$ and $OS$ keywords to
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verify that the client is running on an appropriate platform and operating
system at the time the active link executes. See “Building Qualifications” on
page 218 for more information.

Assigning Values from a DDE Request

You can set a field to the value resulting from a dynamic data exchange (DDE)
request operation executed on a Windows client. DDE is a part of Microsoft
Windows and is a form of interprocess communication that uses shared
memory to exchange data between applications.

The syntax for loading the result of a DDE request operation is as follows:
$DDE$ < servicename>;< topic>;< pathtoprogram>[;<item>]

The DDE parameters hold the following information:

<servicename>The unique ID of the DDE application.

<topic>The topic name that identifies a logical data context.

<pathtoprogram>The location on the PC where the DDE service is found.

<item>(Optional) A string identifying a unit of data.

For example, you might enter the following:
$DDE$excel;sheet1;c:\excel\excel.exe;R1C1

This operation returns the contents of cell R1C1 of Sheet 1 in Excel to the
current field.

Refer to the Microsoft Windows documentation for more information on DDE.
To integrate the AR System with other Windows applications, refer to
Appendix C, DDE Functionality in the AR System in the Action Request
System User’s Guide for Windows. To integrate with another application, refer to
that application’s documentation as well.

The keyword $DDE$ indicates that all following text is a DDE command line.
The command line can include substitution parameters from the current screen
to allow values from the current screen to be placed into the command line
before it is executed. You can select substitution parameters (as well as the
$DDE$ string) from the Fields Value menu button.
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When the active link is performed on a Windows client, the specified DDE
request is executed and the User Tool waits for the operation to complete.
Whatever data the DDE request returns is then entered into the field.

If the active link is performed on a non-Windows client, an empty or null
string is returned.

Assigning Values Using Arithmetic Operators

You can use arithmetic operators to load a computed value. You can combine
an arithmetic operator with a static value, a keyword, a value from the current
screen or an existing AR, a function, a DDE request, or a value from a process.
The same arithmetic operators allowed for specifying qualifications are
allowed to build a computed value (see “Table of Operators” on page 444). The
operation must meet all the rules for arithmetic operators and produce a result
whose type is compatible with the target field. If you include a process or DDE
result in the operation, the process definition must not be contained within
parentheses and it must be the last item in the operation since all data after the
keyword $PROCESS$ is considered to be part of the command line.

Note – If you include either a process result or a DDE operation in a
mathematical operation, they must not be contained within parentheses and it
must be the last item in the operation since all data after the keyword is
considered to be part of the operation.

Here are some examples of valid arithmetic operators:
$TIMESTAMP$ - $CREATE-DATE$

$FIRST NAME$ +'' '' + $LAST NAME$

''hostname ='' + $PROCESS$ hostname

Assigning Values Using Function Results

The AR System supports a set of functions that you can use in the set fields
action. The functions allow you to manipulate data so that you can control
various aspects of values you are loading into fields. For example, you can use
the UPPER function to convert the value loaded in a field to all uppercase.
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To use a function in the set field operation:
1. From the Fields Name drop-down list, select the field where you want the

value loaded.

2. From the Fields Value menu button, choose the Function cascading list to
see a list of the available functions.

3. Select the function you want to use. It will appear in the field with a set of
parentheses to the right.

4. Within the parentheses, enter any arguments that are appropriate for the
function you have selected. (With the exception of $PROCESS$, you can
include keywords, field values, other functions, and arithmetic
operations).

Note – If the value of any of the arguments of a function is NULL, the result of
the function is NULL (the field is blank). To avoid this result, use a
qualification that tests that the transaction includes a value for all arguments.

Information about each of the functions supported by the AR System is
provided in Table 10-1 on page 247.

Defining Permissions for Active Links
The Permissions active link property setting lets you determine which access
control groups will be able to use the active link. By default, the group access
for any new active links is already set to their default permissions.

Note – If a user has access to an active link, the link will execute for that user
whenever the basic conditions for the link are met. If a user does not have
access, the link does not execute and the user’s view of the schema does not
show an active link button, even if one is defined.

To define permissions for an active link:
1. Select Active Link from the Server Window.

2. Select an active link from the Active Links list. The Modify Active Link
window appears.
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3. Click the Permissions tab (Figure 12-4 on page 275) to set active link
permissions globally for each group defined for a server.

Figure 12-14 Permissions — Active Link Window

4. In the No Permission list, double-click the group for which you want to
assign access (or select a group, then press the Add button). Groups with
access to the active link appear in the Permission list.You can also do the
following:
• Click the Remove button to delete a group from the Permission list.
• Click the Add All button to add all the groups to the list.
• Click the Remove All button to delete all the groups from the list.
• Click the Set to Defaults button to reset the active link to its default

permissions (for more information, see “Setting Default Active Link
Permissions” on page 57).

5. Click the Save button on the toolbar to save the group access settings.
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Defining Group Permissions for Multiple Active Links
The Administrator Tool lets you do bulk assignments of group permissions for
all active links within a server. Rather than going through each active link
individually to assign permissions for a group, the Group Permissions dialog
box lets you assign them all at once.

The Group Permissions dialog box is particularly useful when you have added
a new access control group since the active links were created. You use this
dialog box to assign the new group access for each active link instead of having
to open each active link and modify the conditions for each active link.

Note – The Administrator Tool offers several different ways to set permissions.
For example, when creating an active link, you might give access to the Public
group. However, if you decide that you want to deny the Public group access
to active links, you then can use the Group Permissions dialog box to set the
group permissions for all active links at the same time.

To define permissions for multiple active links on a server:
1. In the Server Window, select a server, then double-click Groups to see a

list of groups defined on the server.

2. Double-click a group from the Groups list. The Group Permissions dialog
box appears (Figure 12-15 on page 309). You use this dialog box to set
group permissions for schemas, fields, and active links.

3. Click the Active Link Permissions tab. All the active links defined for the
server appear. You use this window to set active link permissions for each
group defined for a server.
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Figure 12-15 Active Link Group Permissions Dialog Box

4. To assign active link access to a group, select a schema from the Schema
drop-down list. All the active links for that schema appear in the No
Permissions list.

5. Double-click the active link for which you want to define permissions (or
select an active link, then press the Add button). You can also do the
following:
• Click the Add All button to give permissions for all the active links to the

group.
• Click the Remove button to delete an active link from the Permissions list.
• Click the Remove All button to delete all the active links from the

Permissions list.

6. Click the OK button to save the permission settings.
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Building and Using Active Link Change History
The AR System lets you record information about the owner of an active link,
the user who last modified it, and the date of the modification. You can display
this information at any time by clicking the Change History tab in the Active
Link window.

The basic steps involved in creating active link change history are just like the
steps to define filter change history as described in “Building and Using Filter
Change History” on page 251.

Creating End-User Help for Active Links
Clicking the Help Text tab in the Active Link window brings up a Help Text
editing window. You can supply help text for the active link here. In most
cases, this help text is simply a description of the active link, what it does, and
how it is used. User Tool users will be able to view this help text in the same
way that they can view help text that is available for fields.

The basic steps involved in building active link help text are just like the steps
to define filter end-user help as described in “Setting Help for Filters” on
page 252.
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Importing and Exporting
Definitions 13

This chapter describes how to use the Import and Export commands to transfer
schema, menu, filter, escalation, and active link definitions from one server to
another. A definition is the structure in which the data in the AR System is
organized and manipulated (for example, for fields or active links).

This chapter also describes how to create mail templates for submitting ARs
using electronic mail.

This chapter covers the following topics:

• Importing definitions.

• Exporting definitions.

• Exporting mail templates.

Importing and Exporting Definitions
The Import and Export commands are located under the Tools menu in the
Server window.
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• The Import command lets you import schema, filter, active link, escalation,
and menu definitions to a server. If you want to move a definition from one
server to another, first export it from the current server (which saves the
structure definition as an ASCII file), and then import the definition into the
AR System on the destination server.
To import data into your server, use the AR System Import Tool. The Import
Tool can import data in the AR Export, CSV, and ASCII file formats. To use
the AR Import Tool, refer to Chapter 14.

• The Export command lets you export schema, filter, active link, escalation,
and menu definitions to a file.

Importing Definitions

Follow these steps to import definitions to a server.

Note – You cannot use the Windows Administrator Tool to import definition
files larger than 32K from pre-2.0.2 UNIX servers. If this is an issue for you, use
the Motif Administrator Tool instead.

This is not an issue for the 2.1 AR System NT server or 2.0.2 (or later) UNIX
servers.

To import definitions:
1. Open a Server Window.

2. Select a server from the Servers list. The currently available servers are
listed.

3. Choose Import Definitions from the Tools menu.
The Import File selection dialog box appears.

4. Specify the filename (generally with a .def extension) containing the
definitions you wish to import.

5. Click the OK button. The Import Definitions dialog box appears, as
shown in Figure 13-1 on page 313. The names of the object definitions in
the file you specified are listed in the Import Definitions dialog box.
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Figure 13-1 Import Definitions Dialog Box

6. Click the tabs in the dialog box to select as many definitions as desired.
• Select a definition by choosing an item from the File list, then clicking the

Add button.
• Select all definitions for each object (for example, Schemas) by clicking the

Add All button.
• Select all definitions for the entire file by using the Select All Items check

box.

Note – Import operations involving large amounts of data can take a great deal
of time and require a great deal of space. You should make sure you have
adequate resources before you begin the operation. You may want to perform
such operations during hours when users do not require access to the system.

You may wish to rename a definition from the file prior to completing the
import, since you may not import a definition whose name already exists in
the target server. Change the definition name by selecting the name from the
Import list and providing a new name in the New Name field.
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7. Click the Import button to import the definitions to the current server.
The new definition names will automatically appear as selections in their
respective categories the next time that you start or log into the
Administrator Tool.

Note – If you import an active link which sets a field to a specific value that
uses the $MENU$ pattern and the menu is not already present on the server, the
import will fail. You must import the menu first and then import the active
link.

Exporting Definitions

This section describes how to export definitions to a file. For information about
exporting mail templates, see “Exporting Mail Templates” on page 316. For
information on exporting data, refer to Chapter 5, Reports in the Action Request
System User’s Guide for Windows.

To export definitions:
1. Open a Server Window.

2. Select a server from the Servers list. The currently available servers are
listed.

3. Choose Export Definitions from the Tools menu.
The Export Definitions dialog box appears, as shown in Figure 13-2 on
page 315. The Export Definitions dialog box lists all available schemas,
filters, active links, menus, and escalations in a scrolling list. This is where
you select the definitions you want to export.

4. Choose the object definitions that you want to export by clicking the
appropriate tab. For example, to export schema definitions, click the
Schema tab.
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Figure 13-2 Export Definitions Dialog Box

5. Select as many individual object definitions as desired from the list on
the left. Use the scroll bars to see all items in the list.
• Add a definition for an object by double-clicking the item from the list on

the left (or select an item, then click the Add button).
• Remove a definition for an object by double-clicking the item in the

Export list (or select the item, then clicking the Remove button).
• Select all definitions for an object by using the Add All button.
• Remove all definitions for an object by clicking the Remove All button.

6. Select the Related Items check box to export all other definitions that are
related to the item(s) selected for export, as follows:
• If you select a schema, the export operation will include all related filters,

active links, escalations, and menus.
• If you select a filter, the export operation will include all related schemas

and all related items for those schemas.
• If you select an escalation, the export operation will include all related

schemas and all related items for those schemas.
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• If you select an active link, the export operation will include all related
menus and schemas and all related items for those schemas.

If you do not select the Related Items check box, the export operation will
include only the selected items themselves.

7. Select the Server Independent check box to specify that the export
operation should remove references to the current server when the
definitions are exported. Selecting this option allows connection to items
on the new server when the definitions are imported.

Note – When active links are exported with the server independent option, any
server names in embedded macros are changed only if the server name is the
current server; otherwise the server names remain intact.

8. Click the Export button.
The Export File dialog box appears that you use for file selection.

9. In the Export File dialog box, specify where you want the definitions
stored.
By default, all the definitions you selected will be stored in a single file with
a .def  extension. However, you can specify any filename and extension
you want. If you select a file that already exists, a File Exists dialog box
appears, prompting you to overwrite, append, or cancel the action.

The actual export will not occur until you complete your actions in the
Export File dialog box. When the export is finished, an Export Complete
message appears.

10. Click the OK button.

Exporting Mail Templates

A mail template is a form for submitting ARs to the User Tool through email.
You can use the Export utility to generate mail template files for schemas. (You
also can create these templates using an editor.) You can then distribute these
files to users.

For more information about mail templates and how the AR System supports
email, see Chapter 15.
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To export a mail template:
1. Choose Export Schema Mail Templates from the Tools menu.

The Export Mail Templates dialog box appears, as shown in Figure 13-3.

Figure 13-3 Export Mail Templates Dialog Box

2. Select one or more schemas for which you want to generate mail
templates.

3. Click the Export button.
An Export File dialog box appears that you use for file selection.

4. In the Export File dialog box, specify where you want the templates
stored.
By default, all the templates you select at a given time will be stored in a
single file with a .arm extension. However, you can specify any filename and
extension you want. If you select a file that already exists, a File Exists
dialog box appears, prompting you to overwrite, append, or cancel the
action.

The actual export will not occur until you complete your actions in the
Export File dialog box. When the export is finished, an Export Complete
message appears.
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5. Click the OK button. The dialog box disappears.
The templates are saved in an ASCII file that you can distribute to users for
use with their mail programs.
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Using the Import Tool 14

The Action Request System Windows Import Tool allows you to bring data
into a schema from a file. The Import Tool’s mapping capability allows you to
specify the information to be imported from the originating source and the
fields that will contain that information on the destination schema. You can
import data directly from AR Export files, Comma Separated Value (CSV) files,
or ASCII files.

The Windows Import Tool runs on a PC-compatible client computer running
Windows.

This chapter includes information on the following topics:

• Starting and exiting the Import Tool.

• Importing data into a schema.

• Mapping information from the source to the destination schema.

• Setting Import Tool preferences.

Import Tool Functions
You use the Import Tool to import data and records from other AR servers or
from other applications into your AR server.
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To import data into a schema, you must have modify permissions for the fields
that you wish to import to. For system fields like Create-date, you must be the
Administrator or Subadministrator of the schema.

The Import Tool includes the following functionality:

• Lets you import data from a wide variety of sources (for example, databases
or spreadsheets) and formats (.csv , .asc , and .arx ).

• Lets you “map” data sources to specific fields in your schemas, even if the
data sources have different names than your fields.

• Lets you interactively handle bad records on a record-by-record basis with
its sophisticated error-handling capability.

Note – You do not use the Import Tool to import definitions into the server. For
information on importing definitions, see Chapter 13.

Starting the Windows Import Tool
Before you start the Import Tool, make sure you have the following:

• The Import Tool must be installed on a PC-compatible client computer
running Windows. To install the Import Tool, see “Installing the Software on
a Windows Client” on page 3.

• Your registered AR System user name and password.

Your user name and password identify you to the AR System and give you the
appropriate access permissions.

To start the Import Tool:
Once the AR System Import Tool is installed, your desktop automatically
displays the Remedy AR System  group window containing the AR Import icon.

1. To start the tool, double-click the AR Import icon.

2. If you are starting the Import Tool for the first time, the Login dialog box
appears. Enter your registered user name and password, then choose the
OK button.
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Logging In as a Different User
If the Import Tool was previously started by another user, you can change the
user information and log in as yourself. This means that you can log in at any
machine on the network that has access to the AR System server.

You also can change the login information of all users by clicking on the Login
Information button on the Login dialog box. For more details, see “Login
Information” on page 15.

Using the Toolbar
For many of the most commonly performed menu items, a corresponding
button is available from the optional toolbar located below the menu bar on the
Import Tool window. To select a function from the toolbar, simply click the
mouse on the button for that function.

Table 14-1 shows the toolbar buttons and their functions.

Table 14-1 Toolbar Functions  (1 of 2)

Button Function
Key
Sequence

Open Schema. The Open Schema dialog box appears,
which lets you select the schema that you want to
import data into. (You also can choose Open Schema
from the File menu.)
The Open Schema button is disabled if you do not have
access to any schemas on any server.

Ctrl+0

Open Import File. The Open Import File dialog box
appears, which lets you select an import file containing
the information you want to import into the schema.
(You also can choose Open Import File from the File
menu.)

Ctrl+I
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Displaying Import Tool Help
Application help information is available on all Import Tool windows and
commands. Help is also available on many of the procedures that you most
commonly perform.

To display Import Tool help:
• From the Help menu, choose Contents to see an index of available help

topics.

• Pressing the F1 key or clicking the Help button when any Import Tool
window or dialog box is open causes the help for that window to appear.

Exiting the Import Tool

To exit the Import Tool:
You can exit the Import Tool by any one of the following ways:

• Choose Exit from the File menu.

Load Mapping. The Load Mapping dialog box appears,
which lets you load a field mapping that you previously
created. (You also can choose Load Mapping from the
Mapping menu.)

Ctrl+M

Save Mapping. The Save Mapping dialog box appears,
which lets you create and save a mapping for future use.
(You also can choose Save Mapping from the Mapping
menu.)
The Save Mapping button is disabled until you mapped
at least one field.

Ctrl+S

Start Import. Starts importing data from the import file
into the schema. Confirmation warning appears.
The Start Import button is disabled until you mapped at
least one field.
(You also can click the Import! menu.)

Table 14-1 Toolbar Functions  (2 of 2)

Button Function
Key
Sequence
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• Type Alt+F, then X .

• Type Alt+F4 .

• Choose Close from the Control menu box in the upper left hand corner of
the Main window.

• Double-click the Control menu box.

Note – If your Import Tool is in the middle of an import from the server, you
will not be able to exit the Import Tool until the import is completed or you
stop the import.

Displaying Version and Environment Information

To display version and environment information about the Import Tool:
• From the Help menu, choose About Import Tool to display information

about the product.

Importing Information from Different Sources
You use the Import Tool to load data from another source into an AR System
schema. The Import Tool expects the data to be in one of three formats:

Importing from an AR System Source

Data from an AR System source can be in any of the accepted formats. All
formats must have all fields of each record on a single line.

The recommended format choice is the AR Export format. This is the most
straightforward method of transferring AR System data.

Table 14-2 AR Import Data Formats

Data Format Extension

AR Export. .arx

Comma Separated Value (CSV). .csv

ASCII. .asc
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If you cannot use the AR Export format, the second choice should be the CSV
format.

Note – In CSV format, the Import Tool interprets \n  in the data as a new line
character. However, in ASCII format, \n  is interpreted as a literal string "\n ".

If you must use the ASCII format, then generate the data file from the User
Tool in the Compressed Text format, and set the Title, Header, Footer, and
Column Title separator strings to empty in the Report Preferences dialog box.
You should also set the Page break per to None and the Column titles per to
Page. Finally, make sure the column separator string does not appear
anywhere in the data records. Set the column separator to a unique string. You
must use the same separator string for the data import operation.

Note – You can only use the Windows Import Tool to load data fields up to
32,767 bytes (32K minus 1 byte) in size. If you need to update a data field
larger than 32,767 bytes in size, use the Motif Import Tool instead.

Importing from a Non-AR System Source

Data from a source outside the AR System must be in comma separated value
(CSV) format or, if it is not possible to generate CSV output, ASCII format.

If you generate a file for import and must use the ASCII format, save the data
with a unique separator string. You must use the same separator specification
for the data import operation.

The Import Tool can read data files in either the UNIX or DOS formats.

To import data using the Import Tool:
1. Start the Import Tool according to the instructions in “Import Tool

Functions” on page 319. The Import Tool window appears as shown in
Figure 14-1 on page 325.
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Figure 14-1 Import Tool Window

Note – All read-only fields in the Import Tool have a gray background.

2. Open the schema that you want to import information into by clicking the
Open Schema button on the toolbar (or choose Open Schema from the
File menu), selecting the schema name from the list in the Open Schema
dialog box, then choosing the OK button. The destination schema name
will appear in the Schema Fields box in the Import Tool.

Note – If your schema contains duplicate or empty field labels, those fields will
appear in the Schema Fields list as their field IDs.

3. Open the file that contains the information you want to import by clicking
the File button on the toolbar (or choose Open Import File from the File
menu). The Open Import File dialog box appears as shown in Figure 14-2
on page 326.

Read-only field
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Figure 14-2 Open Import File Dialog Box

a. Select the file format of the file you want to import by choosing a file format (*.arx ,
*.csv , or *.asc ) from the List Files of Type menu.

If you have a file that is in one of these formats but does not have the above
extensions, you can select the file type, then enter *.* in the File Name field to
see all the files (for example, a .txt  format), then select the file you want to
import.

b. Use the Directories list to navigate through the directory structure in order to
locate the import file. Then, click on the file name from the File Name list.

c. If the file is CSV or ASCII format, specify whether or not the file includes titles by
selecting or clearing the File Contains Field Titles field check box.

If you select this check box, the Import Tool treats the first record of the file as a
list of field titles. Otherwise, it will generate default titles (for example, Field-01 ).

If the file contains titles, you must select the File Contains Field Titles check box.
Otherwise, the Import Tool will treat the first record the same as the rest of the data
in the file and generate default titles.
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d. If the file is ASCII format, enter a character string to be used as the field separator
within the import file in the Field Separator field. For example, “, ”. Use \t  for tab,
\b  for backspace, and \\ for \ . The separator can be a maximum of 32 characters.

e. Click the OK button to load the fields from the import file into the Import Tool’s
main window. The Open Import File dialog box disappears.

Note – If your import file contains duplicate field titles, a warning dialog box
appears. If your file is .arx  format, the fields will appear as their field IDs. If
your file is .csv or .asc  formats, the fields will have a count appended, as in
the following example:
<field_title> [1], <field_title> [2], and so on.

If the Import Tool warns that there is only one field in the import file, you may
have specified the wrong file format. For example, if the file is in record format
but you specified .csv or .asc , this warning will appear.

4. Specify how the data you are importing should be mapped to the fields of
the destination schema according to the instructions in “Mapping Import
Fields” on page 328.

5. If desired, specify default field values for the import operation according
to the instructions in “Defining Fallback Mappings” on page 335.

6. Click the Import button on the toolbar to load the source information into
the schema. Each record in the source file will generate a single AR. (The
import operation also creates an import log file. See “Using the Import
Tool Log File” on page 337 for using information copied to the log file.)

7. After you click the Import button, a confirmation warning appears, asking
if you are sure you want to start importing. Click the Yes button to
continue. An import status message appears (Figure 14-3 on page 328),
listing the number of records processed. If you need to stop importing for
any reason, click the Stop button.
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Figure 14-3 Import Status Dialog Box

After you finish importing, an import information message appears,
describing the following:

Note – If you stop the import before it ends, you are prompted to copy
unprocessed records to the log file. You may not want to copy unprocessed
records to the log file if your import data file is large.

Mapping Import Fields
When you import information, you specify which pieces of information from
the source file should be “mapped” (loaded) into which fields in the
destination schema (see Figure 14-1 on page 325). You can map fields one at a
time or all at once. Fields that you map to each other do not need the same
name. In fact, you can even mismatch data if you are not careful, for example,
mapping character data to selection field data or phone numbers into first
names.

You can map multiple fields to more than one schema field. You can also map
multiple import values to a single schema field or map fields to a keyword, as
in the following:

The Import Tool in Figure 14-4 on page 329 maps two import fields into one
schema field and, with a keyword, substitutes today’s date for the create-date:

If your import... Then the Import Information dialog box displays...
Succeeds How many records were imported.
Partially succeeded or is
stopped by you

How many records were processed and how many were
imported. When the warning dialog appears, click the Yes
button to copy unprocessed records to the import log file.

Failed. An explanation of the error you received from the AR server.

CS Call ID $Product$   $Version$

Modified-date $TIMESTAMP$
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Figure 14-4 Import Tool Window (with Fields Mapped)

To map import file fields to schema fields:
1. Select the destination schema and the import file in the Import Tool

window and set the import parameters according to the instructions in the
previous section, “Importing Information from Different Sources.”

2. From the Schema Fields list, click on a field name. The name appears in
the Schema Field entry field.

3. Choose either Import Fields or Keywords from the Mapping Values drop-
down list. The drop-down list lets you choose either a list of the fields in
the import file or a list of keywords.

4. Choose the import field or keyword you want mapped to the schema field
you selected in Step 2
• You can click on a field name from the Import Fields list to display it in

the Mapping Value field. The result will be a mapping of data from the
import field in the file to the schema.
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• You can click on a keyword from the Keywords list. For example, if you
enter the Create-date field in the Schema Field entry field and you want
each record in the import file to have today’s date as the value of its
Create-date field, you can click on DATE in the keywords list to insert it in
the Mapping field. When you import the file, the resulting value will be
the current date. For more information on keywords, see “Table of
Keywords” on page 447.

If you prefer, you can type field names, keywords, or any string directly into
the Mapping Value field.

You can map more than one value to a single schema field by entering
characters after the first value then selecting (or typing) a second value.

5. Click the Add button to create the mapping for the field.
Note that the field is removed from the Schema Fields list.

6. Continue selecting schema fields and import field mappings until you
have mapped all the fields you want to import.

7. To map all the import fields directly to the schema fields with the same ID
or field name, click the Add All button. The Import Tool will try to match
data to schema fields as follows:

Make sure you double check the mappings to make sure all fields matched
correctly. You can resolve unmatched or incorrectly matched fields by
mapping the fields individually.

Note – If Add All is successful, no entries will be left in the Schema Fields list.
If the matching was partially successful, it will add all the matches that it
found. If it did not find any matches, an informational dialog will be posted
saying it was not able to find any matching fields.

8. To modify a field mapping, select the mapping in the Mapping list. The
Add button will become a Modify button. Change the values in the
Mapping Value field as required, then click the Modify button.

Import File Format Matching (for Add All button only)
AR Export Field IDs (attempted first)

Field names, case insensitive (attempted second for
fields not yet matched)

CSV Field names, case insensitive
ASCII Field names, case insensitive
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9. To delete a field mapping, select the mapping in the Mapping list and
click the Delete button. Click the Delete All button to delete all the
mappings from the list.

10. When you have completed your mapping, your Import Tool window will
look similar to that shown in Figure 14-5.

Figure 14-5 Import Tool Main Window with Mappings Completed

11. Once all settings in the Import Tool main window are as you want them,
click the Import button on the toolbar to load the source information into
the schema. Each record in the source file will generate a single AR. (The
import operation also creates an import log file. (See “Using the Import
Tool Log File” on page 337 for using information copied to the log file.)

Note – You do not need to map all the schema fields before starting the import.
You only need to map the fields that you want to import.

When all fields are
mapped, Schema
Fields box is blank.



332 Action Request System Adminitrator’s Guide for Windows—December 1995

14

Saving Field Mappings

You may want to save a mapping you create for future use. This can save you
a great deal of time if you regularly perform the same import operation.

When you save mappings, the entire set of information is saved. This includes
the schema name, the server name, the import file name, all mappings, all
fallback mappings, and all error-handling, data, and date/time preference
information.

To save mapping information:
1. Specify map settings in the Import Tool main window.

2. Click the Save Mapping button on the toolbar (or choose Save Mapping
from the Mapping menu). The Save Mapping dialog box appears
(Figure 14-6).

Figure 14-6 Save Mappings Dialog Box

3. Enter a name in the Mapping Name field. This name will become the file
name for the mapping file.

4. Specify the directory that will contain the mapping file by choosing from
the list of available directories. You also can type the directory name
directly into the Path field.
You can click the Browse button to use the directory browser to locate the
path where the mapping file is to be stored.

5. Optionally, you can enter text in the Help Text field to describe the
mapping file you are saving.
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6. Click the Save Log Filename check box if you want to use the current
directory and path name of the import log file when you load the
mapping.
The import log file logs error messages encountered during the import
process.

7. Click the OK button to create the mapping file. If a file by the same name
already exists, you will be asked if you want to overwrite the file. Click
Continue to overwrite the file. Click Cancel to cancel the save operation.

Note – The Windows Import Tool cannot write out or read in a mapping file of
64 kilobytes or greater. Use the Motif Import Tool for that size of mapping files.

The Windows Import Tool can only write out and read in mapping files in the
PC format, that is, with CR LF at the end of each line. Mapping files in the
Motif file format, with LF at the end of each line, need to be converted to the
PC format before being loaded by the Windows Import Tool.

Using Saved Field Mappings

You can load mappings you previously saved by following the steps below.

To use an existing mapping file:
1. Click the Load Mapping button on the toolbar (or choose Load Mapping

from the Mapping menu). The Load Mapping dialog box appears
(Figure 14-7 on page 334).



334 Action Request System Adminitrator’s Guide for Windows—December 1995

14

Figure 14-7 Load Mappings Dialog Box

2. Specify the directory that contains the mapping file by choosing from the
list of available directories.
Selecting All lists the mappings in all directory paths in which you stored
mappings.

3. Select the mapping file from the Mappings list. Its directory is listed in
the Mapping’s Path field.

4. Click the OK button. The mappings will be loaded into the Main window
as well as the Fallback Mappings and Preferences dialog boxes.

Note – Loading a mapping file will change your saved preferences to be the
same as those in the mapping file.

Considerations for Importing Data

Because sizeable performance impacts can occur if you are importing a lot of
data into a schema with Full Text Search (FTS) fields, you should consider
shutting down FTS from the AR System Administrator Tool before importing
the data. For instructions, see “Importing Data into Schemas with FTS Fields”
on page 405.

You should factor in the following when deciding whether to shut down FTS:

• Size of the database.
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• When will you re-index the database.

• How soon you need the data.

One more consideration: do not edit the import file between the time you start
the Import Tool and the time you start the actual import of data. (See “Using
the Import Tool Log File” on page 337 for using information copied to the log
file.)

Defining Fallback Mappings
You can define fallback mappings to tell the Import Tool what to do if there is
a problem importing data.

Fallback mappings are used when the import value is invalid for the schema
field type. For example, if the schema field is of type integer and the import
value is a string (such as “name”), the fallback mapping for the field will be
used, if one is defined.

In cases where an error can only be detected by the server, the Fallback
mappings will not be used. For example, the import data may be valid for the
field type but not an acceptable value (for example, if the schema field has a
range of 1 to 10 and the import value is 11 or if a required field has a null
value).

To set fallback mappings:
1. In the Import Tool main window, choose Define Fallback from the

Mapping menu (or type Ctrl+F ). The Fallback Mappings dialog box
appears, as shown in Figure 14-8 on page 336. The Schema Fields list
contains a list of the fields for the currently selected destination schema.
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Figure 14-8 Fallback Mappings Dialog Box

2. Select the field you want to specify a fallback mapping for from the
Schema Fields list. The field name appears in the Schema Field field.

3. Specify the fallback mapping by selecting a keyword from the Keywords
list or by typing a value into the Fallback Mapping Value field.
If you prefer, you can type keywords directly into the field.

You can map more than one keyword or string to a single schema field by
entering a space or other character after the first value then selecting (or
typing) a second value.

4. Click the Add button to add the mapping to the Fallback Mapping list.

5. To modify a mapping, select the mapping in the Mapping list. The Add
button will become a Modify button. Change the values in the Schema
Field and Mappings fields as required, then click the Modify button.

6. To delete a mapping, select the mapping then click the Delete button. To
delete all current fallback mappings, click the Delete All button.

7. Once you have specified all the fallback mappings you want to specify,
click the OK button.
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Using the Import Tool Log File
The import operation creates a log file that you can use for diagnosing import
problems. If you have set Import Tool preferences to alert you of bad records or
to use fallback options, a dialog box appears (Figure 14-9), informing you that
an error has occurred each time a record cannot be successfully imported.

Figure 14-9 Import Error Dialog Box

You can then select one of three options:

You may also set error handling preferences so that records that cannot be
imported are skipped automatically and recorded in the import log, or to use
the fallback mapping, then only alert you if the fallback mapping also had an
error.

No matter how you set preferences, the import log file contains detailed
information on every error that occurred, including information that was not in
the error dialog. It also contains a copy of every record that caused an error.

Once the import operation is ended, you can open the import log to examine
the records in error. You can then edit the import log to correct the problem
that caused the error and, if you copied all remaining records to the log file,
you can choose to complete the data import operation by using the corrected
import log itself as the import source file, after removing all non-data
information from the file.

Yes You can skip the record and import the rest of the data. The record
in error will be written to the import log and the Import Tool will
continue importing the remaining data.

Yes to All You can skip all records with the same error(s) and import the rest
of the data. The records in error will be written to the import log
and the Import Tool will continue importing the remaining data.

Stop Import You can stop the import operation at that point with the option to
copy all remaining data to the import log.
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Alternatively, you can examine the import log to identify the cause of the
problem then correct the problem in the original source file and re-import from
that file. If you choose this alternative, be sure to delete any data from the
source file that was imported successfully during the original import operation
to avoid creating duplicate ARs.

Setting Import Tool Preferences
You can set preferences that control the behavior of the Import Tool, including
how you want the tool to perform error handling and data transformations and
other options you want to set.

Desktop Preferences

These preferences define the appearances of the Import Tool.

To set desktop preferences for the Import Tool:
1. Choose Preferences from the File menu. The Import Tool Preferences

window appears as shown in Figure 14-10.

.

Figure 14-10 Import Tool Preferences — Desktop Dialog Box
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2. You can select any of the following desktop options:

3. Click the OK button to accept the options settings, or click another tab to
set other options.

Error Handling Preferences

These preferences define how the Import Tool deals with records that cannot
be imported and records that contain entry-IDs which duplicate those already
in the schema.

To set error handling preferences for the Import Tool:
1. Choose Preferences from the File menu.

2. In the Preferences dialog box, click the Error Handling tab. The Import
Tool Preferences window appears as shown in Figure 14-11 on page 340.

Maximize
Application

Select to have the Import Tool Main window fill the entire screen
(maximize) on startup.

Always Prompt for
Login

Select if you want to be prompted for your login every time you
open the Import Tool. This setting is useful when more than one
user uses the same workstation.

Shows Status Bar Select to cause the status bar to appear at the bottom of the
window. Clear to hide the status bar.

Show Toolbar Select to cause the toolbar to appear below the menu bar. Clear to
hide the toolbar.

Save Window Size
and
Position on Close

Select to cause the AR System to remember the size and position of
all windows. The size and position are used the next time you
open that window.

AR Path Specifies the directories where you can access mapping files. Enter
the entire directory name for each directory you want to access.
The default value is <ar_config_dir>\arcmds . You also can enter
multiple pathnames by separating them with a semi-colon (;).
You also can click the Browse button to specify a new directory to
be added to the path.

Import Log File Enter a directory and path name for a file that logs error messages
encountered during the import process.
The default value is <ar_config_dir>\arimport.log .

Reset Log File at
Login

Select if you want to purge the import log each time you log into
the Import Tool. If you do not reset the log file, you have to
monitor the size of the file more closely. The log file can grow
quite large depending on what is added to it during importing.
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Figure 14-11 Import Tool Preferences — Error Handling Dialog Box

3. To select or clear an option, click the option. You can select any of the
following error handling options:

4. Click the OK button to accept the options settings, or click another tab to
set other options.

Bad Records Alert User with
Popup Dialog

The import process is interrupted and you receive
an error dialog.

Skip Bad Records The record is not imported in the schema and the
Import Tool will not alert the user before
recording the error to the log file.

Try
Fallback Mapping
before
Alerting User

The Import Tool uses the fallback mapping that
you specify for the field in the Fallback Mappings
dialog box. If the fallback mapping also produces
an error, it will alert the user.

Duplicate Entry
ID

Generate New ID
for All Records

New Entry IDs are assigned to all of the ARs in
the import file.

Reject
Duplicate Records

The existing ID will be used for all entries
imported. If an ID is already in use, an error will
be returned.

Generate New ID
for Duplicate
Records

Entries will be imported using their existing IDs.
If an ID is already used, a new ID will be
generated for the new record.
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Data Preferences

These preferences deal with how data and values are handled in import files.

To set data preferences for the Import Tool:
1. Choose Preferences from the File menu.

2. In the Preferences dialog box, click the Data tab. The Import Tool
Preferences window appears as shown in Figure 14-12.

Figure 14-12 Import Tool Preferences — Data Dialog Box

3. To select or clear an option, click the option. You can select any of the
following data preference options:

4. Click the OK button to accept the options settings, or click another tab to
set other options.

Remove leading and
trailing spaces and tabs

If set, all leading and trailing white space (blanks and tabs) is
removed from values before they are imported. If not set,
values are imported as they are in the import file.

Truncate string exceeding
field limit

If set, any character values that are too long for the target field
are truncated. If not set, an error is reported if a value will not
fit within the field limits.
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Date/Time Preferences

These preferences should reflect what data format is in your import file.

Note – Make sure the date/time preferences that you set here match the dates
and times in your import file.

To set date/time preferences for the Import Tool:
1. Choose Preferences from the File menu.

2. In the Preferences dialog box, click the Date/Time tab. The Import Tool
Preferences window appears as shown in Figure 14-13.

Figure 14-13 Import Tool Preferences — Date/Time Dialog Box

3. To select or clear an option, click the option. You can select any of the
following date/time options:

Short Date
Format

Select the format of the date fields in your import file and specify
the separator character between the month, day, and year.

Long Date
Format

Select the format of the date fields in your import file.
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Note – The Import Tool will accept either short or long date formats in your
import file. It will also ignore leading zeros.

4. Click the OK button to accept the options settings, or click another tab to
set other options.

Confirmation Preferences

These preferences deal with the warnings, messages, and alerts you receive
when importing data.

To set confirmation preferences for the Import Tool:
1. Choose Preferences from the File menu.

2. In the Preferences dialog box, click the Confirmations tab. The Import
Tool Preferences window appears as shown in Figure 14-14.

Figure 14-14 Import Tool Preferences — Confirmations Dialog Box

Time
Format

Select either the 12 hour or 24 hour check box to match the format
of your data. If 12-hour format, specify the string for before noon
and after noon, and specify the separator character between the
hour, minutes, and seconds.
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3. To select or clear an option, click the option. You can select any of the
following confirmation options:

4. Click the OK button to accept the options settings, or click another tab to
set other options.

Confirm to Exit Select if you want a confirmation message every time you
exit the Import Tool.

Confirm to Delete all
Mappings

Select if you want a confirmation message every time you
click on the Delete All button in the Import Tool’s Main or
Fallback Mappings windows.

Confirm before
Losing Mappings

Select if you want a confirmation message every time you
create mappings but do not save them before exiting the
Tool or changing the schema or file.

Confirm before
Losing Fallback Mappings

Select if you want a confirmation message every time you
create fallback mapping but do not save them before exiting
the Tool or changing the schema or file.

Confirm before
Losing New
Mapping Value

Select if you want a confirmation message every time you
add or modify a mapping value without clicking the
Add/Modify button before exiting the dialog box or
starting import.
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 Electronic Mail Support 15

This chapter describes how the AR System makes use of electronic mail (email)
to allow users without direct access to the AR System server to submit ARs,
query ARs, or receive notifications. It describes how to set up and use the
electronic mail handler (armaild ) so that users can submit ARs. It also
describes how users can receive notifications by email. The following topics are
included:

• Overview of the electronic mail interface.

• Submitting ARs through email.

• Querying via email.

• Receiving notifications through email.

The AR System Electronic Mail Interface
Electronic mail (email) may be the interface of choice for submitting action
requests and receiving notifications in environments where there is no
high-speed network link between the user and the AR System server.

This chapter describes the setup and configuration for both the UNIX and
Windows NT-based armaild  services. While the capabilities of armaild  are the
same regardless of the platform it is running on, their operation and
configuration are a little different. The differences for each of the platforms are
clearly indicated throughout the chapter.
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The main differences between the two platforms are described in Table 15-1:

The AR System mail handler (armaild ) allows users to submit and query ARs
using their email facility. The armaild  daemon watches the mailbox designated
for use by the AR System for new messages. When messages are received and
processed, the mail handler creates the new AR and enters it into the AR
System. If there is an error, the original message and error messages are
returned to the submitter. If the AR server is not responding, the message is
held and periodically resubmitted until the server responds.

The AR System also allows users to receive notifications via email. You may
design filters and escalations to send specified text or the contents of selected
fields to users via email notification. The AR System sends the notifications via
the sendmail  command on UNIX servers and via armaild  on Windows NT
servers.

Using Electronic Mail to Submit ARs
Before users can submit ARs using electronic mail, you need to perform the
following administrative tasks.

Table 15-1 Differences Between armaild  in UNIX and Windows NT

Function UNIX Windows NT

email Uses SMTP for email. Uses Microsoft Mail (MS
Mail) for email.

Sending email
Notifications

* Server sends email
notifications.
* In some circumstances, you
can override who the email is
sent from.

* armaild  sends email
notifications.
* Notifications always come
from the armaild  Microsoft
Mail logon account, which
you cannot override.

Location of
Configuration File

 /etc/armaild.conf
You can specify another
filename and location through
the command line. For more
information, see “Starting the
Mail Handler” on page 353.

<ar_install_dir>\conf\
armaild.cfg
In addition, the Windows NT
armaild  service has extra
configuration values that
reside in the ar.cfg
configuration file.
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1. Establish a mailbox address for the mail handler. If you are in the
Windows NT environment, create a user in Microsoft Mail for the
armaild  mail handler to use.

2. Install the mail handler and, optionally, specify a configuration file
containing values that define the operational settings for the mail handler.

3. Generate one or more email templates for each schema you want to make
available for users to submit via email.

Details on how to perform each of these administrative tasks are included in
this chapter.

Establishing a Mail Address

For UNIX Servers

The AR System mail handler must have a mail address somewhere in your
system. By default, the AR System will look for the address ARSystem.
However, you can use any address you want, if you specify the address in the
armaild  configuration file.

The mail address you specify should be used strictly for the AR System.

The most likely machine on which to establish the mail address is the machine
running the AR server. However, this is not a requirement. You can establish a
mail address on any machine in your network that has the ability to access the
AR server by using the procedure that follows:

• Update the /etc/aliases file to add an entry for the mail address. For
example, if you use the default name ARSystem for your mail address, you
could add an entry of the form:

For all other nodes in the network, you need to make any changes that are
required for them to forward mail targeted at the mail handler to the
appropriate location. This may or may not require updates to the other nodes.

If you are using NIS services, you would make the changes noted above
following the rules and guidelines for updating files under NIS.

ARSystem:/usr/spool/mail/ARSystem
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For Windows NT Servers

The only machine on which to establish the armaild  service is the system
running the AR server. All mail sent by the armaild daemon will be from the
Microsoft Mail ID configured at installation. Mail destined for the AR server
should be sent to this Microsoft Mail address.

Setting Up the Mail Handler

The armaild  daemon must have access to several types of information in order
to process action requests through email. It must know the address of the AR
System mailbox. It must also know other information, including what server to
use, what schema to process a submittal for, and what to do if the transaction
succeeds or fails.

There are several ways to supply needed information to the mail handler:

• You can accept AR System defaults, where defaults exist.

• You can specify a configuration file when you start the mail handler. This
file should contain values for various options affecting how the mail handler
operates. These settings will then become “defaults” for that run of the mail
handler. Values set through a configuration file will override AR System
defaults. See the section Creating an Email Configuration File that follows for
information on defining the configuration file values.

• You can make sure that the mail templates available to users submitting ARs
include all necessary specifications. Settings included in a template will
override both system defaults and values set through a configuration file.
See “Using Mail Templates” on page 354 for information on mail templates.

Creating an Email Configuration File

You can set a number of options for the AR System mail handler by including
their specifications in an ASCII file. You then designate the file as the
configuration file when you start the armaild  daemon. The values set through
the configuration file will be associated with that run of the mail handler
process and the values for options specified in the configuration file will
override the system defaults.
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Table 15-2 shows the options that you can specify in the configuration file:

Table 15-2 armaild  Configuration File Options (1 of 3)

Option Function System Default

Address: The mail address the mail handler should
watch for AR System messages. (UNIX
only.)

ARSystem

Default-
Password:

The AR System password to use if no
password is specified in the submitted
message.

No password

Default-
Schema:

The schema to submit to if no schema is
specified in the submitted message.

None. The schema
must be specified
here or in the
message

Default-
Server:

The AR System server to submit to if no
server is specified in the submitted
message.

The machine
running the
armaild  process

Default-User: The AR System login user to use if there
is no login specified in the submitted
message.

Mailer daemon

Include-
Original-
On-Failure:

A flag indicating whether to include the
full text of the original message in a reply
to a failed submission. Legal values are T
and F.

T (include full text)

Include-
Original-
On-Success:

A flag indicating whether to include the
full text of the original message in a reply
to a successful submission. Legal values
are T and F.

T (include full text)

Poll-
Interval:

The number of seconds to wait between
polls to the mailbox to check for new
messages. The minimum interval is 5
seconds.

300 (5 minutes)

Query-Match-
Full:

Defines the maximum number of
matches that can be returned to a
successful Full Format query request.
For example, if a user submits a query
request with Full format indicated, and
the query matches 120 items, only the
first 25 will be returned.

25
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Query-Match-
Short:

Defines the maximum number of
matches that can be returned to a
successful Short Format query request.
For example, if a user submits a query
request with Short format indicated, and
the query matches 120 items, only the
first 50 will be returned.

50

Reply-
Failure:

The email address to use for replies to
failed submissions. Use to redirect replies
for failed submissions to a third party
rather than the message sender. This field
only applies to submits, not queries.
To suppress sending a message on reply
failure, for UNIX, set the address to
/dev/null  (or to an address directed to
/dev/null  in the mail aliases file with a
line like nobody: /dev/null ). For
Windows NT, set the address to
Discard .

Reply to message
sender. Use
Reply-to:  field,
then From:  field,
and finally the
From header to
find user.

Table 15-2 armaild  Configuration File Options (2 of 3)

Option Function System Default
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For Windows NT Servers

Table 15-3 on page 352 shows additional configuration parameters that are
used for the Windows NT server. These parameters are located in the

Reply-
Success:

The email address to use for replies to
successful submissions. Use to redirect
replies for successful submissions to a
third party rather than the message
sender. This field only applies to submits,
not queries.
To suppress sending a message on reply
success, for UNIX, set the address to
/dev/null  (or to an address directed to
/dev/null  in the mail aliases file with a
line like
nobody: /dev/null ). For Windows
NT, set the address to Discard .

Reply to message
sender. Use
Reply-to:  field,
then From:  field,
and finally the
From header to
find user.

Required-
Schema:

The only schema for which submissions
will be accepted. If there is a Schema:
line in the submitted message, it must
contain this schema name or the
submission will be rejected. If there is no
Schema:  line, the Default-Schema:
setting in the configuration file must
match this schema name or the
submission will be rejected.

No required
schema setting.

Required-
Server:

The only server for which submissions
will be accepted. If there is a Server:
line in the submitted message, it must
contain this server name or the
submission will be rejected. If there is no
Server:  line, the Default-Server:
setting in the configuration file must
match this server name or the submission
will be rejected.

No required server
setting.

Table 15-2 armaild  Configuration File Options (3 of 3)

Option Function System Default
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<ar_install_dir>\conf\ar.cfg configuration file.

Sample Email Configuration File

The following is an example of a configuration file that specifies a mailbox
address of NewTickets  and sets the default server to narnia and the default
schema to TroubleTickets :

Table 15-3 Windows NT Server armaild  Configuration File Options

Option Function System Default

MailNotifyDir: Indicates the full pathname for the
mailntfy  directory that holds all of the
email notifications the server passes to
the armaild service. The armaild
service deletes them after they are
processed.

<ar_install_dir>\arserver\mailnt
fy

MailLogin: Indicates the Microsoft Mail and NT
account login name.

No default.

MailPassword: Indicates the Microsoft Mail and NT
account login password.

No default. Stored encrypted.

PO-Location: Indicates the NT full pathname for the
system and share file that hold the
Microsoft Mail post office.

UNC (universal naming convention)
name for the Microsoft Mail
postoffice.
No default.

Address: NewTickets
Default-Server: narnia
Default-Schema: TroubleTickets
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Starting the Mail Handler

For UNIX Servers

Once you have established a mail address for messages to be mailed to the AR
System and set up a configuration file, if one is desired, you can run the AR
System mail handler, armaild . The syntax for armaild  is as follows:

Command Options

The following command options may appear in any order on the command
line:

To start the mail handler:
The following example will start the mail handler using a configuration file
called mailopt . (You will need read/write access to the file.)

You will probably want to add the command line you will use most often to
start the mail handler to your system start-up script.

-d Set the system into debugging mode. This mode prints messages to
stdout  that detail the progress of the operations being performed.
You should use debugging mode only to find problems with how the
mail handler is running.

-f <filename> Process the indicated configuration file for command options to the
armaild  process. The various options are described in “Creating an
Email Configuration File” on page 348.

-n <number-of
intervals>

The number of polling intervals this daemon will run. This setting
allows you to limit the amount of time the mail handler will run. If
this option is not specified, the daemon will run until terminated.

armaild [-d][-f filename ][-n number-of-intervals ]

% armaild -f mailopt &
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For Windows NT Servers

The mail handler is installed to run as a Windows NT service. The startup
settings for the armaild  service must start the service as the Windows NT
account designated for use during installation, not as the System Account , as
described in “Establishing a Mail Address” on page 347.

You also can use the following debug options with armaild :

• If you run armaild  as a Windows NT service and use the -d debug option,
debug messages are logged in the
<ar_install_dir>\arserver\db\armaild.log  file and do not appear on
the screen.

• If you do not want to run armaild  as a Windows NT service, you can run
armaild  in manual mode by adding the -m option to the command line, as
in the following example.

Debug messages appear on screen and not in the armaild.log  file.

For more information on the armaild  command options, see “Command
Options” on page 353.

Using Mail Templates

Users who wish to submit ARs using email will use the mail templates that are
available to them according to the instructions provided in the Action Request
System User’s Guide. As the AR administrator, it is your responsibility to
generate the mail templates and modify them so that they meet the needs of
your users.

Generating Mail Templates

To generate a mail template for any schema, you use the Export operation of
the Admin Tool. Instead of exporting the schema definition to a file, you
choose the Export Schema Mail Definition menu choice to create an ASCII file
that can then be used to submit ARs via mail. See “Importing and Exporting
Definitions” on page 311 for complete instructions on exporting mail templates.

%  armaild -d -f c:\remedy\armaild.cfg -m
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The Export operation generates a template that looks like Figure 15-1. Only the
fields shown below are available to all users during submission:

Figure 15-1 Email Template

Email templates have four pieces:

• The initial comment block stating when the template was generated.

• A header containing fields identifying the schema and user.

• A block of fields.

• Begin and end message comment lines.

The comment block is optional and can be retained or deleted as desired. Any
line beginning with a # in column 1 will be treated as a comment. Comments
can occur anywhere in the message.

#
# File exported Sun Nov 17 14:30:02 1995
#
# AR-Message-Begin                   Do Not Delete This Line

Schema: Schema01
Server: narnia
Login:
Password:
Action: Submit
#Values: Submit, Query
Format: Short
#Values: Short, Full

 Submitter! 2!:
 Short-Description ! 8!:
 Long-Description ! 9!:
 Notify-method !12!: None
# Values: None, Notifier, E-mail
 Submitter-Severity !13!: Low
# Values: Low, Medium, High

# AR-Message-End              Do Not Delete This Line
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The header block may contain a Schema: line with a valid schema named, a
Server:  line to identify the server on which the schema is located, a user login
and password, and optional Action and Format lines to define the operation to
perform.

If no schema is specified or the specified schema does not exist, the mail
handler will check to see if a schema was defined in a configuration file that
was specified when the mail handler was started. If not, the item will be
rejected since a schema must be specified.

If no server is specified or the specified server does not exist, the mail handler
will first check to see if a server was defined in a configuration file that was
specified when the mail handler was started. If not, then the machine running
the armaild  process will be used as the server.

If no user name or password is specified, the mail handler will check to see if
they were defined in a configuration file that was specified when the mail
handler was started. If not, the user performing the operation is set to “Mailer
daemon.”

If no action line is specified, the mail handler defaults to Submit. If you make a
query and do not specify a format, the mail handler uses the Short format.

The header block is considered ended when any field other than a comment or
one of the header labels is encountered. The blank line shown in the example
above is useful but not required.

The field block section of the email template contains the fields that can be set.
The Export operation includes all fields open to all users at submit time. Field
order is not significant. The Export operation generates fields in the same order
as on the default administrator view of the schema.

A field consists of:

• An optional field name (the field name is just to provide a useful name, the
ID is what the AR System uses).

• The field ID within exclamation points (!) (for example, field ID 9 would be
!9!), with any single delimiter character after the second !. The character :
(colon) is often used as a delimiter. Blanks are acceptable. If any characters
other than digits and spaces are between the exclamation points, the
reference is not recognized as a field ID.
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• Values can be entered any place after the single delimiting character.
Leading blanks are ignored when reading a value. When generated from the
Export operation, fields with default values have the values loaded in the
template.

You can place several field references on a single line as long as the second (or
third) item starts far enough after the end of the previous item to leave enough
room for a full-length value. For example, if the first field is a 10-byte
maximum character string, the second field name or ID must start at least 10
bytes after the start of the value of the first item. Any diary type or character
type with an unlimited length or length limit over 50 characters cannot have a
following field on the same line. The export operation generates a single field
on each line.

There is no significance to the positioning of the field IDs on a line. They can be
placed to align for readability or not, as desired.

The AR-Message-Begin and AR-Message-End comment lines are
recommended but not required. The begin and end message delimiters avoid
armaild  parsing problems that can be encountered when mail passes through
mail gateways on its way to armaild .

Modifying Mail Templates

If necessary, you can modify mail templates before distribution, as long as the
resulting template matches the rules discussed in this section.

When you export a mail template, the template contains only those fields that
are available to all users during the submit operation; that is, all fields that
have a create mode of Open. It is possible for you to add any of the fields that
are not exported under this rule to the template; however, since they did not
meet the requirements to be included in the template automatically, these fields
have additional security protection. A user submitting an entry with a value
for one of these additional fields must specify their Login and Password in
order to gain access to these protected fields. If the Login and Password fields
are not supplied in either the template or the configuration file specified when
armaild  was started, the submission defaults to Mailer daemon.
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Submitting ARs Using Templates

Once you have established an email address for the AR System, set up and
installed the mail handler, and generated email templates, AR System users
will be able to use the templates to submit ARs. To do so, the user opens the
appropriate email template in their email tool (or in any text editor), fills in the
fields as required, and directs the resulting message to the AR System mailbox.
Users will receive confirmation if their submission is successful, or receive a
message identifying any errors if the submission is rejected. See the Action
Request System User’s Guide for more information on using email templates to
submit action requests.

Querying via Electronic Mail
The armaild  process also supports querying via email. AR System users can
send the armaild  process query requests encapsulated in specially formatted
email messages and receive the query results by email.

Overview

Users now have the ability to query the AR System, in addition to the already
established ability to submit to the AR System. The AR System administrator
needs merely to modify the email template.

The query requests are supported in three formats:

Formatting

All matching requests are listed in the body of the message one after another.
In full format, each entry is separated by a line of dashes. If a request fails, an
error envelope is returned with an indication of the cause of the failure.

Query by Entry
ID

The simplest method is the query by entry-id, which requires that the
user email a specific entry-id value.

Query by Field The query by fields method allows the user to specify a selection on a
field or fields for the schema they wish to query, much like the
functionality of the user tool. This method can return multiple entries.

Query Bar
Command

The query via a query bar request is the most powerful version of the
query via email functionality. It provides an email based query-bar
facility, anything you can enter in the query bar can also be done via
email.
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If a query request returns more than one match, the beginning of the message
indicates the total number of matches that were made. If a request exceeds the
configured query match limit, an additional message is provided indicating
this, as well as what the limit was. The maximum number of allowable
matches are returned in the message.

The Action and Format keywords can appear anywhere in the header portion
of the message. The user specifies whether the action to be performed is a
query or a submission by typing Query  or Submit  after the Action keyword. If
the Action keyword does not appear, the armaild  daemon will treat the email
message as a submit request.

The user can chose that requested information be formatted in full or short
form using the Format keyword, as described below.

• The default format is short, and returns the information via the query list
definition for the schema being queried.

• The full format lists the information for all accessible fields. The user
controls the format through the Format keyword in the header portion of
the email request.

The AR-Message-Begin and AR-Message-End comment lines are
recommended for use in the email templates, but are not required. Gateways
may add extra text or graphics before and after the body of a message. The
beginning and end message delimiters prevent armaild  from having trouble
parsing these additions.

Additional Configuration File Options

To prevent large email responses, you can define limits on the total number of
entries that can be returned in the armaild configuration file. The
modifications needed for the /etc/armaild.conf  file (for UNIX) or
<ar_install_dir>\conf\armaild.cfg file  (for Windows NT) are described
in “Creating an Email Configuration File” on page 348.

These settings allow the administrator to limit the number of matches returned
to the requester. All matching requests are listed in the body of the message
one after another. In Full format, each entry is separated by a line of dashes. If
a request fails, an error envelope is returned with an indication of the cause of
the failure.
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If a query request returns more than one match, the beginning of the message
indicates the total number of matches that were made. If a request exceeds the
configured query match limit, an additional message is provided indicating
this happened and what the limit was. The maximum number of allowable
matches are returned in the message.

The Format keyword is followed by the requested format, either Full or Short.
This setting allows the requestor to control the information used in the
summary. The Format keyword is only useful with query requests; it has no
affect on submit requests.

Preparing the Electronic Mail Template

To create the format required to use the query capability, modify the email
submit format you create using the Administrator Tool. For more information,
see “Using Mail Templates” on page 354.

Follow the steps below to modify the email template.
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To create the query by entry ID format:
1. Export the schema mail template via the Administrator Tool for the

schema that you want to query. Figure 15-2 shows an example of an
exported schema mail template.

Figure 15-2 Original Template for Query by Entry-ID

2. Edit the exported file by doing the following:

a. Make sure the Action keyword value is set to Query .

b. In the body portion of the message, you can only define the entry-ID
field. It must have a field-id value of 1.

c. Fill in the data portion of the message with the entry ID of the ticket to
be retrieved.

#
# File exported Mon Dec 18 08:57:00 1995
#
# AR-Message-Begin           Do Not Delete This Line

Schema: AR-HD Calls
Server: narnia
Login:
Password:
Action: Submit
# Values: Submit, Query
Format: Short
# Values: Short, Full

# Values: Phone, AR System, email,
Method !536870914! Phone
 # Priority !536870915! Low
Phone Number !536870916!

# AR-Message-End              Do Not Delete This Line
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d. Remove all other fields from the body of the template. The only field in
the body should be !1! TT00000000119 .

Figure 15-3 shows an exported file and how it was modified to become a
query by entry ID message.

Figure 15-3 Modified Template For Query by Entry-ID

The Action keyword and format can appear anywhere in the Header portion of
the message. If the Action keyword and format does not appear, or the action
keyword is present but specifies Submit , then the armaild  daemon will treat
the email message as a submit request.

To create the query by field format:
The query by field format requires the same Action keyword as the query by
entry ID, but can have more that one field defined.

#
# File exported Mon Dec 18 08:57:00 1995
#
# AR-Message-Begin         Do Not Delete This Line

Schema: AR-HD Calls
Server: narnia
Login:
Password:
Action: Query
Format: Short

 !1! TT00000000119

# AR-Message-End                Do Not Delete This Line
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1. Export the schema mail template via the Administrator Tool for the
schema that you want to query. Figure 15-4 shows an example of an
exported schema mail template.

Figure 15-4 Original Template for Query by Fields

2. Edit the exported file by doing the following:

a. Make sure the Action keyword value is set to Query .

b. Set the Format option as desired if you want other than the default
(Short).

#
# File exported Mon Dec 18 08:57:00 1995
#
# AR-Message-Begin           Do Not Delete This Line

Schema: AR-HD Calls
Server: narnia
Login:
Password:
Action: Submit
# Values Submit, Query
Format: Short
# Values Short, Full

Source !5368737933! Phone
# Values: Phone, AR System, email,
#      NMP, ACD
Caller Impact !5368783455! Low
# Values: High, Medium, Low
Last Name !5386753452!
Phone Number !5386748345!

# AR-Message-End          Do Not Delete This Line



364 Action Request System Adminitrator’s Guide for Windows—December 1995

15

c. Edit the body portion of the message to include the fields you are
querying, but remove all other extra information. Only fields that have
values are used in the request. Field that do not have values are
ignored.

Figure 15-5 shows an exported file and how it was modified to become a
query for multiple fields message.

Figure 15-5 Modified Template For Query for Fields

Note – Compare Figure 15-5 on page 364 with Figure 15-4 on page 363. The
Action keyword value has been changed to Query , and the unneeded fields
(Last Name and Phone Number ) have been removed

To create the query bar format:
The Query bar format requires the same Action keyword as the query via entry
ID, but the field format is a little different.

#
# File exported Mon Dec 18 08:57:00 1995
#
# AR-Message-Begin          Do Not Delete This Line

Schema: AR-HD Calls
Server: narnia
Login:
Password:
Action: Query
Format: Full

Source !5368737933! Phone
Caller Impact !5368783455! Low

# AR-Message-End          Do Not Delete This Line
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1. Export the schema mail template via the Administrator Tool for the
schema that you want to query. Figure 15-6 shows an example of an
exported schema mail template.

Figure 15-6 Original Template for Query Bar Format

2. Edit the exported file by doing the following:

a. Make sure the Action keyword value is set to Query .

b. Remove all fields in the body portion of the message to include a
Query Bar line. The query bar formatted request must have the
keyword QueryBar  in the field label portion of the line. The field ID
can be any non-negative value, though zero is recommended. The
value portion of the field can be any valid query bar formatted query.
All of the restrictions that apply to the query bar in the user tool apply
to its usage when performed via email.

#
# File exported Mon Dec 18 08:57:00 1995
#
# AR-Message-Begin         Do Not Delete This Line

Schema: AR-HD Calls
Server: narnia
Login:
Password:
Action: Submit
# Values: Submit, Query
Format: Short
# Values: Short, Full

Source !5368739331! Phone
# Values: Phone, AR System, email,
#      NMP, ACD
Caller Impact !5368783455! Low
# Values: High, Medium, Low
Last Name !5386753452!
Phone Number !5386748345!

# AR-Message-End         Do Not Delete This Line
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c. Figure 15-7 shows an exported file and how it was modified to become
a query bar format message.

Figure 15-7 Modified Template For Query Bar Format

Note – Make sure that the value after the Query Bar keyword and its field ID is
in valid AR System query-by-example format.

Using Electronic Mail for Notifications
You can define filters and escalations that direct AR System notifications to
users via electronic mail by specifying E-mail  as the delivery mechanism when
you define the Notify filter or escalation action. You can send a text message or
you can send the contents of selected fields, as long as the user being notified
has the appropriate permissions for those fields.

See Chapter 10, and Chapter 11 for details on setting up a filter or an escalation
to send notifications to users via email.

For UNIX Servers

The AR System will automatically generate a sendmail  command to send the
notification text (and field contents) to the designated user when the filter or
escalation is triggered.

#
# File exported Mon Dec 18 08:57:00 1995
#
# AR-Message-Begin         Do Not Delete This Line

Schema: AR-HD Calls
Server: narnia
Login:
Password:
Action: Query
Format: Short

QueryBar !0! 'Source' = "Phone" OR 'Source' = "email"

# AR-Message-End         Do Not Delete This Line
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For Windows NT Servers

The AR System server automatically passes notifications to the armaild

service, which then sends the notifications. This is different than the UNIX
armaild  daemon which only receives email tickets for submission to the AR
System. To send email notifications, the armaild  service on NT must be
running.

The notification information is passed to armaild  via the
<ar_install_dir>\arserver\mailntfy  directory. The armaild  service
periodically checks the directory for notifications and sends all that it finds.
You define the frequency of the polling interval by setting the Poll-Interval:

configuration parameter.
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The Multi-Process Server Option 16

This chapter discusses the administration and performance of the multi-
process (MP) server option in the AR System server. The topics covered include
the following:

• Multi-processing and the AR System.

• Configuring an MP server.

• Administering an MP server.

• Using the MP server with different AR System clients.

• Using the MP server with private servers.

Note – The MP server option is a feature that you can purchase along with the
AR System 2.0 (or later) UNIX server and may not be available on the server
you are administering.

Multi-Processing and the AR System
To improve AR System performance, you may want to run more than one AR
System server. Running multiple arserverd  processes involves performance
questions that only you, the administrator, can answer. Sometimes it makes
sense to off-load certain operations to a different server, sometimes not.



370 Action Request System Adminitrator’s Guide for Windows—December 1995

16

Using multiple arserverd  processes improves system performance by
distributing the process load. For example, using several servers allows the AR
System to do multiple database searches in parallel. If users feel that queries
are taking too long, increasing the number of servers should create a noticeable
improvement in performance.

The MP server is scalable from a single Admin server doing all server
functions to multiple servers doing specific functions. The arserverd  processes
adapt to the configuration parameters defined and spread the load. You
determine what amount of server resources to dedicate to the AR System.

Note – The 2.0 (or later) AR server is compatible with earlier versions of AR
clients. However, the only way you can take advantage of the MP ability of the
AR System is if you are using 2.0 (or later)
clients.

The MP server option provides the following features:

• All operations are hidden within the API.

• Scalability. You can add additional servers as needed.

• Compatibility with clients using older versions of our API.

• Allows users to run private servers (if needed).

• Provides a distinct and measurable gain in performance.

Figure 16-1 shows how the MP server design works and shows the server
processes and their RPC socket numbers.

Figure 16-1 MP Server Design

You can start as many arserverd  servers as you need. Note that there are five
types of arserverd  processes:

arservtcd

Admin Fast1 [Fast2 ...] List1 [List2] [List3 ...] Escalation

(RPC 390604)

(RPC 390600) (RPC 390620 to 390634) (RPC 390635 to 390669) (RPC 390603)
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• Admin arserverd  process.

• Fast arserverd  processes.

• List arserverd  processes.

• Escalation arserverd  process.

• Private arserverd  processes.

The following sections describe the admin, fast, list, and escalation arserverd

processes. For private arserverd  processes, see “Using the Multi-Process
Server with Private Servers” on page 377.

Admin Server

The arserverd  admin process is an AR System server that can perform any
operation within the system. It performs all admin restructuring operations,
guaranteeing the serialization and integrity of all restructuring operations.
There can be only one admin server process at any time.

In addition to its role as the restructure server, the admin server is also the
main server for older clients that do not handle MP server capabilities. In a
worst case scenario (all older clients with an MP server running), all operations
from all clients would be handled through the admin server.

If you do not have an MP server license or choose not to run any fast, list, or
escalation servers, you will be running the arservtcd  server and the admin
server. For information on the arservtcd  controller process, “Configuring
Multiple Process Servers” on page 373.

Fast Servers

Fast servers handle all the fast operations of the AR System, that is, the
operations that generally run to completion quickly without blocking access to
the server. The arserverd  fast servers handle all server operations except for
admin operations that restructure the database (which use the Admin process),
and the ARExport, ARGetListEntry, and ARGetEntryStatistics calls (which use
the List processes).

User Tool operations that use a fast server include the following:

• Previous and Next buttons in the Display and Modify windows.
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• Generating reports.

• Modify Individual and Modify All functions.

• Submit functions.

• Generating lists of schemas and fields.

For most sites, you probably only need a couple of fast servers. However, for
larger sites, you might benefit from the use of additional fast servers. To
configure the number of fast servers, see “Configuring Multiple Process
Servers” on page 373.

List Servers

List servers handle operations of the AR System that may take some time:
ARExport, ARGetListEntry (high-performance database searches), and
ARGetEntryStatistics.

User Tool operations that use list servers include the following:

• Queries.

• Initial connection to a schema.

Most sites can benefit from using multiple list servers. For example, to
eliminate waiting for access to the database, list server processes allow
multiple searches to occur in parallel. To configure the number of list servers,
see “Configuring Multiple Process Servers” on page 373.

Escalation Server

Typically, the admin server handles escalation processes. However, if you
create and use many escalations with short intervals for checking conditions,
putting the load on an arserverd  server that handles only escalations makes a
lot of sense.

As with all MP servers, sharing the processing load insulates the admin server
from escalation overhead. However, you must juggle whether creating an
escalation server is worth the performance cost to your system or whether you
have enough escalation processes that merit creating an escalation server in the
first place.
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You can have only one escalation server. To enable the escalation server, see
“Configuring Multiple Process Servers” on page 373.

Multi-Process Server Lock and Log Files

Normally, to prevent multiple instances of the arserverd  process from
running, a lock file is created (ar.lck ). When using the MP server feature, to
prevent multiple instances of the server running on the same RPC socket
address, lock files related to the specific RPC socket address are created. The
admin server creates a lock file named ar.lck  while the servers using other
RPC sockets create files named ar.lck. <rpcnum> where <rpcnum> is the RPC
socket address. For example, if using the RPC socket address of 390680, the
associated lock file would be ar.lck.390680 . But, in general, you do not need
to worry about these files.

If you specify an SQL, Filter, Escalation, User, or API log file using the
Administrator Tool, a similar file naming strategy is followed. The system adds
.<rpcnum> to the end of the log filename that you supply. This logs the
operations related to each server into separate files.

Configuring Multiple Process Servers
To configure the multiple-process server environment, click the Multiple
Processes tab (Figure 16-2 on page 374) in the Server Information dialog box to
specify a multiple process server configuration. If you do not have a Multi-
Process Server Option license, the Multiple Processes tab does not appear in
the Server Information window.

To set the multiple-process server environment:
1. Choose Server Information from the File menu. The Server Information

dialog box appears.

2. In the Server Information dialog box, click the Multiple Processes tab, as
shown in Figure 16-2 on page 374.
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Figure 16-2 Server Information — Multiple Servers

3. Select from the following options or enter settings as required:

4. Click the OK or Apply button to save the option settings.
• If you increase the number of fast or list servers, the arservtcd  server

immediately starts the additional fast and list servers you configure.
• If you activate the escalation server, the arservtcd  server does not start

the escalation server until you stop and restart the arservtcd  server.
• If you reduce the number of fast, list, or escalation servers, those processes

are not killed until you stop and restart the arservtcd  process.

Fast Servers Number of processes to run as fast servers. For more
information on fast servers, “Fast Servers” on page 371.

List Servers Number of processes to run as list servers. For more
information on list servers, “List Servers” on page 372.

Activate
Escalation Server

If your site uses many escalations which the server checks
frequently, select this check box to activate a separate
escalation server. If you clear the check box, escalations are
handled by the main Admin server.
For more information on escalation servers, “Escalation
Server” on page 372.
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Administering Processes
The AR System includes a controller process, arservtcd , that handles requests
from clients for information on which socket to use for communicating with
the various arserverd  processes. The arservtcd  server responds to requests
for which RPC socket to use for the Fast and List processes. In addition, the
arservtcd  server starts and manages arserverd  processes. While arservtcd  is
available to all AR System server licenses, it includes extra capabilities if you
are running multiple-server processes.

All querying of the arservtcd  server is done automatically within the API and
is invisible to the user. Regardless of the client platform being used, the various
fast and list server processes being used are invisible to the user.

Note – If the arservtcd  process is not running, all clients default to using the
Admin server (on RPC socket 390600).

The arservtcd  process administers the MP servers for you, including the
following:

• Launching configured processes at startup.

• Relaunching any child processes that shut down.

• Inheriting any running server (the arservtcd  process checks every 15
minutes on inherited processes).

• Automatically launching new fast and list servers if the Administrator
increases the number of processes in the Server Info window in the
Administrator Tool.

• Sending kill -15  (SIGTERM) to arservtcd  will cause it to shut down all
MP servers.

• Sending kill -1  (SIGHUP) to arservtcd  will cause it to synchronize all
MP servers.

Figure 16-3 on page 376 illustrates how the arservtcd  controller process
handles requests from 2.0 (or later) clients and administers the escalation, fast,
and list servers.
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Figure 16-3 MP Server Environment
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Using the Multi-Process Server with AR Clients
You can use the MP server with clients using older versions of the AR System
API (1.2 and earlier). The AR System always runs a server process on RPC
socket 390600 that responds to any and all client requests. Figure 16-3 on
page 376 illustrates how older versions of the AR System fit in the 2.0 (or later)
MP server environment.

1.2 AR System clients are compatible with the 2.0 (or later) release and can
continue to be used without change. In fact, you can use 1.2 and 2.0 (or later)
clients in any combination with 1.2 and 2.0 (or later) servers.

1.1 clients are also compatible with the 2.0 (or later) release but cannot take
advantage of many of the features of the 2.0 (or later) release.

Note – You cannot use 2.0 (or later) clients against 1.1 servers.

Wherever possible, it is a good idea to allow customize privileges for users
who will access a 2.0 (or later) server from a 1.1 client tool. This will allow the
1.1 users to deal with many of the cases where they cannot take advantage of
2.0 (or later) features. But in cases where this is not possible (for example, for
users running the ASCII client tools), the schema designer will need to account
for differences when designing a schema.

Using the Multi-Process Server with Private Servers
In addition to fast, list, and escalation servers, AR administrators also can
create private servers for specific users who need more dedicated access to
system operations. For example, you might create a private server for a user
who is performing critical operations that you do not want blocked by other
users of the AR System. The RPC socket numbers used for the multiple-process
server do not overlap the socket numbers used for private servers.

Private servers support all operations except restructuring operations. These
are supported only on the Admin server (“Admin Server” on page 371).
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Note – Figure 16-3 on page 376 illustrates how private servers fit in an MP
server environment. Notice that the private servers are not managed by the
arservtcd  process. As a a result, stopping or starting the arservtcd  process
does not stop or start these private servers. You must stop or start them
separately.

Server RPC Socket Addresses

When using a private server, you must specify the RPC socket address that the
server will use. You can specify an RPC address in one of two ways:

• Starting a private server by using the -r  command line argument.

• Defining the ARRPC environment variable.

Starting a Private Server

To start a private server, enter the following UNIX command in a shell tool at
the command line (first log in as root):

# arserverd -r < socketnumber > &

The -r option allows you to specify which server to run. In the AR System,
socket numbers 390680 to 390694 are reserved for private servers.

Note – If you use the -r  command line argument and also define the ARRPC

environment variable, the value supplied with the -r  command line argument
takes precedence.

You can run one or more private servers as is appropriate for your
environment. For example, to run two private servers in your environment,
you could start the server processes as follows:

# arserverd -r 390680 &
# arserverd -r 390681 &
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Note – You do not need to use the socket addresses in sequence. You can
choose from among any of the available sockets. These servers are in addition
to the servers managed by arservtcd .

Killing a Private Server

Killing the arservtcd  process does not kill private servers. You must kill them
separately.

To kill a private server:
1. Log in as root and get the process ID number of the private arserverd

process:
For SunOS systems, type the following:

For other systems, type the following:

2. Kill the arserverd  process by typing the following UNIX command at the
UNIX prompt:

Note – Do not use the kill -9  command to stop a private server. Doing so
may leave your database in an inconsistent and unrecoverable state.

Defining the ARRPC Environment Variable

For users, the difference between the arservtcd  server and the private server
is transparent.

# ps -ax

# ps -ef

# kill < process_number_arserverd >
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Note – The Administrator Tool always uses the admin server, no matter what
the ARRPC environment variable is set to.

Using Motif Clients with a Private Server
When using a Motif client, you can connect clients to the private server
processes by using the ARRPC environment variable to specify the RPC address
of the private server.

• For the C shell, use the following commands:

• For the Bourne shell, use the following commands:

Using Windows Clients with a Private Server
To connect a Windows client to a private server, the user needs to add the
following line in the [User] section of their ar.ini  file before starting the tool:

Note – Each user of the Windows client on the same PC needs to add the
RPCSocketNumber to their own ar.ini  file.

% setenv ARRPC 390680
% aruser &

% ARRPC=390680; export ARRPC
% aruser &

[User]
RPCSocketNumber= <RPC_#_of_private_server>
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This chapter discusses some of the capability, performance, and administration
issues of full text search (FTS) in the AR System. The topics covered include the
following:

• Introduction to FTS, including an overview of FTS features.

• Who can perform an FTS search.

• How to use FTS to retrieve records, especially using the accrue operator (the
LIKE  operator with comma separators).

• Administering FTS.

• Licensing users for FTS.

• Configuring FTS in the AR System, including:
• Setting search options.
• Modifying the ignore words list.
• Rebuilding the index for FTS.
• Defining a field for FTS.
• Estimating the size of the FTS index.
• Weighting the results of an FTS.
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Note – Full text search is an optional feature that you can purchase for the AR
System 2.0 or later UNIX server. It may not be available on the server you are
administering.

What is Full Text Search?
Full text search (FTS) is an important and extremely useful feature of the AR
System. For starters, FTS is typically much faster than searching in relational
databases for long text fields.

FTS benefits also include making use of your knowledge base. For example,
FTS lets you access your company’s history of solving problems that are
sometimes stored in long text fields. With the FTS option, you can easily search
through long text fields to find solutions to related problems. You may even
want to re-design schemas to require entering data into diary or long-text
fields in order to build up a knowledge base that helps you learn from
previous experience.

The FTS option provides quick and consistent access to the records (or ARs)
that you are searching for. Unlike OR searches that retrieve records in random
order, the FTS accrue operator presents the best solutions first to your query
with a “weighted” order. The accrue operator lets you use multiple search
terms in a query, for example, computer , PC, and an error number 3794 .
Records that contain the most search terms receive a higher weight and appear
higher on the list (if ordered in descending order of weight) and are more
likely to contain the information you are looking for. In contrast, if an OR search
yielded 20 records, you would have to look through all 20 records because you
would have no way of knowing which records contain what information. For
more information, “Accruing and Weighting Results in an FTS” on page 383.

FTS solves many problems that users confront when searching their databases,
including the following:

• Searching long text fields. The FTS option lets you index character and diary
fields for searching and matches entries from FTS-indexed fields against the
search criteria you specify. Like database indexes, an FTS index can greatly
decrease the time required for a database search.

• Searching for key words regardless of the underlying database, whether flat-
file or relational.
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Note – If you have questions about searching against text fields or the search
capabilities in particular database products, refer to your database reference
documentation.

• Improving search performance by searching large volumes of data. FTS
organizes long text in a way that is typically quicker to access than when in
relational databases.

• Defining how the server interprets wildcards used in queries on FTS-
indexed fields in order to tailor search performance to your specific needs.
For more information, “Configuring FTS Search Options” on page 397.

• Performing case-insensitive searches. Administrators can enable or disable
case sensitivity. For more information, “Case” on page 396.

• Using the [ ] wildcards in an FTS field even if the underlying database does
not support them. For example, you could enter do[a-z ] to find ARs that
include doe , don , and dot .

Accruing and Weighting Results in an FTS

As mentioned earlier, weighing results of an accrue search is a powerful FTS
feature. FTS does not limit you to searches for key words in FTS-indexed fields.
You also can use a special accrue operator (the LIKE  operator with comma
separated words) to cause the AR System to “accrue” and retrieve from the
database all the ARs that contain any or all of the comma separated words. For
more information, “Using the Accrue Operator” on page 386.

Records that are retrieved in an accrue operation are assigned a “weight” by
the FTS engine. WEIGHT is a number that varies from 0 to 100. With WEIGHT, the
AR System can sort the ARs in a query list using a “the more, the better”
approach: if you set the Field Sort Order in the User Tool to include WEIGHT in
descending order, the more search terms found in an AR, the earlier in the list
it appears in the set of retrieved ARs. The closer the weight number is to 100,
the better it matches the search criteria.

For more information about modifying Query List attributes to include FTS
weights, “Placing FTS Weight in a Query List” on page 407.



384 Action Request System Adminitrator’s Guide for Windows—December 1995

17

Sorting Records by Weight

In the User Tool, users can sort records retrieved in an FTS by weight in
descending or ascending order, by selecting WEIGHT and the sort order in the
Field Sort Order window. For more information on setting the sort order, see
Sorting Query Operation Results in the Action Request System User’s Guide.

Using the Ignore Words List

You can tell the FTS engine to ignore frequently-used words (such as and , the ,
because , and so on) or words that you do not want indexed. Adding entries to
the Ignore Words List saves space in the FTS index and speeds up text
searches. The FTS option comes with a default set of ignore words that you can
modify as needed. For more information, “Modifying the Ignore Words List”
on page 401.

Be aware that accrue searches that contain words from the Ignore Words List
will not find any matching ARs for those words. However, the accrue search
will retrieve ARs with the other search terms of the query. For restrictions on
FTS, “Limitations of FTS” on page 389.

Who Can Perform A Full Text Search?
Users must have a fixed or floating FTS license to use the FTS capability. Full
text licenses are separate from AR System read/write licenses.

• If users are assigned a fixed FTS license, they can always perform a search in
an FTS-indexed field.

• If users are assigned a floating FTS license but one is not currently available,
they will get a warning the first time they perform a database operation in
the User Tool. The system will use the search capabilities of the underlying
database (to the degree available). When a floating license becomes
available, each affected user will be alerted with a note and will then be able
to perform a search using the FTS capability.

Note – Users can tell if a field is indexed for FTS by looking at the context-
sensitive help for that field.

For more information, “Licensing Users for FTS” on page 393.
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How Do I Use FTS?
FTS is transparent to end-users in queries:

• If an FTS license is available and the field is indexed for FTS, then FTS is
used. If users are getting unexpected results in their searches, make sure
that they have either a fixed or floating FTS license.

• If an FTS license is unavailable or the field is not indexed for FTS, the AR
System uses the search capability of the underlying database.

To use FTS to retrieve ARs, you can either enter a query-by-example (QBE)
value in any field indexed for FTS or you can enter a value into the query bar,
just like an ordinary database query.

Performing a Query in an Field Indexed for FTS

Entering a string into a field indexed for FTS returns results consistent with the
ordinary database searches most users expect. Users can still use the query
strings and search patterns they are already familiar with. But FTS offers
additional benefits. Unlike some databases, the FTS engine lets you index and
search long-text fields for any text string in the entire field. Users might also
notice enhanced performance in retrieving ARs.

Depending on factors like wildcards entered in the query or the QBE match
settings of the field, the FTS engine uses that query to search the entire
contents of all ARs indexed for that field. (This is also known as a “document
search” or a “pattern search.”)

For example, in a field indexed for FTS (with a QBE match setting of
Anywhere and an FTS query option of Query Unchanged), searching for turn

retrieves all ARs with these variations of turn :
turn
return
upturn
turns
turned
turnoff
turnabout

For more information on how QBE settings affect FTS, “How QBE Settings
Affect FTS” on page 389.
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Using the Accrue Operator

You can use a special accrue operator (the LIKE  operator with comma
separators) to search for ARs with multiple terms, as in the following entry in
a field indexed for FTS:

ntclientd, notifier, turn

This search would retrieve all ARs with any of the search terms and their
stems. (This is also known as a “word search.”)

You also can perform an accrue search for a single word, as in the following:
turn,

When the FTS engine encounters a comma in the search string, it then begins
using the accrue operator, even if there is only one search term. This search
retrieves ARs with turn  and its stems. For information on stemming,
“Searching for Word Stems” on page 387.

Note – You can use the accrue operator only with fields indexed for FTS. Using
the same operator for a field which is not FTS indexed will cause the AR server
to search for the literal string.

Using the QBE Method
• If the QBE match property for the field is not set to Equal, you do not need

to add any wildcards to the search string, as in the following:
ntclientd, notifier, turn

• If the QBE match property for the field is set to Equal, you must add a
leading wildcard to the string to use the accrue operator, as in the following
QBE example that you would enter into the field on the schema:
%ntclientd, notifier, ntserverd

For more information on how QBE settings affect FTS, “How QBE Settings
Affect FTS” on page 389.

Using the Query Bar Method

Use the accrue operator in the Query bar, according to the following syntax:
<field> LIKE "ntclientd, notifier, ntserverd"
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The accrue operator causes the AR System to retrieve ARs that contain one or
more of the search terms, ntclientd or notifier or ntserverd. Remember that an
FTS also returns weight information that is a function of the number of
occurrences found.

Searching for Word Stems

For case-insensitive searches with no wildcards added, you can use the accrue
operator to search for common variations of word stems. For example, the
query ntclientd, notifier, turn  in an field indexed for FTS would also
retrieve ARs with the following variations of turn:

turns
turning
turned

However, the capability of searching for words stems will not return ARs with
turnabout , return , or upturn  in them.

Using Wildcards

You can also use the % wildcard for a search with the accrue operator,
according to the following syntax:

<field> LIKE "nt%, notifier"

This query would retrieve all ARs that contain the search term notifier  and
words that start with nt , including ntclientd , ntserverd , and so on.

Combining FTS and Non-FTS Fields

You can include FTS and non-FTS fields in a query, as in the following:
<field> LIKE "ntclientd, notifier, ntserverd" AND 'Create-date' > "01/01/95"

This query bar search using the FTS accrue operator would retrieve all ARs
that contained any of the search terms ntclientd or notifier or ntserverd and that
were created after January 1, 1995.

Search Strategies and Issues

When querying fields within the AR System for which FTS indexing has been
enabled, be aware of the following tips and strategies:
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• Make your queries as specific as possible. As a rule of thumb, remember
that the more defined and qualified that your queries are, the fewer hits to
the database. In addition, it is more likely you will actually find the
information that you really want (as opposed to having to search through
hundreds of ARs). A more efficient query will also yield a quicker response
time.

• Remove common words in FTS searches. Try using more specific, more
particular search terms. For example, if you use the accrue operator against
5 words and the search yields hundreds of hits to the database, you may
want to consider dropping more generic terms from the list to focus your
query on a smaller set.

In conclusion, remember that some queries work better than others. If you
receive unexpected results or a time-out, try reformulating your query.

FTS Issues When Performing Queries

Be aware of these issues when performing FTS queries:

• FTS queries that involve a field and an arithmetic operation result in the
underlying database executing the query. For example, a search like
'Short Description ' LIKE  'Assigned To ' + "ing " will defer the query to the
underlying database.

• FTS does not treat the following as literal characters in a search string,
unless they are preceded by a backwards slash in the query. Instead, the
special characters listed in Table 17-1 have unique functions in an FTS
search.

For example, a search for "Hello, world " will be translated by the FTS
engine into an accrue search for the terms Hello  and world . To perform a
literal search for the string, "Hello, world ", enter a backwards slash before
the comma, as in the following: "Hello\, world ".

Table 17-1 Special Punctuation in FTS Searches

, comma ! exclamation mark

{ } curly brackets ? question mark

[ ] straight brackets _ underscore

* asterisk \ backslash

% percent sign
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How QBE Settings Affect FTS

Enter a query-by-example (QBE) in any field indexed for FTS, according to the
following syntax:

ntclientd, notifier, ntserverd

However, be aware the QBE property settings influence how an accrue works,
as shown in Table 17-2:

Note – When you index a field for FTS, we advise that do not set the QBE
match property to Equal. For more information on QBE, see “QBE Match” on
page 154.

Limitations of FTS

There are certain limits in doing an FTS, including the following:

Table 17-2 How QBE Property Settings Affect FTS

 If the QBE Match
property setting is... The server receives the following query:

 Anywhere %ntclientd, notifier, ntserverd%
The User Tool adds wild cards to the start and end of the
query.

 Leading ntclientd, notifier, ntserverd%
The User Tool adds a wild card to the end of the query.

 Equal ntclientd, notifier, ntserverd
The User Tool does not add any wildcards to the search
string, but it will use the Equal operator instead of the
LIKE operator if the first character in the search string is
not a %.
Therefore, to use the accrue operator with a QBE property
setting of Equal, users must either:
Add a leading wild card to the string, as in the following:

 %ntclientd, notifier, ntserverd

Use the Query bar to enter the accrue operator.
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• In accrue searches, you cannot search for most punctuation because they are
treated as word separators. For more detail, see Table 17-1 on page 388.
If you are searching for special punctuation like commas or dashes, use the
backwards slash to include them in the search string. For example, if you are
searching for the phrase database, remedy from the Short-Description
field, you would enter the following in the Query bar:

'Short-Description' LIKE "%database\, remedy%"

Using QBE, you would enter the following:

database\, remedy

• In accrue searches, do not use words from the Ignore Words List. For
example, if the word the  is in the Ignore Words List, searching on the
phrase the, database, remedy in the Short-Description field may return
records with the word in them but it was not used in the search itself. For
additional information, “Modifying the Ignore Words List” on page 401.

• In queries that use FTS, be aware that newly submitted or modified ARs
might not appear immediately in the query list, if you are searching on an
FTS-enabled field. There is sometimes a short delay from the time the AR is
submitted or modified in the database to the time that the AR is available
for searching in the FTS index.

Administering FTS
This section describes how to administer FTS in the AR System.

Selecting Fields for FTS Indexing

You can only index character or diary fields for FTS. You should only index
fields that are frequently searched. Work diaries and descriptions of problems
are good candidates for FTS, especially if the underlying database does not
support searches of these fields.

For example, you could search for one or more key words in a diary field that
would retrieve and weight all the ARs that describe how to solve a problem
suggested by those keywords. Here you would perform a search on key words
or phrases, like the following:

• Schemas, tools, screens, hardware and software products, and so on.
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• Descriptions of problems or solutions.

• Topics, subjects, or other areas of interest.

When you define a field as indexed for FTS, it may take some time before that
field is available for full text searches. Indexing a field can take a long time (up
to several hours), depending on the amount of data in that field, system load,
and other factors. While a field is being indexed for FTS, you can still do non-
FTS searches on that field if the underlying relational database permits it.

To index a field for FTS, “Defining a Field for FTS in the Field Properties
Window” on page 404.

Remember that for each field that you index for FTS, the amount of disk space
required for the FTS index can grow significantly. To estimate approximately
how much space you will need for your FTS index, see “Estimating the Size of
the FTS Index” on page 405.

Note – Do not define fields for FTS during normal production hours, especially
if you have a lot of ARs in your database. The indexer accesses the database at
the same time as the AR servers, which can significantly impact the
performance of your system.

Re-Indexing

Most of the time, you should not have to rebuild your FTS index because the
arservftd  process automatically optimizes space after ARs are added or
deleted. However, you might need to rebuild the FTS index (re-indexing) in the
following circumstances:

• If you make changes to your Ignore Words List.

• If you delete ARs to reclaim disk space (normally they are simply marked as
deleted in the FTS index, not removed). So if disk space is getting low on the
partition that the FTS index resides on and a lot of ARs have been deleted,
then administrators should schedule some time to do a full reindex.

For additional information, “Rebuilding the Full Text Search Index” on
page 403.
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Time Required to Rebuild an Index

Because re-indexing rebuilds your entire FTS index from scratch, it can take a
long time, depending on the following factors:

• Amount of data in each FTS-indexed field in each AR.

• System load.

• Whether your indexes are on NFS-mounted or local directories. For more
information on where to locate your FTS indexes, especially for performance
reasons, “Estimating the Size of the FTS Index” on page 405.

Note – Do not rebuild an index during normal production hours.

After Modifying the Ignore Words List

When you modify the Ignore Words List and do not re-index, your changes
affect only tickets that are inserted, deleted, or modified after that point in
time. For example, if you added network to the Ignore Words List, the FTS
would ignore the word network only for ARs added or modified from this
time on. However, the FTS index with the word network would still exist for
all ARs created before the Ignore Words List was modified, if there were ARs
with the word network in them.

When you re-index all the fields in all your schemas that are currently flagged
as indexed for FTS, you create a new FTS index that then ignores the word
network in all ARs. To change the Ignore Words List, “Modifying the Ignore
Words List” on page 401.

The FTS Server (arservftd) Process

The AR System uses the arservftd  process to insert or delete all data in the
FTS index. All changes to the FTS index are made through the arservftd

process. In addition, the arservftd  process optimizes the FTS index every 2000
index field commands (from the time that arservftd  is started).

The AR System runs only one arservftd  process at a time.
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The arservftd process is started or stopped by the arservtcd process that
administers all the other types of AR servers, if you have valid FTS user
licenses.

When you are performing an FTS, it is the arserverd  process that searches the
FTS index for ARs. If the server’s FTS operations are disabled when an AR is
submitted, modified, or deleted, changes are still made to the FTS index. But if
FTS operations are disabled when a query is made, the underlying database
executes the query instead of the FTS engine.

Moving the FTS Index

The installation script for the AR System places the FTS index into the
<ar_install_dir>/ftindex  directory by default. If you have a large amount
of data in a lot of ARs that are indexed for FTS, you may find that you need
more disk space in which to locate the FTS index. Use the Administrator Tool
first to disable FTS operations, then move the index as needed. For more
information, “FTS Index Directory” on page 396.

If you decide to move the FTS indexes, first make sure that you relocate them
in a directory with enough space. To estimate the size of FTS indexes,
“Estimating the Size of the FTS Index” on page 405.

Licensing Users for FTS
To be able to perform an FTS, users must be assigned a fixed or floating FTS
license. You specify the type of license that users have through their entry in
the User schema (Figure 17-1), just like you would with their AR System write
licenses.

To license a user for FTS:
1. Open the User schema in the User Tool.
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Figure 17-1 User Schema (with Full Text License Message)

2. Query the database for the user you want to license for FTS. Or open the
Submit window if you are creating a new user, as in Figure 17-1.

3. Select the type of FTS license that you want the user to have, whether
fixed or floating.

4. Click the Apply button. If you issued the user a fixed FTS license, a
message appears (Figure 17-1).

5. Click the OK button to dismiss the message.

Configuring FTS in the AR System
Use the Administrator Tool to configure the operation of FTS. To configure the
AR System’s FTS capabilities, the system must have valid fixed or floating FTS
licenses from Remedy Corporation.

FTS Options in the Server Information Window

Click the Full Text Search tab (Figure 17-2) to set FTS options in the Server
Information window. If you do not have an FTS license, the Full Text Search
category on the Server Info window is disabled and you cannot access this
window.
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To display and update information about full text search:
1. Choose Server Information from the File menu. The Server Information

dialog box appears.

2. In the Server Information dialog box, click the Full Text Search tab, as
shown in Figure 17-2.

Figure 17-2 Server Information — Full Text Search

3. Select from the following options or enter settings as required:

Enable
Full Text
Search

* Selecting the Enable check box activates the FTS engine; the system
alerts you with a message that FTS will be started. The default is
Enable.
* Clearing the check box turns off the FTS engine; the system alerts
you with a message that FTS will be stopped.
Note that clearing the check box will disable the Case, Reindex, and
Ignore Words List options and enable the FTS Index Directory field.
Selecting the Enable check box does the opposite.
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4. Click the OK or Apply button to save the option settings.

FTS Index
Directory

Directory where the index files for FTS are located. The installation
script puts this directory in a default location with the other AR
System directories (<ar_install_dir>/ftindex ), but if needed,
you can relocate the index files in a different directory.
Changing the location of the index directory requires that FTS
capability be temporarily disabled. This prevents the system from
trying to update files while they are being transferred. This field is
disabled when FTS is enabled. You must temporarily disable FTS
(by clearing the Enable check box) to change the location of the
index directory.
When moving your index, you need to be sure that there is sufficient
space in the new location.
* For more information, “Moving the FTS Index” on page 406.
* For information on how much disk space is needed to store the
index files, see “Estimating the Size of the FTS Index” on page 405.

Case Selecting Sensitive includes case as a criterion for full text search. The
full text search looks for specific upper- and lower-case letters in
words. If you select Sensitive, you cannot use the stemming
capability in accrue searches. (For more information, “Searching for
Word Stems” on page 387.)
By default, case is set to Insensitive.
Selecting Insensitive excludes case as a criterion for full text search
(the search engine will ignore case completely). For example, if you
search for the word project , the search engine looks through the
FTS index for Project , project , PROJECT, and so on.

Search Options Use this menu to configure how wild cards are interpreted by the
server in queries on fields indexed for FTS. For information on
setting the FTS match operator and the types of responses users can
expect, “Configuring FTS Search Options” on page 397.
By default, Search Options is set to Query Unchanged.

Reindex Selecting this check box rebuilds the FTS index. The default is off.
For information on re-indexing,
“Rebuilding the Full Text Search Index” on page 403.
Note that re-indexing can take a long time.

Ignore Words List Displays the Ignore Words List used for full text searches in the
database. This window lets you specify which words will not be
indexed. Using the Ignore Words List, the AR System ignores these
words in the database. To use the Ignore Words List, “Modifying the
Ignore Words List” on page 401.
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Configuring FTS Search Options

In both accrue and non-accrue searches, the Search Options menu in the Full
Text Search window (Figure 17-3 on page 400) allows you to configure how the
server interprets queries on fields indexed for FTS. Whether or not users create
FTS queries using wild cards, you can define how those queries will be
interpreted by the server. This is important because the presence or absence of
wild cards in an FTS query can significantly impact search performance.

Note – If the FTS search option is set to add wildcards to the search string, the
stemming capability on accrue searches is disabled. For additional information,
“Searching for Word Stems” on page 387.

For Searches Using the Accrue Operator

Table 17-3 lists FTS search option actions in the server when users enter an
accrue operator in a query.

Table 17-3 FTS Search Option Actions for Accrue Operation (1 of 3)

Search
Option

Search
Term
Passed
to Server

Server
Interprets ARs Retrieved

Search Performance
Results

Force
Leading
& Trailing
Wildcard

turn, %turn%, Any AR with
turn as part of
the word,
including:
* right turn
* turn left
* turned
* return
* turned left
* user returned
* turnabout is

* Slowest search
performance for
users.
* Maximum number
of ARs retrieved.

%turn, %turn%,

turn%, %turn%,

%turn%, %turn%,
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Ignore
Leading
& Force
Trailing
Wildcard

turn, turn%, Any AR starting
with turn as the
starting part of the
word, including:
* right turn
* turn left
* turned
* turned left
* turnabout is

Will not retrieve ARs
with return in
them.
Creates performance
results that users will
most likely expect in
an FTS, including:
* Relatively fast
search.
* Retrieves the
number of ARs most
users probably
anticipate from an
FTS.

%turn, turn%,

turn%, turn%,

%turn%, turn%,

Ignore
Leading
Wildcard

turn, turn, Any AR starting
with word turn and
possibly its stems,
including:
* right turn
* turn left
* turned
* turned left

Will not retrieve ARs
with return in
them.
* Relatively fast
search.
* May not retrieve
the ARs that users
expect because query
does not
consistently add a
trailing wild card.
For example, the
search terms turn%
and %turn% will
retrieve ARs with
turnabout is  in
them, the other
search terms will
not.

%turn, turn,

turn%, turn%,

%turn%, turn%,

Table 17-3 FTS Search Option Actions for Accrue Operation (2 of 3)

Search
Option

Search
Term
Passed
to Server

Server
Interprets ARs Retrieved

Search Performance
Results
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Note – Be aware that the QBE Match settings defined in the Field Properties
window will affect the search terms that are passed to the server. For example,
a QBE Match set to Anywhere adds additional wild cards to your search term
(perhaps creating unexpected results in QBE searches). We recommend that the
QBE Match not be set to Equal if a field is indexed for FTS.

Remove
Leading
& Trailing
Wildcards

turn, turn, Any AR with word
turn (and its stems),
including:
* right turn
* turn left
* turned
* turned left

Will not retrieve ARs
with return or
turnaround in
them.
* Fastest search
performance.
* Potentially fewest
ARs retrieved
because query never
contains wild cards.

%turn, turn,

turn%, turn,

%turn%, turn,

Query
Unchange
d (default)

turn, turn, Retrieves ARs that
match the
the search string.

Depends on the
wild cards specified
by the user.

%turn, %turn,

turn%, turn%,

%turn%, %turn%,

Table 17-3 FTS Search Option Actions for Accrue Operation (3 of 3)

Search
Option

Search
Term
Passed
to Server

Server
Interprets ARs Retrieved

Search Performance
Results
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For Non-Accrue Searches

The information in Table 17-3 on page 397 on how the server interprets
wildcards also applies to non-accrue searches, with the following qualification.
In non-accrue searches, the FTS engine searches the entire contents of all ARs
indexed for that field. As a result, if you enter the query string turn  and the
server does not add or remove wildcards, you find exact matches if the only
data in the AR is turn .

However, if you entered turn% , you would retrieve ARs with the following:
turn left
turned
turned left
turning
turnabout

To configure the FTS search option:
1. With the Full Text Search tab selected in the Server Information dialog

box (Figure 17-3), select an item from the Search Options drop-down list.

Figure 17-3 FTS Search Options Menu

2. Click the OK or Apply button to save the search option settings.
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Modifying the Ignore Words List

The Ignore Words List (Figure 17-4) causes the full text search engine to ignore
frequently-used words or words you do not want indexed (such as and , the ,
because , and so on).

Note – If you extensively modify the ignore words list, you should consider
rebuilding the FTS index. Because the indexes are already created, the modified
ignore words list affects only changes to the FTS index that are made after you
click the OK button. To rebuild the index, “Rebuilding the Full Text Search
Index” on page 403.

To modify the Ignore Words List:
1. In the Server Information — Full Text Search dialog box, click the Ignore

Words List button. The Ignore Words List dialog box appears, as shown in
Figure 17-4. The Ignore Words list contains the words that are currently
defined.
This dialog box lets you define which words will not appear in the index.
You can either modify the existing list entry by entry or append a series of
ignore words to the Ignore Words list by loading a file.

Figure 17-4 FTS Ignore Words List

2. To modify the Ignore Words list, do one of the following:
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• To add a word to the Ignore Words list, type a word in the Word field, then
click Add. Each entry in the Ignore Words list must be unique.

• To delete a word from the Ignore Words list, choose an entry, then click
Remove.

• To modify an entry in the Ignore Words list, choose the entry from the list.
The entry appears in the Word field. Edit the entry, then click Modify. The
edited entry re-appears in the Ignore Words list.

• To delete all words from the Ignore Words list, choose Remove All.
• To append a list of words to the Ignore Words list, click Load From File,

then select a file from the dialog box.

3. Click the OK button in the Ignore Words List dialog box to save the
settings.

4. Click the OK button in the Server Information dialog box to apply all the
changes you made from the Full Text Search tab. Remember that the
modified ignore words list affects only changes to the FTS index that are
made after you click the OK or Apply buttons.

Appending a List of Words to the Ignore Words List

You can append an entire list of words to the Ignore Words list rather than
having to add words one at a time.

To append a list of words to the Ignore Words List:
1. In the Ignore Words List dialog box, click the Load From File button. A

dialog box will appear.

2. Specify a file name containing the list of words you want appended to the
Ignore Words List. This file can contain only one word per line.

3. Click the OK button. The file entries appear in the Ignore Words list and
the words append to the previous list.

4. Click the OK button in the Ignore Words List dialog box.

5. If needed, select the Reindex check box in the Server Information dialog
box to rebuild the FTS index after making any changes in the Ignore
Words List.

6. Click the OK button to save the option settings.
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Note – To replace the current Ignore Words List with a list from the file, first
click Remove All, then load the list from the file.

Rebuilding the Full Text Search Index

If you need to rebuild the FTS index, be aware that rebuilding it can take
several hours.

To re-build the FTS index:
1. In the Server window, select the server that is licensed for FTS.

2. Choose Server Information from the File menu. The Server Information
dialog box appears.

3. Click the Full Text Search tab (Figure 17-5).

Figure 17-5 Server Information Dialog Box

4. Select the Reindex check box.
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5. Click the OK button to start the re-indexing process. You are prompted if
you want to continue re-indexing. The Server Information dialog box
closes when re-indexing is completed.

Note – Remember that rebuilding your entire index could take several hours.
Do not rebuild an index or define fields for FTS during normal production
hours, especially if you have a lot of ARs in your database.

Defining a Field for FTS in the Field Properties Window

Use the Field Properties window (Figure 17-6) to create an FTS index of the text
in character and diary fields.

Note – Do not define fields for FTS during normal production hours, especially
if you have a lot of ARs in your database.

To define a field for FTS:
1. Open the Field Properties window (Figure 17-6).

Figure 17-6 Index For FTS Setting in Field Properties Dialog Box

2. Click the Attributes tab.

Setting a field to
be indexed for
FTS
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3. Select the Index For FTS check box.

4. Click the Save button on the toolbar. The AR System then begins to index
the field for FTS.

The FTS index for a field is automatically updated and does not require
manual run-time administration when you create, delete, or modify entries.

Note – The Index For FTS check box does not appear for servers that do not
support the FTS option.

Importing Data into Schemas with FTS Fields

Be aware that sizeable performance impacts can occur if you are importing a
lot of data into a schema with FTS fields.

Note – Do not import data in schemas with FTS fields during normal
production hours, especially if you have to disable Full Text Operation.

Estimating the Size of the FTS Index

Locate the FTS index in a directory that has sufficient disk space. Remedy
recommends that the directory be large enough to accommodate
approximately 1 to 1.5 times the amount of data that is indexed for FTS. For
example, if the total amount of data in all fields you want to be indexed for
FTS in all schemas is 100 MB, then you will need between 100 and 150 MB of
disk space for the full text indexes.

Remember that this example of determining the size of an FTS index is an
approximation only.

Note – For performance reasons, you should create indexes on local partitions
in your system, not NFS-mounted partitions. Indexing and searching NFS-
mounted directories takes significantly longer than when using local
directories.
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To estimate size of the FTS index:
Use the following steps to determine approximately how much disk space is
occupied by the FTS index:

1. Estimate the size of text in your database. For example, take a small
sample of entries and calculate the average size of data in the field. Then
multiply this average by the number of ARs to derive the size of text in
your database.

2. Use a number between 1.0 and 1.5 as a percentage multiplier. The ratio of
the size of the FTS index to source text can differ widely, based on, for
example, the size of your Ignore Words List.
If the estimated size of text is 100 MB, the FTS index occupies between 100
and 150 MB of disk space: 100 MB * 1.0 = 100 MB as the lower boundary of
the FTS index and 100 MB * 1.5 = 150 MB as the upper.

Moving the FTS Index

There may be situations when you need to move the FTS index, especially if it
becomes quite large.

To move the FTS index:
1. Estimate how much space you need in the new directory location to

relocate the FTS index.

2. Before disabling FTS on the server, wait until the number of pending ARs
in the <ar_install_dir>/db/arftp.lst file reaches 0 (zero).

3. Open the Server Information dialog box and disable FTS by clearing the
Enable Full Text Search check box (Figure 17-7 on page 407).
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Figure 17-7 Server Information Dialog Box

4. Copy the contents of the FTS index directory to its new location.

5. Enter the new location of the directory in the FTS Index Directory field.

6. Enable FTS.
You then can remove or delete the old FTS index, as needed. However, you
do not have to copy the contents of the old directory if you re-index after
changing the directory location and enabling FTS.

Placing FTS Weight in a Query List

In the Query List Fields Dialog Box (Figure 17-8 on page 408), you can display
the FTS weight for all records retrieved in the query list.

To define fields returned in a query list:
1. Create or open the schema for which you want to define the query list

format.

2. Open the Schema Properties dialog box appears (Figure 17-8 on page 408).
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Figure 17-8 Query List Fields Dialog Box

3. Click the Query List Fields tab in the Schema Properties dialog box.

4. From the Fields in schema menu, select WEIGHT along with any fields that
you want to appear in the Field Name list.

5. Click the OK button, then click the Save button on the toolbar to save
your query list definition.

Including the WEIGHT value displays the weighted value of retrieved ARs when
you do a query list in the User Tool. In the query results shown in Figure 17-9
on page 409, the FTS engine assigned different “weights” to the records
retrieved and listed them in descending order, based on how many times the
search terms were found.

Selecting WEIGHT
for a full text search
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Figure 17-9 Query List Results with FTS Weighting

For further information on weights in an FTS, “Sorting Records by Weight” on
page 384.

FTS weights assigned
to the records
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AR System Server Utilities 18

This chapter describes how to use the arcache  and arreload  utilities to
administer your Windows NT server.

This chapter covers the following topics:

• Using arcache .

• Using arreload .

• Modifying the Windows NT registry to include additional servers.

Using the arcache Utility
You use arcache  to update an entry in one or more user/group caches in the
AR System. Use the following command and options from the command line:

arcache  {-U | -G} {a | d}  [ -d ] -e entryId  [ -n name ] [ -s server ]
[ -g groupList ] [ -ld dashboardLicense ] [ -lf fulltextLicense]
[ -lw writeLicense ] [ -m mailAddress ] [ -p password ]
[ -x notifyMech ]
-i groupId ] [ -t groupType ]

The arcache  utility allows you to update a single user/group entry in the
access control cache for one or more AR System servers. You specify the
operation you want to perform and the information about the item to update.
The program will send that update to all the appropriate target servers to
update their caches with the new information.
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This program is only used in a multi-server environment where there is a
desire to have a centralized access control scheme. All updates from a
user/group schema to the local access control cache are performed
automatically.

This program is generally run using a filter in the AR System. A set of four
sample filters to add/delete from the user/group cache when deletes or
submits/sets are made to the User or Group schemas are provided in the
<ar_install_dir>\arserver\samples directory with an AR System
installation. These filters allow the system to perform an appropriate update
operation on all servers whenever the schemas that contain the user/group
information are updated.

arcache Options

There is a set of common options that can be used with either users or groups
and a set of options specific to one or the other. Each option is identified below
according to which type of option it is.

The following settings and options to arcache  may appear in any order on the
command line:

Table 18-1 Settings and Options for the arcache  utility  (1 of 3)

Option Action

-d Set the system into debugging mode. This mode prints messages to
stdout that detail the progress of the operations it is performing.
Debugging mode should be used only to find problems with how the
arcache process is running.

-e Identifies the entry ID of the corresponding entry in the User or Group
schema. This is the key for the entry and must be supplied for both
users and groups.

-g A list of groups defining the user’s permissions in the system. This list
consists of a set of one or more group IDs separated by semicolons. This
field is used only when adding/updating users.
For example, for a new user who was an administrator, the group list
value would be 1; . If the user had Customize capability and was a
member of the Staff group (which had an ID of 43), the value would be
2; 43;.
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-G Identifies this operation as an operation on the group cache. This tag
must be followed by the type of operation to be performed:
a — Add a new or update an existing group
d — Delete an existing group
This option is mutually exclusive with the -U option.

-i The ID for the group. This field is used only when adding/updating
groups.

-ld The Flashboards license type (0 — none, 1 — fixed, or 2 — floating) to be
issued to this user. This field is used only when adding/updating users.
If no Flashboards license type is specified, it will default to none.

-lf The full text license type (0 - none, 1 - fixed, or 2 - floating) to be issued
to this user. This field is used only when adding/updating users.
If no full text license type is specified, it will default to none.

-lw The write license type (0 - read, 1 - fixed, or 2 - floating) to be issued to
this user. This field is used only when adding/updating users.
If no write license type is specified, it will default to read.

-m The email address for the user. The address is used by default when a
message is to be sent to the user. This field is used only when
adding/updating users.

-n The name of the user/group. This field is required for add operations
and is recommended (but not required) for delete operations. This field
is used with both users and groups.

-p The password for the user. This field is used only when
adding/updating users.

-s The name of a single server. Ordinarily, the program will update the
entry in all servers in the system. It finds all servers by reading the
<ar_config_dir>\ar file and contacting all AR System servers it
identifies. With this option, you can identify a single specific server to be
updated with the information. This field can be used with both users
and groups.
Note: If you do not specify a -s option, arcache will look for a list of
servers from the Windows NT Registry. For more information, see
“Creating and Modifying the Server List in the Windows NT Registry”
on page 416.

Table 18-1 Settings and Options for the arcache  utility  (2 of 3)

Option Action



414 Action Request System Adminitrator’s Guide for Windows—December 1995

18

Using arcache from the Command Line

The following example adds a new user to all server caches. The new user is
Fred Johnson with no password, an email address of fredj@remedy.com, and a
default notify mechanism of 1. The entry ID of the entry in the User schema is
000000000000104. Fred will be added to the cache as a user who is a member of
no access group.

arcache -Ua -e000000000000104 -n "Fred Johnson" -m \
"fredj@remedy.com" -x 1

Using the arreload Utility
You use arreload  to reload all the user/group cache entries from a given
schema. Use the following command and options from the command line:

arreload  { -u | -g } schema -a adminUser [ -d ] [ -f ]
[ -p adminPassword ]  [ -s server ]

The arreload utility allows you to reload the user/group caches from a given
user/group schema to one or more AR System servers. The process will delete
all the existing cached entries for the selected schema and load all the
information from the schema into the cache. This is useful for bringing all the
servers into sync.

-t The type of the group (1 — view only or 2 — view/change). This field
is used only when adding/updating groups.

-U Identifies this operation as an operation on the user cache. This tag must
be followed by the type of operation to be performed:
a — Add a new or update an existing user
d — Delete an existing user
This option is mutually exclusive with the -G option.

-x The default notify mechanism for the user. The notify mechanism is
used when a notification is delivered to the user via the default notify
method for that user. This field is used only when adding/updating
users.
If no notify mechanism is specified, it will default to 1 (notifier).

Table 18-1 Settings and Options for the arcache  utility  (3 of 3)

Option Action
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Note – This process must be run on the same machine as the AR System server
that contains the schema to be reloaded. You can only run arreload  on a
machine that is an AR server and it will only load users from that machine’s
schemas.

In a multi-server environment, this program is generally run as part of a
periodic maintenance operation for the AR System. Setting up a job to run on a
weekly or monthly basis that does a reload of the user/group caches helps
insure that all the caches remain in sync with all the latest information. In a
single-server environment, this program is generally unused (except to recover
from disk crashes).

arreload Options

The following options to arreload  may appear in any order on the command
line:

Table 18-2 Settings and Options for the arreload utility  (1 of 2)

Option  Action

-a The user name of a user with Administrator access to the schema to be
reloaded.

-f Flush the user or group cache definition of entries from all servers
before reloading the cache with the specified definitions. This option is
especially useful when you are changing or renaming the machine that
is running the AR System.

-d Set the system into debugging mode. This mode prints messages to
stdout that detail the progress of the operations it is performing.

-g Identifies this operation as a group reload and supplies the name of the
schema that is to be reloaded.
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Using arreload from the Command Line

The following example reloads the user cache of all servers to remove any
existing definitions from the user schema on this server and add entries for all
the current users defined in the User schema. The administrator user is Admin
with a password of password to allow access to the schema to get the
information to be reloaded.

arreload -a Admin -p password -u User

Creating and Modifying the Server List in the Windows NT Registry
In the Windows NT environment, if you want to use arcache  or arreload  to
update multiple servers (or to make the ARGetListServer API call), use the
Registry Editor to modify the server list for your machine.

To create or modify the Windows NT Registry:
1. Open the Register Editor by entering the following at a DOS command

prompt:

regedt32

The Registry Editor appears.

-p The password for the Administrator user identified with the -a option.
If there is a password for the Administrator identified (which is
recommended), you must specify this option with the appropriate
password.

-s The name of a single server. Ordinarily, the program will update the
entry in all servers in the system. It finds all servers by reading the
<ar_config_dir>\ar  file and contacting all AR System servers it
identifies. With this option, you can identify a single specific server to
be updated with the information.
Note: If you do not specify a -s option, arreload  will look for a list
of servers from the Windows NT Registry. For more information, see
“Creating and Modifying the Server List in the Windows NT Registry”
on page 416.

-u Identifies this operation as a user reload and supplies the name of the
schema that is to be reloaded.

Table 18-2 Settings and Options for the arreload utility  (2 of 2)

Option  Action
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2. Select the HKEY_LOCAL_MACHINE on Local Machine window, as
shown in Figure 18-1.

Figure 18-1 Register Editor

3. Select the SOFTWARE\Remedy\ARServer\CurrentVersion directory.

4. If the ServerList entry already exists, double-click it to open the Multi-
String Editor. Otherwise, perform steps a - c.

a. From the Edit menu, choose Add Value. The Add Value dialog box
appears (Figure 18-2).

Figure 18-2 Add Value Dialog Box

b. In the Value Name field, enter the following:

ServerList
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c. From the Data Type drop-down list, choose REG_MULTI_SZ and click
the OK button. The Multi-String Editor appears, as shown in
Figure 18-3.

Figure 18-3 Multi-String Editor

5. Add any servers to the list that you want updated whenever you use
arcache , arreload, or the ARGetListServer API call.

6. Click the OK button. The ServerList appears in the
HKEY_LOCAL_MACHINE on Local Machine window, as shown in
Figure 18-4 on page 419.
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Figure 18-4 Server List Added to Registry
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Networking Notes A

To run the AR System Administrator Tool, you must have installed one of the
following supported network stacks:

• Windows Sockets certified on one of the following:
- Chameleon NFS by NetManage.
- LAN WorkPlace by Novell.
- Pathway by Wollongong.
- PC-NFS by SunSelect.
- PC/TCP by FTP.
- Reflection Network Series 4.0 by Walker Richer & Quinn
- Super TCP/NFS by Frontier.
- TCP/IP by Microsoft.
- TCP/IP for OS/2 by IBM.

Requirements for Supported Stacks

Chameleon by NetManage

Supported Versions

4.0 (with patch 4) or later
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Additional Considerations

You need to acquire and install the latest winsock.dll. This patch may be
obtained through the following:

• Call NetManage support at (408) 973-7171.

LAN WorkPlace by Novell

Supported Versions

4.12 or later

Additional Considerations

Purchase LAN WorkPlace or LAN WorkGroup from Novell.

Pathway by Wollongong

Supported Versions

3.2 or later

Additional Considerations

You need to acquire and install the latest winsock.dll. This patch may be
obtained through the following:

• Call Wollongong support at (415) 962-7140.

PC-NFS by SunSelect

Supported Versions

5.1 or later
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Additional Considerations

You need to have 500K of conventional memory free before and after you start
Windows.

PC/TCP by FTP

Supported Versions

3.0 (VxD) or later

Additional Considerations

You need to acquire and install the latest winsock.dll. This patch may be
obtained through the following sources:

• Anonymous ftp from vax.ftp.com.

• BBS dial-in to (508) 659-6240.

• Call FTP support at (800) 382-4FTP.

Reflection Network Series by Walker Richer & Quinn

Supported Versions

4.0 or later

Super TCP by Frontier

Supported Versions

4.0 (with patch) or later
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TCP/IP by Microsoft

Supported Versions

TCP/IP-32 version 3.11a or later

Additional Considerations

You need to acquire and install the latest winsock.dll. This patch may be
obtained through the following:

• Anonymous ftp from microsoft.com.

• BBS dial-in to (503) 531-8100

• Call Microsoft at (206) 882-8080.

TCP/IP for OS/2 by IBM

Supported Versions

IBM OS/2 Warp

TCP/IP Version 2.0 for OS/2: Base Kit
TCP/IP Version 2.0 for OS/2: DOS/Windows Access Kit
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AR SystemFile Locations B

This Appendix describes the various files needed by and created by the AR
System. The directory where the AR System executables are installed is
referred to here as <ar_install_dir> (by default, this directory is \remedy ). The
directory specified to hold the user’s configuration information is referred to
here as <ar_config_dir> (by default, this directory is \Home ).

AR System Administrator Tool Files
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AR System Import Tool Files

File Locations on the UNIX System Server

Note – Terminology Be aware in this appendix that, for some of the files listed,
“NT” refers to the AR System Notification Tool, for example, NTSystem . When
this appendix refers to the Windows NT operating system, it is described either
as “the Windows NT operating system” or simply as “Windows NT.”
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File Locations on the Windows NT System Server

Note – Terminology Be aware in this appendix that, for some of the files listed,
“NT” refers to the AR System Notification Tool, for example, NTSystem . When
this appendix refers to the Windows NT operating system, it is described either
as the Windows NT operating system” or simply as “Windows NT.”
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Core and Reserved Schema Fields C

The AR System allows flexibility in creating schemas to address the varied
needs of its users. While it is recognized that customization is vital, it is also
recognized that the schemas created for resolving action requests have a set of
concepts and information needs in common.

The AR System core schema fields are a set of fields that every schema must
have. The commonality gained by such a convention is useful for conceptual
consistency, sharing macros, sharing filters, and exchanging and merging
databases.

The AR System reserved fields are special purpose data fields that exist on
either the User schema or the Group schema, for row level access control, or
that you can add to schemas if you are licensed with the Distributed Server
Option. You can use the reserved fields in any schema, if desired. See
Chapter 5, for more information on access control.

There are additional limits placed on the core fields, including the fact that
some fields are required, others are maintained by the system, and others have
fixed or maximum sizes. Core field limits cannot be changed. All the extra core
field limits are noted in this appendix.

In addition to the core and reserved fields, a number of other fields are defined
within the AR System. These are fields that were core fields in prior releases of
the AR System. You can still use these fields on the schemas you design, as
long as you follow the rules that pertain to them. These fields and their rules
are also noted in this appendix.
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Core Schema Fields

Note – Users can change these field labels.

The following list of fields are common to all schemas:

Table C-1 Core Schema Fields  (1 of 2)

Field Description

Entry-Id A unique identification value for each request entering the system.
It is created and maintained by the system; however it is possible to
prepend a string to the value for descriptive purposes. Groups that
have neither Change nor View access to a schema’s Entry ID field
will not be able to access information from any of the schema’s
fields, regardless of the permissions settings of the other fields.
Data Type           Character
Max Length        15
Min Length         5
Field ID                1

Submitter The name of the user who submitted the entry. It is usually the
name of the AR System user who performed the submit operation,
though it may not be (as in the case of someone submitting for
someone else).
Data Type        Character
Length              30
Field ID             2

Create-date The time at which the entry was created in the system. This field is
set by the AR System and cannot be modified. It serves as a reliable
time-stamp for database entries.
Data Type        DateTime
Field ID            3

Assigned-to The name of the user who has been assigned responsibility for the
AR.
Data Type        Character
Length             30
Field ID             4
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Last-
modified-by

The name of the user who last altered the AR. This field is set by the
AR System to the login name of the user who last changed the entry.
It cannot be modified.
Data Type        Character
Length                30
Field ID               5

Modified-
date

The date the field was last modified. This field is set by the AR
System to the time the last change to this entry was made. It cannot
be modified.
Data Type        DateTime
Field ID             6

Status Indicates the current state of the entry. Users have control over this
field. It must have a value at all times; there must be a default value
in case there is no value specified by the user at create time. The
actual names and values of the status field can be customized.
Data Type        Selection
Field ID            7

Short-
Description

A brief description of the reason for the request. A size limit forces
the submitter to be concise, including only the key problem. This
allows for quick delegation to appropriate support staff who can
then investigate more descriptive fields.
Data Type        Character
Max Length        128
Field ID                  8

Status-
History

The user who last changed and the time the change was made to
each of the states identified by the Status field. This field is set and
maintained by the AR System and cannot be modified.
Data Type        Character
Field ID              15

Table C-1 Core Schema Fields  (2 of 2)

Field Description
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Reserved Schema Fields
The AR System User schema contains eight reserved fields, as listed below.

Table C-2 Reserved Schema Fields  (1 of 2)

Field Description

Login name The name of a user who is allowed to access the AR System. This is
the name the user will enter in the User Name field on the Login
dialog box when logging into the system.
Data Type        Character
Length                30
Field ID           101

Password The password of the user whose login name is in the Login name
field. This is the password the user will enter when logging into the
system.
Data Type        Character
Length               30
Field ID          102

Email
Address

The email address of the user whose login name is in the Login
name field.
Data Type        Character
Max Length        255
Field ID             103

Group list The list of access control groups to which the user whose name is in
the Login name field belongs. Group names are separated by
spaces. Note that though you make entries to the Group list using
the alias name (Group name for a group), the Group ID is actually
stored as an integer value.
Data Type        Character
Max Length        255
Field ID              104

License Type The type of write license the user has. The choices are Read
(includes Submit permission), Fixed, and Floating.
Data Type        Selection
Selection           Read/Fixed/Floating
Field ID            108
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The AR System Group schema contains three reserved fields, as listed below:

Default Notify
Mechanism

The notification method that is used if the user specifies
that the default mechanism should be used. There are as many
choices as there are notify mechanisms.
Data Type        Selection
Field ID            109

Full Text
License Type

The type of full text license the user has. The choices are None,
Fixed, and Floating.
Data Type        Selection
Selection           None/Fixed/Floating
Field ID            110

Flashboards
License

The type of Flashboards license the user has. The choices are None
and Fixed.
Data Type        Selection
Selection           None/Fixed
Field ID            111

Table C-3 Reserved Fields in Group Schema

Field Description

Group name The alias by which the access control group is known. This is the
name used in the Group list field of the User schema and in the
Group Permissions list of each schema field.
Data Type        Character
Length               30
Field ID          105

Group id The integer ID that is the identifier by which the AR System
recognizes the group named in the Group name field. (For groups
that you create, the ID should be greater than 10.)
Data Type        Integer
Range                 0-100 (can be expanded if desired)
Field ID            106

Group type The maximum permission type intended for the group named in the
Group Name field. The choices are None, View, and Change.
Data Type        Selection
Selection          None/View/Change
Field ID        107

Table C-2 Reserved Schema Fields  (2 of 2)

Field Description
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You also can add a field to support row level access, as listed below:

The AR System Distributed Server Option contains the following reserved
fields that you can add to schemas, as listed below:

Table C-4 Row Level Access Control Reserved Field

Field Description

Assignee The group assigned ownership of the entry.
Data Type        Character
Field ID            112

Table C-5 Distributed Mapping Reserved Fields

Field Description

Transfer
Status

The status of a distributed server transfer operation. The choices are
Success, Retry, Failure, Timeout, and Cancelled.
Data Type        Selection
Selection           Success/Retry/Failure/Timeout/Cancelled
Field ID            301

Update
Status

The status of a distributed server update operation. The choices are
Success, Waiting, Retry, Failure, Timeout, and Cancelled.
Data Type        Selection
Selection           Success/Waiting/Retry/Failure/Timeout/
                            Cancelled
Field ID            302

Master Flag Flag indicating whether or not the entry is the master. The choices
are No and Yes.
Data Type        Selection
Selection           No/Yes
Field ID            303

From
Entry ID

The ID of the original entry from which this copy was transferred.
Data Type        Character
Length               15
Field ID          307

From Schema The schema from which this entry was transferred.
Data Type        Character
Length                30
Field ID           310
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From Server The server from which this entry was transferred.
Data Type        Character
Length                64
Field ID           311

To
Mapping

The field which tells the Distributed Server Option the mapping to
be used when transferring the entry.
Data Type        Character
Length                30
Field ID           300

From
Mapping

The mapping that was used during a transfer to create this entry.
Data Type        Character
Length                30
Field ID           306

To Entry ID The ID of the entry that the data was transferred to.
Data Type        Character
Length                15
Field ID           308

To Schema The schema to which to transfer the entry.
Data Type        Character
Length                30
Field ID           312

To Server The server to which to transfer the entry.
Data Type        Character
Length               64
Field ID           313

Mapping
History

A history tracking record created at transfer time, which includes
the date/time of transfer, source entry ID, source schema, source
server and the name of the specific mapping used.
Data Type        Character
Field ID            309

Current
Schema

The schema in which the master copy of the entry resides.
Data Type        Character
Length                30
Field ID           304

Table C-5 Distributed Mapping Reserved Fields

Field Description
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Additional AR System Defined Fields
The following fields were defined as core fields in AR System versions prior to
the 1.2 release. You may use these fields in schemas you design; however, you

Current
Server

The server on which the schema with the master copy of the entry
resides.
Data Type        Character
Length               30
Field ID           305

When to
Update

The frequency with which to update the original entry if a
transferred copy is updated. The choices are Immediately, Hourly,
Daily, On Return, and No Update.
Data Type        Selection
Selection            Immediately/Hourly/Daily/On Return/
                             No Update
Field ID             314

Transfer
Mode

The type of transfer to perform. The choices are Data Only, Data +
Ownership, Independent Copy, and Copy + Delete.
Data Type        Selection
Selection           Data Only/Data + Ownership/
                            Independent Copy/Copy + Delete
Field ID           315

Duplicate
Entry ID
Action

The action that will occur if you transfer an entry and there is
already an entry with the same entry ID in the To schema. The
choices are Error, Overwrite, and Create New.
Data Type        Selection
Selection           Error/Overwrite/Create New
Field ID           316

Max Time to
Retry

The maximum time (in hours and minutes) to keep re-trying a
distributed operation on an entry before the system cancels the
operation.
Data Type        Integer
Field ID           317

Table C-5 Distributed Mapping Reserved Fields

Field Description
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must follow the rules specified below.

Table C-6 Additional AR System Defined Field

Field Description

Long-
Description

An open-ended description of the problem. The long description is
used to expand upon the short description.
Date Type        Character
Field ID            9

Disposition A running log of the progress on the request, time and user
stamped each time it is accessed. Once information in this field has
been applied, it becomes read-only. This field will always accept
new information.
Data Type        Diary
Field ID           10

Related-to Information about items this entry is related to, such as Entry IDs of
other tickets with similar problems.
Data Type        Character
Max Length        128
Field ID               11

Notify-
method

How the submitter wishes to be notified of significant progress on
the request.
Data Type        Selection
Field ID           12

Submitter-
severity

How critical the AR is to the submitter. It is a subjective assessment
of the severity of the problem.
Data Type        Selection
Field ID           13

Assigned-
priority

The priority assigned to the request by the delegator or support
staff. The value in this field can be used for generating statistics and
reports, as well as setting priorities for support staff.
Data Type        Selection
Field ID           14
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Operators, Wildcards, and
Keywords D

The following information is provided in this appendix:

• Operators used in defining qualifications.

• Operator precedence.

• Wildcards.

• Keywords.
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Table of Operators

Table D-1 Operators Used in Qualifications  (1 of 2)

Operator Action

AND

&&

Logical AND of the result of two conditions (the result is true only if
both conditions are true). For example, 'Status'=''New'' AND
'Assigned-to'=''Andy''  would find all new ARs assigned to
Andy.
You can use the symbol && instead of the word AND.

OR

||

Logical OR of the result of two conditions (the result is true if either
condition is true). For example, 'Status'=''New'' OR
'Assigned-to'=''Andy''  would find all new ARs and all ARs
assigned to Andy (no matter what their status).
You can use the symbol ||  (two vertical lines) instead of the word OR.

NOT

!

Negates the condition that follows (if the condition is false, the result
is true). For example, NOT 'Status'=''New''  would find all ARs
that are not new.
You can use the symbol ! instead of the word NOT.

LIKE Performs a pattern search. For example, 'Submitter' LIKE
''Bob%ton''  would find all ARs with a submitter name that begins
with the letters “Bob” and ends with the letters “ton” — such as Bob
Compton and Bobby Fenton. The LIKE  operator is useful only with
character and diary type fields. For more information on wildcards,
see Table D-2 on page 446.
You also use LIKE  along with comma separators as the accrue
operator in full text searches. For further information, see “How Do I
Use FTS?” on page 385.

+ * Adds two integer or real values.
* Adds an integer or real interval to a time value.
* Concatenates two character strings.
For example, 'Create-date' > $DATE$ + 28800  would find all
ARs that were created after 8:00 am today. (28800 is the number of
seconds in 8 hours.)

- * Subtracts two integer or real values.
* Subtracts two time values (resulting in an integer).
* Subtracts an integer or real interval from a time value.
For example, 'Create-date' > $DATE$ - 604800 would find all
ARs that were created within the past week. (604800 is the number of
seconds in one week.)
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Operator Precedence

When you use multiple operators in constructing qualification criteria, they are
evaluated in the following order.

1. ( )

2. !, NOT, - (unary minus)

* Multiplies two integer or real values. For example,
'Quantity' * 'Price' > 50  finds all ARs where the contents of the
Quantity field times the contents of the Price field is over 50.

/ Divides two integer or real values. For example,
'Total Expenses' / 'Total Income' = 1  would find all ARs
where the total amount spent for expenses equaled the total amount
brought in as income.

% Supplies the modulo of two integer values (the remainder of a divide
of the values). Since a percent sign is also a valid wild card symbol, the
context when using a percent sign determines how it is interpreted.
For example,
'ID' % 2 = 1  finds all ARs with an odd number in the ID field.

< Matches contents that are less than the value. For example,
'Create-date' < ($DATE$ - 86400)  would find all ARs created
more than 24 hours ago. (86400 is the number of seconds in 24 hours.)

> Matches contents that are greater than the value. For example,
'Create-date' > "06/10/93 00:00:00"  would find all ARs
with Create-dates that are more recent than June 10, 1993 at midnight.

!= Matches contents that are not equal to the value. For example,
'Status' != "Closed"  finds all ARs that aren’t closed.

<= Matches contents that are less than or equal to the value. For example,
'Salary'<= 10000 would find all ARs where the contents of the
Salary field is less than or equal to 10000.

>= Matches contents that are greater than or equal to the value. For
example, 'Create-date' >= "10/31/93"  would find all ARs with
Create-dates equal to or more recent than October 31, 1993.

= Matches contents that are exactly equal to the value. For example,
'Status' = 0  would find all ARs with a status value equal to the
first selection value.

Table D-1 Operators Used in Qualifications  (2 of 2)

Operator Action



446 Action Request System Adminitrator’s Guide for Windows—December 1995

D

3. *, /, %

4. +, -

5. <, <=, >, >=, =, !=

6. && (AND)

7. || (OR)

Operators of the same precedence are performed left to right.

Table of Wild Cards
The table below lists the wild cards that you can use with the LIKE  operator in
qualifications.

Wild card symbols are only interpreted as wild cards when used with the LIKE

operator; otherwise they are interpreted verbatim. To use the percent symbol
(%), underbar ( _ ), or open bracket ( [ ) as an explicit text character within a
LIKE  operation, you must enclose the symbol in brackets. For example, [%] will
match the % character — not find 0 or more characters. The close bracket ( ] )
functions as a wild card only when it is accompanied by an open bracket ( [ ).
The hyphen functions as a wild card character only when preceded by an open
bracket ( [ or [^ ).

Table D-2 Wild Card Symbols

Wild Card Action

% Matches any string of 0 or more characters.
Example: J%son matches Jackson, Johnson, Jason, and Json.

- (Underbar) Matches any single character.
Example: B_b matches Bab, Bob, and Bub.

[ ] Matches any single character within a specified range or set.
Example: [a-f ] matches the range of characters a through f . [abcf ]
matches the set of characters abc and f .

[- ] (Hyphen) Indicates a character range. Used only within brackets ([ ]).
Example: [a-f ] matches the range of characters a through f .

[^ ] Matches any single character not within the specified range or set.
Example: [^a-f ] matches all characters except the range a through f .
[^abcdf ] matches all characters except the set of abcdf .
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You must use the % symbol when you want to include leading and trailing
characters. For example, if you want to match Jill Bobbington, Bobby Fenton,
and Bob Compton in the Submitter field, you could enter
'Submitter' LIKE ''%Bob%ton%'' .

Table of Keywords
You can use any of the keywords from Table D-3 in qualifications or to set a
field value.

• In a qualification, the data type of the keyword value must match the field
data type.

• In a set field, the system will attempt to correct the data type if it is not
compatible.

Table D-3 Keywords  (1 of 2)

Keyword Value

$DATE$ The current date (time defaults to midnight).

$DEFAULT$ The default value for the field, if any.

$HARDWARE$ The hardware on which the process is running. This is the name
that the hardware vendor has given to their hardware, as in the
following:
* On UNIX platforms, the name returned by the uname -m
command (for example, sun4c ).
* On PC platforms, the processor type (for example, PC i486 ).
You can use this keyword to build filters, escalations, and active
links that execute only if the process is running on an appropriate
platform. This is especially useful in an active link, if the action is
to run a UNIX process and the current platform may be a PC.

$GROUPS$ The groups of which the current user is a member. (This keyword
is an empty string for escalations.)

$NULL$ A null value (no value).
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$OPERATION$ The current operation (CREATE, DELETE, GET, MERGE, SET, or
QUERY). You can use this keyword in filter and active link
qualifications to determine whether the current operation is one
that should activate the filter or active link.
For example, in the Modify Active Link window, you could use
the $OPERATION$ keyword to set an “Audit Log” field to:
"Filter X executed on operation" + $OPERATION$
This entry would inform you if the filter fired during a submit
operation (CREATE returned) or a modify operation (SET
returned).
You could also create a qualification that fires only for the Modify
Individual window and not for the Display window, as in the
following example:
 $OPERATION$ = "SET"
Operation values indicate the following AR System actions:
* CREATE — In active links, used on Submit window. In filters,
during an operation to create a new entry.
* DELETE — In filters, during a delete operation. (Unused in
active links.)
* GET — In filters, when an entry is retrieved. (Unused in active
links.)
* MERGE — Merge an existing entry. Used when loading an AR
Export format file with the Import Tool. (Unused in active links.)
* SET — In active links, used on Modify Individual and Modify
All Selected windows. In filters, used on Modify operations.
* QUERY — In active links, used on the Query window. (Unused
in filters.)

$OS$ The operating system of the platform on which the process is
running. You can use this keyword to build filters, escalations, and
active links that execute only if the actions are supported under
the operating system that is running.

$SCHEMA$ The name of the current schema.

$SERVER$ The name of the current server.

$TIME$ The current time as a character string (date defaults to current
day).

$TIMESTAMP$ The current date/time as a character string.

$USER$ The current login user. (This keyword is AR_ESCALATOR for
escalations.)

$WEEKDAY$ The current day of the week as a string.

Table D-3 Keywords  (2 of 2)

Keyword Value
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Design Worksheets E

For beginning AR System administrators and subadministrators, this
appendix contains worksheets that you can reproduce as needed to create
workflow diagrams and design the various AR System objects (for example,
schemas, active links, and so on).
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Workflow Worksheet
State Diagram Objects You Need to Create

Schemas

Data Fields

Filters

Escalation Criteria

Groups

Macros

Active Links

Users
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Schema Worksheet

Schema Name: ____________________________________
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Fields Worksheet

Schema Name: ____________________________________



Design Worksheets 455

E

Active Links Worksheet
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Filters Worksheet
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Escalations Worksheet

New Fields Needed for Escalation?

Escalation Actions & Description
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Procedures F

Here is a list of procedures and their locations.

To install the Windows Administrator and Import Tool software  3
To start the Administrator Tool  14
To specify alternate login information  16
To modify login information  19
To copy login information  20
To delete login information  21
To change the current login  22
To exit the Administrator Tool  22
To display Administrator Tool help  23
To display version and environment information about the Administrator Tool 23
To select a server  39
To display platform information about the currently selected server  42
To set timeouts  43
To display license information and set the Submitter Mode  45
To set the configuration  46
To set log files  50
To display and update information about the database  51
To display information about licenses  53
To force the release of a floating license  56
To create default schema permissions  57
To create default active link permissions  58
To create default field permissions  59
To set desktop preferences  61
To set confirmation preferences  62
To set schema fonts preferences  64
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To set the display menu method  66
To update the change history  69
To establish row level access to a schema and fields  105
To create a group  107
To modify a group  108
To delete a group  109
To add users to the system  111
To allow users to change their passwords  113
To delete a user  113
To create a user with subadministrator capabilities  115
To create a schema  122
To open a schema  122
To save and name a schema  123
To save a schema under a different name  124
To rename a schema  125
To delete a schema  126
To define fields returned in a query list  128
To define indexes for a schema  130
To define permissions for a schema  132
To allow all users to see a schema  133
To define subadministrator permissions  134
To define change history for a schema  135
To define help text for a schema  137
To define permissions for multiple schemas on a server  138
To create a new field  142
To modify a field  143
To restore field properties  144
To delete a field  144
To make a field non-operational  145
To copy a field  146
To create selection values  162
To define field permissions for schema fields  165
To define help text for a field  167
To define change history for a field  168
To define permissions for multiple fields in a schema  170
To select and modify a schema view  175
To copy a schema view  176
To select a default administrator view  176
To delete a schema view  177
To move a field  180
To move multiple fields  181
To enable and display the grid  183
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To define grid size  183
To align fields to the grid  184
To align multiple objects  186
To expand the spacing between fields  188
To create a menu  194
To open a menu  197
To save a menu under a different name  198
To delete a menu  199
To define a character menu  200
To define a menu that uses a file  202
To define a menu that uses a query  204
To define change history for a menu  207
To define help text for a menu  209
To create a filter  213
To open a filter  214
To save a filter under a different name  214
To delete a filter  215
To specify or change filter conditions  216
To create a filter action  225
To modify a filter action  226
To delete a filter action  226
To change the order of filter actions  227
To define the Log to File filter action  228
To define the Message filter action  230
To define the Notify filter action  231
To define the Run Process filter action  236
To define the Set Fields filter action  240
To assign a value from another field in the current transaction  243
To assign a value from a different AR  243
To assign a value using a function in the set field operation  246
To define change history for a filter  251
To define help text for a filter  252
To create an escalation  257
To open an escalation  258
To save an escalation under a different name  258
To delete an escalation  259
To specify or change escalation conditions  260
To specify or change escalation time criteria  263
To set an execution interval  264
To set an execution time  265
To create an active link  271
To open an active link  272



462 Action Request System Adminitrator’s Guide for Windows—December 1995

F

To open an active link from the Modify Schema window  272
To save an active link under a different name  273
To delete an active link  274
To specify or change active link conditions  276
To define display properties for active link buttons  279
To create an active link action  281
To modify an active link action  281
To delete an active link action  282
To change the order of active link actions  282
To define the Change Field active link action  283
To define the DDE active link action  286
To define the Message active link action  290
To define the Run Macro active link action  292
To define the Run Process active link action  295
To define the Set Fields active link action  297
To assign a value from another field on the current screen  301
To assign a value from a different AR  301
To use a function in the set field operation  306
To define permissions for an active link  306
To define permissions for multiple active links on a server  308
To import definitions  312
To export definitions  314
To export a mail template  317
To start the Import Tool  320
To display Import Tool help  322
To exit the Import Tool  322
To display version and environment information about the Import Tool  323
To import data using the Import Tool  324
To map import file fields to schema fields  329
To save mapping information  332
To use an existing mapping file  333
To set fallback mappings  335
To set desktop preferences for the Import Tool  338
To set error handling preferences for the Import Tool  339
To set data preferences for the Import Tool  341
To set date/time preferences for the Import Tool  342
To set confirmation preferences for the Import Tool  343
To start the mail handler  353
To create the query by entry ID format  361
To create the query by field format  362
To create the query bar format  364
To set the multiple-process server environment  373
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To kill a private server  379
To license a user for FTS  393
To display and update information about full text search  395
To configure the FTS search option  400
To modify the Ignore Words List  401
To append a list of words to the Ignore Words List  402
To re-build the FTS index  403
To define a field for FTS  404
To estimate size of the FTS index  406
To move the FTS index  406
To define fields returned in a query list  407
To create or modify the Windows NT Registry  416
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Glossary

access control
Security feature that lets you limit the access users have to specific fields
within a schema and to specific functions within the system.
See also access control group, permissions.

access control group
Facility of the Action Request System used primarily to define user access to
the contents of a schema field. Each group can have its own member list
defining users who belong to that group. The AR System defines a number of
special groups: Public, Administrator, Subadministrator, Customize, Submitter,
Assignee, and Flashboards Administrator. You can define additional groups
through the Group schema. Once you have defined a group, you can specify
the type of access that the group will have to specific fields within a schema.
See also access control, permissions.

access permissions
See permissions.

action request
AR. A collection of information that describes an event (transaction), such as a
problem or a service request.

active link
A cause and effect relationship that you define on a per schema basis. Active
links cause the Action Request System to perform specific operations in
response to specific user actions. The AR System administrator can define
active links that run macros, set fields to specified values, run independent
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system processes, send an interactive message to the user, change field
characteristics, or execute a DDE operation on a Windows User Tool. Active
links run on the client machine.

administrator
Individual responsible for the management of the AR System, including setting
up schemas, setting access rights for users, and designing the workflow
process. To manage the AR System, you must be a member of the
Administrator or Subadministrator group.

administrator default
Value that the administrator assigns to a field while designing the schema.
When the user sets defaults, this value is used unless the user has assigned
their own default. When a user submits an AR, the AR System automatically
enters this value in the field unless the user has assigned their own default or
has entered a different value.

Administrator group
One of several special access control groups provided by the AR System.
Members of this group have full and unlimited access to the AR System,
including unlimited ability to create schemas, filters, escalations, active links,
menus, and administrator commands. See also Subadministrator group.

Administrator Tool
The part of the AR System used exclusively by administrators (and to a lesser
extent, by subadministrators) to set up the system for use by support staff and
end users. This includes setting up schemas, setting access permissions (users
and groups), and creating filters, escalations, active links, menus, and
administrator commands.

administrator view
The layout of a schema that was designed by the AR System administrator.
This is the view that users will see unless they customize their view.

admin server
The arserverd process that can handle any AR System operation. The admin
server performs all admin restructuring operations, guaranteeing the
serialization and integrity of data. There can be only one admin server process
at any time.
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API
Application programming interface. A set of functions that provide application
programmers with access to the full functionality of a product. The AR System
API provides a complete interface to the AR System server.

AR
See action request.

arservtcd server
The controller server process that handles requests from clients for information
on which socket to use for communicating with other server processes.

AR System client
1.Subset of AR System software necessary to allow a user to access an AR
System server on the network and run the AR System tools on a local
workstation.
2.Hardware (workstation, terminal, Macintosh, or PC) running the AR System
client software.

AR System server
1.Full set of AR System software, including the arservtcd and the fast, list, and
escalation arserverd processes. When installed on a workstation on the
network, the server software provides access to the full feature set of the AR
System and can be accessed by workstations, Macintoshes, terminals and PCs
on the network that are running the AR System client software.
2.Hardware (workstation) running the AR System server software.

assignee
The person who is assigned responsibility for resolving an action request.

Assignee group
One of several special access control groups provided by the AR System. This
is an implicit group; users automatically belong to this group and, if they have
a valid AR System license, are granted change access for ARs for which they
have been assigned responsibility (their name is in the Assigned-to field).

character data type
Data type used for fields where you will be entering text. The AR System
administrator can specify a maximum length for the field or leave the length
unlimited. The administrator can also specify a pattern to restrict the data that
users can enter or attach a character menu to the field.
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character menu
A type of menu that the AR system administrator can create and attach to any
character-type data field. Character menus can be displayed as list boxes or
pull-right menus.

client
See AR System client.

command line options
Parameters that you can combine with the commands to start the User,
Administrator, Notification, and Import Tools that allow you to specify how
the tools will run. For the User Tool, you can execute a macro or open to the
Query or Submit window. For the Administrator Tool, you can attach to a
specific server or open the tool with a specific category displayed.

configuration
1.The process of setting up hardware and/or software so that it operates in a
manner consistent with the needs of a location.
2.The physical setup of a device or devices.
3.The operating characteristics of software.

core field
One of a set of basic fields that are common to all AR System schemas.
Additional limits, such as fixed or maximum sizes, are placed on some core
fields.

Customize group
One of several special access control groups provided by the AR System. This
group grants users the right to customize their schema layout and create
custom commands in the User Tool.

database
A collection of information maintained in the form of individual entries.

data type
Property of a field that determines what type of information the field contains.
The choices are character, date/time, diary, integer, real, and selection.

date/time data type
Fields with this data type are limited to calendar dates and time.
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DDE
Dynamic Data Exchange. This is a standard inter-application communication
feature used in Windows applications. For more information, see your
Windows documentation.

default
Administrator or user defined setting or value that automatically applies to a
field if users do not supply a different setting or value when submitting a new
action request.

diary data type
Fields with this data type allow you to capture a history of the actions taken
for an AR. Each multiple character entry is stamped with the time, date, and
name of the user who entered the item.

dynamic menu
Menu that performs a query at the time a user selects the menu icon and uses
the results of the query to build the list of menu items from which the user
chooses.

email
Electronic mail. The AR System allows you to set up an electronic mail handler
so that users can submit ARs through email if they do not have access to a User
Tool or if the AR server is inaccessible. (If you are running the client tools on a
PC, your PC must be equipped with an SMTP gateway to allow email
submissions.)

end user
In the AR System, an end user is the person who notifies support staff of
problems and service requests by submitting ARs.

escalations
Facility that tests server transactions at specified times or regular intervals to
see if certain conditions are met and responds to the conditions by taking a
specific action or actions. The AR System administrator can define escalations
to perform actions such as notify an individual, run a process, set specified
fields, or make an entry to a log file.

This facility is useful if, for example, you want to notify support staff when
ARs are in the Assigned state too long.

escalation server
The arserverd process that, if enabled, handles all escalation operations.



470 Action Request System Adminitrator’s Guide for Windows—December 1995

export
Facility that lets you move schemas, filters, active links, menus, administrator
commands, and mail templates to a file. Exporting is useful if you want to
share schemas, filters, active links, menus, and administrator commands with
another server or generate mail templates.

fast server
The arserverd process that, if enabled, handles the operations that generally
run to completion quickly without blocking access to the server.

filter
Facility that tests every server transaction to see if certain conditions are met
and responds to the conditions by taking a specific action or actions. The AR
System administrator can define filters that set fields to specified values, run
independent system processes, send an interactive message to the user, notify
the user when the state of an AR changes, or make an entry in an audit trail log
file. Filters run on the server.

fixed license
Write license that is permanently assigned to a user so that the user always has
access to the AR System.
See also floating license, write license.

Flashboards license
Fixed or floating license that allows a user access to the AR System
Flashboards product.

floating license
Write license that exists on a server and is allocated to any user who requests a
license and who is defined in the User database as having a floating license
type. If no floating license is available at the time of the user request, the user
must wait until a license becomes available.
See also fixed license, write license.

FTS
See full text search.

FTS license
Fixed or floating license that allows a user to perform a full text search in any
large text or diary field indexed for FTS.
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Full Text Search (FTS)
Facility that allows a user to quickly search for information in large text or
diary fields. The fields must be indexed and FTS-enabled by the AR System
administrator, and the user must have an FTS license.

group access
See group type.

Group schema
Schema that lets you add new groups, delete groups, and modify group
permissions.

group type
The maximum permission type allowed for a group. May be None, View, or
Change. (Note that permission may be set below the group’s maximum at the
field level.)

guest user
An unregistered user with a limited set of capabilities (submit ARs and
possibly review those ARs). Unregistered users may not be allowed at your
site.

hidden field
A field that exists but is not visible in a user’s view of the schema.

import
Facility that lets you share schemas, filters, escalations, active links, menus,
and administrator commands that were created on another server. First, you
must export the definitions from the server on which they were created to an
ASCII file, then you can import the file to your own server.

Import Tool
The part of the AR System that lets you transfer data from one server to
another.

integer data type
Fields with this data type contain numeric values between
-2147483648 and 2147483647. (The range for a particular field may be limited
by the administrator.)

license
See Flashboards license, fixed license, floating license, FTS license, read license,
write license.
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list server
The arserverd process that, if enabled, handles the operations of the AR System
that may take some time to complete: AR Export, ARGetListEntry (high-
performance database searches), and ARGetEntryStatistics.

login window or dialog box
Window that allows you to login to the AR System when you first start an AR
System tool.

macro
A set of operations recorded for later execution. Macros are useful for
automating frequently used or complex query operations.

mail template
Template that contains the fields that you need to fill in to submit an action
request using electronic mail. Templates are generated by the administrator
from existing schema using the export facility. (If you are running the client
tools on a PC, your PC must be equipped with an SMTP gateway to allow
email submissions.)

multiple schema views
Ability of an administrator to create different views of what users see when
they bring up a schema, including hiding or re-arranging fields by changing a
field’s display properties.

multi-process server
A product that allows the AR System administrator to distribute operations
among different servers and, consequently, improve the performance of the AR
System.

For example, the arservtcd process routes the load among the Admin server,
Fast server, List server, Escalation server and Private servers as appropriate,
automatically starts the specified arserverd processes and restarts the arserverd
processes if they terminate.

notification
An alert that tells you that an AR System event has occurred. The alert may be
a system beep, flash, the display of a notice window, or the opening of the
Notification Tool.

Notification Tool
The part of the AR System that alerts you when specific changes are made to
ARs. Also referred to as the Notifier.
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operator
One of a number of functions that let you define complex queries or build
qualifications. The AR System operators are available through use of the query
bar palette or the qualification palette or you can type them in directly.

permissions
Property setting that allows you to control who can view and change
individual fields of a schema. You also set permissions for schemas and active
links. Permissions are defined for each access control group. View permission
limits group members to reading the contents of a field. Change permission
allows group members to read and write the contents of a field. See also access
control group.

pick list
See selection list.

private server
An arserverd process that, if enabled, provides dedicated access to system
operations for specific users.

property
An attribute that is defined. For example, the properties of a field include its
data type, physical characteristics such as length, and whether it is required or
optional.

Public group
One of several special access control groups provided by the AR System. Every
user is automatically a member of this view only group.

pull-right menu
See character menu.

query
Process that lets you select a subset of ARs according to search criteria that you
define and then perform one of several operations on the selected ARs. See also
query operation.

query bar
Part of the Query window, Active Link Qualification window, and the Filter
Qualification window that lets you define complex query criteria. Includes a
palette of operators that you can use in the query you build.

query list
A list that includes a one-line summary of each AR matching a query.
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query operation
Action that you can perform on the entries that match the criteria defined in a
query. The possible operations are: Query List, Display, Modify, Report, and
Delete.

query statement
A complete definition of query criteria constructed in the query bar.

Query window
The User Tool window that lets you search the database for ARs that match
specific criteria and display the results of the search. You also use the Query
window to view or modify an existing AR. See also Submit window.

range
Defines the upper and lower limits of acceptable values. For example, if a
field’s range is -10 to 100, you will be able to enter any number from negative
10 to positive 100 inclusive.

read license
License that allows a user to query the AR System schemas and submit new
ARs but does not allow the user to modify existing ARs. See also write license.

real data type
Fields with this data type contain a floating-point number. The range is set by
the administrator.

report format
The layout that you specify when you generate a report from an AR System
query. You can format a report in columns or as a list of records. You can also
choose selected fields to print or print them all. To create a more sophisticated
layout, you can export the report to a file and import the file into a desktop
publishing application.

reserved field
One of a set of fields defined with specific interpretations. You can use these
fields in any schema, if desired.

schema
The definition of the data fields in a database. Each schema represents a
database on an AR System server. The AR System comes with several sample
schemas and you can build as many additional schemas as needed.
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scroll bar
Window element that appears when there is more information to view than
will fit in the window. You use the mouse to slide the scroll bar and shift the
view area. A scroll bar at the bottom of the window lets you move the viewing
area left and right. A scroll bar on the right side of the window lets you move
the viewing area up and down.

selection data type
Fields with this data type present a set of mutually exclusive choices from
which the user is to choose. The selections are displayed as radio buttons or as
items on a menu.

selection list
List that appears as a result of an active link that performs a query that returns
more than one AR. The selection list lets the user pick the appropriate AR so
the active link can continue processing.

server
See AR System server.

status field
Core field that lets you keep a record as an AR moves through the various
stages of the process you are using to resolve ARs. The defined states should
reflect the workflow process.

status history
Information that shows the progress that has been made on an AR. You can
view status history from the Display or Modify Individual window.

subadministrator
Individuals who have limited administrative access to the AR System. To be a
subadministrator, you must be a member of the Subadministrator group and
belong to a group with subadministrator access to a schema.

Subadministrator Group
One of several special access control groups provided by the AR System.
Members of this group have limited access to the AR System. You must be a
member of this group to be able to administer any schemas that your group
has subadministrator access to and to create and administer filters, active links,
and escalations connected to schemas that your group has administrative
access to.
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Submit window
The User Tool window that lets you enter the appropriate information to create
and submit a new AR. See also Query window.

submitter
The person who submits an action request. The submitter’s name is entered in
the Submitter field.

Submitter group
One of several special access control groups provided by the AR System. This
is an implicit group; users submitting ARs automatically belong to this group
and, if they have a valid AR System license or if the Submitter Mode is set to
Locked, are granted change access for ARs that are submitted with their name
in the Submitter field.

support staff
Person or group responsible for resolving action requests. They assign and are
assigned ARs, log their progress in appropriate fields, and use information
stored in previous ARs to help resolve problems.

toolbar
Part of the Main window that allows easy access to some of the more
commonly performed functions in the Windows Administrator Tool: New
Server Window, New Object, Save, Align Left, Align Right, Align Value Left,
Align Value Right, Align Top, Align Bottom, and Show Grid.

user default
Value that a user who has customize permission can assign to a field. When the
user sets defaults, the AR System loads this value into the field. When the user
submits an AR, the AR System automatically loads this value into the field
unless the user has entered a different value.

User schema
Schema that lets you add users to the AR System and specify the type of access
each user will have.

User Tool
The part of the AR System that lets users enter new ARs and track them
through the troubleshooting process. Users can also query the database for
ARs that match specified criteria, generate reports, and modify existing ARs
with the User Tool.
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user view
What the user sees when they bring up a schema. If users have permission to
customize their views, they are able to change the physical layout and other
properties of the schema and schema fields as they appear.

variable
Data element that changes according to user input. In macros, you can include
variable definitions that will cause the AR System to prompt the user for
certain information when the macro executes.

version
The system release number. To display the version of the AR System that you
are running, select AboutOn Version under the Help menu in the User,
Administrator, or Import Tools.

view layout
The location of fields in a user’s view of a schema.

wild card
Character that you can enter to represent other characters in a query. In query
statements in character and diary fields, for example, you can use wild card
characters to match single characters, strings, or characters within a range or
set.

write license
License that allows a user to modify and save data on existing ARs as field and
schema permission settings allow. Write licenses may be either fixed
(permanently attached to a single user) or floating (allocated to users as
required).
See also fixed license, floating license, read license.
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Symbols
$, 235, 237
$PROCESS$

active links, setting fields in, 302
filters, setting fields in, 244

%, 445
*, 445
+, 444
/, 445

A
About Admin Tool dialog box, 24
About Import Tool dialog box, 323
accelerator keys, 27
access control

active links, 306
allow any user to submit check

box, 167
change permission, 100
create mode, 164
creating groups, 107
defining, 100
group list, 111, 112, 116
group permissions, 111, 164
groups, 99, 102
overview, 99
row level, 104

schemas, 132
view permission, 100

access permission
change, 100
view, 100

accrue operator in full text searches,
using, 383, 386

Action Request System
designing schemas for, 77
general design questions, 74
setting up, 73

actions
active links, 94, 280
escalations, 86, 261
filters, 33, 84, 218

activating
active links, 277
escalations, see filters, 217
filters, 217

active link
$PROCESS$ in set fields, using, 302
access control, 306
action types, 282
actions, 94, 280
activating, 277
assigning field values

from a DDE request, 304
from arithmetic operations, 305
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from other ARs, 301
from other fields, 300
from process results, 302

assigning keyword values, 300
button properties, 279
buttons to appear to users,

placing, 279
buttons, using, 278
change history, 310
changing order of actions, 282
comparing with filters, 95
conditions, 93
constructing qualification

statements, 301
creating, 33
creating macros for, 293
default permissions, 58
definition of, 33
designing, 92
difference from filters, 95
execution option

button, 277
display, 277
menu choice, 277
modify, 277
return, 277
set default, 277
submit, 277

execution options, 93, 277
execution order, 276
help text, 310
importing, 312
modifying, 33
name, 276
opening, 272
order of, 282
permissions, 306
qualifications, 277
save as, 273
selecting a schema, 276

active link action
Change Field, 94, 283
creating, 281
DDE, 94, 285
deleting, 282

Message, 94, 290
modifying, 281
Run Macro, 94, 291
Run Process, 94, 294
Set Fields, 94, 297

Active Link Button Properties dialog
box, 279

Active Link window, 270
Actions, 282
Basic, 274
Change History, 310
Help Text, 310
Permissions, 307

active window, 25
adapting a schema for new needs, 80
adding

fields to schemas, 81
groups, 105
multiple users, 16
users, 109, 111

Address email option, 349
address for email, 347
admin server, 371
Admin Tool window

Edit menu, 36
File menu, 34, 120, 121, 178
Help menu, 38
Tools menu, 36
using, 34
Window menu, 37

Administrator access, 102
Administrator group, 102, 112
Administrator Tool

exiting, 22
files, 425
functions, 32
icon, 13
installing, 3
limit on who can run, 14
Main window, 25
Server window, 25
starting, 13, 14

administrator view, 80
aliases, 106
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aligning
field segments to grid, 184
multiple field and objects, 186

allow any user to submit check box
Default Permissions dialog box, 60
Field Properties dialog box, 167

allow guest users, 47
allow unqualified queries, 48
Alt key, 27
alternate configuration directory, 15
AND operator, 444
appending menu choices, 157
AR Export format, 323
AR Path

desktop preferences, 62
AR System

conventions, 25
displaying information, 39

AR System file locations, 427, 429, 430
ar.ini file, 3

DDE timeout settings, 288
runmacro, using with, 238
security alert, saving password, 15

ar.log file, 228
arcache, using, 411
arithmetic operators, 444
armaild, 348

command options, 353
NT servers, 345
querying via email, 358
starting, 353
UNIX servers, 345

arranging
icons in a group, 38
windows, 38

arreload, using, 414
arserverd processes, 370
arservftd process, 392
arservtcd process, 375, 393
ASCII format (for importing), 323
ASCII text fields, 157
Assigned-priority defined field, 441

Assigned-to core field, 434
assignee, 100

Assignee (row level access control)
reserved field, 438

assignee access, 103
Assignee group, 103

assigning
field IDs, 152
field values

from a DDE request, 304
from arithmetic operations, 246,

305
from other ARs, 243, 301
from other fields, 242, 300
from process results, 244, 302

keyword values in active links, 300
keyword values in filters, 242

audit trail, 84, 90, 227

B
backward compatibility of 2.0.x with

1.2, 377
basic conditions

active links, 274
escalations, 260, 262
filters, 33, 215

before importing data, 334
bold field labels, 78
building

active link qualifications, 277
change history, 68
escalation qualifications, see filter

qualifications, 218
filter qualifications, 218, 221
qualifications

for active link Set Fields
action, 300

button fonts, setting, 65
button properties for active links, 279
buttons, active link placing, 278

C
calendar for escalation time, setting, 265



482 Action Request System Adminitrator’s Guide for Windows—December 1995

capturing history data, 82, 158
Chameleon network stack, 421
change access, 100
Change Field active link action, 94, 282,

283
change field permission, 100, 147, 164
change group permission, 107
change history, 68

active link, 310
escalation, 266
fields, 168
filter, 251
schema, 135
updating, 69

changeable submitter mode, 101
changing field characteristics in an active

link, 283
character fields, 157

length, 153
menus, 157

character menus, 157, 191
checking database values, 219, 220
checking transaction values, 219, 220
choice fields, 161
choices from the toolbar, making, 27, 321
clients

2.0.x with 1.2 or 2.0.x servers,
using, 377

multi-process servers with AR,
using, 377

closing
all open Admin Tool windows, 38
current window, 35
dialog boxes, 26

comma separated format, 323
command options for email, 353
comment block, 355
comparing filters and active links, 95
compatibility, backward of 2.0.x with

1.2, 377
conditions

active links, 274
escalations, 260

filters, 33, 215
configuration directory, 15, 425

alternate, 15
configuration file

email, 348
table of options, 349

Configurations window, using, 46
confirmation preferences, setting, 62
confirmation upon exiting, 63
context-sensitive help, see help
controlling size and position of

window, 27
conventions

in the AR System, 25
Windows, 25

Copy View dialog box, 176
copying

fields, 146
schema view, 176

core fields, 32, 77, 144, 152, 433
Assigned-to, 434
Create-date, 434
Entry ID, 434
Last-modified-by, 435
Modified-date, 435
on new schema, 78
Short-description, 82, 435
special characteristics, 82
Status, 435
Status-history, 435
Submitter, 434

create mode, 357
Create-date core field, 434
creating

access control group, 107
active link actions, 281
active links, 33
character menus, 191
email templates, 34, 317, 354
escalations, 258
export mail templates, 34, 317, 355
fields, 141

no labels or duplicate labels,
with, 64, 148
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filter actions, 225
filters, 213
groups, 107
macros for active links, 293
mail templates, 316, 354
menus, 194
schemas, 32, 33
selection field values, 161
users, 111

cross reference blank password, 48
cross reference for notifications, 234
CSV format, 323
current licenses, 55
Current Schema reserved field, 439
Current Server reserved field, 440
Customize access, 103
Customize group, 103, 112
customizing

query list fields, 127
schema layout, 103

D
daemon, armaild, 346
data entry segment of fields, 184
data fields, 81
data segment of field, 184
data, importing, 323
database

field properties, 150
home, 52
information, 52
name, 52
password, 53
Server Information dialog box, 52
table, see schemas
type, 52

field, 150
values, checking, 219, 220
version, 52

Date Format
desktop preferences, 62

DATE function, 247

DATE keyword, 447
DAY function, 247
DDE, 285

$DDE$ keyword, 304
assigning value from DDE request in

active link, 304
examples of use in an active link, 288,

289
item name, 285
service name, 285
topic name, 285

DDE active link action, 94, 283, 285
debug mode, 253, 267
default action, 26
default administrator schema view, 176
DEFAULT keyword, 447
default login, using, 21
Default Notify Mechanism field, 111
Default Notify reserved field, 437
Default Permissions dialog box

Active Link Permissions, 58
Field Permissions, 60
Schema Permissions, 57

default schema view, 80
Default-Password email option, 349
Default-Schema email option, 349
Default-Server email option, 349
Default-User email option, 349
defined field, 440

Assigned-priority, 441
Disposition, 441
Long-description, 441
Notify-method, 441
Related-to, 441
Submitter-severity, 441

defining
Change Field active link action, 283
data fields, 81
DDE active link action, 286
get list fields, 127
Log to File filter action, 228
menu that queries, 204
menu using a file, 202
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Message active link action, 290
Message filter action, 230
Notify filter action, 231
Run Macro active link action, 292
Run Process active link action, 295
Run Process filter action, 236
schema indexing, 129
schema permissions, 132
Set Fields active link action, 297
Set Fields filter action, 240
states, 82
workflow process, 84, 92, 95

definition properties for a field, 81
definitions

exporting, 34, 311
importing, 34, 312

Delete View dialog box, 177
deleting

active link actions, 282
fields, 144
filter actions, 226
groups, 109
login information, 21
schema view, 177
schemas, 126
users, 113

Demo user, 14
description field, 82, 107
design considerations for schemas, 82
design questions, 74
designing

active links, 92
escalations, 86
filters, 84
from an existing schema, 79
menus, 83
schemas, 77
worksheets available, 451

desktop preferences, 61
AR Path, 62
Date Format, 62
Keyboard Step Size, 62
Maximize on Startup, 61
Save Window Sizes on Close, 62

setting, 61
Show Field Properties on Field

Creation, 62
Show Status Bar, 61
Show Tool Bar, 62

dialog box
About Admin Tool, 24
About Import Tool, 323
closing, 26
Copy View, 176
Default Permissions, 56
Delete View, 177
Directories, 6
Expand Control Spacing, 189
Export Definitions, 315
Export Mail Templates, 317
Fallback Mappings, 336
Field Properties, 143
Font, 66
Group Permissions, 137
Ignore Words List, 401
Import Definitions, 313
Import Error, 337
Import Status, 328
Import Tool Preferences, 337, 338
Installation Options, 5
License Information, 54, 55
Load Mappings, 334
Login, 14
Login Information, 17
New Object, 122, 194, 213, 257, 271
Open Import File, 326
Preferences, 61
Rename Schema, 125
Run, 3
Save Active Link As, 273
Save Escalation As, 259
Save Filter As, 215
Save Mappings, 332
Save Menu As, 199
Save Schema As, 124
Schema Properties, 128
Select Admin Default View, 177
Select View, 175
Server Information, 42
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Set Grid Size, 184
Time Zone, 7
Welcome, 4
See also window

Directories dialog box, 6
directory

configuration, 15
installation, 425

directory of server, 42
disabling full text search, 395
disallowing unqualified queries, 48
disk space requirements for Windows, 2
display length, 149, 153
display properties for a field, 81
display properties for an active link, 279
display type

field, 150
displaying

a confirmation box upon exit, 63
help on help, 39
help on procedures, 39
information about AR System, 39
license information, 53
menu help, 39
server information, 42
status bar, 61, 339
tool bar help, 39
toolbar, 62, 339
version and environment

information, 23, 323
Disposition defined field, 441
distributed server option reserved

fields, 438
double-clicking with the mouse, 26
dragging the mouse, 26
Duplicate Entry ID Action reserved

field, 440
dynamic data exchange, 285
dynamic data exchange, see DDE

E
Edit menu

Copy, 120
Cut, 120
Delete, 120
Paste, 120
Restore, 120
Schema window, 119
Server window, 36

editing definitions, 36
email

armaild, 345
command options, 353
comment block, 355
configuration file, 348
creating templates, 34, 317
establishing an address, 347
exporting templates, 356
fields, 356
header block, 356
mail handler, 348
mail templates, 316
option

Address, 349
Default-Password, 349
Default-Schema, 349
Default-Server, 349
Default-User, 349
Include-Original-On-

Failure, 349
Include-Original-On-

Success, 349
Poll-Interval, 349
Reply-Failure, 350
Reply-Success, 351
Required-Schema, 351
Required-Server, 351

overview, 345
querying via, 358
receiving notifications, 366
sending notifications, 233, 366
setting options, 348
Subject line, 234
submitting ARs, 355
table of options, 349
templates

creating, 316, 354
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generating, 316, 354
modifying, 357
using, 354

user notifies from, 49
Email Address reserved field, 110, 436
entering text, 157
entering values in fields, 85, 91, 94, 297
Entry ID core field, 434
entry in audit log, 84, 90, 227
environment information, 23, 323
equal-to query bar operator, 445
error message

active links, 94, 290
filters, 84, 229

escalation action
Log to File, 90
Notify, 91
Run Process, 91
Set Fields, 91

escalation basic conditions,
specifying, 260, 372

escalation log file, 373
escalation server, setting, 374
Escalation Time Criteria window, 265
escalations

action types, 262
actions, 86, 261
activating, 261
basic conditions, 262
change history, 266
changing order of actions, 261
conditions, 260
constructing qualification statements,

see filters, 244
definition of, 33
execution order, 92
help text, 267
how executed in AR System, 89
importing, 312
interval, setting, 264
intervals described, 88
intervals, setting, 263
logging activity, 267
name, 261

order of, 261
process timeout, 44
save as, 258
selecting a schema, 261
server, 372
server checking, 88
strategy, 87
time, setting, 264, 265
trace, 267
window, 265

Escalations window, 256, 263
Actions, 262
Basic, 260
Change History, 266
Help Text, 267
Time Criteria, 262

escape key, 26
exactly equal operator, 445
example

email template, 355
filter qualifications, 221
workflow process, 76

executing a macro, 94, 291
execution options for active links, 93, 277
execution order, 86, 92

active links, 276
escalations, 261
filters, 217

exit menu option, 35
exiting

Admin Tool, 22, 35
Import Tool, 322

Expand Control Spacing dialog box, 189
explicit groups, 102
Export Definitions dialog box, 315
export mail templates, 34, 356
Export Mail Templates dialog box, 317
exporting, 34

mail templates, 312, 316, 356
menu option, 37

expressions, see qualifications
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F
Fallback Mappings dialog box, 336
fallback mappings in the Import Tool, 335
fast servers

administering, 371
setting, 374

Field Properties dialog box
active links, displaying, 278
attributes, 155
change history, 169
database properties, 150
display properties, 148
help text, 168
index for full text search, 403, 404
permissions, 166
selection field attributes, 163
setting, 146

fields, 127
access control, 100
aligning multiple, 186
bolded, see required
change history, 168
changing characteristics in an active

link, 283
copying, 146
core, 434
creating, 141
data segments, 184
data type property, 150
database properties, 150
Default Notify Mechanism, 111
default permissions, setting, 59
defining, 81
definition properties, 81
deleting, 144
descriptive, 107
display length, 149, 153
display properties, 81
display type property, 150
email, 356
Email Address, 110
expand spacing between, 188
Full Name, 111
getting help information, 70

grid, using, 183
Group ID, 106
Group List, 111, 112, 116
Group name, 106
Group type, 107
help text, 167
hide field property, 150
import, mapping, 328
label

meaning of type style, 78
not using or duplicating, 64, 148
position, 149
property, 148
segment, 184

laying out, 178
length, 153
License Type, 110
Login name, 110
Long Group Name, 107
making non-operational, 145
mapping import, 328
modifying, 141
multiple, moving, 182
no labels or duplicate labels, with, 64,

148
number of rows, 149
optional, 78, 153
Password, 110
permissions, 107
properties, see Field Properties dialog

box
rearranging, 181
required, 78, 153
reserved, 436
restricting contents, 156
row level access control (field ID

112), 104
segments, aligning to grid, 184
setting properties, 146
specifying permissions, 164
status, 82
status history, 82
system maintained, 78
text font, setting, 65
X/Y property, 149
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file formats for importing data, 323
File menu option

Close, 35, 119
Default Permissions, 35
Exit, 35
License Information, 35
Login, 35
New Object, 35
Preferences, 35
Rename, 119
Save Schema, 119
Save Schema As, 119
Schema window, 119
Server Information, 35
Server window, 34

files
Admin Tool, 425
AR System file locations, 426, 429
ar.ini, 3
ar.log, 228
flat-file database file locations, 429,

431
Import Tool, 426
logs for debugging, 49
NT System file locations, 428, 429

fill-in aid, 157, 191
filter

$PROCESS$ in set fields, using, 244
action types, 227
actions, 84, 218
activating, 217
assigning field values

from arithmetic operations, 246
from other ARs, 243
from other fields, 242
from process results, 244

assigning keyword values, 242
basic conditions, 33, 215
change history, 251
changing order of actions, 226
comparing with active links, 95
conditions, 215
conditions, specifying, 216
constructing qualification

statements, 244

creating, 213
definition of, 33
difference from active links, 95
examples, 85
execution order, 86, 217
help text, 252
importing, 312
logging activity, 253
name, 217
opening, 213, 214
order of, 226
process timeout, 44
qualification examples, 221
qualifications, 218
saving as, 214
security alert running a process, 236
selecting a schema, 217
subject line, 234
trace, 253
wild cards in qualifications, 446

filter action, 33
creating, 225
deleting, 226
Log to File, 84, 227
Message, 84, 229
modifying, 226
Notify, 85, 231
Run Process, 85, 236

security alert, 236
Set Fields, 85, 239

filter basic conditions, 33
filter execution option

delete, 217
merge, 217
modify, 217
query, 217
submit, 217

filter log file, 51, 373
filter qualifications

checking database values, 219, 220
checking transaction values, 219, 220
non-numeric values, 220

Filter window, 212
Actions, 227
Basic, 216
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Change History, 251
Help Text, 253
qualifications, building, 218

fixed licenses, 45
Flashboards License reserved field, 437
flat-file database

file locations, 429, 431
floating license timeout, 44, 56
floating licenses, 45
Font dialog box, 66
force release of floating license, 56
format

AR Export, 323
ASCII, 323
comma separated, 323
CSV, 323
importing, 323

format for menu file, 203
formatting qualifications, 219
free idle floating license, 56
From Entry ID reserved field, 438
From Mapping reserved field, 439
From Schema reserved field, 438
From Server reserved field, 439
Frontier Super TCP network stack, 423
FTP PC/TCP network stack, 423
FTS Index Directory field, using, 396
FTS Search Options menu, 400
FTS-indexed fields in queries, using, 383
Full Name field, 111
full text search

accrue operator, using, 383
arservftd process, 392
capabilities, 382
case, 396
configuring, 394
fields, indexing, 390, 403, 404
FTS Index Directory, using, 396
ignore words list, 396
importing data (when to

rebuild), 334, 405
indexes, managing FTS, 393
indexing, 390

licenses, fixed and floating, 384
limits, 389
moving index, 407
number of licenses, 111
QBE settings affecting, 389
rebuilding index, 396, 403
relocating index, 396
search options, 396
Search Options menu, 400
size of FTS indexes, estimating, 405
sorting records by WEIGHT, 384
users, licensing, 393
using, 385

Full Text Search Ignore Words dialog
box, 401

Full Text Search License Type reserved
field, 437

functions
Admin Tool toolbar, 28
Import Tool toolbar, 321
in filter set field operation, 247

G
generating mail templates, 354
get list fields, setting, 127
getting information about licenses, 53
getting information about the server, 41
greater than operator, 445
greater than or equal to operator, 445
greater-than

query bar operator, 445
greater-than-or-equal-to

query bar operator, 445
grid

aligning multiple objects with grid
on, 186

displaying, 183
enabling, 183
field segments, aligning to, 184
sizing, defining, 183

group
Administrator, 102, 112
Assignee, 103
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Customize, 103, 112
Public, 103
Subadministrator, 103, 112
Submitter, 103

Group ID field, 106
Group id reserved field, 437
GROUP keyword, 447
Group List field, 111, 112, 116
Group list reserved field, 436
Group name field, 106
Group Name reserved field, 437
group permissions, 164

none, 107
view or change, 107

Group Permissions dialog box, 139, 171,
307, 309

Active Link Permissions, 309
Field Permissions, 171
Schema Permissions, 137

Group schema, 105
key fields, 106

Group type field, 107
Group type reserved field, 437
grouping icons, 38
groups, 102

access for schemas, defining, 138, 169
adding, 105
creating, 107
deleting, 109
explicit, 102
implicit, 102
special, 102
Subadministration permissions, 127

guest users, 47

H
HARDWARE keyword, 286, 295, 303, 447
hardware platform, 43
hardware requirements for Windows, 2
header block, 356
help

active link help text, 310

Admin Tool, displaying Windows
application, 23, 322

administrators, for, 71
context-sensitive, 70
end-users, for
escalations help text, 267
field help text, 167
filter help text, 252
help, on, 39
Import Tool, 322
menu, 39
menu help text, 208
schema, for, 137
tool bar, 39
Windows clients, 71

Help menu options, 38
About Admin Tool, 39
Contents, 38
How to Use Help, 39
Menu Items, 39
Procedures, 39
Search for Help On, 39
Toolbar, 39

hide field, 150
hiding

status bar, 61, 339
toolbar, 62, 339

history, 82, 158
home directory, see configuration

directory
HOUR function, 247

I
icon

Admin Tool, 13
Import Tool, 320
Remedy AR System group, 13, 320
toolbar, 28, 321

ignore words list
appending words, 402
index criteria, 396
modifying, 401
rebuilding index, 392

Ignore Words List dialog box, 401
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implicit groups, 102
Import Definitions dialog box, 313
Import Error dialog box, 337
import file, opening, 325
Import Status dialog box, 328
Import Tool, 320

data, loading, 323
fallback mappings, 335
files, 426
functions, 319
help, 322
icon, 320
information, importing, 323
installing, 3
log file, using, 337
login information, 321
mapping fields, 328
preferences, 338
quitting, 322
starting, 320
toolbar, using, 321
using, 319

Import Tool Preferences dialog box
confirmations, 343
data, 341
date/time, 342
desktop, 337, 338
error handling, 340

importing, 34
active links, 312
data with the Import Tool, 323
data, before, 334
definitions, 312
escalations, 312
filters, 312
menu option, 37
rebuilding FTS index after importing

data, 334, 405
sample schemas, 80
schemas, 312

Include-Original-On-Failure email
option, 349

Include-Original-On-success email
option, 349

Index Fields dialog box, 131
indexes

FTS, managing, 393
schema attributes, 126
schemas, 129
size of FTS indexes, estimating, 405

indexing for a schema, 129
information

about licenses, 53
about the server, 41
importing into AR System, 323

installation
Admin Tool, 3
directory, 425
email support, 347
Import Tool, 3
prerequisites, 3

Installation Options dialog box, 5
interactive message, 84, 230, 290
invalid password, 15
issues when designing the AR System, 74
italic field labels, 78
item name, 285

K
keep window open, 280

active link button properties, 280
field properties, 144

keeping data in two places, 81
key

Alt, 27
Return/Enter, 26

key fields
Group schema, 106
User schema, 110

Keyboard Step Size
desktop preferences, 62

keywords, 242, 300, 447
$PROCESS$, 244, 302
used to restrict data entry, 156
values in qualifications, 220

killing server processes, 379
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L
label

field, 148
field segment, 184

LAN Workplace network stack, 422
Last-modified-by core field, 435
laying out a schema, 78
layout, 178
Layout menu, 121, 178

Align Objects, 179
Align to Grid, 179
Expand, 179
Grid Size, 180
Select All, 180
Show Grid, 179

LEFT function, 247
LENGTH function, 247
length of character fields, 153
length of field display, 149, 153
less than operator, 445
less than or equal to operator, 445
license

current users, 55
Fixed, 54
Floating, 55
full text search, 111, 384
information, 53
Read, 56
registered users, 54
revoke idle license, 44, 56
server ID, 46
type, 45
users, licensing for FTS, 393

License Information dialog box, 54, 55
License Type field, 110
License Type reserved field, 436
LIKE operator, 444
limits

character fields, 155
permissions, 107
running Admin Tool, 14

list servers
administering, 372

setting, 374
listing servers, 15
Load Mappings dialog box, 334
lock files, 373
locked submitter mode, 101
log file, 373

filter, 51
Import Tool, 337

Log to File
ar.log (when logging fails), 228
escalations, 90, 262
filters, 84, 227

logging
escalation activity, 267
filter activity, 253
in as Demo user, 14
into Admin Tool, 14, 35
into Import Tool, 320

logical operators, 444
Login dialog box, 14

Admin Tool, 14
Import Tool, 320

Login Information, 15
deleting, 21
dialog box, 17
Import Tool, 321
modifying, 16, 19

login name, 110, 111
Login name reserved field, 110, 436
Login option, 35
Long Group Name field, 107
Long-description defined field, 441
LOWER function, 247
LPAD function, 248
LTRIM function, 248

M
macro, 97

directories, specifying, 62, 339
executing through active link, 94, 291

mail
configuration file, 348
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setting options, 348
mail address, 347
mail handler, 348

command options, 353
information needed, 348
setting options, 348
starting, 353

mail templates, 34, 316
creating, 316, 354
exporting, 312, 356
generating, 316, 354
modifying, 357
querying via email, 360
using, 354

Main window, 24, 25
making a field non-operational, 145
manipulating windows, 27
mapping fields

fallback mappings, 335
import fields, mapping, 328
saving mappings, 332

Mapping History reserved field, 439
Master Flag reserved field, 438
match values anywhere in a field, 154
match values at beginning of field, 154
match values exactly, 154
MAX function, 248
Max Time to Retry reserved field, 440
Maximize on Startup

desktop preferences, 61
maximum entries returned by GetList, 49
maximum length of character fields, 153
maximum number of items in menus, 194
maximum schemas allowed on server, 45
media, installation for Windows, 1
memory needed for opening windows,

resource, 40
memory requirements for Windows, 2
Menu window

Change History, 208
Character, 201
File, 203

Help Text, 209
Query, 205, 207

menus, 83
copying, 198
creating, 191, 194
defining a list, 200
deleting, 199
design considerations, 83
file, 202
file format, 203
frequency of retrieval, 195
help text, 208
maximum number of items

displayed, 194
menu bar, 25
menu that uses a file, defining, 202
menu that uses a query, defining, 204
Menu window, using, 192
opening, 197
refresh code, 195
save as, 198
schemas, using in, 191
Search Option menu (for FTS), 400
selections, making, 26, 27
styles, 83, 193

message
active link interactive, 94, 290
filter interactive, 84, 229
numbers, 231, 291

Message active link action, 94, 283, 290
Message filter action, 84, 227, 229
Microsoft Windows TCP/IP, 424
MIN function, 249
MINUTE function, 249
Modified-date core field, 435
Modify Schema window, 118
modifying

active link actions, 281
active links, 33
configuration directory, 15
escalations, 258
fields, 141
filter actions, 226
filters, 213, 257, 271
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login information, 16, 19
mail templates, 357
order of active link actions, 282
order of escalation actions, 261
order of filter actions, 226
schemas, 32, 33

MONTH function, 249
mouse

double-clicking, 26
dragging, 26
pressing, 26
pull-right, 26
selecting, 26
using, 26

MP servers, see servers
multiple group names, 106
multiple schema views, 80

copying, 176
defining, 173
deleting, 177
display properties, setting field, 148
modifying, 175

multiple users, adding, 16
multi-process servers, see servers

N
naming a schema, 123
NetManage Chameleon network

stack, 421
network stacks

Frontier Super TCP, 423
FTP PC/TCP, 423
Microsoft Windows TCP/IP, 424
NetManage Chameleon, 421
Novell LAN Workplace, 422
Sun PC-NFS, 422
system requirements, 2
Walker Richer & Quinn Reflection

Network Series, 423
Wollongong Pathway, 422

New Object dialog box, 35
active links, 271
escalations, 257

filters, 213
menus, 194
schemas, 122

new schema, 77
NIS services, 347
non-numeric values in filter

qualifications, 220
non-operational fields, 145
not equal to operator, 445
NOT operator, 444
note to user

active link, 94, 290
filter, 84, 229

not-equal-to
query bar operator, 445

Notification Tool, 86, 233
Notification Tool, see AR System User’s

Guide
notifications, 86, 92, 111

cross reference, 234
other (for paging beeper

daemon), 234
send using email, 233, 366
through email, 233
user default, 233

Notify
escalation action, 91, 262
filter action, 85, 227, 231
mechanism, 111
text, 232

Notify-method defined field, 441
Novell LAN Workplace network

stack, 422
NT servers (Windows), see servers
NT System file locations, 428, 429
NULL keyword, 447
NULL VALUE, 447
NULL values in qualifications, 220
number of rows, 149
number of windows that can be open at

one time, 40
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O
objects, creating, 35
on-line help, see help
Open Import File dialog box, 326
opening

a help topic window, 38
active links, 272
available windows, 38
escalations, 258
filters, 213, 214
import files, 325
menus, 197
New Server window, 38
resource memory available, 40
schemas, 122

operating system
Admin Tool requirements, 2
Server Information, 43

OPERATION keyword, 448
operator

AND, 444
available operators, 444
LIKE, 444
NOT, 444
OR, 444
precedence, 445

optional field font, setting, 65
Optional Field preferences, 65
optional fields, 78, 153
options

Edit menu, 36
File menu, 34, 120, 121, 178
Help menu, 38

OR operator, 444
OS keyword, 295, 303, 448
OS requirements for Windows, 2

P
password, 14, 111

allowing users to change their
own, 113

database, 53

invalid, 15
security alert, 15

Password field, 110
Password reserved field, 436
Pathway network stack, 422
pattern, 156
PC/TCP network stack, 423
PC-NFS network stack, 422
performance of AR System, 369, 372
permissions, 164

active link, setting default, 57
active links, 306
Administrator, 102
allow any user to submit check

box, 167
Assignee, 103
change, 100
Customize, 103
determining, 100
fields, 107
filters, 85
group, 164
maximum, 100
Public, 103
schema properties, 127
schema, setting default, 56
schemas, 132
Subadministrator, 103
Submitter, 103
view, 100

physical layout of schema, 178
pick list, 127
plain text field labels, 78
Poll-Interval email option, 349
pop-up text editing window, 153, 155, 158
position

field label, 149
fields, 178
windows, 27

precedence of operators in filter
qualifications, 445

preferences
field permissions, setting default, 59
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fonts, specifying, 65
Import Tool, 338
Optional Field, 65
schema permissions, setting

default, 56
Preferences dialog box

confirmations, 63
desktop, 61
display menu method, 67
schema fonts, 65

pressing the mouse, 26
private servers, administering, 377
privileges for a user, 108
procedures, help on, 39
PROCESS keyword, 244, 302
process timeout, 44
processes, administering multiple

server, 375
properties

display length, 149, 153
entry, 153
group permissions, 164
index for full text search, 403, 404
label position, 149
number of rows, 149

public access, 103
Public group, 103
pull-right, using the mouse, 26
Push Button preferences, 65

Q
Qualification line, 218, 261, 277
qualifications

conventions used in, 219
formatting conventions, 219
in active links, 93, 277
in escalations, 261
in filters, 218
keyword values, 220, 447
NULL values, 220
operators, list of, 444
precedence of operators, 445
statements

in active links, 301
in escalations, see filters, 244
in filters, 244

wild cards, 446
queries, using FTS-indexed fields in, 383
query bar operator, 445

greater-than, 445
greater-than-or-equal-to, 445
not-equal-to, 445

query list display definition, 127
query list fields

schema properties, 126
Query List Fields dialog box, 128, 131,

133, 134, 136, 137, 407, 408, 409
querying via email, 358
quitting, see exiting

R
radio buttons

fonts, 65
preferences, 65

rebuilding full text search index, 396
recording an audit trail, 84, 90, 227
reference /etc/passwd file, 48
Reflection Network Series network

stack, 423
refresh code for menu, 195
registered licenses, 54
registry, modifying server list in Windows

NT, 416
re-indexing full text search, 391, 396
Related-to defined field, 441
releasing a floating license, 56
relocating FTS index, 396
Remedy AR System group icon, 13, 320
Rename Schema dialog box, 125
REPLACE function, 249
Reply-Failure email option, 350
Reply-Success email option, 351
Required Field preferences, 65
required fields, 77, 78, 153
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font, 65
Required-Schema email option, 351
Required-Server email option, 351
requirements, system for Windows, 2
reserved fields, 433

Assignee, 438
Current Schema, 439
Current Server, 440
Default Notify, 437
distributed server option, 438
Duplicate Entry ID Action, 440
Email Address, 436
Flashboards License, 437
From Entry ID, 438
From Mapping, 439
From Schema, 438
From Server, 439
Full Text Search License Type, 437
Group id, 437
Group list, 436
Group Name, 437
Group type, 437
License Type, 436
Login name, 436
Mapping History, 439
Master Flag, 438
Max Time to Retry, 440
Password, 436
row level access control, 438
To Entry ID, 439
To Mapping, 439
To Schema, 439
To Server, 439
Transfer Mode, 440
Transfer Status, 438
Update Status, 438
When to Update, 440

resource memory needed for opening
windows, 40

restricting contents of fields, 156
retrieving a menu, 195
Return/Enter key, 26
returned in query list, 127
revoke idle license, 44

RIGHT function, 249
roles of users, 79
ROUND function, 249
row level access control, 104

reserved field, 438
rows, 149
RPAD function, 250
RPC socket numbers (servers), 370
RTRIM function, 250
Run dialog box, 3
Run Macro active link action, 94, 283, 291
Run Process active link action, 94, 283, 294
Run Process escalation action, 91, 262
Run Process filter action, 85, 227, 236

NT server, 237, 245
runmacro.exe, 238
security alert, 236

runmacro.exe, using with run process
filter action, 238

running
Admin Tool, 14
Import Tool, 320

running a process, 85, 91, 94
active links, 294
filters, 236

S
sample

schemas, 80
workflow process, 76

Save Active Link As dialog box, 273
save as

active links, 273
escalations, 258
filters, 214
menus, 198
schemas, 124

Save Escalation As dialog box, 259
Save Filter As dialog box, 215
Save Mappings dialog box, 332
Save Menu As dialog box, 199
Save Schema As dialog box, 124
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Save Window Sizes on Close
desktop preferences, 62

saving objects under a different name, see
save as

schema
Group, 105
User, 109

schema change history, 135
schema fonts preferences

Push Button, 65
Radio Button, 65
Required Field, 65
setting, 64
System Field, 65

SCHEMA keyword, 448
Schema menu option, 120

Field Properties, 121
Schema Properties, 120
View, 121

schema permissions, defining, 132
Schema Properties dialog box

help text, 137
indexes, 131
permissions, 133
query list fields, 128
schema change history, 136
subadmin permissions, 134

Schema window
Edit menu, 119
File menu, 119
Layout menu, 121, 178
Schema menu, 120

schemas
access control, 138, 169
attributes, defining, 126
core fields, 77
creating, 32, 33
default permissions, setting, 56
default view, 80
definition of, 32
deleting, 126
design considerations, 82
designing, 77
grid, using, 183

help, 137
importing, 312
indexing, 129
layout, 78
maximum number on server, 45
modifying, 32, 33
multiple schema views, 80, 173
naming, 123
opening, 122
sample, 80
save as, 124
selecting for active link, 276
selecting for escalations, 261
selecting for filters, 217
views, 173

search options for FTS, 396
Search Options menu, 400
SECOND function, 250
security, 99, 112, 115

Demo password, 14
See also access control, 112, 115

security alert
run process filter action, 236
saving password, 15

Select Admin Default View dialog
box, 177

Select View dialog box, 175
selecting

a menu item, 27
a schema for active link, 276
a schema for escalations, 261
a schema for filters, 217
with the mouse, 26

selection fields
creating, 161
set number of rows, 149

Selection List window, 127
send interactive message

active links, 94, 290
filters, 84, 229

send message to user
escalations, 91
filters, 85, 231

separator for query list fields, 129
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server information, 41, 42, 374
NT servers, 41
UNIX servers, 41

Server Information dialog box
configuration, 47
database, 52
full text search, 395
licenses, 45
log files, 50
multiple servers, 374
platform, 42
timeouts, 43

Server Information option, 35
SERVER keyword, 448
server list, 15

in Windows NT registry,
modifying, 416

Server window, 24
servers

2.0.x with 1.2 or 2.0.x clients,
using, 377

accessing, 25
admin, 371
administering processes, 375
armaild process, 345
arserverd processes, 369, 393
arservftd process, 392
arservtcd process, 375, 393
configuring, 373
escalation, setting, 374
escalations, checking, 88
fast, 371
fast, setting, 374
list, 372
list, setting, 374
lock and log files, 373
maximum schemas allowed, 45
multiple processes, 369
multi-process server design, 369
performance, 369
private, running with multi-process

servers, 377
processes, administering, 375
registry, modifying Windows

NT, 416

Remedy ID, 46
RPC socket numbers, 370
running processes with NT

servers, 237, 245
search options, configuring FTS, 397
setting multi-process, 373
sockets, 370
using multi-process with AR

clients, 377
using private with Motif clients, 380
using private with Windows

clients, 380
service name, 285
set fields, 85, 91, 239
Set Fields active link action, 94, 283, 297
Set Fields escalation action, 91, 262
Set Fields filter action, 85, 227, 239
Set Grid Size dialog box, 184
setting

confirmation preferences, 62
default email options, 348
desktop preferences, 61
field property, 146
fields, 240
fonts for buttons, 65
multi-process servers, 373
optional field font, 65
radio button fonts, 65
required fields font, 65
schema fonts preferences, 64
system field fonts, 65
text fonts, 65

setting up
AR System, 73
mail, 348

Short Description field, 82
shortcut key sequences, 27
Short-description core field, 435
Show Field Properties on Field Creation

desktop preferences, 62
Show Status Bar desktop preference, 61
Show Tool Bar desktop preferences, 62
size limits, 157
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size of windows, 27
socket numbers (servers), 370
sorting records by WEIGHT, 384
special characteristics of core fields, 82
special characters, 129
special groups, 102
specifying

a pattern, 156
active link actions, 280, 281
active link basic conditions, 274
active link execution order, 276
active link name, 276
Change Field active link action, 283
DDE active link action, 286
directories to access macro files, 62,

339
escalation basic conditions, 260, 262,

372
escalation name, 261
escalations actions, 261
filter actions, 218, 225
filter conditions, 215, 216
filter execution order, 217
filter name, 217
filter qualifications, 218
Log to File filter action, 228
Message active link action, 290
Message filter action, 230
message numbers, 231, 291
Notify filter action, 231
number of rows, 149
optional fields, 153
permissions for a field, 164
required fields, 153
Run Macro active link action, 292
Run Process active link action, 295
Run Process filter action, 236
Set Fields active link action, 297
Set Fields filter action, 240
text for character menus, 201
values for fields, 85, 91, 94, 239, 297

SQL database, 52
SQL log file, 373
starting

Admin Tool, 13, 14
Admin Tool window fills screen, 61,

339
Import Tool, 320
mail handler, 353
mail handler (armaild), 353

states, 82
statistical information, processing, 159
status bar, 25

displaying, 61, 339
Status core field, 435
status field, 82
status history, 82
Status-history core field, 435
strategy for escalations, 87
STRSTR function, 250
styles of menus, 83
Subadmin Permissions, 127
Subadmin Permissions dialog box, 134
Subadministrator group, 103, 112

access, 103
admin permissions, 127
permissions described, 114
schema properties, 127

Subject line for email in filters, 234
submitter, 100
submitter access, 103
Submitter core field, 434
Submitter group, 103
submitter mode, 101
Submitter-severity defined field, 441
submitting ARs through email, 355
SUBSTR function, 250
Sun PC-NFS network stack, 422
Super TCP network stack, 423
supplying information to the mail

handler, 348
system defined fields, 440
system field

fonts, 65
preferences, 65

system maintained fields, 78
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system requirements for Windows, 2

T
table, database see schemas
TCP/IP network stack, 424
text editing window, 153, 155, 158
text entry, 153, 155, 158
text fields

in schemas, 157
size limits, 157

Time Criteria window, 265
TIME function, 250
TIME keyword, 448
Time Zone dialog box, 7
time zone, specifying during install, 7
TIMESTAMP keyword, 222, 448
To Entry ID reserved field, 439
To Mapping reserved field, 439
To Schema reserved field, 439
To Server reserved field, 439
toolbar, 25, 27, 321

displaying, 62, 339
functions, 28
icons, 28, 321
Import Tool functions, 321

Tools menu option
Export, 37
Import, 37

Tooltips, 27
topic name, 285
tracing

escalation activity, 267
filter activity, 253

transaction values, checking, 219, 220
Transfer Mode reserved field, 440
Transfer Status reserved field, 438
TRUNC function, 250
type style in field labels, 78
types

of active link actions, 282
of escalation actions, 262

of filter actions, 227
of licenses, 110

U
UNIX servers, see servers
unqualified queries, 48
Update Status reserved field, 438
updating change history, 69
UPPER function, 251, 305
use password file, 48
USER keyword, 448
User schema, 109

key fields in, 110
users

adding, 109, 111
deleting, 113
log file, 373
password, allowing users to

change, 113
passwords, 48
permissions, 108
privileges, 108
roles, 79
user default for notifications, 233
user email notifies from, 49
user name, 14, 110, 111
validating, 48
validation, 48
Windows conventions, 25

uses of the Administrator Tool, 32
using

active link change history, 310
Admin Tool window, 34
change history, 68
default login, 21
email to send notifications, 233, 366
escalations change history, 266
filter change history, 251
filters versus active links, 95
keywords, 447
mail templates, 354
mouse, the, 26
sample schemas, 80
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schema change history, 135
toolbar, the, 27, 321

V
validating users, 48
version

Admin Tool information, 23
database, 52
Import Tool information, 323
server, 42

view
access, 100
field permission, 100, 147, 164
group permission, 107

views of schemas
copying, 176
default admin view, selecting, 176
deleting, 177
multiple, 173
selecting and modifying, 175

W
Walker Richer & Quinn Reflection

network stack, 423
warning

active links, 94, 290
filters, 84, 229

WEEKDAY function, 251
WEEKDAY keyword, 448
WEIGHT, sorting records by, 384
Welcome dialog box, 4
When to Update reserved field, 440
width of query list fields, 129
wild cards, 446

QBE settings affecting FTS, 389
search options, configuring FTS, 397

window
active, 25
Active Link window, 270
arranging, 38
closing all, 38
closing current window, 35

controlling size and position, 27
Escalations window, 256, 263
Filter window, 212
Group Permissions, 139, 171, 307, 309
help topic, 38
Import Tool, 325
Main, 24, 25
manipulating, 27
Menu window, 201
Modify Schema, 118
New Server, 38
number that can be open, 40
open, 38
Query List Fields dialog box, 407,

408, 409
resource memory for opening, 40
Server, 24
See also dialog box

Window menu option, 37
Arrange Icons, 38
Cascade, 38
Close All Windows, 38
New Server Window, 38
Open Windows List, 38
Save Window Location, 38
Tile, 38

Windows
clients help, 71
installing client software, 3
NT servers, see servers
requirements

disk space, 2
hardware, 2
memory, 2
network stacks, 2

Tooltips, 27
user conventions, 25

Wollongong Pathway network stack, 422
workflow process

chart, 76
defining, 84, 92, 95

worksheets for designing workflow and
objects, 451
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X
X/Y field, 149

Y
YEAR function, 251
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